Building Reports Using the Web Intelligence Java Report Panel

BusinessObjects XI Release 2
Windows and UNIX
## Contents

### Part I  Introducing Web Intelligence

#### Chapter 1  About Web Intelligence  
- About Web Intelligence
- How Web Intelligence performs business intelligence over the web
- Interacting with Web Intelligence reports
- Creating and editing Web Intelligence documents

#### Chapter 2  Getting up and running  
- Overview
- Logging in and out of InfoView
- Selecting your Web Intelligence document editor

#### Chapter 3  Creating and editing Web Intelligence documents  
- Overview
- Creating new documents
- Editing existing documents
- Setting your Java Report Panel options
- Java Report Panel interface tour

### Part II  Working with data providers

#### Chapter 4  Building basic data providers  
- Overview
- Understanding data providers and universes
- Building a simple query
- Setting the scope of analysis
- Viewing and editing the SQL behind the query definition
- Defining query properties
- Working with query contexts
## Contents

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Working with combined queries</td>
<td>69</td>
</tr>
<tr>
<td></td>
<td>Overview</td>
<td>70</td>
</tr>
<tr>
<td></td>
<td>Types of combined query</td>
<td>70</td>
</tr>
<tr>
<td></td>
<td>What can you do with combined queries?</td>
<td>71</td>
</tr>
<tr>
<td></td>
<td>Building a combined query</td>
<td>73</td>
</tr>
<tr>
<td></td>
<td>Combined query structure</td>
<td>74</td>
</tr>
<tr>
<td></td>
<td>Combined query precedence</td>
<td>75</td>
</tr>
<tr>
<td>6</td>
<td>Including multiple data providers</td>
<td>79</td>
</tr>
<tr>
<td></td>
<td>Overview</td>
<td>80</td>
</tr>
<tr>
<td></td>
<td>Using multiple data providers</td>
<td>81</td>
</tr>
<tr>
<td></td>
<td>Defining multiple data providers in a document</td>
<td>82</td>
</tr>
<tr>
<td></td>
<td>Purging data from multiple data providers</td>
<td>90</td>
</tr>
<tr>
<td></td>
<td>Synchronizing multiple data providers</td>
<td>90</td>
</tr>
<tr>
<td>7</td>
<td>Merging dimensions from multiple data providers</td>
<td>93</td>
</tr>
<tr>
<td></td>
<td>Overview</td>
<td>94</td>
</tr>
<tr>
<td></td>
<td>Merging dimensions</td>
<td>94</td>
</tr>
<tr>
<td></td>
<td>Working with merged dimensions in reports</td>
<td>97</td>
</tr>
<tr>
<td></td>
<td>Understanding the effects of merged dimensions</td>
<td>98</td>
</tr>
<tr>
<td></td>
<td>Detail objects and merged dimensions</td>
<td>101</td>
</tr>
<tr>
<td>8</td>
<td>Filtering data retrieval using query filters</td>
<td>105</td>
</tr>
<tr>
<td></td>
<td>Overview</td>
<td>106</td>
</tr>
<tr>
<td></td>
<td>How query filters work</td>
<td>107</td>
</tr>
<tr>
<td></td>
<td>Types of query filters</td>
<td>114</td>
</tr>
<tr>
<td></td>
<td>Using predefined filters</td>
<td>115</td>
</tr>
<tr>
<td></td>
<td>Creating custom query filters</td>
<td>117</td>
</tr>
<tr>
<td></td>
<td>Combining multiple filters on a query</td>
<td>122</td>
</tr>
<tr>
<td></td>
<td>Applying query filters to business questions</td>
<td>128</td>
</tr>
</tbody>
</table>

4 Building Reports Using the Web Intelligence Java Report Panel
## Contents

**Chapter 9**  
Filtering data using subqueries and database ranking  
- Overview .................................................. 136  
- What is a subquery? .................................. 136  
- What is a database ranking? ...................... 141  

**Chapter 10**  
Building prompt filters on data providers  
- Overview .................................................. 146  
- What are prompts? ................................... 147  
- Adding prompts to documents ................... 155  
- Applying multiple prompts ....................... 157  

**Part III Working with Reports**

**Chapter 11**  
Inserting and formatting tables  
- Overview .................................................. 164  
- Web Intelligence table templates .................. 165  
- Working in Structure or Results View .......... 169  
- Adding tables to reports ............................ 170  
- Duplicating tables .................................... 176  
- Applying a different template to existing tables 178  
- Adding or removing table rows or columns .... 182  
- Moving or swapping table rows or columns ..... 186  
- Replacing table columns and rows ............... 188  
- Modifying tables to create crosstabs ............. 190  
- Clearing cells and removing tables ............. 193  
- Formatting tables and table cells ............... 197  
- Setting properties for table headers and footers 206  
- Setting page layout for tables .................... 208  
- Selecting display properties for empty table cells 209  
- Avoiding duplicate row aggregation .......... 210  
- Copying tables ....................................... 210
# Contents

## Chapter 12 Displaying information in free-standing cells
- Overview ................................................................. 214
- What are free-standing cells? ................................. 215
- Inserting text, images, and formulas ....................... 216
- Inserting information about the report data ............. 218
- Inserting page number information ....................... 220
- Formatting free-standing cells .............................. 223
- Copying free-standing cells ................................. 224

## Chapter 13 Inserting and formatting charts
- Overview ................................................................. 226
- About charts and chart templates ......................... 227
- Creating charts ...................................................... 229
- Changing existing tables and charts to different chart types ................ 235
- Removing charts .................................................... 239
- Working with charts .............................................. 239
- Formatting charts .................................................. 242
- Copying charts ...................................................... 266

## Chapter 14 Formatting numbers and dates
- Overview ................................................................. 268
- Default formats ..................................................... 269
- Applying predefined formats ................................. 269
- Defining custom formats ...................................... 273

## Chapter 15 Using sections, breaks, and sorts
- Overview ................................................................. 282
- Using sections to group data on reports ................. 283
- Using breaks to group data on tables ..................... 294
- Using sorts to organize sections and data on tables .... 303

## Chapter 16 Ranking Data
- Overview ................................................................. 308
- Ranking workflows ................................................. 308

---

6 Building Reports Using the Web Intelligence Java Report Panel
## Contents

**Chapter 17 Filtering the values displayed in reports**  
Overview ......................................................... 318
How report filters work ........................................ 319
Creating custom report filters ............................... 327
Applying multiple filters to a report ....................... 333
Viewing the filters applied to the report .................... 334
Editing and removing report filters ......................... 336

**Chapter 18 Using standard calculations**  
Overview ......................................................... 340
Working with standard calculations ......................... 341
Inserting calculations in tables and crosstabs .......... 342
Inserting multiple calculations .............................. 344
Removing calculations ........................................ 345

**Chapter 19 Using alerters to highlight key results**  
Overview ......................................................... 348
How alerters work .............................................. 349
Creating alerters ................................................. 356
Formatting alerters ............................................. 364
Applying multiple conditions ............................... 370
Adding sub-alerters .......................................... 374
Switching alerters on or off ................................ 379
Prioritizing alerters .......................................... 382
Editing, duplicating, and removing alerters ............ 384
Using formulas to create advanced alerters ............. 388

**Chapter 20 Creating custom calculations**  
Overview ......................................................... 402
Creating formulas .............................................. 403
About functions ............................................... 409
About operators ................................................. 410
Defining the calculation context ............................ 412
8 Building Reports Using the Web Intelligence Java Report Panel

Chapter 21 Web Intelligence functions
Overview ................................................. 440
What is a function? ................................. 440
Using functions ................................... 441
Function examples and descriptions ....... 442
Function reference .............................. 447

Chapter 22 Saving formulas as variables
Overview ............................................. 450
Creating, editing, and deleting variables .. 450
Using variables to simplify formulas ....... 455

Chapter 23 Troubleshooting formulas
Overview ............................................... 462
#DIV/0 .................................................. 463
#MULTIVALE .......................................... 464
#OVERFLOW ......................................... 464
#SYNTAX ............................................. 464
#INCOMPATIBLE .................................. 465
#RANK ............................................... 465
#DATASYNC ......................................... 465
#CONTEXT ......................................... 466
#SECURITY ........................................ 466
#RECURSIVE ....................................... 467
#ERROR ............................................. 467

Part IV Working with Documents

Chapter 24 Setting up documents for drill analysis
Overview ............................................. 472
What is drill? ........................................ 473
# Contents

Setting your drill options .............................................. 474  
Making documents drillable ............................................ 480  
Beginning your drill session ........................................... 483  
Drilling on dimensions in tables and sections ........................ 485  
Drilling on measures in tables and sections .......................... 496  
Synchronizing drill across multiple tables and charts ............. 499  
Drilling on charts ..................................................... 501  
Using filters when you drill ............................................ 507  
Using query drill ....................................................... 515  
Ending Drill Mode ..................................................... 519  

## Chapter 25 Saving and deleting Web Intelligence documents 523
Overview ................................................................. 524  
Saving Web Intelligence documents to InfoView ..................... 525  
The document is saved in InfoView. ................................... 526  
Deleting Web Intelligence documents .................................. 527  
Saving documents as Excel or PDF files ............................... 528  

## Chapter 26 Linking documents with OpenDocument 531
Overview ................................................................. 532  
How OpenDocument works ............................................. 532  
Supported document types .............................................. 533  
OpenDocument syntax .................................................. 533  

## Chapter 27 Printing Web Intelligence documents 545
Overview ................................................................. 546  
Printing the reports in documents ...................................... 547  

## Appendix A Business Objects Information Resources 551
Documentation and information services ............................... 552  
Documentation .......................................................... 552  
Customer support, consulting and training ............................ 554  
Useful addresses at a glance ............................................ 556
Contents

Index  557

10 Building Reports Using the Web Intelligence Java Report Panel
About Web Intelligence
How Web Intelligence performs business intelligence over the web

Web Intelligence provides business users an easy to use interactive and flexible user interface for building and analyzing reports on corporate data over the web, on secured intranets and extranets. The Web Intelligence software is installed by your administrator on a web server on your corporate network.

To use Web Intelligence from your local computer, you log into the business intelligence portal InfoView via your Internet browser. Then, depending on your security profile, you can interact with the reports in corporate documents or edit or build your own documents using a Web Intelligence report panel or query panel.
Interacting with Web Intelligence reports

Depending on your security profile and on how Web Intelligence is deployed across your organization, you can view, analyze, or enhance and modify the data displayed on reports.

Viewing and printing reports

Once logged into the business intelligence portal InfoView, you can access Web Intelligence documents and view reports. Onscreen navigation is made easy with page-to-page navigation buttons and a document map that allows you to jump from section to section or report to report.

The same document can provide the information adapted to each user due to prompts that request each user, who opens the document, to specify the data they want to return to the reports.

When you print reports, Web Intelligence automatically generates a copy of reports in Portable Document Format (PDF) format for optimum print quality.

Drilling results

Drilling on Web Intelligence reports in HTML or in Interactive format enables you to analyze the detailed data behind the displayed results. You can turn the report you are viewing into a drillable report or drill on a duplicate of the original report to retain a version of the results before your drill analysis.

Once you have found the information you need, you can save a snapshot of the drilled report to share the results of your analysis with other Web Intelligence users, or save the document in Excel or Portable Document (PDF) format to print or email to other business contacts.
Performing on-report analysis

Viewing Web Intelligence reports in Interactive view format enables you to enhance reports and fine-tune the data reports contain, to highlight the information that most interests you on demand.

On-Report Analysis is designed for:

• users who need to build data providers and then want to build reports
• report consumers who need to manipulate the reports created by others

With On-Report Analysis you can:

• view document metadata to understand the data behind reports and see how reports are structured and filtered
• filter and sort results
• add new tables and charts
• add formulas and create variables
• format and change the layout of charts and tables
• slice and dice results by adding other data to charts and tables

Full information on how to use On-Report Analysis can be found in Performing On-Report Analysis with Web Intelligence.

Note: On-report analysis of Web Intelligence reports in Interactive view format is only available, if your administrator has deployed Web Intelligence in JSP mode.
Creating and editing Web Intelligence documents

You can create or edit Web Intelligence documents using one of several tools:

- Java Report Panel
- Query – HTML
- HTML Report Panel

This section explains the differences between each tool.

**Web Intelligence Java Report Panel**

The Java Report Panel is designed for users who need more flexibility with designing report layout and defining formulas and variables. A graphical Formula Editor enables you to build formulas rapidly using drag-and-drop.

Note: The Web Intelligence Java Report Panel is available if your administrator has deployed Web Intelligence in ASP mode and if your administrator has deployed Web Intelligence in JSP mode.
Web Intelligence Query – HTML

Designed for users requiring a pure HTML environment to build data providers, Web Intelligence Query – HTML offers the ability to define the data content of documents on multiple data sources. You can use Query – HTML to create new documents from scratch or edit the data providers in documents created using any of the other Web Intelligence tools.

Used together with On-Report Analysis, Query – HTML provides a complete solution for building data providers and designing powerful reports in a pure HTML environment. Once you have run the data providers to generate a standard report, you can leverage Web Intelligence On-Report Analysis features to format multiple reports, add formulas, and create variables.

**Note:** Web Intelligence Query – HTML and On-Report Analysis in Interactive view format are only available, if your administrator has deployed Web Intelligence in JSP mode.
Web Intelligence HTML Report Panel

Designed for users who need to build basic reports, the HTML Report Panel provides query and report features in a simple wizard-like interface. Each document is based on a single data source and can contain multiple reports, displaying different subsets of information.

In addition, the HTML Report Panel is 508 compliant and can be customized for specialized deployments.

**Note:** The Web Intelligence HTML Report Panel is only available, if your administrator has deployed Web Intelligence in JSP mode.

**Related topics:**

This guide tells you how to build reports using the Java Report Panel. For information on performing on-report analysis on Web Intelligence reports, see *Performing On-Report Analysis with Web Intelligence*. For information on using Web Intelligence Query – HTML, see *Building data providers Using Web Intelligence Query – HTML*. For information on using the Web Intelligence HTML Report Panel, see *Building Reports Using the Web Intelligence HTML Report Panel*. 
Getting up and running
Overview

You access the Web Intelligence Java Report Panel via InfoView, the corporate business intelligence portal.

This chapter tells you how to:

• log in and out of InfoView
• select the Java Report Panel as your Web Intelligence document editor
Logging in and out of InfoView

You access Web Intelligence by using your web browser to log into InfoView, the corporate business intelligence portal. Once you are in InfoView, you can analyze Web Intelligence reports and create or edit Web Intelligence documents.

This section tells you how to:
• log into InfoView
• log out of InfoView

Logging into InfoView

Before you can use InfoView and Web Intelligence you need the following information:
• a URL to the InfoView server
• the InfoView server name and port number
• your login and password
• your authentication, which controls the InfoView resources available to you

Note: Contact your administrator for this information, if necessary.

To log into InfoView:
1. Launch your web browser.
2. Point your browser to the InfoView bookmark or URL.
   The InfoView login page appears.
3. If the System box is blank, type the name of the InfoView server followed by a colon (:), and then type the port number.
   For example, if the name of the InfoView server is corpbusintell and the port number is 4200, then type: corpbusintell:4200
   Your administrator can provide you with this system information.
4. In the Username box, type your user name.
5. In the Password box, type your password.
6. In the Authentication box, select the authentication provided to you by your administrator.
7. Click Log On.

    The InfoView home page appears.

    To find out how to edit or create Web Intelligence documents, see "Creating and editing Web Intelligence documents" on page 27. To find out how to access Web Intelligence documents, see the Performing On-Report Analysis with Web Intelligence guide.

Logging out of InfoView

When you finish using InfoView or Web Intelligence you need to log out, instead of simply closing your web browser.

Note: Before logging out of InfoView, verify that any documents you have open are saved. For information on saving documents, see “Saving Web Intelligence documents to InfoView” on page 525.

Logging out of InfoView enables:

• you to save any user settings you modified during your InfoView session
• your administrator to track how many users are logged into the system at any given time and to optimize InfoView and Web Intelligence to best serve the needs of yourself and other users

Logging out of InfoView

To log out of InfoView:

• Click the Logout button.

    The login page appears. You are logged out of InfoView.
Selecting your Web Intelligence document editor

To edit or create documents using the Java Report Panel, you need to verify your Web Intelligence Document Preferences are set accordingly. Information on how to do this is provided below.

**Note:** If you are using Web Intelligence deployed in ASP mode, only the Java Report Panel is available. It is therefore not necessary to select the Java Report Panel on the Web Intelligence Document Preferences page.

**Note:** Information on setting your options for viewing, analyzing, and interacting with reports is provided in the *Performing On-Report Analysis on Web Intelligence Reports* guide, since these options do not affect how you use the Web Intelligence Java Report Panel.

► **Setting your Create/Edit options**

To set your create/edit options:

1. Click the **Preferences** button on the InfoView toolbar.
2. Click the **Web Intelligence Document Preferences** tab.
   
   The **Web Intelligence Document Preferences** page appears.
3. In the **Select a report panel** section, click **Java Report Panel**.
4. Click **OK**.
   
   InfoView displays the page you were on previously.

To find out how to create documents, see “Creating new documents” on page 29. To find out how to edit documents, see “Editing existing documents” on page 30.
Getting up and running
Selecting your Web Intelligence document editor
Creating and editing Web Intelligence documents
Overview

You create and edit reports in Web Intelligence documents by launching a Web Intelligence report panel from InfoView. This guide tells you how to create and edit documents using the Java Report Panel.

This chapter tells you how to:
• create new documents
• edit existing documents
• set your Java Report Panel options

Note: Before you can edit or create a Web Intelligence document using the Java Report Panel, you need to verify that the Java Report Panel is selected on the Web Intelligence Document Preferences page in InfoView. To find out how to do this, see “Setting your Create/Edit options” on page 25.
Creating new documents

You create Web Intelligence documents by selecting a universe in InfoView. Each universe maps to a database containing corporate business information. This database can be a relational database or an OLAP (On-Line Analytical Processing) database. Although the data is stored differently in relational and OLAP databases, you access it in the same way through a universe.

When you connect to a universe, Web Intelligence launches a report panel automatically. You use the report panel to define the data and the reports you want to include in the new document.

**Note:** Before you can edit or create a Web Intelligence document using the Java Report Panel, you need to verify that the Java Report Panel is selected on the **Web Intelligence Document Preferences** page in InfoView. To find out how to do this, see “Setting your Create/Edit options” on page 25.

Selecting a universe and launching a report panel

To select a universe and launch a report panel:

1. On the InfoView Home page, click **New Document**.
2. Click the title of the universe on which you want to create a document.

The Web Intelligence report panel opens.

**Note:** The first time you use the Java Report Panel, Web Intelligence automatically downloads a Java applet to your computer. If your computer is using Microsoft Windows 2000 as its operating system, you must be logged into your computer as Administrator to download the applet.

You define the data selection and the report structure for the new document using the Web Intelligence report panel selected on the **Web Intelligence Document Preferences** page in InfoView. For more information, see “Selecting your Web Intelligence document editor” on page 25.

To see how to build documents using the Web Intelligence Java Report Panel, see “Building basic data providers” on page 39.
Editing existing documents

You open and edit Web Intelligence documents from InfoView, the corporate business intelligence portal. If you have not already logged into InfoView, see “Logging in and out of InfoView” on page 23.

**Note:** Before you can edit or create a Web Intelligence document using the Java Report Panel, you need to verify that the Java Report Panel is selected on the Web Intelligence Document Preferences page in InfoView. To find out how to do this, see “Setting your Create/Edit options” on page 25.

There are two ways to open a Web Intelligence document in edit mode:

- view the document first and then switch to Edit mode
- switch to edit mode directly without viewing the document contents first

**Viewing a document and switching to Edit mode**

To view a document and then switch to Edit mode:

1. Make sure you are logged into InfoView.
   For full information, see “Logging into InfoView” on page 23.
2. On the InfoView home page, navigate to the document you want to open.
   You do this by clicking the folders in My Folders or Public Folders, or by entering a keyword or the title of the document in the Search box on the InfoView home page.
   The list of documents appears.
3. Click the document title.
4. If the document contains any prompts, you need to select the value(s) you want returned to the document, and then click Run Query.
   The Java Report Panel launches and displays the document.
Creating and editing Web Intelligence documents

Editing existing documents

- Editing a Web Intelligence document directly

To edit a Web Intelligence document directly:

1. Make sure you are logged into InfoView.
   For full information, see “Logging into InfoView” on page 23.

2. On the InfoView home page, navigate to the document you want to open.
   You do this by clicking the folders in My Folders or Public Folders, or by entering a keyword or the title of the document in the Search box on the InfoView home page.
   The list of documents appears.

3. Click Modify below the document name.

4. If the document contains any prompts, you need to select the value(s) you want returned to the document, and then click Run Query.
   The Java Report Panel launches and displays the reports in the document.

**Note:** To edit Web Intelligence documents using the Java Report Panel, the Java Report Panel needs to be selected on the Web Intelligence Document Preferences page in InfoView. To find out how to do this, see “Setting your Create/Edit options” on page 25.
Setting your Java Report Panel options

You can personalize the following display settings of the Web Intelligence Java Report Panel to help you position report elements on report pages:

- define the unit for measurement
- display a grid to help align page elements
- use snap to grid to reposition page elements accurately
- define grid spacing

To set your Java Report Panel Options

1. Click the **User Settings** button in the Java Report Panel toolbar.

   The **User Settings** dialog box appears.

2. Specify measurement settings for the document properties and define grid settings here.

3. Click **OK**.

   Web Intelligence saves your new settings. The new settings are applied the next time you launch the Java Report Panel.
Java Report Panel interface tour

The Java Report Panel provides a rich interface for working with Web Intelligence documents.

You interact with documents in two ways:

• through toolbars
• through report tabs

This is what the interface looks like:

Configure View menu

Set the object order on the Data tab by clicking here

Main toolbar
Formatting toolbar
Pagination toolbar
Report toolbar
(Docked in new position)
Report tabs
Toggle Auto Hide icon
Toolbars

The following table describes the Java Report Panel toolbars:

<table>
<thead>
<tr>
<th>Toolbar name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Main         | Used to save and print reports, to switch between Query and Report view, to show/hide the other toolbars and to select default interface configurations.  
**Note:** The Main toolbar is always visible in Report View and Query View (when you are working in the Query Panel). |
| Formatting   | Used to set font styles and background colors. |
| Reporting    | Used to work with reporting functionality such as filters, alerters and ranking |
| Page Navigation | Used to navigate through a report |

You display and hide the toolbars by selecting/deselecting the Configure View > Toolbars > `<toolbar name>` option on the Main toolbar or right-clicking any of the toolbars and selecting/deselecting the toolbars on the menu that appears.

You can drag toolbars and dock them in a new position just as you can with products such as Microsoft Word. For example, you can drag a toolbar from a horizontal position across the top of the interface to a vertical position along the left-hand side.

Report tabs

The Java Report Panel has four report tabs as described in the following table:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
<td>Contains the objects (universe objects and variables) available to be placed in a report. You can order the objects either alphabetically or by query (if your report contains more than one query) by clicking the <strong>Arranged By</strong> arrow at the bottom of the tab and selecting the order type.</td>
</tr>
<tr>
<td>Template</td>
<td>Used to add tables, charts and free-standing cells to a report. (See, for example, “Creating a table by selecting a template” on page 172.)</td>
</tr>
</tbody>
</table>
Creating and editing Web Intelligence documents

Java Report Panel interface tour

The Java Report Panel has four default configurations for the tabs. You access these configurations from the Configure View menu on the Main toolbar.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map</td>
<td>Describes the report structure graphically.</td>
</tr>
<tr>
<td>Properties</td>
<td>Used to set the properties associated with the currently-selected report element. The property list changes depending on the selected element. For example, if you select a cell, the tab lists the properties associated with cells. If you select a table, the tab lists those properties associated with tables. The report elements for which the Properties tab contains groups of properties are: report, section, free cells, table cells, charts, headers and footers. You set properties either directly in the Properties tab, in the space to the right of the property, or you click the button or arrow that displays in the space to the right of the property when you select it. This button displays the appropriate dialog box for setting the property. When you select a property, Web Intelligence displays a short help text to at the bottom of the tab to explain what the property does. You can select multiple report elements of different types. In this case the Properties tab shows only those properties that are common to all types. <strong>Note:</strong> You do not set document properties in the Properties tab. To set document properties, right-click on a report outside any of the above elements and select Document Properties from the menu to display the Document Properties tab.</td>
</tr>
</tbody>
</table>
The following table describes the default configurations:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data</strong></td>
<td>• All tabs appear on the left with the Data tab at the front.</td>
</tr>
<tr>
<td><strong>Data/Properties</strong></td>
<td>• All tabs appear on the left.</td>
</tr>
<tr>
<td></td>
<td>• The Properties tab appears below the other three.</td>
</tr>
<tr>
<td><strong>Data/Properties on Right</strong></td>
<td>• The Data, Templates and Map tabs appear on the left.</td>
</tr>
<tr>
<td></td>
<td>• The Properties tab appears on the right.</td>
</tr>
<tr>
<td><strong>Collapsed Data/Properties</strong></td>
<td>• The Data, Templates and Map tabs appear collapsed in toolbar form down the left side of the screen.</td>
</tr>
<tr>
<td></td>
<td>• The Properties tab appears collapsed down the right side.</td>
</tr>
<tr>
<td></td>
<td>• You click on the tab icon in the collapsed toolbar to display the tab. If another tab on the same toolbar is currently displayed it is replaced by the tab you click.</td>
</tr>
<tr>
<td></td>
<td>• You click the <strong>Toggle auto hide</strong> icon in the top right corner of an extended tab to revert the tab to its extended position.</td>
</tr>
<tr>
<td></td>
<td>• You click the <strong>Toggle auto hide</strong> icon on an extended tab to revert the tab to its collapsed position.</td>
</tr>
</tbody>
</table>
Working with data providers
Building basic data providers
Overview

This chapter describes how you can build a basic report by creating and running a data provider using objects in a universe. It explains the fundamentals of universes and describes the objects that you use to construct a query.

It includes information on the following:

• understanding data providers and universes
• building a simple data provider
• setting a scope of analysis, to include additional data for analysis
• viewing and editing the SQL generated for the data provider
• defining data provider properties, to return data more efficiently
• selecting a context, to direct a data provider to return specific data
• incompatible objects
Understanding data providers and universes

You access data in a database by running data providers using objects in a universe. This section describes what a data provider is, how you use a universe to build and run data providers to get the data you need, and how to create reports using the Web Intelligence Java Report Panel.

What is a data provider?

A data provider contains one or more queries that return data from a database. A query requests data from the database. If the data is available, then the requested data is returned by default in the form of a table which contains rows and columns.

When you build a query, you are creating a request for information from a database. A request can be very simple, for example; give me total sales in California for the first quarter of last year, or more complicated, for example; give me an average age of customers who bought sweaters during the spring television promotion in Paris.

Queries are sent to the databases in a language called SQL (Structured Query Language). However, when you use Web Intelligence you do not have to know any SQL. The Web Intelligence report panel presents the information available in the database as objects that have names and meanings familiar to you. These objects are organized in a structure called a universe.

You build data providers by combining objects in a universe. The universe translates the objects presented in your business language to SQL, and then sends the request for information to the database. Web Intelligence can generate SQL data providers of unlimited length. When the data is returned to the Web Intelligence report panel, it is presented in a table form, with columns that have the same names as the objects that you used in the query. The data is arranged in rows.
Data providers and queries are based on universes

You build data providers and queries in the Java panel using objects in a universe. A universe is a representation of the information available in a database. This information is presented in everyday terms that describe your business situation. The universe appears on the Data tab to the left of the Result Objects and Query Filters panes.
What does a universe contain?

Universes are made up of objects and classes. These are described below:

<table>
<thead>
<tr>
<th>Universe component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>Named component that maps to data or a derivation of data in the database. You use objects in a query to retrieve data for your reports. For example, some of the objects in a sales universe would be Products, Region, and Sales Revenue.</td>
</tr>
<tr>
<td>Class</td>
<td>Logical grouping of objects. Each class has a meaningful name, for example; the class Store contains the objects State, City, and Store name.</td>
</tr>
</tbody>
</table>

What types of objects can you use in a query?

Objects can represent different types of information:

<table>
<thead>
<tr>
<th>Object</th>
<th>Examples</th>
<th>Description</th>
</tr>
</thead>
</table>
| Dimension | - Country  
- Resort  
- Service Line | Retrieves the data that will provide the basis for analysis in a report. Dimension objects typically retrieve character-type data, for example; customer names, line names, or dates. |
| Detail | - Customer  
- Age  
- Phone Number  
- Address  
Details | Provides descriptive data about a dimension. A detail is always attached to the dimension for which it provides additional information. For example, Age is a detail object that is associated with Customer dimension. Address provides additional information on customers. |
| Measure | - Revenue  
- Number of guests  
- Future guests | Retrieves numeric data that is the result of calculations on data in the database. For example; Revenue is the calculation of the number of items sold multiplied by item price. Measure objects are often located in a Measures class. |
Classes and Subclasses

Objects are grouped into folders called classes. Each class can also contain one or more subclasses. Subclasses contain objects that are a further subcategory of the objects in the upper level of the class.

The role of classes is to organize the objects into logical groups. When you create data providers on the universe, classes help you to find the objects that represent the information that you want to use in a query.

Classes and Objects are presented in a tree structure as follows:

```
<table>
<thead>
<tr>
<th>Data</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fashion demo - MS Access</td>
<td></td>
</tr>
<tr>
<td>Time zone</td>
<td></td>
</tr>
<tr>
<td>Store</td>
<td></td>
</tr>
<tr>
<td>State</td>
<td></td>
</tr>
<tr>
<td>City</td>
<td></td>
</tr>
<tr>
<td>Store name</td>
<td></td>
</tr>
<tr>
<td>Zip Code</td>
<td></td>
</tr>
<tr>
<td>Address</td>
<td></td>
</tr>
<tr>
<td>Store details</td>
<td></td>
</tr>
<tr>
<td>Sales floor size?</td>
<td></td>
</tr>
<tr>
<td>Owned stores</td>
<td></td>
</tr>
<tr>
<td>Stores with long opening hours</td>
<td></td>
</tr>
<tr>
<td>Product</td>
<td></td>
</tr>
<tr>
<td>Promotions</td>
<td></td>
</tr>
<tr>
<td>Measures</td>
<td></td>
</tr>
<tr>
<td>Sales revenue</td>
<td></td>
</tr>
<tr>
<td>Quantity sold</td>
<td></td>
</tr>
<tr>
<td>Margin</td>
<td></td>
</tr>
<tr>
<td>Discount</td>
<td></td>
</tr>
</tbody>
</table>
```

Each folder represents a class
Each icon within a class represents an object
Details are under dimensions

You can search for classes and objects in the tree by selecting an item in the tree, then typing a letter. You can refine the search by typing further letters. For example, if you type "y" then "e", Web Intelligence first searches for objects beginning with "T", then "searches for objects beginnning with "ye". The objects that correspond to the search condition are selected in the tree.

Creating and running a query

You use a universe to create a query in much the same way that you use nouns and verbs to construct a sentence. The dimension objects form the subject matter for the query. These are the objects that contain the information you want to retrieve, and a measure gives the query its required action, it tells the query what to do with the information represented by the dimensions.
Why build a query?
You build a query to answer a business question that requires data from a database. The query is your means to ask the database for information.

How do you use the universe to build a query?
The universe is displayed in the Query Manager. From the Query Manager, you select the dimensions and details that represent the information that you want to retrieve, and add them to a work space called the Results Objects pane. You add one or two measure objects that represent the calculation, or the action that you want to perform on the information.

Once you have constructed your query, you then run the query against the database.

What happens when you run a query?
When you run a query, you retrieve the information from the database represented by the objects that you have added to the Results Objects pane. The request for information is processed in the database, and the results are sent back to the Web Intelligence Java Report Panel in the form of a document. The document contains all the information that you asked for in the query, arranged in table columns and rows.

What happens when you interrupt run query?
You can interrupt a query before Web Intelligence has returned all the data to the document. Interrupting a query is useful if you realize you want to change the definition of the query after you have already clicked the Run Query or the Refresh button. For full information on the options you can choose when you interrupt a query, see “Interrupting data providers” on page 64.

Returned data is stored for analysis
The data that is returned in a query is stored in the document. It is convenient to visualize the returned data as being organized as a cube. In the document, the data is displayed as a table. The table is a flat, two dimensional view of the of the data cube.

Each of the columns in a returned document represents an axis in the cube. You can edit the document by swapping and manipulating the data within the cube on any axis. When you swap or change data between different axis, the new result is again projected as a flat table in the resulting document.

The data stored in the cube allows you to create a report that corresponds to your business needs without having to send another query to the database.
If you want to add information to the document that is not in the cube, then you must add the object to the query and run the query again to get the new information.

Building a simple query

Before you can create a query, you must firstly start the Web Intelligence Java panel and select a universe. Refer to the chapter “Creating and Editing Web Intelligence Documents” for more information on connecting to a universe.

Once you are connected to a universe, the universe objects appear in the Query Manager. You build a query by selecting objects in the Query Manager Data page, and adding them to the Results Objects pane. You can set various properties for the query, and then run the query to get the data for each object.

The following is an overview of the steps that you follow to build a query. Each stage is described in more detail in its corresponding section. A procedure for the whole process is given in the section “Building and running a simple query” on page 59.

You can control the amount and type of data that is returned for an object by setting filters on the object. This is described in “” on page 105.

Overview

An overview of the query building process appears below:

<table>
<thead>
<tr>
<th>What you do to build a query</th>
<th>See the section</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigate the Query Manager to find the objects</td>
<td>“Using the Data tab” on page 47</td>
</tr>
<tr>
<td>that you want to use in the query.</td>
<td></td>
</tr>
<tr>
<td>Select and add objects to a query</td>
<td>“Building the query” on page 48</td>
</tr>
<tr>
<td>Set the scope of analysis</td>
<td>“Setting the scope of analysis” on page 50</td>
</tr>
<tr>
<td>Set properties for the data providers</td>
<td>“Defining query properties” on page 56</td>
</tr>
<tr>
<td>Run the query</td>
<td>“Running a simple query” on page 59</td>
</tr>
</tbody>
</table>
Using the Data tab

The objects that you can use in a query are contained in a universe. The universe is displayed on the Data tab at the left of the Result Objects and Query Filter panes.

Within a universe, objects are organized in folders called classes which are arranged in a tree view in the Data tab. Each class is attached to the tree by a node. You click the node alternatively to open the class folder to display its objects or close the class folder to hide its objects. You navigate through the objects in a universe by expanding and closing classes.

Opening and closing a class folder

You open a class folder to display its objects. You close a class folder to hide its contents. Opening a class folder is called expanding a class.

To expand a class:

• Click the + sign next to the class that contains the object that you want to use in a query.
  Or
  Double-click a class folder.
  The class expands. The objects contained in the class appear in the tree view.

To close a class:

• Click the - sign next to the class that you want to close.
  Or
  Double-click an open class folder.
  The class closes. The objects contained in the class are no longer displayed.
Building the query

You build a query by selecting objects in the Data tab and dragging them onto the Result Objects pane. You can add objects one-by-one or add all the objects in a class folder at once. You can also remove objects from the Result Objects pane at any time.

This section of this guide tells you how to:

- add an object to a query
- add all the objects in one class to a query
- remove an object from a query

**Adding an object to a query**

To add an object to a query:

1. Verify you are in Query View.
   - The **Edit Query** button is pressed in when you are working in Query View.
2. In the **Data** tab, open a class.
   - The class expands to show the objects that belong to the class.
3. Select an object and drag it over to the **Result Objects** pane.
   - The object or class appears in the Result Objects pane.

**Adding all the objects in a class to a query**

To add all the objects in a class to a query:

1. Verify you are in Query View.
   - The **Edit Query** button is pressed in when you are working in Query View.
2. Select a class and drag it over to the **Result Objects** pane.

![Image of Web Intelligence interface](image)

All of the objects in the class appear in the Result Objects pane.

**Removing an object from a query**

To remove an object from a query:

1. Make sure you are in Query View.
   
   The **Edit Query** button is pressed in when you are working in Query View.

2. Select an object in the **Result Objects** pane.

3. Drag the object over to the **Data** tab.
   
   Or
   
   Click **Delete**.

   The object is removed from the Result Objects pane. The next time you run the query the object is not included in the query definition.
Setting the scope of analysis

In a universe, the objects within each class are usually represented in a hierarchy. For example, a class called Time period contains the objects Year, Quarter, Month, and Week arranged in a hierarchy as follows:

```
- Time period
  - Year
  - Quarter
  - Month
  - Week
```

Note: The hierarchy does not always correspond to the order of dimensions within a class. This is because the hierarchies can be customized at the universe level by your administrator, using BusinessObjects Designer.

What is a scope of analysis?

The scope of analysis for a query is extra data that you can retrieve from the database to give more details on the data returned by each of the objects in a query. This extra data does not appear in the initial result document, but it remains available in the data cube, so you can pull this data in to the report to allow you to access more detail at any time. This process of refining the data to lower levels of detail is called drilling down on an object.

In the universe, the scope of analysis corresponds to the hierarchical levels below the object selected for a query. For example, a scope of analysis of one level down for the object Year, would include the object Quarter, which appears immediately under Year.

You can set this level when you build a query. It allows objects lower down the hierarchy to be included in the query, without them appearing in the Results Objects pane. The hierarchies in a universe allow you to choose your scope of analysis, and correspondingly the level of drill available.

You can also create a custom scope of analysis by selecting specific dimensions to the Scope of Analysis pane.

Note: You cannot define a scope of analysis when working in Query Drill mode. Query Drill defines the scope automatically in response to drill actions.
Setting levels of analysis

When you set the scope of analysis for a query, you include dimensions one or more levels down the hierarchy tree for each dimension that you have added to the Result Objects pane.

When you run the query, the dimensions included in the scope of analysis are returned to the cube for that document, but are not projected onto the reports that the document contains. They can be added to the reports at any time, without having to run the query again. Values for the dimensions in the scope of analysis can also be viewed by switching a report to Drill mode, and then drilling down to them from the values displayed on the report. (For full information on performing drill analysis, see “Setting up documents for drill analysis” on page 471.)

How many scope of analysis levels can you set?

You can set the following levels for scope of analysis:

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Only the objects that appear in the Results Objects pane are included in the query.</td>
</tr>
<tr>
<td>One level down</td>
<td>For each object in the Results pane, one, two, or three objects lower down the hierarchy tree are included in the query. The data from these objects is stored in the cube until you add them to the document.</td>
</tr>
<tr>
<td>Two levels down</td>
<td></td>
</tr>
<tr>
<td>Three levels down</td>
<td></td>
</tr>
<tr>
<td>Custom</td>
<td>All objects added manually to the Scope of Analysis panel are included in the query.</td>
</tr>
</tbody>
</table>

Note: Including a scope of analysis in a document increases the document size significantly. This is because the data necessary for the scope you specify is saved with the document, even though it is not visible in the reports unless you start drill mode and drill down to the data to display the corresponding values.

In order to minimize the size of documents and optimize performance, we recommend that you only include a scope of analysis in documents where you are certain that users will need to drill.
**Setting the Scope of Analysis**

To set the scope of analysis:

1. Verify that you are in Query View.
   
   The Edit Query button on the Web Intelligence toolbar is pressed in when you are in Query View.

2. Click the **Show/Hide Scope of Analysis Pane** button so that it appears pressed in.
   
   The Scope of Analysis panel appears at the bottom of the Result Objects pane. The default scope of analysis is **None**.

   Each dimension in the Result Objects pane appears in the Scope of Analysis pane.

3. Click the down arrow in the **Scope of Analysis** drop-down list box.

4. Select a level for the scope of analysis.
The level appears in the list box and the dimensions that are hierarchically below each dimension in the Result Objects pane appear in the Scope of Analysis pane.

5. If you want to add selected dimensions to the scope of analysis or create a custom scope of analysis, select dimensions in the Query Manager and drag them across to the Scope of Analysis panel.

**Viewing and editing the SQL behind the query definition**

When you build a query, Web Intelligence automatically generates the appropriate SQL to retrieve the data from the database that you are accessing. You can view and edit this SQL.

- **Viewing the SQL behind a query**
To view the SQL behind a query:

1. Verify you are in Query view.
   If the reports are displayed, click **Edit Query** to go to Query view.

2. On the query panel toolbar, click **View SQL**.
   The SQL Viewer dialog box appears, displaying the SQL behind the query.

3. If you want to re-use the SQL in another application, click **Copy** to copy the SQL to the clipboard.
Building Reports Using the Web Intelligence Java Report Panel

Building basic data providers

Viewing and editing the SQL behind the query definition

Sometimes Web Intelligence generates more than one SQL statement to satisfy a query. Web Intelligence runs each SQL query separately, then resolves the results. This occurs in the following situations:

- Your query contains incompatible objects. (For more information on incompatible objects, see “How Web Intelligence handles incompatible objects” on page 66.)
- Your document contains multiple data providers. (For more information on multiple data providers, see Chapter 6: Including multiple data providers on page 79.)
- You have used a combined query and the database does not support the combination operator you used. (For more information on combined queries, see Chapter 5: Working with combined queries on page 69.)

In each case you see a hierarchical view of the SQL queries on the left of the dialog box. The root item of the hierarchy is labelled according to the reason why the SQL was generated in multiple queries. For example, if the SQL was generated from a combined query using MINUS, the root item is Minus; if the SQL was generated from a query containing incompatible objects, the root item is Synchronization.

Viewing the SQL behind a query with multiple SQL statements

To view the SQL:

1. Verify you are in Query view.
   - If the reports are displayed, click Edit Query to go to Query view.
2. On the query panel toolbar, click View SQL.
   - The SQL Viewer dialog box appears, displaying the SQL behind the query.
3. In the left pane, click the root item to expand the hierarchy of SQL queries. (The queries are named Select 1, Select 2... in the hierarchy.)
4. Click the the query you want to view to display the SQL in the right pane.
   - If you want to re-use the SQL in another application, click Copy to copy the SQL to the clipboard.

Editing the SQL behind a query

1. Verify you are in Query view.
   - If the reports are displayed, click Edit Query to go to Query view.
2. On the query panel toolbar, click View SQL.
   - The SQL Viewer dialog box appears, displaying the SQL behind the query.
3. Click **Use custom SQL**.
   The SQL becomes editable.
4. Edit the SQL then click **Validate** to ensure that it is correct.
5. Click **Save** to save the new SQL.
Defining query properties

You can set properties for the query that can optimize the time taken for the query to run, or the amount of data returned, set security options, specify the order of prompts in the report, and control potential ambiguous query results. The query properties options are grouped together in sections on the Properties tab in Query View.

Query property options
You can set the following query properties:

<table>
<thead>
<tr>
<th>Query Property</th>
<th>Available Options and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>• The name you specify for the selected query is displayed on the corresponding query tab.</td>
</tr>
</tbody>
</table>
| Data           | • **Retrieve duplicate rows**  
In a database, the same data may be repeated over many rows. You can choose to have these repeated rows returned in a query, or to have only unique rows returned. |
| Limits         | • **Max rows retrieved**  
Maximum number of rows of data that can be returned when a query is run. If you only need a certain amount of data, you can set this value to limit the number of rows of data that is returned to your document. This prevents a query from taking too much time or from returning unnecessary data to the document.  
**Note:** The **Max rows retrieved** setting can be overridden by the limits set by your administrator in your security profile. For example, if you set the **Max rows retrieved** setting in the HTML report panel to 400 rows, but your security profile limits you to 200 rows, only 200 rows of data will be retrieved when you run the query.  
• **Max retrieval time**  
Maximum time that a query can run before the query is stopped. This can be useful when a query is taking too long due to an excess of data, or network problems. You can set a time limit so a query can stop within a reasonable time. |
<table>
<thead>
<tr>
<th>Query Property</th>
<th>Available Options and Description</th>
</tr>
</thead>
</table>
| Security       | • **Allow other users to edit all data providers**  
When selected, other users who have the appropriate editing rights can access Query View and modify the data providers in the document. When cleared, only the report creator can modify the data providers. This option is selected by default. Unlike the other query properties, which only apply to the selected query, this option applies to all of the data providers in the document. |
| Prompt Order   | • Prompts are listed in the list. You can use the up and down arrows to move a prompt up or down the list to change the order. |
| Contexts       | • **Context list**  
Displays contexts selected during the previous refresh of the report.  
• **Reset contexts on refresh**  
When selected, you are prompted to choose a context each time a query requiring a context is run. When unselected, Web Intelligence retains the context specified the first time you run the query.  
• **Clear contexts**  
All selected contexts are removed from the context list. The user is prompted to select a context when the report is refreshed. |

**Setting query properties**

To set query properties:

1. Verify that you are in Query View.

The **Edit Query** button is pressed in when you are working in Query View.
2. Click the **Properties** tab. The Query Properties options appear.

3. Click the **Fold/Unfold** arrows at the top right of each section of the options to expand or close the property groups.

4. Select or type query property options.
   For a full explanation of each option, see “Query property options” on page 56.
   The modifications you make to the query properties are applied immediately.
Running a simple query

Once you have built your query by adding the required objects to the Result Objects pane, set the scope of analysis and defined query properties, you are ready to run the query. When you run a query, the universe asks the database to find the data that corresponds to the demands of each of the objects in the query. You run a query by clicking the Run Query button.

Creating a simple query

Before you can create a query you must ensure that you have connected to a universe from the InfoView portal. For full information, see “Logging in and out of InfoView” on page 23 and “Selecting a universe and launching a report panel” on page 29. Once the universe is available in the Java Report Panel, you can start building a query.

► Building and running a simple query

To build and run a simple query:

1. Verify that you are in Query View.
   The Edit Query button is pressed in when you are in Query View.
2. Click the + sign next to the class folder containing the object you want to include in the query.
   The class expands to show objects.
3. Select an object and drag it into the Result Objects pane.
   Or Double-click an object.
   The object appears in the Result Objects pane.
4. Repeat steps 2. and 3. for each object that you want to include in the query.
5. If you want to set a scope of analysis level, do the following:
   • Click the Scope of Analysis button on the Query toolbar
   • Select a level for the scope of analysis from the Scope of Analysis drop-down list box.
6. Click the Run Query button.
Web Intelligence generates a report that contains a vertical table displaying the results of the query. Each table column corresponds to an object added in the Result Objects pane. Data for each of those objects appears in the table rows.

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Category</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>Q1</td>
<td>2 Pocket shirts</td>
<td>$7,100</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>Belts, bags, wallets</td>
<td>$1,908,564</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>Bermudas</td>
<td>$6,791</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>Boatwear</td>
<td>$3,352,22</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>Cardigan</td>
<td>$1,610,00</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>Casual dresses</td>
<td>$1,300</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>Daywear</td>
<td>$1,481,00</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>Drywear</td>
<td>$1,115,90</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>Evening wear</td>
<td>$1,071,26</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>Fancy fabric</td>
<td>$1,232,03</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>Full length</td>
<td>$1,711</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>Hair accessories</td>
<td>$41,447</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>Hats, gloves, scarf</td>
<td>$39,359</td>
</tr>
</tbody>
</table>

The report and table use the Web Intelligence default layout and formatting. You can modify the data contents and formatting of the report as you wish. For full information, see the chapters in the section called "Working with Reports" on page 161.
Working with query contexts

When you create a query, or refresh a report, you may be asked to choose a context before the query can run. In a universe, contexts are implemented to avoid ambiguous data providers. This section describes what is an ambiguous query, how contexts are used, and explains how you can choose a context to ensure that your query returns relevant information.

What is an ambiguous query?

An ambiguous query is a query that contains one or more objects that can potentially return two different types of information.

In a universe, certain dimensions may have values that are used for two different purposes in the database. For example, the [Country] dimension in the query below can return two types of information:

- Customers and the country in which they spent their vacation.
- Customers and the country for which they have made their reservation.

The role that Country plays in this query is ambiguous. A country value can be either the country where a vacation was sold, or a country where a vacation is reserved. One is existing information (sales), and the other is future information (reservations).

To avoid ambiguities in a query, the universe designer identifies the different ways that objects can be used in the universe, and implements restrictions on how these objects can be combined. These restrictions are called contexts.

What is a context?

A context is a defined group of objects that share a common business purpose. This business purpose is usually the type of information that these related objects represent. For example, a sales context is a grouping of all the objects that can be used to create sales data providers. A reservations context is a grouping of all the objects that can be used in reservation data providers. Contexts are defined in a universe by the universe designer.

You can combine any object within the same context to create a query. You can also combine objects in different contexts. If you use an object that is common to both contexts, Web Intelligence will try to determine the context that best fits the other objects in the query.
If it can not determine a context, you are prompted to choose the context that you want to apply to the query. For example, When you run the query above, a dialog box appears asking you to choose whether you want the country information to be sales or reservations information.

**Defining how contexts are used in a query**

In Web Intelligence you can customize how contexts are used in a report. You can set the following options to determine how contexts are used when you refresh a report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Reset contexts on refresh | • When selected, you are prompted to choose a context each time a query requiring a context is run.  
  • When cleared, a query is run automatically using the context used on previous refresh. |
| Clear contexts          | Clears the contexts listed in the list after the first refresh.                                                                                |

When you run a query, or refresh a report that can result in an ambiguous query, a dialog box appears asking you to select a context.
Selecting context properties
To select context properties:
1. Verify that you are in Query View.
2. Click the Properties tab.
   The Query Properties options appear.
3. In the Context section of the Query Properties, select or clear the Reset contexts on refresh check box.
   Or
   If you want to remove all existing contexts saved in the report, click the Clear contexts button.
   This does not remove the context from the universe.

Selecting a context
To select a context:
1. From the Select a Context box, click one of the listed contexts.
   This is the context that contains the data that is relevant to your query.
2. Click OK.
   The query is run for the selected context.
Interrupting data providers

When you interrupt a query, only partial data is returned to the document. The values displayed in the document do not accurately reflect the definition in the query. Before returning the data to the document, Web Intelligence requests you to choose which version of the data you want retrieved.

Interrupting a query

To interrupt a query:

1. On the Retrieving Data dialog box, click Cancel.

Note: The Retrieving Data dialog box appears when you click Run Query or Refresh Data to retrieve the latest values from the database to a document.

The Interrupt Data Retrieval dialog box appears.

2. Select one of the following options:
   
   - **Restore the results from the previous data retrieval** – Web Intelligence restores the values to the document that were retrieved the last time the query was run. The values displayed will not be the most up to date information available on the database. You can run the query later to return the up to date values from the database.
   
   - **Purge all data from the document** – Web Intelligence displays the document empty of values. The structure and formatting of the document is retained. You can run the query later to return the up to date values from the database.
   
   - **Return the partial results** – Web Intelligence displays the new values retrieved so far in the appropriate parts of the document. The rest of the document will display the values retrieved the last time the query was run.
3. Click **OK**.

Web Intelligence displays the results on the reports, according to the option you selected.
About Incompatible objects in data providers

Sometimes it is not possible to use certain combinations of objects in data providers. This situation arises when objects bear no relationship to one another. These objects are called incompatible objects.

For example, the Island Resorts Marketing universe contains the [Reservation Year] and [Revenue] objects, which are incompatible. This is because there is no revenue associated with a reservation. Revenue is generated only when the customer is invoiced. The underlying database structure reflects this; you cannot build a query that aggregates revenue by reservation year because there is no such thing as revenue by reservation year. In other words, the aggregation context that you specified for the [Revenue] object does not exist.

Incompatible objects and SQL

When you build a query, Web Intelligence generates SQL behind the scenes. This SQL is run against the database to produce a result that Web Intelligence displays in a report. For a query to be free of incompatible objects, Web Intelligence must be able to generate a single SQL query to retrieve the data. If this is not possible, the query contains incompatible objects.

How Web Intelligence handles incompatible objects

If a report requires more than one SQL query to provide its data, Web Intelligence places the data from each query in a separate block, as shown below.

<table>
<thead>
<tr>
<th>Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>FY1998</td>
<td>1,063,564</td>
</tr>
<tr>
<td>FY1999</td>
<td>1,107,240</td>
</tr>
<tr>
<td>FY2000</td>
<td>1,115,730</td>
</tr>
</tbody>
</table>

Web Intelligence does not allow you to place incompatible objects in the same block by dragging and dropping. You can create a block with incompatible objects by using the formula bar to type the names of the objects. In this case the incompatible objects appear as #INCOMPATIBLE.
Building basic data providers

About Incompatible objects in data providers
Working with combined queries
Working with combined queries

Overview

Chapter 4: Building basic data providers on page 69 describes how to create basic data providers. The data providers described in that chapter contain one query only. You can create much more powerful data providers by including combined queries. Combined queries are multiple queries on the same universe that return a single set of data.

Note: You cannot create combined queries across multiple universes.

Types of combined query

You can combine queries in three relationships:

- union
- intersection
- minus

In a union combination, Web Intelligence takes the all the data from both queries, eliminates duplicate rows, and builds a combined data set.

In an intersection combination, Web Intelligence returns the data that is common to both queries.

In a minus combination, Web Intelligence returns the data in the first query that does not appear in the second.

Example: Union, intersect and minus queries

In this example you have two queries that return lists of countries as shown in the following table:

<table>
<thead>
<tr>
<th>Query</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query 1</td>
<td>US; UK; Germany; France</td>
</tr>
<tr>
<td>Query 2</td>
<td>US; Spain</td>
</tr>
</tbody>
</table>

Depending on the type of combined query, Web Intelligence returns the following values:

<table>
<thead>
<tr>
<th>Combination type</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNION</td>
<td>US; UK; Germany; France</td>
</tr>
<tr>
<td>INTERSECTION</td>
<td>US</td>
</tr>
<tr>
<td>MINUS</td>
<td>UK; Germany; France</td>
</tr>
</tbody>
</table>
What can you do with combined queries?

Combined queries allow you to answer questions that are otherwise difficult or impossible to frame in a single Web Intelligence query.

**Example:** Return a data set using a combined query

The Island Resorts Marketing sample universe contains the dimension Year, which is associated with guests who have already stayed in a resort, and Reservation Year, which is associated guests who have reserved to stay in the future. Because of the structure of the database and universe, these objects are incompatible, which means that you cannot include them in the same block in a report. (For more information on incompatible objects, see “About Incompatible objects in data providers” on page 66.)

What if you want to return a single list of years that includes those years where more than \( n \) guests stayed in a resort and those years where more than \( n \) guests reserved to stay in a resort? You can do this using a combined query, as follows:

<table>
<thead>
<tr>
<th>Query</th>
<th>Returns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query 1</td>
<td>Years where more than ( n ) guests stayed in a resort</td>
</tr>
<tr>
<td>UNION</td>
<td></td>
</tr>
<tr>
<td>Query 2</td>
<td>Years where more than ( n ) guests reserved to stay in a resort</td>
</tr>
</tbody>
</table>

The union between these two queries returns the list of years that you want.

How does Web Intelligence generate combined queries?

If your database supports the type of combination in your query, combined queries work at the database level: they alter the query that Web Intelligence submits to the database. They do so by generating SQL (Structured Query Language) queries containing UNION, INTERSECT and MINUS operators.

**Note:** SQL is the standard query language of relational databases, although each database has its own dialect.
What can you do with combined queries?

If your database does not support the type of combination in your query, Web Intelligence performs the query at the report level by generating multiple SQL queries whose data it resolves after retrieval from the database. For more information on the SQL generated by Web Intelligence, see “Viewing and editing the SQL behind the query definition” on page 53.
Building a combined query

You build a combined query in the Query Panel.

To build a combined query
1. Create an initial query in the Query Panel.
2. Click Combined Query on the toolbar.

Web Intelligence adds a copy of the initial query to the data provider. The second query has the following characteristics:

- It contains the same report objects as the original query.
- It does not contain the filters defined on the original query.
- It is combined with the original query in a UNION relationship.

The individual queries in the combined queries are named Combined Query n.

3. To switch to a query, click Combined Query n.
Combined query structure

The queries within a combined query must return the same number of objects of the same data type and the objects must be in the same order. You cannot combine queries when the number of objects in the query results and the data types of those objects are not identical. For example, you cannot combine a query that returns Year with a query that returns Year and Revenue, and you cannot combine a query that returns Year with a query that returns Revenue.

You must also pay attention to the *semantics* of your combined queries. While it is possible to combine a query that returns Year with a query that returns Region if both dimensions are of the same data type, the result - a mixed list of years and regions - is unlikely to be meaningful. Typically, if your first query contains a Year dimension, your second query also contains a dimension that returns a list of years.

**Example:** Return a list of years and reservation years based on the numbers of guests

This example describes the workflow for the query described in “Return a data set using a combined query” on page 71. You want to build a query that returns a list of years consisting of years where more than n guests stayed in a resort and years where more than n guests reserved to stay in a resort. To do this:

1. Select the Island Resorts Marketing universe in the list of universes to open the Query Panel.
2. Drag the Year object to the Result Objects pane.
3. Drag the Number of Guests object to the Query Filters pane and create a report filter that restricts the Number of Guests to greater than $n$. (For more information on building query filters, see Chapter 8: Filtering data retrieval using query filters on page 69.)

4. Click Combined Query.
   The Combined Query pane appears in the bottom left of the Query panel with the two queries joined by union.

5. Click on the second query and remove the Year and Number of Guests objects.

6. Drag the Reservation Year object to the Result Objects pane.

7. Drag the Future Guests object to the Query Filters pane and create a report filter that restricts the future guests to greater than $n$.

8. Click Run Query.

9. The query returns the combined list of years and reservation years.

---

**Combined query precedence**

It is important to understand the order in which Web Intelligence executes query combinations in a combined query. The order of execution is crucial in determining the final result.

In the simplest form of combined query you combine two or more queries in a relationship as follows:

- **INTERSECTION**
  - Query 1
  - Query 2
  - Query 3

In such a case, Web Intelligence first finds the set of data that represents the union/intersection/minus between Combined Query $n$ and Combined Query $n + 1$, then finds the union/intersection/minus between that data set and the data returned by Combined Query $n + 2$. Web Intelligence continues in this way through all the queries in the relationship. This gives the following result for the above example:

<table>
<thead>
<tr>
<th>Query</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query 1</td>
<td>US; UK; France; Germany</td>
</tr>
<tr>
<td>Query 2</td>
<td>US; France; Finland</td>
</tr>
</tbody>
</table>
Multiple combined queries

You can combine multiple queries in complex relationships to determine the order of execution, as in the following example:

Web Intelligence processes query groups from right to left as they appear in the Query Panel, and from top to bottom within each group. (Higher-precedence groups, such as the MINUS group in the above example, appear indented to the right in the Query Panel.) In the above query Web Intelligence first determines the result of the minus combination then finds the intersection of this result with the result of Combined Query 3 as shown in the following table:
Working with combined queries

Combined query precedence

**Note:** If your database directly supports the type of combined query you wish to execute, Web Intelligence generates SQL containing combination operators. (For more information see “How does Web Intelligence generate combined queries?” on page 71.) In this case the order of precedence depends on the order of precedence defined in the database. See your Web Intelligence administrator for more details.

▶ **Setting the order of precedence**

1. Build the first query in the Query Panel.
2. Click **Combined Query**.
3. Repeat steps 1 and 2 until you have built all the component queries.
4. To increase the precedence of a pair of queries, drag and drop a query on to the *query* with which you want to associate it in the higher-precedence pair.
   Web Intelligence indents the source and target queries in the drag-and-drop operation and combines them by default in a UNION.
5. Continue adding queries to the higher-precedence group by dragging and dropping them on to the *space* between any two queries already in the group.
6. To create further higher-precedence groups within an existing higher-precedence group, repeat steps 4 and 5.
7. Double-click the combination operators of all the groups in the query to change them as required.
   The query appears in a form similar to the following in the Query Panel. (In this example the MINUS combination has the higher precedence.)

8. Click **Run Query**.
Working with combined queries

Combined query precedence
Including multiple data providers
Overview

This chapter tells you how you can include multiple data providers in a single document.

It includes the following information:

• using multiple data providers
• defining multiple data providers in a document
• purging data from multiple data providers

Note: This chapter tells you how to add data providers to documents that already include a first data provider. For information about creating new documents and building the first data provider, see “Building basic data providers” on page 39.
Using multiple data providers

You can include one or multiple data providers in a single Web Intelligence document. When you include multiple data providers, those data providers can be based on a single universe or on multiple universes available in InfoView.

**Example:** Include product sales data and customer data in the same document

In this example, your corporate data for product line sales is available on one universe and data on customers is available on another universe. You want to present product line sales results and information on customer age groups in the same report. To do this, you create a single document that includes two data providers; one query on each universe. You can then include and format results from both data providers on the same report.

**Note:** You cannot include objects from different universes in the same report block (that is, in the same table or chart). For full information, see "For more information on merged dimensions, see Chapter 7: Merging dimensions from multiple data providers on page 79." on page 91.
Defining multiple data providers in a document

Defining multiple data providers in a single document is necessary when the data you want to include in a document is available on multiple universes, or when you want to create several differently-focused data providers on the same universe. You can define multiple data providers when you can build a new document or add more data providers to an existing document. You can present the information from all of the data providers on a single report or on multiple reports in the same document.

**Note:** A maximum number of 15 data providers is supported per document.

This section of this chapter tells you how to:

- add a new query
- rename a query
- duplicate a query
- move a query

**Note:** This chapter tells you how to add data providers to documents that already include a first query. For information about creating new documents and building the first query, see “Building basic data providers” on page 39.
Adding a new query to a document

To add a new query to a document:

1. With the Java Report Panel open, make sure you are in Query View.
   The Edit Query button is pressed in when you are in Query View.
   The query or data providers already defined for the document appear here.
   (If you require information on creating a new document and defining the first query, refer to “Building basic data providers” on page 39.)

2. Click the Add Query button on the Query toolbar.
The Universe dialog box appears.

You can create a new query on a universe already used in the document or select a different universe.

3. In either of the two lists, select the universe on which you want to define a query.

4. Click OK.

The new query pane appears.

The query tab for the new query displays the default name for data providers: Query followed by a number that indicates the total number of data providers in the document; for example Allow other users to edit all data providers. You can rename the query with a more meaningful name now or later. (See “Renaming a query” on page 88.)

5. Define the objects, filters, and scope of analysis, and properties you want for the query.

The data content, scope of analysis, and filters you define here will only apply to the selected query. The query properties, you define only apply to the selected query, with the exception of the option Allow other users to edit all data providers. This option applies to all of the data providers in the document.
For full information about the options you can select for query properties, see “Defining query properties” on page 56.

6. If you want to return the data from just the new query now, click the arrow next to the Run Query button on the toolbar, then select the new query from the drop-down list of data providers.

Or

If you want to return the data from all of the data providers in the entire document, simply click the Run Query button on the toolbar.
The **New Query** dialog box appears.

You need to choose how you want to include the data from the new query into the document.

7. Select the appropriate option:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Then select...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the data on a new report in the document,</td>
<td>Insert a table in a new report</td>
</tr>
<tr>
<td>Display the data on the currently selected report in a new table,</td>
<td>Insert a table in the current report</td>
</tr>
<tr>
<td>Include the data in the document without displaying the data on a report, (You can add the objects returned by the query to the report(s) later.)</td>
<td>Include the result objects in the document without generating a table</td>
</tr>
</tbody>
</table>

8. Click **OK**.

Web Intelligence runs the new query and returns the data to the document. The data is included as you specified.

You can rename the new query (see “Renaming a query” on page 88), or build further data providers, or duplicate the query and then edit the duplicate before returning the data to the document (see “Duplicating a query” on page 87 below).
Duplicating data providers

If you want to build a different query on a universe already included in the document, you can duplicate the existing query on that universe and then modify it, instead of starting from scratch.

**Duplicating a query**

To duplicate a query:

1. Make sure you are in Query View. The *Edit Query* button is pressed in when you are in Query View.
2. Select a the query you want to duplicate by right-clicking the appropriate query tab at the bottom of the report panel.
3. Right-click the query tab and then select **Duplicate Query** from the drop-down menu.

Web Intelligence creates a duplicate of the selected query and adds it to the report panel.

You can edit the data definition of the duplicate query. For full information, see “Building and running a simple query” on page 59.
Renaming data providers

By default, Web Intelligence names each query by a number in sequence. For example, the first query is named Query 1, the second query is named Query 2 and so on. You can rename data providers with more meaningful names to reflect the data each query includes.

**Renaming a query**

To rename a query:

1. Make sure you are in Query View.
   
   The Edit Query button is pressed in when you are in Query View.
   
   Either right-click the tab of the query you want to rename and then select Rename Query from the shortcut menu.
   
   ![](image)
   
   Or
   
   With the query tab you want to rename selected, click the Properties tab.
   
   The Query Properties sub-tab appears.

2. In the Name box, type the name for the query.

3. Press the Enter key.
   
   The new name appears on the Query tab.
Moving data providers

You can also change the order in which the data providers are run by moving the data providers before or after the other data providers in the document. This is particularly useful if different data providers in the document include prompts. You can define the order in which the prompts will appear when users refresh the document, by ordering the data providers accordingly.

For example, if Query 1 has a prompt on [Sales Region] and Query 2 has a prompt on [Service Line], you can ensure that the prompt for Service Line appears to users first, by moving Query 2 before Query 1.

Moving a query

To move a query:

1. Make sure you are in Query View.
   
The Edit Query button is pressed in when you are in Query View.

2. Right-click the tab of the query you want to move.

3. Select Move Query from the shortcut menu.

A sub-menu appears.

4. Depending on where you want to move the query, select Left or select Right.

The selected query moves accordingly.
Purging data from multiple data providers

When you purge data from a document you remove all data from the document, while leaving the document structure intact. If the document contains multiple data providers, you can purge specific data providers within the document.

Note: If you view purged reports in Results View, charts are not visible. To view the structure of purged reports with charts, click View Structure.

► Purging all the data providers in the document

To purge all the data providers in a document:

• Click the Purge button on the toolbar.

The values are removed from all report cells throughout the document. To return the data to the document, click Refresh Data.

► Purging data from a specific query

To purge a specific query in a document:

1. Click the arrow next to the Purge button on the toolbar.

A drop-down menu lists the data providers in the document.

2. Select the query you want to purge.

The values are removed from the report cells that contain data from the selected query.

To return the data to the document, click the arrow next to the Refresh Data button, and then select the query you purged.

Synchronizing multiple data providers

Web Intelligence allows you to synchronize the data from multiple data providers by creating **merged dimensions**. You create a merged dimension from existing dimensions whose data is related. For example, if you have data providers showing revenue by city and projected revenue by city, it makes
sense to synchronize the data providers on the city dimension. This allows
you to create reports showing the relationship between projected and actual
revenue.

For more information on merged dimensions, see Chapter 7: Merging
dimensions from multiple data providers on page 79.
Including multiple data providers

Synchronizing multiple data providers
Merging dimensions from multiple data providers
Overview

This chapter describes how to synchronize multiple data providers in a Web Intelligence report by merging them on common dimensions. After merging common dimensions you can place dimensions from different data providers in the same block.

Merged dimensions and data synchronization are new in Web Intelligence XI R2. They enormously increase the power and flexibility of Web Intelligence by allowing you to synthesise data from different sources in the same report, rather than simply including the data.

For example, if you have one database that contains detailed customer information and another database that contains sales data, you can synchronize the two data sources around the customer.

This chapter includes information on the following topics:
• merging dimensions
• working with merged dimensions in reports
• understanding the effects of merged dimensions

Merging dimensions

Chapter 6: Including multiple data providers on page 79 describes how you can include multiple data providers in a Web Intelligence document. You often need to synchronize the data returned by these data providers. You do this by incorporating common dimensions into a merged dimension.

In what situations do you merge dimensions?

You merge dimensions when your report draws related data from different data providers. For example, you have a report showing revenue and sales targets. The report contains sections based on the year, and each section shows revenue and sales targets. If revenue and sales target data comes from two different data providers, Web Intelligence does not know that it is related. You tell Web Intelligence that the data is related by merging the two data providers on the common dimension, year.

When you merge dimensions, Web Intelligence creates a new dimension that contains all the values from the original dimensions that make up the merged dimension. You use this dimension in reports as you use any other report object. You can add report objects from all the data providers synchronized through the merged dimension in the same block as the merged dimension.
Which dimensions do you merge?

The only restriction that Web Intelligence imposes on merged dimensions is that they must be of the same data type: for example, character data. But it does not make sense to merge unrelated dimensions even when their data types are the same. For example, it does not make sense to merge a dimension containing customer names with a dimension containing sales regions.

Merged dimensions often have the same name in both data sources, but this is not obligatory. It can make sense to merge dimensions with different names if they contain related data.

To merge dimensions correctly you need to be aware of the semantics of the data (what the data refers to) in the different data sources. The dimension data types and names are an approximate guide only to dimensions’ suitability for merging.

Merging dimensions

To merge dimensions:

1. Click **Merge Dimensions** button on the toolbar.
   
   The Merge Dimensions dialog box appears.
Merging dimensions from multiple data providers

Merging dimensions

2. Select the dimensions you want to merge in the boxes at the top of the dialog box.
   
   **Note:** When you select a dimension, all dimensions of different data types are disabled because you cannot merge dimensions of different data types.

3. Click **Values** to view the values associated with the dimensions.

4. Click **Merge**.
   
   The Create Merged Dimension dialog box appears. You use this dialog box to specify the properties of the merged dimension.

5. Select the dimension in the **Source Dimension** drop-down list.
   
   The source dimension provides the default name, description and number formats for the merged dimension.

6. Type the merged dimension name in the **Merged Dimension Name** box and the merged dimension description in the **Description** box.

7. Click **OK**.
   
   The merged dimension name appears in the Merged Dimensions box and the dimensions that are part of the merged dimension appear in the boxes alongside it. Because an original dimension can be part of one merged dimension only, it no longer appears in the box above that lists the original dimensions in the query.

8. Click **OK** to close the Merged Dimensions dialog box.
   
   Web Intelligence adds the merged dimensions to the list of merged dimensions in the **Data** tab.
Automatic merging

You can set Web Intelligence to merge dimensions automatically under the following circumstances:

- The dimensions have the same name
- The dimensions have the same data type
- The dimensions are in the same universe.

To do this:
1. Right-click outside any block or chart and click Document Properties on the popup menu.
2. Click Auto-merge dimensions.

Working with merged dimensions in reports

Once you have created a merged dimension you can include it in a report as you include any other report object. Merged dimensions appear under the Merged Dimensions folder in the Data tab. You can expand each merged dimension to see the dimensions that are merged in it.

Editing merged dimensions

To edit a merged dimension:
1. In the Data tab, select the dimension in the Merged Dimensions folder and click the right mouse button.
2. Select Edit Merged Dimension from the menu. The Merged Dimensions dialog box appears.
3. Edit the merged dimensions as described in “Merging dimensions” on page 95.
Merging dimensions from multiple data providers

Understanding the effects of merged dimensions

- **Deleting merged dimensions**
  To delete a merged dimension:
  1. Select the dimension in the Merged Dimensions folder and click the right mouse button.
  2. Select **Delete Merged Dimension** from the menu.
     The merged dimension is deleted.

- **Adding merged dimensions to reports**
  To add a merged dimension to a report:
  1. Select the dimension in the Merged Dimensions folder and drag it to the report.
     The dimension is added to the report and shows all values from all dimensions merged in it.

**Understanding the effects of merged dimensions**

Data synchronization through merged dimensions adds enormous power to Web Intelligence. Merged dimensions also have implications for the results that Web Intelligence displays in certain situations. You need to understand these implications to work effectively with merged dimensions and synchronized data.

The following sections describe these situations.

**Synchronizing data providers with different aggregation levels**

You can synchronize data providers with different aggregation levels. This can have implications for the way in which Web Intelligence calculates measures.

**Example:** Synchronizing data providers with different aggregation levels

In this example you have two data providers as follows:

<table>
<thead>
<tr>
<th>Customer</th>
<th>Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jones</td>
<td>2004</td>
<td>1,500</td>
</tr>
</tbody>
</table>
If you merge the two data providers and the table properties Avoid Duplicate Rows Aggregation and Show Rows with Empty Dimensions are unchecked, Web Intelligence returns the following:

<table>
<thead>
<tr>
<th>Customer</th>
<th>Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jones</td>
<td>2004</td>
<td>1,500</td>
</tr>
<tr>
<td>Jones</td>
<td>2005</td>
<td>2,000</td>
</tr>
<tr>
<td>Smith</td>
<td>2005</td>
<td>1,200</td>
</tr>
</tbody>
</table>

(For more information on the Avoid Duplicate Rows Aggregation and Show Rows with Empty Dimensions properties, see the Web Intelligence online help.)

Web Intelligence cannot determine the number of sales per year for customer Jones because the data provider that stores the number of sales does not break them down by year. Web Intelligence therefore reproduces the total number of sales on each row.

**Note:** Although the Number of Sales values are duplicated, if you add a standard calculation to the bottom of the column (for example a Sum or Average calculation), the result is correct.

One way of addressing this issue is to add the dimensions to the second data provider that allow Web Intelligence to calculate to the appropriate level of data. If this is not possible, you must be aware of any situations where Web Intelligence cannot aggregate the data to the necessary level of detail.
Merged dimensions are a new concept in Web Intelligence XI R2. Synchronizing data providers already exists in Desktop Intelligence/BusinessObjects but it does not involve the creation of a new merged dimension. BusinessObjects reports use the original dimensions that make up a merged dimension in Web Intelligence.

You can use these original dimensions in a Web Intelligence report. When you place them in the report, Web Intelligence returns by default only those dimension values that have corresponding values in the data providers synchronized through the merge. You need to be aware of this when migrating reports from Desktop Intelligence and BusinessObjects because BusinessObjects/Desktop Intelligence behaves differently.

**Example: Web Intelligence and Desktop Intelligence/BusinessObjects behavior when dimensions are merged**

You have a report with the following data providers:

<table>
<thead>
<tr>
<th>Country of origin</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Germany</td>
<td>470</td>
</tr>
<tr>
<td>Japan</td>
<td>499</td>
</tr>
</tbody>
</table>

If you include the Country of Origin dimension from Data Provider 1 and the Revenue measure from Data Provider 2 in the same block, Web Intelligence returns the following result:

<table>
<thead>
<tr>
<th>Country of origin</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Germany</td>
<td></td>
</tr>
</tbody>
</table>

The same block in Desktop Intelligence/BusinessObjects returns the following result:

<table>
<thead>
<tr>
<th>Country of origin</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Germany</td>
<td>499</td>
</tr>
<tr>
<td>Japan</td>
<td></td>
</tr>
</tbody>
</table>

The block is different in Desktop Intelligence/BusinessObjects because BusinessObjects extends the values of the Country of Origin dimension through the values returned by the Revenue measure.
You can alter the Web Intelligence default behavior so that it corresponds with Desktop Intelligence/BusinessObjects behavior in this situation.

**Extending dimension values in Web Intelligence**

To extend dimension values in Web Intelligence:

1. Right-click your report outside any blocks or charts and select **Document Properties** on the shortcut menu.
   
   The Document Properties pane appears on the right side of the report.

2. Check the **Extend merged dimension values** option.

### Detail objects and merged dimensions

Detail objects are associated with dimensions and provide additional information about the dimension. (For more information on detail objects, see “What types of objects can you use in a query?” on page 43.)

Web Intelligence XI R2 requires a one-to-one relationship between dimensions and details (this means that a detail object can have one value only for each value of its associated dimension) and does not take detail objects into account when synchronizing data. The following example illustrates why this is necessary.

**Example:** Synchronizing data providers with detail objects

In this example you have two data providers as follows:

<table>
<thead>
<tr>
<th>Customer</th>
<th>Address</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>John</td>
<td>London</td>
<td>10,000</td>
</tr>
<tr>
<td>Paul</td>
<td>Liverpool</td>
<td>15,000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Customer</th>
<th>Age</th>
</tr>
</thead>
<tbody>
<tr>
<td>John</td>
<td>25</td>
</tr>
<tr>
<td>Paul</td>
<td>28</td>
</tr>
</tbody>
</table>

If you create a merged Customer dimension to synchronize the data providers, and Address can have more than one value for each customer, the result is ambiguous because there is no common value around which WebIntelligence can synchronize the data:
For example, Paul might also have an address in London, which means that there is no unique ‘Paul’ row with which WebIntelligence can synchronize Paul’s age:

<table>
<thead>
<tr>
<th>Customer</th>
<th>Address</th>
<th>Age</th>
</tr>
</thead>
<tbody>
<tr>
<td>John</td>
<td>London</td>
<td></td>
</tr>
<tr>
<td>Paul</td>
<td>Paris</td>
<td></td>
</tr>
<tr>
<td>Paul</td>
<td>London</td>
<td></td>
</tr>
<tr>
<td>John</td>
<td></td>
<td>25</td>
</tr>
<tr>
<td>Paul</td>
<td></td>
<td>28</td>
</tr>
</tbody>
</table>

If the relationship between Customer and Address is one-to-one, WebIntelligence can ignore Address in the synchronization. This removes the ambiguity:

<table>
<thead>
<tr>
<th>Customer</th>
<th>Address</th>
<th>Age</th>
</tr>
</thead>
<tbody>
<tr>
<td>John</td>
<td>London</td>
<td>25</td>
</tr>
<tr>
<td>Paul</td>
<td>Paris</td>
<td>28</td>
</tr>
</tbody>
</table>

Previous versions of WebIntelligence, as well as Desktop Intelligence and BusinessObjects, allow a one-to-many relationship between dimensions and details. If you migrate a report created using any of these products and the detail object contains multiple values, Web Intelligence places the #MULTIVALUE error in the detail cell.

You can solve this in Web Intelligence XI R2 by checking the Avoid Duplicate Row Aggregation property.

For more information on working with variables, see “Creating, editing, and deleting variables” on page 450.

Filtering merged dimensions

Merging dimensions has implications for the way in which Web Intelligence applies filters.

**Note:** You cannot apply a filter on a merged dimension. You apply filters on the dimensions that make up the merged dimension.
Report filters and merged dimensions

When you apply a report filter to a dimension that is part of a merged dimension, Web Intelligence applies the filter to all data providers that are synchronized through the merged dimension.

**Example: Filtering a merged dimension**

In this example you have a report with the following data providers, which are merged on the Country dimension:

<table>
<thead>
<tr>
<th>Country</th>
<th>Resort</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>France</td>
<td>French Riviera</td>
<td>835,420</td>
</tr>
<tr>
<td>US</td>
<td>Bahamas Beach</td>
<td>971,444</td>
</tr>
<tr>
<td>US</td>
<td>Hawaiian Club</td>
<td>1,479,660</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Country</th>
<th>Future Guests</th>
</tr>
</thead>
<tbody>
<tr>
<td>France</td>
<td>46</td>
</tr>
<tr>
<td>US</td>
<td>56</td>
</tr>
</tbody>
</table>

If you apply the filter Country="US" to the first block, Web Intelligence also filters the second block to give the following result:

<table>
<thead>
<tr>
<th>Country</th>
<th>Future Guests</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>56</td>
</tr>
</tbody>
</table>

If the Country dimensions are not merged the second block is unaffected by the filter.

Section filters and merged dimensions

When a dimension that is part of a merged dimension is set as a section header, any filter applied to the section also applies to blocks from synchronized data providers within the section. If Country is set as the section header in the example "Filtering a merged dimension" on page 103 and the filter Country="US" is applied to the section, Web Intelligence filters both blocks in the section—(Resort, Revenue) and (Country, Number of Guests)—so that only those rows appear where the country dimension is equal to "US", even though Country in the second block comes from a synchronized data provider.
Merging dimensions from multiple data providers

**Detail objects and merged dimensions**

**Block filters and merged dimensions**

When you apply a block filter to a dimension that is part of a merged dimension, Web Intelligence applies the filter to the block. Web Intelligence does not apply the filter to other data providers synchronized through the merged dimension.

**Drilling on merged dimensions**

When you merge dimensions, the new merged dimension belongs to the hierarchies of all dimensions involved in the merge.
Filtering data retrieval using query filters
Overview

You limit the data returned to a Web Intelligence document by applying filters when you define the query. Using query filters enables you to secure the data you don't want specific user groups to see and limits the size of the documents stored on your network. When you run the query or refresh the document data, Web Intelligence returns only the values that meet the query filter definitions.

This chapter tells you about:

• how query filters work
• the different types of query filter
• using predefined filters
• creating custom filters
• combining multiple filters on a single query
• editing and removing query filters
• applying query filters to business questions

This chapter explains how to apply filters to objects in a query using the Java Report Panel.
How query filters work

When you build a query on a universe, you can filter the query to limit the data Web Intelligence returns to the document. Query filters retrieve a sub-set of the data from the database and return the corresponding values to the document. You define filters that match the criteria of specific business questions. For example, you can filter the [Year] dimension to view only sales revenue for Year 2003; or filter the [Annual Income] dimension to view only customers whose annual income is equal to or greater than $1.5M.

Including query filters on the data definition of the query enables you to:

• retrieve only the data you need to answer a specific business question
• hide the data you don’t want specific users to see when they access the document
• minimize the quantity of data returned to the document to optimize performance

Example: In 4Q2002, which stores in my sales region gained margins above $13K?

As Regional Marketing Manager for Texas, you are only interested in analyzing margins for Texas, but the sales universe includes data US-wide. In addition, you only want to view information for stores where margins reached over your 4Q 2002 quarterly target figure: $130K. To create a document with only the information you need, you apply the following query filters:

Year = 200
Quarter = Q$
State = Texas
Margin >= 130,000

To avoid displaying the filtered values Texas, 2002, and Q4 in the table columns Year, Quarter, and State, you exclude the [Year], [Quarter], and [State] objects from the Result Objects pane. When you generate the report, the report values correspond to Texas stores with 4Q 2002 margins greater than or equal to $130K:

<table>
<thead>
<tr>
<th>Store name</th>
<th>Sales revenue</th>
<th>Margin</th>
</tr>
</thead>
<tbody>
<tr>
<td>e-Fashion Houston</td>
<td>$307,914</td>
<td>$133,802</td>
</tr>
<tr>
<td>e-Fashion Houston Leighton</td>
<td>$316,252</td>
<td>$136,055</td>
</tr>
</tbody>
</table>

This enables you to filter the report for the specific values that interest you and to minimize the values displayed in the table.
The difference between query filters and report filters

You can apply filters at two levels within a document:

- query filters – these filters are defined on the query; they limit the data retrieved from the data source and returned to the Web Intelligence document
- report filters – these filters limit the values displayed on reports, tables, charts, sections within the document, but they don’t modify the data that is retrieved from the data source; they simply hide values at the report level

Query filters

You define query filters in Query View. Users without the security profile to edit the query cannot modify the query filters you define. This ensures that the data saved with a document is appropriate for those who view or analyze the data within that document.

**Tip:** Query filters decrease the time it takes to run the reports in the document and limit the size of the document to the data relevant to the users who consult it. Query filters also ensure document security.

Report filters

Filters you apply to the data displayed in the report are called report filters. You use report filters to limit the values displayed in the reports within a document. You can filter each report to display a different subset of the same data. The data hidden by the report filters remains saved with the Web Intelligence document. You can modify the report filters to display different data in the report or remove the report filters altogether to display all the data defined in the query. You define report filters in Report View.

For information on using report filters, see “How report filters work” on page 319.

**Note:** When you add a report filter, it is possible to create an aggregation context that Web Intelligence is unable to process because you have made some of the objects in the report incompatible. For more information on incompatible objects, see “About Incompatible objects in data providers” on page 66.
What makes up a filter?

To create a filter, you need to specify three elements:

- a filtered object
- an operator
- a value(s) or comparison object

**Example:** Filtering the data source to retrieve only values for the Accessories product line

For example, to display data only for the Accessories product line, you select:

- an operator: Equal to
- a value: Accessories
- filtered object: [Lines]

When you run the query, Web Intelligence applies the operator to the filtered object and retrieves the value(s) from the database that correspond to the value(s) you specified.

You can filter multiple objects in a query. For example, you can create another filter on the [Sales Revenue] measure to focus your data to a more specific range of results. When you run the report again, Web Intelligence applies both query filters.

What objects can I filter on the query?

You can define custom query filters on any dimension, measure, or detail object listed on the Data tab in Query View. You can also use predefined filters created by your administrator at the universe level. Predefined filters appear with the universe objects and are indicated by the filter icon.

For example, you can filter the [Year] dimension to return values for a specific year, filter the [Revenue] measure to return values for a range of revenue figures, or filter the [Postal Code] detail to return values for a specific postal area. For an illustrated description and examples of dimensions, measures, and details, see “What types of objects can you use in a query?” on page 43.
Filtering data retrieval using query filters

**Note:** Your administrator can prevent objects from being filtered. If you create filters on these objects, when you try to run the query a warning appears listing the filters that you cannot use. You need to remove these filters from the query in order to run the query.

**Which operator should I choose?**

It is important to understand the effect of each operator available to you when you define a filter. The table below lists the operators available for query filters and provides an example of each operator in the context of a business question:

<table>
<thead>
<tr>
<th>To obtain data...</th>
<th>for example...</th>
<th>select...</th>
<th>to create the filter...</th>
</tr>
</thead>
<tbody>
<tr>
<td>equal to a value you specify,</td>
<td>retrieve data for the US only,</td>
<td>Equal to</td>
<td>[Country] Equal to US.</td>
</tr>
<tr>
<td>different from a value you specify,</td>
<td>retrieve data for all quarters except Q4,</td>
<td>Not Equal to</td>
<td>[Quarter] Not Equal to Q4</td>
</tr>
<tr>
<td>greater than a value you specify,</td>
<td>retrieve data for customers aged over 60,</td>
<td>Greater than</td>
<td>[Customer Age] Greater than 60</td>
</tr>
<tr>
<td>greater than or equal to a value you specify,</td>
<td>retrieve data for revenue starting from $1.5M upward,</td>
<td>Greater than or equal to</td>
<td>[Revenue] Greater than or equal to 1000500</td>
</tr>
<tr>
<td>lower than a value you specify,</td>
<td>retrieve data for exam grades below 40,</td>
<td>Less than</td>
<td>[Exam Grade] Less than 40</td>
</tr>
<tr>
<td>lower than or equal to a value you specify,</td>
<td>customers whose age is 30 or less,</td>
<td>Less than or equal to</td>
<td>[Age] Less than or equal to 30</td>
</tr>
<tr>
<td>between two values you specify that includes those two values,</td>
<td>weeks starting at week 25 and finishing at 36 (including week 25 and week 36),</td>
<td>Between</td>
<td>[Weeks] Between 25 and 36</td>
</tr>
<tr>
<td>outside the range of two values you specify,</td>
<td>all the weeks of the year, except for weeks 25 through 36 (week 25 and week 36 are not included),</td>
<td>Not between</td>
<td>[Weeks] Not Between 25 and 36</td>
</tr>
<tr>
<td>To obtain data...</td>
<td>for example...</td>
<td>select...</td>
<td>to create the filter...</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------</td>
<td>------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>the same as several values you specify,</td>
<td>you only want to retrieve data for the following countries: the US, Japan, and the UK,</td>
<td>In list</td>
<td>[Country] In list ‘US; Japan; UK’</td>
</tr>
<tr>
<td>different from the multiple values you specify,</td>
<td>you don’t want to retrieve data for the following countries: the US, Japan, and the UK,</td>
<td>Not in list</td>
<td>[Country] Not in list ‘US; Japan; UK’</td>
</tr>
<tr>
<td>for which there is no value entered on the database,</td>
<td>customers without children (the children column on the database has Null as the data entry),</td>
<td>Is null</td>
<td>[Children] Is null</td>
</tr>
<tr>
<td>for which a value was entered on the database,</td>
<td>customers with children (the children column on the database does not have Null as the data entry),</td>
<td>Is not null</td>
<td>[Children] Is not Null</td>
</tr>
<tr>
<td>that includes a specific string,</td>
<td>customers whose date of birth is 1972,</td>
<td>Matches pattern</td>
<td>[DOB] Matches pattern, ‘72’</td>
</tr>
<tr>
<td>that doesn’t include a specific string,</td>
<td>customers whose date of birth is not 1972,</td>
<td>Different from pattern</td>
<td>[DOB] Different from pattern, ‘72’</td>
</tr>
<tr>
<td>that corresponds to two values you specify,</td>
<td>telco customers who have both a fixed telephone and a mobile phone,</td>
<td>Both</td>
<td>[Account Type] Both “fixed” and “mobile”</td>
</tr>
<tr>
<td>that corresponds to one value you specify and does not correspond to another value you specify</td>
<td>telco customers who have a fixed telephone, but don’t have a mobile phone,</td>
<td>Except</td>
<td>[Account Type] “fixed” Except “mobile”</td>
</tr>
</tbody>
</table>
Filtering data retrieval using query filters

How query filters work

**Different from, Not in List and Except**

*Different from*, *Not in list*, and *Except* are all operators that exclude certain data from your query results. For example, you could use this query filter to obtain a list of customers who have not bought accessories:

**Lines Different From Accessories**

However, the filter illustrated above would not exclude customers who had bought accessories, if these customers had also bought other line products from your company. The same is true if you use the *Not in list* operator.

If you used *Except*, the query would exclude all customers who had bought accessories, whether they had bought other line products from your company or not.

**How do I specify the value(s)?**

When you define query filters, you specify the value(s) you want Web Intelligence to retrieve from the database and return to the document. For example, if you want to limit the document data to data for one or more countries, the value(s) you define will be the names of those countries, such as the US and Japan.

There are two ways you can define the values for a filter using the Java Report Panel:

- type the value yourself – this is called a *constant*
- ask Web Intelligence to prompt you with the list of values present on the database so you can select the values you want to retrieve

The following table gives examples of when it is more efficient to type a constant or select value(s) from list:

<table>
<thead>
<tr>
<th>If...</th>
<th>for example...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>the list of values on the dimension or detail you are filtering is long and you are sure of how to spell the value you want to filter;</td>
<td>names of months or numbers for specific years,</td>
<td>type a constant.</td>
</tr>
<tr>
<td>you are not sure how to spell the value(s) you want to filter;</td>
<td>customer names or product lines, which can change frequently and include unusual spellings,</td>
<td>select value(s) from the List of Values.</td>
</tr>
</tbody>
</table>
How many filters can I apply to a query?

You can apply one or multiple filters to a single query. For example, to retrieve data for stores with long opening hours and only for stores in specific US states, you can combine a pre-defined filter with a custom filter:

Stores with long opening hours
AND
State in list: California, Florida, New York

For information on how to combine multiple query filters, see “Combining multiple filters on a query” on page 122.

Can I filter data without including the filtered object among the report data?

If you don’t want to include a filtered object on the Data tab of reports, you can filter the object without including the object on the Result Objects pane. This is useful if you want to filter a query to limit the document information to specific values, but you don’t want other users who modify the reports to see the filtered object.
Filtering data retrieval using query filters

Types of query filters

You can apply four types of filters to data providers when you build data providers using the Java Report Panel:

- predefined filters – created by your administrator
- custom filters – you define on the query
- prompts – you define these dynamic filters to display a question or a list of values so you or other users can select different filter value(s) at each document refresh
- advanced filters – subqueries and rankings

You can combine all four types of filters on a single query.

This chapter explains how to use the following two filter types:

- predefined filters
- custom filters

For information on creating prompts, see “Building prompt filters on data providers” on page 145. For information on creating advanced filters, see Chapter 9: Filtering data using subqueries and database ranking.

Tip: Use query filters systematically when you create Web Intelligence documents to:

- ensure the document data is relevant to your analysis
- optimize the time it takes to return the data to the reports in documents
- minimize the size of documents stored on your system
Using predefined filters

Predefined filters are a method of making the specific data you most typically need for reports permanently available in the Web Intelligence data tab. They are created by an administrator and saved with the universe. Predefined filters often contain complex expressions that require a detailed knowledge of the database structure. Including predefined filters on the universe means you don’t need to create the same custom filters every time you create new Web Intelligence documents based on the same universe.

Example: Targeting only privileged customers with a new store card payment scheme

In this example, you are a sales representative who wants to analyze the number of purchases by customer by year, in order to target an incentive campaign for a new type of store card payment scheme. Only those customers who are high spenders interest you.

Your administrator has created a filter on the universe, called Privileged Customers, to make it easy for users building documents to analyze only those customers. When you use this predefined filter as a query filter, the data returned to the report table or chart will only include data for the customers your company considers privileged customers.

Note: As a Web Intelligence user, you cannot edit predefined filters. This needs to be done by an administrator. Predefined filters can only be used to filter the query, they cannot be used to filter specific reports, sections, or blocks in the document.
Filtering data retrieval using query filters

Using predefined filters

- **Including a predefined query filter**
  
  To include a predefined query filter:
  
  1. Make sure you are in Query View.
     
     The *Edit Query* button is pressed in when you are in Query View. Web Intelligence displays the universe objects on the Data tab.
  
  2. Double-click the objects you want to include in the query.
     
     Or
     
     Drag and drop the objects onto the *Result Objects* pane. The objects appear on the Result Objects pane.
     
     For step-by-step instructions on selecting objects to build a query, see “Adding an object to a query” on page 48.
  
  3. Double-click the predefined filter.
     
     Or
     
     Drag-and-drop the predefined filter to the *Query Filters* pane.
     
     The predefined filter appears on the Query Filters pane.
     
     When you run the query, the data corresponding to the query filter(s) you selected is returned to the report.
     
     You can apply multiple filters to the same query by combining predefined filters with custom filters. For more information, see “Combining multiple filters on a query” on page 122.
  
    **Note:** Predefined filters are created and edited by your administrator. As a Web Intelligence user, you cannot view the component parts of predefined filters or edit predefined filters.
Creating custom query filters

You create custom query filters to limit document data to information corresponding to:

- a specific business question
- the business information needs of a specific group of users

For example, you can create custom filters to retrieve sales results data for specific dates, products, or services, or to view customer information only for customers who are high wage earners or who live in a particular region.

**Example:** Analyzing year 2002 sales revenue figures at large stores nationwide

In this example, you are a finance officer who wants to analyze the revenue figures for the larger stores nationwide at your company. The universe you connect to contains data for all stores for all years. You create the following filters:

- **Year = 2002**
- **Sales floor size group greater than 3000-3999**

The custom filters, which you defined and applied to the [Store Floor Size] and [Year] dimensions, limits the values returned to the document to values for year 2002 for larger stores.

You can define custom query filters two ways:

- Using the Quick Filter option – allows you to quickly select one or multiple values from a list of value(s)
- Using the Filter Editor – allows you to select from many operators and to either type or select the value(s)

**Using the quick filter option to create filters**

Quick filters allow you to quickly define the value(s) you want to retrieve for a specific object without launching the Filter Editor. By default, Quick filters use the Equal to operator if you select a single value or the In list operator if you select multiple values.

For example:
Filtering data retrieval using query filters

Creating custom query filters

- If you select the [Payment Status] dimension and the value “unpaid” you create the filter:
  [Payment Status] Equal to “unpaid”
- If you select the [Country] dimension and the values US, Japan, Germany, you create the filter:
  [Country] In list “US;Japan;Germany”

Creating a query filter using the quick filter option

To create a query filter using the quick filter option:

1. Make sure you are in Query View.
   The Edit Query button is pressed in when you are working in Query View.
2. Make sure the Query Filters pane is visible.
   If the pane is not displayed, click the Show/Hide Filter Pane button.
3. In the Data tab, select the object you want to filter and drag it to the Result Objects pane.
4. Reselect the object on the Result Objects panel and click the Add Quick Filter button on the Report toolbar.
   The List of Values dialog box appears. The values for the selected object are listed.
5. Select the value(s) you want to retrieve from the database.
   For example, to filter the query for values in Q1, select the [Quarter] dimension, then select Q1 from the list of values.

6. Click OK.
   The new filter appears on the Query Filters pane.
   When you run the query or refresh the document, Web Intelligence retrieves only the values that correspond to the filter.
   You can apply multiple filters to the same query. See “Combining multiple filters on a query” on page 122.
Using the Query Editor to create filters

Using the Query Editor allows you to choose from a range of operators to define the filter condition and to either select values from the List of Values or to type a constant when you define the filter value(s).

Creating a custom query filter using the Filter Editor

To create a custom query filter using the Filter Editor:

1. Make sure you are in Query View.
   The Edit Query button is pressed in when you are working in Query View.

2. On the Query toolbar, click the Show/Hide Filter Pane button to display the Query Filters pane.
   The Query Filters pane is where Web Intelligence displays all the filters defined on the query.

For information on how to define the result objects you want Web Intelligence to retrieve to the document, see “Building and running a simple query” on page 59.
3. Select the object you want to filter and drag it to the **Query Filters** pane. The query filter appears in outline in the Query Filters pane.

4. Click the arrow next to the default operator (In List) and select the query operator from the list of operators.

5. Click the arrow on the right of the query filter and select **Constant, Value(s) from List** or **Object**.

6. Type/select the constant, list of values or object you want to include in the filter.

7. Click **OK**.
   The new filter appears in the Query Filters pane.

8. To remove the filter, right-click it and select **Remove** from the menu.

9. To edit the filter, repeat steps 4-7 above.

When you run the query, only data corresponding to the query filter is returned to the report.

**Note:** You can choose to display the filtered values in the report, by including the object you filter in the Result Objects pane, or filter the object without displaying the filtered values, by excluding the object you filter from the Result Objects pane.

You can apply multiple filters to the same query. See “Combining multiple filters on a query” on page 122.
Combining multiple filters on a query

Typical business questions require to retrieve information that matches more than one criteria. For example, if you are analyzing customer services data, you will most likely want to focus on customers for a specific time period and also for a specific region, and probably also for a specific level of customer service contract. With Web Intelligence, you retrieve data that answers several criteria like this by combining filters in the same query.

Example: Analyze sales revenue this year at stores where the floor size is over 4,000 square feet and sales revenue figures are equal to or less than $1.5M

In this example, you are an operations manager for a retail chain. You want to analyze information about the large retail stores in your chain that are making less than the sales revenue figure your company has set as the target. To do this you add a predefined filter on the [Year] dimension to specify that you only want to retrieve values for this year. Then you create a second filter on the [Sales Floor Size] dimension to specify that you only want to retrieve data for stores where the floor size is greater than 4,000 square feet. After this, you create a third filter on the [Sales Revenue] measure to specify that you only want to retrieve data for stores where the sales revenue figures are equal to or less than $1.5M. Finally, you combine these three filters with the And operator:

When you run the query, only data for stores that satisfy all three criteria will be returned to the report.
The section tells you how to:

• combine query filters
• combine simple filters with combined filters

How you combine query filters

You combine filters to retrieve data that corresponds to multiple business criteria. For example, to retrieve data for customers who live in California and who don’t have a premium service contract, you combine the following two filters:

Filter 1: [State] Equal to California
And
Filter 2: [Service Contract] Not equal to Premium

Combining query filters

To combine query filters:

1. Create each filter.

For step-by-step information on how to create query filters, see “Creating a custom query filter using the Filter Editor” on page 120.

2. Make sure that the Show/Hide Filters pane button on the Query toolbar is pressed in.

You view the filters on the query in the Query Filters pane.

By default Web Intelligence combines the filters with the And operator:
3. You can leave the And operator or change the operator to Or.
   This table explains the difference between the And and the Or operators:

<table>
<thead>
<tr>
<th>You want to retrieve...</th>
<th>for example...</th>
<th>select...</th>
</tr>
</thead>
<tbody>
<tr>
<td>data true for both filters,</td>
<td>customers who ordered supplies in Q1 and who are based in the US (the data you retrieve will include: US customers who placed orders in Q1),</td>
<td>And</td>
</tr>
<tr>
<td>data true for any one of the filters,</td>
<td>customers who ordered supplies in: Q1 or who are based in the US (the data you retrieve will include: worldwide customers who placed orders in Q1 and US customers who placed orders during any quarter),</td>
<td>Or</td>
</tr>
</tbody>
</table>

4. If necessary, change the operator to Or, by double-clicking the And operator once:

```
Query Filters

Or

- Report.Country Equal to: Japan
- Revenue Greater than or equal to: 100000
```

Or now displays as the operator.
Combining simple filters with combined filters

You can combine filters with other groups of combine filters to retrieve data that corresponds to one or multiple business criteria. You combine filters with And or Or operator. You can combine groups of filters with single filters to answer complex criteria. The following example explains how the And and Or operators affect the data Web Intelligence retrieves to a document.

**Example: Using And or Or to combine query filters**

This example illustrates how using And and Or operators in four different ways to combine the same three query filters affects the values retrieved to a document. The three filters are on the [State] dimension, the [Quarter] dimension, and the [Sales Revenue] measure.

**Using And**

Using And to combine all three filters returns data for Texas in Q4, if the Sales Revenue total is greater than $2M:

```
<table>
<thead>
<tr>
<th>State</th>
<th>Quarter</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Texas</td>
<td>Q4</td>
<td>$2,586,516</td>
</tr>
</tbody>
</table>
```

In this case, the Sales Revenue for Texas in Q4 is over $2M, so the following values are returned to the default report when you run the query:

When you use the And operator to combine all the query filters like this, all of the criteria specified in all of the filters need to be matched by the data on the database for Web Intelligence to run the query. If any one filter is unmatched Web Intelligence displays a warning to inform you that there is no data corresponding to the query definition. If you run the query anyway, the default report displays without any values. Only the table headers appear.
Filtering data retrieval using query filters

Combining multiple filters on a query

Using Or

Using Or to combine all three filters returns data that matches any one of the filters:

In this case, Web Intelligence returns values for Texas for all quarters and data for all states in Q4, and data for all states where sales revenue was greater than $2M.

Using And and Or

You can retrieve data that answers either the criteria specified in one filter or the criteria specified in the other filter(s). You can combine the first filter with either the second or third filter by using And and Or as follows:

In this case, Web Intelligence retrieves data that corresponds to:

• the first filter – [State] Equal to Texas
  and
• that also corresponds to either
  • the second filter – [Quarter] Equal to Q4
  or
  • the third filter – [Sales Revenue] Greater than $2M
Filtering data retrieval using query filters

Combining multiple filters on a query

Using Or and And

You can reverse the operators and combine the same three filters as follows:

In this case, Web Intelligence retrieves data that corresponds to:

• the first filter – [State] Equal to Texas
  or that corresponds to

• both the second filter – [Quarter] Equal to Q4 and the third filter – [Sales Revenue] Greater than $2M
Applying query filters to business questions

This section provides examples of how you can apply query filters to Web Intelligence documents to answer typical business questions.

Retrieving a range of values

Using filters to retrieve a range of values is useful if you want to define a date range to analyze invoices or orders for a particular calendar period, or if you want to define an alphabetical range; such as for customer names or product lines.

Example: Analyzing the payment status of invoices sent to customers in December 2002

In this example you want to analyze the payment status of all invoices sent to customers during the month of December, 2002. To do this you need to retrieve data for invoices dated between December 1, 2002 and December 31, 2002.

To do this:

1. Click the Edit Query button on the Web Intelligence toolbar. Query View appears.
2. Drag and drop the [Invoice Date] object into the Query Filters pane. The Filter Editor dialog box appears.
3. Select the operator Between.

Note:

<table>
<thead>
<tr>
<th>To retrieve data that...</th>
<th>for example...</th>
<th>double-click...</th>
</tr>
</thead>
<tbody>
<tr>
<td>include a range of values,</td>
<td>retrieve data for 12/01/02 through 12/31/2002,</td>
<td>Between</td>
</tr>
<tr>
<td>omit a range of values,</td>
<td>Exclude data for 12/01/02 through 12/31/2002,</td>
<td>Not between</td>
</tr>
</tbody>
</table>

4. If you know how dates are typed into the database, select Constant. If you are unsure how dates should be typed or you want to select from new values entered into the database that you haven’t yet seen, select Value(s) from list.
5. Enter the start date and end date for the month of December 2002:

<table>
<thead>
<tr>
<th>If you selected Constant...</th>
<th>if you selected Value(s) from list...</th>
</tr>
</thead>
<tbody>
<tr>
<td>• type the date for December 1, 2002 into the From: box,</td>
<td>• select the date for December 1, 2002 and click the From&gt;&gt; button</td>
</tr>
<tr>
<td>• type the date for December 31, 2002 in the To: box</td>
<td>• select the date for December 31, 2002 and click the To&gt;&gt; button</td>
</tr>
</tbody>
</table>

6. Click **OK** to confirm the filter.

The new filter appears in the Query Filters pane.

When you run the query, only invoices for the month of December 2002 will be returned to the document.

**Tip:** To avoid displaying the Year column in the table, which will display the same value “2002” in each row, remove the [Year] object from the Result Objects pane when you define the query. The document data will still be filtered for 2002, but the value “2002” will no longer be displayed in the report(s).
Using the In list operator to define filters

Using the In list operator for filters is useful, if you want to retrieve data for several values, such as specific cities, product lines, or named customer accounts, that are not already grouped together in objects on the universe.

**Example:** Analyzing sales revenue for the cities in your sales region

In this example, you want to analyze sales revenue for the cities that fall into your sales region. The [City] object on the universe includes all the cities with which your company does business. In order to analyze only those cities for which you are responsible, you need to create a filter that selects the cities you specify.

To do this:

1. Click the **Edit Query** button on the Web Intelligence toolbar.
   Query View displays the query definition of the open document.
2. Drag and drop the [City] object into the Query Filters pane.
   The Filter Editor dialog box appears.
3. Select the **In list** operator.
   
   **Note:**

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>for example...</th>
<th>select...</th>
</tr>
</thead>
<tbody>
<tr>
<td>include data that is listed in a list of values that you specify,</td>
<td>retrieve values for three cities: London, Paris, Tokyo,</td>
<td>In list</td>
</tr>
<tr>
<td>exclude data that is listed in a list of values that you specify,</td>
<td>exclude values for three cities: London, Paris, Tokyo,</td>
<td>Not in list</td>
</tr>
</tbody>
</table>

4. Select the **Operand type, Value(s) in list**.
   The values related to the [City] object appear.
5. Select each city by selecting the city name(s) in the **List of Values** box, and then press the **>** button.
   The selected cities are listed in the **Values Selected** list.
6. Click **OK**.

The new filter appears in the Query Filters pane:

```
<table>
<thead>
<tr>
<th>Result Objects</th>
</tr>
</thead>
<tbody>
<tr>
<td>City</td>
</tr>
<tr>
<td>Revenue</td>
</tr>
</tbody>
</table>
```

```
<table>
<thead>
<tr>
<th>Query Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>City in [Bil, London, Paris, Tokyo]</td>
</tr>
</tbody>
</table>
```

When you run the query, Web Intelligence only returns the values that correspond to data for the cities you defined in the filter.
Filtering data retrieval using query filters

Applying query filters to business questions

Retrieving data that includes a specific alphanumeric string

Using filters to retrieve values with a specific string or characters is useful if you want to retrieve data for multiple values, where all these values include the same string of numbers or characters in their label.

This is particularly useful for retrieving data for post codes for addresses or SKU codes for specific line categories. For example, you can retrieve post codes that include “NY,” SKU codes that include “606,” or customer date of births that include “1971.”

**Example:** Analyzing data for customers in a specific postal area by filtering the first two letters of their post code

In this example, you want to analyze data for customers living in the CA postal area. You can do this by retrieving only the data for customers whose post code includes CA.

To do this:

1. Click the **Edit Query** button on the Web Intelligence toolbar. Query View appears.
2. Drag and drop the [Post Code] object into the Query Filters pane. The Filter Editor dialog box displays.
3. Select the operator **Matches pattern**.

**Note:**

<table>
<thead>
<tr>
<th>To retrieve data that...</th>
<th>for example...</th>
<th>select...</th>
</tr>
</thead>
<tbody>
<tr>
<td>includes an alphabetical or numeric character string you specify,</td>
<td>a SKU code prefix, month of birth, or post code prefix,</td>
<td><strong>Matches pattern</strong></td>
</tr>
<tr>
<td>does not include an alphabetical or numeric character string you specify,</td>
<td>a SKU code prefix, month of birth, or post code prefix,</td>
<td><strong>Different from pattern</strong></td>
</tr>
</tbody>
</table>

**Tip:** Very large databases can contain thousands of values for each table column or row. To select multiple values quickly, you can use wildcard characters to retrieve values that have the same string of characters in common.

4. Select the operand type, **Constant**.
5. In the **Constant** text box, type the character or numerical string you want to filter. In this example, the character string you type will be CA. If you only want to type a partial string, you can include wildcard characters when you type the string definition.

6. Click **OK**.

The new filter appears in the Query Filters pane.

When you run the query, only data for customers whose post code includes the string you specified, will be returned to the document.
Filtering data retrieval using query filters

Applying query filters to business questions
Filtering data using subqueries and database ranking
Overview

Chapter 8: Filtering data retrieval using query filters explains how you restrict
the data returned by a query by adding query filters. This chapter explains how
to work with more advanced types of query filter.

This chapter covers the following advanced query filters:

• subqueries
• database rankings

Subqueries and database rankings allow you to create filters that are much
more powerful than standard query filters.

What is a subquery?

A subquery is a more flexible kind of query filter that allows you to restrict
values in more sophisticated ways than with an ordinary query filter.

Subqueries are more powerful than ordinary query filters for the following
reasons:

• They allow you to compare the values of the object whose values are
  used to restrict the query with values from other objects.
• They allow you to restrict the values returned by the subquery with a
  WHERE clause.

What can you do with subqueries?

Subqueries allow you to pose complex questions that are difficult or
impossible to formulate with simple query filters. For example: what is the list
of customers and their associated revenue where the customer purchased a
service that had previously been reserved (by any customer) in Q1 of 2003?
The example “Which customers bought a service that had previously been
reserved in Q1 of 2003, and how much revenue have they generated?” on
page 140 shows you how to answer this question using a subquery.

How do subqueries work?

Subqueries work by modifying the SQL that Web Intelligence generates to
retrieve the query data. Web Intelligence generates SQL containing a
subquery that restricts the data returned by an outer query. For more
information on SQL subqueries, see any book on SQL.
Filtering data using subqueries and database ranking

What is a subquery?

For more information on viewing the SQL generated by Web Intelligence, see "Viewing and editing the SQL behind the query definition" on page 53.)

**Note:** SQL is the query language supported by all relational databases (RDBMS), although each database has its own syntax.

### Building a subquery

You build a subquery in the Query Filter pane of the Query Panel.

**Note:** You can mix subqueries and other types of query filter in the Query Filters pane.

1. **To build a subquery**
   1. Add the objects that you want to appear in the query to the Result Objects pane.
   2. Select the object that you want to filter with a subquery.
   3. Click **Add a subquery**.

      The subquery outline appears in the Query Filters pane. By default the object you selected appears as the Filter object and Filter By object. For more information on the Filter Object and Filter By object, see “Subquery parameters” on page 139.

4. To add a WHERE condition to the subquery, drag a report object to the area of the subquery below the *Drop an object here* boxes.

   **Note:** You can use an existing subquery or standard query filter as a WHERE condition in a subquery. To do so, drag and drop the existing filter or subquery to the area of the subquery below the *Drop an object here* boxes. To copy rather than move the existing filter to the WHERE condition, hold down the Control key while dragging and dropping. In this case the existing filter remains in its initial place and becomes part of the WHERE condition of the subquery.

5. Select the operator and values used to filter the object in the WHERE condition.

   **Note:** For more information on query filter operators and values, see Chapter 8: Filtering data retrieval using query filters.
Filtering data using subqueries and database ranking

What is a subquery?

6. Click **Subquery** to add an additional subquery to the query filter.

   By default the two subqueries are linked in an AND relationship. Click the AND operator to toggle between AND and OR.

   In addition to linking subqueries in AND or OR relationships, you can **nest** them (create subqueries within subqueries) by dragging an existing subquery to the area beneath the **Drop an object here** boxes. In this case the inner subquery becomes part of the WHERE condition of the outer subquery. To copy rather than move the subquery to the WHERE condition, hold down the Control key while dragging and dropping. In this case the second subquery remains at the same level as the first, and becomes part of the WHERE clause of the first.
Subquery parameters

A subquery or set of subqueries contains the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Filter Object(s)</strong></td>
<td>The object whose values are used to filter the result objects. You can include more than one Filter Object. If you do, Web Intelligence concatenates the values of the objects you specify.</td>
</tr>
<tr>
<td><strong>Filter By Object(s)</strong></td>
<td>The object that determines which Filter Object values the subquery returns. You can include more than one Filter By object. If you do, Web Intelligence concatenates the values of the objects you specify.</td>
</tr>
<tr>
<td><strong>Operator</strong></td>
<td>The operator that specifies the relationship between the Filter object and the Filter By object. Because of database restrictions you cannot use certain combinations of operators and Filter By objects together. For example, if you use the Equal To operator with a Filter By object that returns multiple values, the database rejects the SQL because this type of subquery requires the Filter By object to return one value only. In cases where the generated SQL is rejected by the database, you see an error message showing the error description returned by the database.</td>
</tr>
<tr>
<td><strong>WHERE condition</strong></td>
<td>An additional condition that constrains the list of values of the Filter By object. You can use ordinary report objects, predefined conditions or existing query filters (including subqueries) in the WHERE condition.</td>
</tr>
<tr>
<td><strong>Relationship operator</strong></td>
<td>If there is more than one subquery, determines the relationship between the subqueries. AND - the conditions in all of the subqueries must be satisfied. OR - the conditions in any one of the subqueries must be satisfied.</td>
</tr>
</tbody>
</table>
Example: Which customers bought a service that had previously been reserved in Q1 of 2003, and how much revenue have they generated?

To answer this question
1. Drag the Customer and Revenue objects to the Result Objects pane of the Query Panel.
2. Select the Service object on the Data tab.
3. Click Subquery.
   The subquery outline appears in the Query Filters pane.
   Note: The selected object appears in both boxes in the subquery outline. You often use the same object in both boxes, although this is not required. If the objects do not return any common values, the subquery returns no values, and the query therefore returns no values.
4. Drag the Reservation Year object to the area of the subquery outline beneath the Service objects.
   Web Intelligence adds a WHERE condition on the Reservation Year object.
5. Set the Reservation Year condition operator to Equal To.
6. Type ‘FY2003’ in the Type a constant box.
   Note: For more information on the types of operators you can use in the WHERE condition, see Chapter 8: Filtering data retrieval using query filters.
7. Drag the Reservation Quarter object to the area of the subquery outline beneath the Service objects.
   Web Intelligence adds the Reservation Quarter object to the WHERE condition.
8. Set the Reservation Quarter condition operator to Equal To.
9. Type ‘Q1’ in the Type a constant box.
10. Click Run Query to run the query.

How the subquery components combine

How does the subquery in this example answer the question? By dragging the Service object into the subquery as the Filter object, you ensure that the list of customers will be filtered by service. By again dragging the Service object into the subquery as the Filter By object, you ensure that Web Intelligence will filter the customer list by only those services that satisfy
certain criteria. By setting up the conditions in the subquery WHERE clause, you specify those criteria and ensure that the list of services will include only those reserved in Q1 of 2003.

What is a database ranking?

When you rank data you sort and filter it according to ranking criteria. Web Intelligence allows you to return unranked data from a database, then rank it in Web Intelligence. (For more information, see Chapter 16: Ranking Data.) A database ranking allows you to specify a ranking at the query and database level so that the data returned to Web Intelligence by the query is already ranked. This has the following advantages:

- Ranking data can be processing-intensive. By ranking at the database level you allow the server, which is typically far more powerful than the client machine, to perform this processing.
- Pre-ranking data reduces the amount of data retrieved across the network and stored in Web Intelligence.

Note: You can perform a database ranking only if your database supports it. If this is not the case, the Add a database ranking button is disabled on the Query Panel toolbar. Databases that support ranking are Oracle, DB2, Terradata and Redbrick.

What can you do with a database ranking?

Database rankings allow you to answer questions like “Return the top 3 customers based on the revenue they generated for each year” at the query level, without the need to return data that falls outside the ranking to Web Intelligence and then filter it using a Web Intelligence ranking.

How does a database ranking work?

A database ranking works by modifying the SQL that Web Intelligence generates to retrieve the query data. If your database supports ranking, Web Intelligence generates SQL to rank the data.

Note: Web Intelligence uses the SQL-99 Rank function in ranking SQL. For more information on viewing the SQL generated by Web Intelligence, see “Viewing and editing the SQL behind the query definition” on page 53.)

Note: SQL is the query language supported by all relational databases (RDBMS), although each database has its own syntax.
Filtering data using subqueries and database ranking

**What is a database ranking?**

**Ranking parameters**

A ranking appears as follows in the Query Filters pane of the Query Panel:

```
<table>
<thead>
<tr>
<th>Top</th>
<th>Bottom</th>
<th>Number of records</th>
<th>Ranking dimension</th>
<th>Based on</th>
<th>For Each (optional)</th>
<th>WHERE condition (optional)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

The following table describes the parameters from left to right in the ranking:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| Top/Bottom     | Ranking order.  
                | **Top** - ranks in descending order.  
                | **Bottom** - ranks in ascending order. |
| Number of records | The number of records to return in the ranking. For example, the top 10. |
| Ranking dimension | The dimension used in the ranking. For example, if the dimension is Region and the ranking is Top 10, the ranking returns the top 10 regions. |
| Based on       | The measure by which the ranking dimension is ranked. For example, if the measure is Revenue and the dimension is Region, Web Intelligence ranks regions by the amount of revenue they generate |
| For Each (optional) | Dimension that specifies additional calculation context for the ranking. For example, if the ranking dimension is Region, the measure is Revenue and the For Each dimension is Country, Web Intelligence ranks regions by revenue within each country. |
| WHERE condition (optional) | Additional restriction on the values returned in the ranking that appears below the other parameters. For example, a ranking of regions with a condition that restricts Country to “USA” ranks only those regions in the USA. |

**Creating a database ranking**

You create a database ranking in the Query Panel.  

*Note:* You can mix database rankings and other types of query filter in the Query Filters pane.
To create a database ranking

1. Add the objects that you want to appear in your query to the Result Objects pane of the Query Panel.
2. Select the dimension that you want to rank by.
3. Click **Add a database ranking** on the toolbar.

   The ranking outline appears in the Query Filter pane. The dimension you selected appears as the ranking dimension and the first measure in the query appears as the ranking measure in the **Based on** box.

   **Note:** The **Add a database ranking** button is disabled if your database does not support ranking.

4. Select the ranking direction (Top or bottom.)
5. Type the number of records you want the ranking to return in the box next to Top/Bottom.

   **Note:** You can specify a prompt instead of a constant by clicking on the arrow next to the number. When you select a prompt the user must enter the ranking number when the query is run. For more information on prompts, see Chapter 10: Building prompt filters on data providers.

6. Drag the dimension that provides the calculation context for the measure to the **For Each** box.

   This dimension is optional. To display the **For Each** box, click the arrow to the right of the **Based on** measure.

7. Drag any dimensions that you want to include in the WHERE restriction to the area at the bottom of the ranking. For more information on the WHERE restriction, see the explanation under “What is a subquery?” on page 136.

8. Click **Run Query**.

**Example:** Create a report that returns the top 10 employees based on salary, and calculated by department.

1. Drag the Department, Employee Name, and Salary objects to the Report Objects pane within the Query Panel.
2. Select the Employee Name object.
3. Click **Database Rank** on the toolbar.

   Web Intelligence adds an outline database rank to the Query Filters pane. The ranking dimension is Employee Name and the ranking measure is Salary.

4. Set the ranking direction to Top.
5. Set the ranking number to 10.
Filtering data using subqueries and database ranking

What is a database ranking?

6. Click the arrow next to the Based on measure if the For Each box is not already visible.

7. Set the For Each dimension to Department by dragging and dropping the dimension.

The ranking now looks like this:

8. Click Run Query.
Building prompt filters on data providers
Overview

This chapter tells you how to build prompts to filter Web Intelligence documents. Each time you refresh the document data, the prompts appear for you to specify the filter values you want Web Intelligence to return to the document.

Prompts enable multiple users to return different data to the same document every time they refresh the document data. You can create prompts that require you to specify an account number, a date, a range of customer names, and so on.

This chapter explains how:

• prompt filters work
• you add prompts to a document
• you apply multiple prompts to a single document
• you edit and remove prompts
What are prompts?

A prompt is a dynamic filter that displays a question every time you refresh the data in a document. You answer prompts by either typing or selecting the value(s) you want to view before you refresh the data. Web Intelligence retrieves only the values you specified from the database and returns those values to the reports within the document. Prompts allow multiple users viewing a single document to specify a different sub-set of the database information and display it in the same report tables and charts. Prompts also reduce the time it takes for the data to be retrieved from the database.

Example: Enable users in the Accounts department to specify the period for which they want to view customer payment information

In this example, the document has a prompt filter on [Invoice Date] so that account managers can specify a period, for which they want to display the payment status of invoices by customer:

When you refresh the data in the report, the prompt displays to request you to specify the start date and end date of the period, for which you want to return data to the document.

Note: When a document contains multiple data providers, any prompts that include (1) objects with the same data type, (2) operators of the same operator type, and that (3) use the same prompt text are merged. When all the data providers are refreshed, a single prompt message appears for such prompts. For full information, see “Merging prompts on multiple data providers” on page 153.

This chapter explains how to create and edit prompts. For detailed information on how to view and refresh documents with prompts, see the Performing On-Report Analysis with Web Intelligence guide.
Building prompt filters on data providers

What are prompts?

What makes up a prompt?

To create a prompt, you need to specify three elements:

- a filtered object
- an operator
- a prompt message

For example, to prompt users to select a specific year, you define a prompt on the [Year] dimension. If your prompt looks like this:

Prompt Equal To (“Select a year”)

it means that the user will see the message “Select a year” and be prompted to enter a value for Year.

You can create multiple prompts on a document. For example,

Prompt Equal To (“Select a year”)
AND
City In List (“Select a city”)

When the user runs the query, Web Intelligence displays the prompt dialog box with the prompt message(s).
When you run the query or refresh the document data, Web Intelligence displays the prompts.

**What objects can I filter with a prompt?**

You can define prompts on any dimension, measure, or detail object listed on the Data tab in Edit Query View.

For example, you can filter the [Year] dimension to return values for a specific year, filter the [Revenue] measure to return values for a range of revenue figures, or filter the [Postal Code] detail to return values for a specific postal area.

For an illustrated description and examples of dimensions, measures, and details, see "What types of objects can you use in a query?" on page 43.
### Which operator should I choose?

It is important to understand the effect of each operator available to you when you define a prompt. The table below lists the operators available for prompts and provides an example of each operator in the context of a business question:

<table>
<thead>
<tr>
<th>To obtain data...</th>
<th>for example...</th>
<th>select...</th>
<th>to create the filter...</th>
</tr>
</thead>
<tbody>
<tr>
<td>equal to a value you specify,</td>
<td>retrieve data for the US only,</td>
<td>Equal to</td>
<td>[Country] Equal to US.</td>
</tr>
<tr>
<td>not equal to a value you specify,</td>
<td>retrieve data for all quarters except Q4,</td>
<td>Not Equal to</td>
<td>[Quarter] Not Equal to Q4</td>
</tr>
<tr>
<td>greater than a value you specify,</td>
<td>retrieve data for customers aged over 60,</td>
<td>Greater than</td>
<td>[Customer Age] Greater than 60</td>
</tr>
<tr>
<td>greater than or equal to a value you specify,</td>
<td>retrieve data for revenue starting from $1.5M upward,</td>
<td>Greater than or equal to</td>
<td>[Revenue] Greater than or equal to 1000500</td>
</tr>
<tr>
<td>lower than a value you specify,</td>
<td>retrieve data for exam grades below 40,</td>
<td>Less than</td>
<td>[Exam Grade] Less than 40</td>
</tr>
<tr>
<td>lower than or equal to a value you specify,</td>
<td>customers whose age is 30 or less,</td>
<td>Less than or equal to</td>
<td>[Age] Less than or equal to 30</td>
</tr>
<tr>
<td>that falls between two values you specify and includes those two values,</td>
<td>weeks starting at week 25 and finishing at 36 (including week 25 and week 36),</td>
<td>Between</td>
<td>[Weeks] Between 25 and 36</td>
</tr>
<tr>
<td>that falls outside two given values you specify,</td>
<td>all the weeks of the year, except for weeks 25 through 36 (week 25 and week 36 are not included),</td>
<td>Not between</td>
<td>[Weeks] Not Between 25 and 36</td>
</tr>
<tr>
<td>To obtain data...</td>
<td>for example...</td>
<td>select...</td>
<td>to create the filter...</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------</td>
<td>-----------</td>
<td>------------------------</td>
</tr>
<tr>
<td>the same as several values you specify,</td>
<td>you only want to retrieve data for the following countries: the US, Japan, and the UK,</td>
<td><strong>In list</strong></td>
<td>[Country] In list ‘US; Japan; UK’</td>
</tr>
<tr>
<td>different from the multiple values you specify,</td>
<td>you don’t want to retrieve data for the following countries: the US, Japan, and the UK,</td>
<td><strong>Not in list</strong></td>
<td>[Country] Not in list ‘US; Japan; UK’</td>
</tr>
<tr>
<td>that includes a specific string,</td>
<td>customers whose date of birth is March 1972,</td>
<td><strong>Matches pattern</strong></td>
<td>[DOB] Matches pattern, ‘72’</td>
</tr>
<tr>
<td>that doesn’t include a specific string,</td>
<td>customers whose names do not begin with S,</td>
<td><strong>Different from pattern</strong></td>
<td>[DOB] Different from pattern, ‘s’</td>
</tr>
<tr>
<td>that corresponds to two values you specify,</td>
<td>telco customers who have both a fixed telephone and a mobile phone,</td>
<td><strong>Both</strong></td>
<td>[Account Type] Both “fixed” and “mobile”</td>
</tr>
<tr>
<td>that corresponds to one value you specify and does not correspond to another value you specify</td>
<td>telco customers who have a fixed telephone, but don’t have a mobile phone,</td>
<td><strong>Except</strong></td>
<td>[Account Type] “fixed” Except “mobile”</td>
</tr>
</tbody>
</table>

**Note:** You can’t use the following operators for prompts: Is null and Is not null. You can define query filters using these operators (see “Which operator should I choose?” on page 150)
### Choosing how prompts display

By default, Web Intelligence prompts display a box and a list of values. You answer the prompt by either typing the value(s) in the box or by selecting value(s) from the list. You can modify how prompts display by checking one, some, or all of the following options:

<table>
<thead>
<tr>
<th>If you want the prompt to display...</th>
<th>(useful when you...)</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>the list of values associated with the filtered dimension, measure, or detail,</td>
<td>want to view all the values for the object and then select from those values</td>
<td>leave the option selected by default: <strong>Prompt with List of Values</strong></td>
</tr>
<tr>
<td>the value(s) specified the last time the prompt was answered (users can select a different value(s)),</td>
<td>often reselect the same value(s) when you refresh the document, but want the ability to select a different value when necessary, such as the name of the current month</td>
<td>select the option: <strong>Keep last values selected</strong></td>
</tr>
<tr>
<td>the value(s) you specify as the default (users can select a different value(s)),</td>
<td>almost always reselect the same value(s) when you refresh the document, but want the ability to select a different value when necessary, such as the number for the current year</td>
<td>select the option: <strong>Set default value(s)</strong></td>
</tr>
<tr>
<td>a list of values from which users select a value(s),</td>
<td>prevent users from typing a value that might not exist on the database</td>
<td>select the option: <strong>Select only from List</strong></td>
</tr>
</tbody>
</table>

**Note:** If the prompt is for a date and you want users to see the popup calendar in order to select the date(s) then do not do not select **Prompt with List of Values**.
Merging prompts on multiple data providers

When a document contains multiple data providers, prompts on those data providers are merged, if the following three parameters in the prompts are the same:

- the objects are the same data type
- the operators are the same operator type
- the prompt text is the same

If these three parameters are the same for multiple prompts, then whenever all the data providers in the document are refreshed, only one prompt message appears for those prompts.

The criteria for merging prompts

The following table provides details on the three criteria for merging prompts:

<table>
<thead>
<tr>
<th>Prompt Parameters</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object data type</td>
<td>The data for the object in each prompt must be of the same type; for example, string, date, or numeric.</td>
</tr>
</tbody>
</table>
| Operator type     | The operators in the prompts must either all be multi-selection operators or all be mono-selection operators.  
|                   | • The following operators are mono-selection:  
|                   |   Equal to, Different from, Greater than, Greater than or equal to, Less than, Less than or equal to, Matches pattern, Different from pattern, Between, Not between, Both, Except  
|                   |   • The following operators are multi-selection:  
|                   |   In list, Not in list |
| Prompt text       | The message displayed by the prompt must be exactly the same. For example:  
|                   | • Prompt 1: “Select Country from list:”  
|                   | • Prompt 2: “Select Country from list:” |
The display properties of the merged prompt

When you create a new prompt that has the same prompt text as another prompt, the display properties specified for the two prompts are applied to the merged prompt according to the following rules:

- **Select only from list** takes priority over a prompt message that does not include this constraint
- **Prompt with List of values** takes priority over a prompt message that does not display the List of values
- **Keep last values selected** takes priority over a prompt message that does not include this constraint
- **Set default value** takes priority over a prompt message that does not have a default value set for it

Web Intelligence applies the properties of the prompt with the most constraints to the merged prompt. For example, a document contains three prompts with the same object data type, the same operator type, and the same prompt text, and with the following display properties:

- **Prompt 1**: Select only from list, Prompt with List of Values
- **Prompt 2**: Prompt with List of Values, Set default value(s)
- **Prompt 3**: Select only from list, Prompt with List of Values, Set default value(s)

In this case, Web Intelligence applies the properties of Prompt 3 to the merged prompt.

The List of Values used by the merged prompt

The List of Values displayed by the merged prompt is the list associated with the object in the prompt that has the most display property constraints. So, in the example given above, the List of Values displayed by the merged prompt is the list associated with the object used in Prompt 3.
Adding prompts to documents

You can apply one or multiple prompts to a document. The prompts appear in the order you create them, but you can also edit the order in which the prompts appear later. For information about prioritizing multiple prompts see “You can also combine prompts with other types of query filter in the same way.” on page 158.

Creating a prompt

To create a prompt:

1. Make sure you are in Query View.
   The Edit Query button is pressed in when you are working in Query View.
2. Make sure the Query Filters pane is visible, then select the query on which you want to create a prompt, by clicking the appropriate query tab.
   If the Query Filters pane is not displayed, click the Show/Hide Query Filters Pane button.
3. From the Data tab, drag the object on which you want to apply a prompt and drop it onto the Query Filters pane.
   The query filter appears in outline in the Query Filters pane.
4. Click the arrow at the right of the Query Filter and select Prompt from the menu.
5. Type the prompt text in the text box.
6. Click the icon next to the text box and use the dialog box that appears to set the prompt properties.

   Note: If the prompt is for a date and you want users to see the popup calendar in order to select the date(s) then do not select Prompt with List of Values.

By default, Web Intelligence prompts display a list of values and a prompt box. For full information, see “Choosing how prompts display” on page 152.

If the document contains multiple data providers, and there is already a prompt that includes (1) objects with the same data type, (2) operators of the same operator type, and (3) that uses the same prompt text as the new prompt, Web Intelligence displays a warning to tell you that the two prompts will be merged. This means that whenever all the data providers are refreshed, a single prompt message will appear for the two prompts. (For full information, see “Merging prompts on multiple data providers” on page 153.)
7. Click OK to confirm the prompt. The prompt appears at each document refresh. For information on refreshing documents with prompts, see page 31.

8. To edit an existing prompt, follow steps 4 - 6.

9. To delete a prompt, right-click it and select Remove from the menu.
Applying multiple prompts

You can apply multiple prompts to a single query so that users accessing the same Web Intelligence document can limit the data returned to the report to the information that corresponds to their specific business interest.

The following section tells you how to:

• combine multiple prompts
• combine prompts within other query filters
• prioritize the order of prompts

Combining multiple prompts

Combining multiple prompts on a single query enables you to filter the data returned to the document, so that each person viewing the reports sees only the information relevant to their business need. For example, if you combine the following three prompts on a Customer Accounts document:

• Which customer
• Which account?
• Which calendar period: from? to?

this enables each accounts manager viewing the document to view report values for a specific customer account during a specific period.

Combining prompts

To combine prompts:

1. Create each prompt.
   
   For step-by-step information on how to create a prompt, see “Creating a prompt” on page 155.

2. Make sure that the Show/Hide Filters pane button on the Query toolbar is pressed in.
   
   You can view the prompts on the query in the Query Filters pane. By default Web Intelligence combines the prompts with the And operator.
3. You can leave the \textit{And} operator or change the operator to \textit{Or}.

This table explains the difference between the \textit{And} and the \textit{Or} operators:

<table>
<thead>
<tr>
<th>You want to retrieve...</th>
<th>for example...</th>
<th>select...</th>
</tr>
</thead>
<tbody>
<tr>
<td>data true for both filters,</td>
<td>customers who ordered supplies in Q1 and in Q2 (the data you retrieve will include: customers who placed orders in both Q1 and Q2),</td>
<td>\textit{And}</td>
</tr>
<tr>
<td>data true for any one of the filters,</td>
<td>customers who ordered supplies in Q1 or Q2 (the data you retrieve will include: customers who placed orders in Q1 only; customers who placed orders in Q2 only, and; customers who placed orders in both Q1 and Q2),</td>
<td>\textit{Or}</td>
</tr>
</tbody>
</table>

If necessary, change the operator to \textit{Or}, by clicking the \textit{And} operator once.

\textit{Or} now displays as the operator. For information on changing the order of prompts, see “You can also combine prompts with other types of query filter in the same way.” on page 158.

\textbf{Note:} You can also combine prompts with other types of query filter in the same way.

\begin{itemize}
  \item \textbf{Prioritizing the order of prompts}
  \end{itemize}

To prioritize the order of prompts:

1. Make sure you are in Query View.

   The \textbf{Edit Query} button is pressed in when you are working in Query View.
2. Click the **Properties** tab.

   If the Properties tab is not visible, click the **Show/Hide Manager** button to display the tab.

   The prompts are listed in order in the **Prompt Order** list box.

   ![Prompt Order List Box]

   Use the up and down arrows to modify the order in which you want the prompts to appear each time the query is run or the document data is refreshed.

3. Select the prompt you want to move and click the up or down arrows to re-position the select prompt.

   When you click **Run Query** or refresh the document data, the prompts display in the new order you specified.

   For information on how to answer prompts when you open Web Intelligence documents, see page 31.
Building prompt filters on data providers

*Applying multiple prompts*
Working with Reports
Inserting and formatting tables
Overview

When you create a new document, Web Intelligence generates a new report with a vertical table and standard formatting. This initial table includes all of the data in the query behind the document.

You can edit the table contents, personalize the formatting, or turn the table into a different table type or chart. You can also insert more tables onto the same report or onto new reports within the same document.

This chapter tells you about:
- Web Intelligence table templates
- working in Structure or Results View
- adding tables to reports
- duplicating tables
- applying a different template to existing tables
- adding or removing table rows or columns
- moving or swapping table rows or columns
- replacing table columns and rows
- modifying tables to create crosstabs
- clearing and removing tables
- formatting tables and table cells
- setting properties for table headers and footers
- setting page layout for tables
- selecting display properties for empty table cells
- avoiding duplicate row aggregation
- copying and pasting tables
Web Intelligence table templates

This section tells you about the different table templates you can use to display information on Web Intelligence reports:

- vertical tables
- horizontal tables
- crosstabs
- forms

The following section describes each template.

Vertical tables

Vertical tables display header cells at the top of the table and the corresponding data in columns. By default, the header cells display the names of the dimensions, details, and measures included in the table. The body cells display the corresponding values.

<table>
<thead>
<tr>
<th>Lines</th>
<th>Sales revenue</th>
<th>Margin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>$2,914,646</td>
<td>$3,693,136</td>
</tr>
<tr>
<td>City Skirts</td>
<td>$347,775</td>
<td>$132,302</td>
</tr>
<tr>
<td>City Trousers</td>
<td>$344,120</td>
<td>$104,364</td>
</tr>
<tr>
<td>Dresses</td>
<td>$2,919,620</td>
<td>$1,173,881</td>
</tr>
<tr>
<td>Jackets</td>
<td>$577,307</td>
<td>$258,130</td>
</tr>
<tr>
<td>Leather</td>
<td>$187,413</td>
<td>$70,589</td>
</tr>
<tr>
<td>Outerwear</td>
<td>$1,183,083</td>
<td>$474,302</td>
</tr>
<tr>
<td>Overcoats</td>
<td>$436,266</td>
<td>$185,522</td>
</tr>
<tr>
<td>Shirt Waist</td>
<td>$4,010,220</td>
<td>$1,616,278</td>
</tr>
<tr>
<td>Sweaters</td>
<td>$2,890,096</td>
<td>$1,000,063</td>
</tr>
<tr>
<td>Sweatshirt T-Shirts</td>
<td>$12,879,869</td>
<td>$6,408,517</td>
</tr>
<tr>
<td>Trousers</td>
<td>$903,220</td>
<td>$337,515</td>
</tr>
</tbody>
</table>
Horizontal tables

Horizontal tables display header cells at the left of the table and the corresponding data in rows. By default, the header cells display the names of the dimensions, details, and measures included in the table. The body cells display the corresponding values.

<table>
<thead>
<tr>
<th>Fiscal Period</th>
<th>FY01</th>
<th>FY02</th>
<th>FY03</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales revenue</td>
<td>$8,085,814</td>
<td>$13,232,246</td>
<td>$15,256,143</td>
</tr>
<tr>
<td>Margin</td>
<td>$3,731,971</td>
<td>$5,910,606</td>
<td>$5,867,824</td>
</tr>
</tbody>
</table>

This table format is useful for reports with several measures, such as financial reports and balance sheets.

Crosstabs

Crosstabs display values for dimensions across the top axis and on the left axis. The body displays the values of a measure that correspond to the cross-section of the dimensions. For example, this crosstab displays values for [Quarter] across the top axis and displays values for [State] on the left axis. The body displays values that [Sales Revenue] for each quarter in each state.

You can include multiple dimensions in crosstabs. For example, this crosstab displays two dimensions. The values for the [Sales Revenue] measure are values each state by quarter for each line.

[Table data]

You can include multiple dimensions in crosstabs. For example, this crosstab displays two dimensions. The values for the [Sales Revenue] measure are values each state by quarter for each line.

[Table data]
Crosstabs display values of the dimensions and measures they contain. You can include additional headers that display the names of the dimensions and measures names. See “Displaying object names in headers on crosstabs” on page 207.

Crosstabs are useful for presenting results that correspond to the intersection of two or more dimensions. For example, including the [State] dimension, the [Quarter] dimension, and the [Line] dimension as well as the [Sales revenue] measure on a crosstab allows you to easily illustrate revenue by region per product line, per quarter.

### Crosstabs with dimensions in the body

When you create crosstabs that include a dimension(s) in the body, the body cell values are calculated according to a multi-dimensional data model. The values displayed in the body are calculated according to all of the coordinates on the table axes, whether or not there is a row for the specific coordinate in the SQL result.

<table>
<thead>
<tr>
<th>Year</th>
<th>California</th>
<th>Colorado</th>
<th>DC</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>Colorado Springs</td>
<td>Colorado Springs</td>
<td>Colorado Springs</td>
</tr>
<tr>
<td>2001</td>
<td>Los Angeles</td>
<td>Los Angeles</td>
<td>Los Angeles</td>
</tr>
<tr>
<td>2001</td>
<td>San Francisco</td>
<td>San Francisco</td>
<td>San Francisco</td>
</tr>
<tr>
<td>2002</td>
<td>Colorado Springs</td>
<td>Colorado Springs</td>
<td>Colorado Springs</td>
</tr>
<tr>
<td>2002</td>
<td>Los Angeles</td>
<td>Los Angeles</td>
<td>Los Angeles</td>
</tr>
<tr>
<td>2002</td>
<td>San Francisco</td>
<td>San Francisco</td>
<td>San Francisco</td>
</tr>
<tr>
<td>2003</td>
<td>Colorado Springs</td>
<td>Colorado Springs</td>
<td>Colorado Springs</td>
</tr>
<tr>
<td>2003</td>
<td>Los Angeles</td>
<td>Los Angeles</td>
<td>Los Angeles</td>
</tr>
<tr>
<td>2003</td>
<td>San Francisco</td>
<td>San Francisco</td>
<td>San Francisco</td>
</tr>
</tbody>
</table>

The current value of the dimension on the axis provides the value to be displayed in the body. The value for that dimension will be the same for the whole column, if the dimension is in the on top axis or for the whole line in other cases.
Forms

Forms are useful in your report if you want to display detailed information per customer, product, or partner. For example, a form is a useful way of displaying individual customer records with information such as the customer account, name, address, and so on. Forms are also useful for formatting address labels for envelopes.

<table>
<thead>
<tr>
<th>Arai</th>
<th></th>
<th>Baker</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone Number</td>
<td>5478 4607</td>
<td>Invoice Date</td>
</tr>
<tr>
<td>Address</td>
<td>341 Toyota Ave</td>
<td>Revenue</td>
</tr>
<tr>
<td>Region</td>
<td>East Japan</td>
<td></td>
</tr>
<tr>
<td>Country of origin</td>
<td>Japan</td>
<td></td>
</tr>
<tr>
<td>Phone Number</td>
<td>5321 655 7010</td>
<td>Invoice Date</td>
</tr>
<tr>
<td>Address</td>
<td>2000 Great Avenue</td>
<td>Revenue</td>
</tr>
<tr>
<td>Region</td>
<td>M1 West</td>
<td>Invoice Date</td>
</tr>
<tr>
<td>Country of origin</td>
<td>US</td>
<td>Revenue</td>
</tr>
</tbody>
</table>

This illustration shows two forms on a report. The form on the left displays personal information about the customer. The form on the right displays the date and amount of each invoice for that customer.
Working in Structure or Results View

The Web Intelligence Java Report Panel allows you to make modifications to documents and preview those changes in Structure View, without implementing each change on the Web Intelligence server. This enables you to make multiple formatting changes quickly and preview them. When you return to Results View, Web Intelligence requests the server to apply the changes and returns the modified format in a single operation.

You can create and format tables in either Structure View or Results View. If you have several modifications to make, however, we recommend you make the modifications in Structure View.
Inserting and formatting tables

Adding tables to reports

You can insert one or multiple tables on a report. You insert tables by dragging one of the following onto a blank area of the report:

- the objects, for which you want the table to display values – this is a fast way to build simple, vertical tables
- a table template that defines the structure of the table, to which you then allocate objects – this is a fast way to build more complex tables with precision

Note: When you create a new document, Web Intelligence generates a default report with a vertical table that contains all the objects in the query. You can modify or remove this table. See “Applying a different template to existing tables” on page 178 or “Clearing cells and removing tables” on page 193.

For information on creating new documents, see “Template ook” on page Chapter. For information on inserting additional blank reports into a document, see “” on page 353.

Creating a table by dragging objects onto a report

To create a table by dragging objects onto a report:

1. Make sure you are in Report View.

   When you work in Report View, the report tab(s) appear across the bottom of the Document pane. You can go to Report View by clicking the Edit Report button on the Web Intelligence toolbar.

   The objects in the document appear in the Data tab.

   If the Data tab is not visible, click the Show/Hide Manager button on the Report toolbar.
2. How you add objects to a report depends on whether the report is empty or not:

• If the report is empty, select either a single object or a class folder on the Data tab, and then drag and drop the object or class onto the report. Selecting a class folder adds all the objects from the class onto the report in the new table.

Or

• If the report already contains tables or charts, press the Alt key, then with the Alt key pressed, drag an object onto an empty area of the report. A new table header and body cell appears on the report. The table header displays the name of the object.

3. To add another object to the table, drag another object from the Data tab and place it to the left or right of the existing column header.

4. When the “Drop here to insert a cell” ToolTip appears, drop the object onto the left or right of the table header. A second column appears before or after the first column. The new column header displays the name of the object.

5. To add more objects to the table, repeat step 3. Web Intelligence displays the values in a vertical table.
You can quickly turn the vertical table to a different table format, such as a crosstab by using the Turn To feature. See “Applying a different template to a table using the Turn To dialog box” on page 180.

Creating a table by selecting a template

To create a table by selecting a template:

1. Make sure you are in Report View.
   
   When you work in Report View, the report tab(s) appear across the bottom of the Document pane. You can go to Report View by clicking the Edit Report button on the Web Intelligence toolbar.

2. Click the report tab of the report where you want to insert a table.
   
   To find out how to add a blank report to the document, see “” on page 353.

3. Click View Structure.
   
   Working in Structure View allows you to define and preview the new table without requesting the server to apply each of your modifications. You then apply all your modifications and display the results in the new table, by returning to Results View.

4. Click the Templates tab.
   
   If the Templates tab is hidden, click the Show/Hide Manager button on the Report toolbar.

   The available Templates appear.

<table>
<thead>
<tr>
<th>Date</th>
<th>Templates</th>
<th>Properties</th>
<th>Map</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Elements</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Report</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tables</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Charts</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Free-Standing Cells</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

5. Click the + sign next to Tables.
   
   The table templates are listed.
6. Drag a template from the Template tab onto a blank area of the report.

![Template tab in Web Intelligence](image1.png)

The template appears on the report.

![Template on report](image2.png)

7. Click the Data tab.

The objects and variables that the document contains appear here. You can add any of these objects or variables to the table.

8. Drag an object or variable onto an empty header or body cell of the table.

9. When the ToolTip “Drop here to replace cell” appears, drop the object onto the table.

![Drop here to replace cell](image3.png)

The empty cell is replaced by the object.
Adding tables to reports

If you are working in Results View, the values of the objects display on the table.

<table>
<thead>
<tr>
<th>2001</th>
<th>2002</th>
<th>2003</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If you are working in Structure View, the name of the object displays on the table.

- [Year]

10. To add more objects to the template, drag an object from the Data tab and drop it onto the template.

Make sure that the ToolTip “Drop here to replace a cell” appears, and then drop the object onto the template.

11. If appropriate, repeat step 10. to allocate more objects to the table columns, rows and body.

Once you have allocated objects to each part of the table template, you can add more objects to increase the size of the table. Each additional object inserts more columns or rows onto the table.
1. To add another object and create an additional table column or row, drag an object from the Data tab and drop it onto a row or column.
   - If you drop the object onto the left of a column, you create a new column before the existing column.
   - If you drop the object onto the right of a column, you create a new column after the existing column.
   - If you drop the object onto the top edge of a row, you create a new row above the existing row.
   - If you drop the object onto the bottom edge of a row, you create a new row below the existing row.

Make sure that the ToolTip “Drop here to insert a cell” appears before you drop the object.

   ![Structure View Diagram]

   The object appears in a new table cell.

2. If you are working in Structure View, click View Results to display the values in the new table.

   ![Results View Example]
Inserting and formatting tables

Duplicating tables

You can include multiple tables on a single report. Instead of creating each table from scratch, you can duplicate an existing table and paste it onto a blank area of the same report. You can then modify the format or data definition of the duplicate table, or change it to a chart.

Duplicating a table

To duplicate a table:

1. Select a table on a report.
   A gray border appears around the table, when the table is selected.
2. Keep your pointer pressed in and press the Ctrl key.
   Web Intelligence creates a duplicate table on top of the original table.
3. With your pointer and the Ctrl key pressed in, drag the duplicate table to an empty area of the report.

   The duplicate table appears in Structure View until you drop it onto an empty report area

   1. Release the pointer, then release the Ctrl key.
The duplicate table appears on the report.

<table>
<thead>
<tr>
<th>Year</th>
<th>State</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>California</td>
<td>$1,542,321</td>
</tr>
<tr>
<td></td>
<td>Colorado</td>
<td>$490,302</td>
</tr>
<tr>
<td></td>
<td>DC</td>
<td>$952,111</td>
</tr>
<tr>
<td></td>
<td>Florida</td>
<td>$405,909</td>
</tr>
<tr>
<td></td>
<td>Hawaii</td>
<td>$737,914</td>
</tr>
<tr>
<td></td>
<td>Massachusetts</td>
<td>$259,810</td>
</tr>
<tr>
<td></td>
<td>New York</td>
<td>$1,687,936</td>
</tr>
<tr>
<td></td>
<td>Texas</td>
<td>$2,199,077</td>
</tr>
<tr>
<td>2002</td>
<td>State</td>
<td>Sales revenue</td>
</tr>
<tr>
<td></td>
<td>California</td>
<td>$3,792,000</td>
</tr>
<tr>
<td></td>
<td>Colorado</td>
<td>$795,305</td>
</tr>
<tr>
<td></td>
<td>DC</td>
<td>$1,256,168</td>
</tr>
<tr>
<td></td>
<td>Florida</td>
<td>$601,252</td>
</tr>
<tr>
<td></td>
<td>Hawaii</td>
<td>$1,150,650</td>
</tr>
<tr>
<td></td>
<td>Massachusetts</td>
<td>$259,810</td>
</tr>
<tr>
<td></td>
<td>New York</td>
<td>$1,687,936</td>
</tr>
<tr>
<td></td>
<td>Texas</td>
<td>$2,199,077</td>
</tr>
</tbody>
</table>

For information on positioning the duplicate table on the report page, see “Aligning tables, charts, and free-standing cells on reports” on page 371. For information on turning tables to charts, see “Applying a different chart template to a table or chart using Turn To” on page 237.
Applying a different template to existing tables

You can modify the layout of existing tables by applying a different template. Web Intelligence automatically displays the values in the original table in the new layout.

**Example:** Turning a vertical table to a crosstab to compare sales results per state

You work in the California branch of a retail clothing chain, and have been sent a report showing revenue by quarter for the western region.

<table>
<thead>
<tr>
<th>Quarter</th>
<th>State</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q1</td>
<td>California</td>
<td>$729,746</td>
</tr>
<tr>
<td>Q1</td>
<td>Colorado</td>
<td>$304,754</td>
</tr>
<tr>
<td>Q1</td>
<td>Texas</td>
<td>$1,102,481</td>
</tr>
<tr>
<td>Q2</td>
<td>California</td>
<td>$769,396</td>
</tr>
<tr>
<td>Q2</td>
<td>Colorado</td>
<td>$213,663</td>
</tr>
<tr>
<td>Q2</td>
<td>Texas</td>
<td>$1,088,221</td>
</tr>
<tr>
<td>Q3</td>
<td>California</td>
<td>$775,766</td>
</tr>
<tr>
<td>Q3</td>
<td>Colorado</td>
<td>$232,898</td>
</tr>
<tr>
<td>Q3</td>
<td>Texas</td>
<td>$1,032,629</td>
</tr>
<tr>
<td>Q4</td>
<td>California</td>
<td>$939,770</td>
</tr>
<tr>
<td>Q4</td>
<td>Colorado</td>
<td>$192,279</td>
</tr>
<tr>
<td>Q4</td>
<td>Texas</td>
<td>$936,768</td>
</tr>
</tbody>
</table>

The data is presented in a vertical table, which presents the results by quarter for each of the three western states, including California. However, it is not easy to compare the results in a glance. You turn the chart to a crosstab to get a comparative view of the sales results quickly.

<table>
<thead>
<tr>
<th></th>
<th>Q1</th>
<th>Q2</th>
<th>Q3</th>
<th>Q4</th>
</tr>
</thead>
<tbody>
<tr>
<td>California</td>
<td>$729,746</td>
<td>$769,396</td>
<td>$775,766</td>
<td>$939,770</td>
</tr>
<tr>
<td>Colorado</td>
<td>$304,754</td>
<td>$213,663</td>
<td>$232,898</td>
<td>$192,279</td>
</tr>
<tr>
<td>Texas</td>
<td>$1,102,481</td>
<td>$1,088,221</td>
<td>$1,032,629</td>
<td>$936,768</td>
</tr>
</tbody>
</table>
You can change the format of existing tables on reports. Web Intelligence applies the new template to the table values. You can change the template by:

- dragging a different table template onto a table
- using the Turn To dialog box

**Applying a different template to a table using drag and drop**

To apply a different template to a table using drag and drop:

1. Make sure you are working in Report View. The **Edit Report** button is pressed in when you are in Report View and the report tabs of each report in the document are visible.

2. Select the report tab that contains the table you want to modify.

3. Click the **Templates** tab.

If the Templates tab is hidden, click the **Show/Hide Manager** button on the Report toolbar. The **Templates** appear.

4. Click the + next to **Tables**. The table templates are listed.
5. Drag a template from the **Template** tab onto a table. You must drop the template directly on the existing report block.

Web Intelligence applies the new template to the table values.

**Applying a different template to a table using the Turn To dialog box**

To apply a different template to a table using the Turn To dialog box:

1. **Make sure you are working in Report View.**
   The **Edit Report** button is pressed in when you are in Report View and the report tabs of each report in the document are visible.

2. **To select the table you want to reformat, click the top edge of the table.** A gray border appears around the table.

3. **Right-click the report block.**

4. **On the shortcut menu, click Turn To.** The Turn To dialog box appears.
5. On the Tables tab or on one of the Chart tabs, select the table or chart template you want to apply to the table.

6. Click OK.

Note: If you turned a table to a chart, the unicode font is not retained in the chart if the font for the text on the table was unicode, and if unicode is not defined as your default font for charts. You need to format the chart with the unicode font, if this font is available on your computer. If this is not the case, you need to contact your administrator to configure the Web Intelligence server and your computer appropriately.
Adding or removing table rows or columns

You can add new rows or columns to tables by:
• using drag and drop
• using the Insert row or column toolbar menu

Adding rows or columns to tables using drag and drop
To add a row or column to a table using drag and drop:
1. Make sure you are working in Report View. The Edit Report button is pressed in when you are in Report View.
2. Select the report tab that contains the table you want to modify.
3. Click the Data tab.
   If the Data tab is hidden, click the Show/Hide Manager button.
   The objects and variables included in the document are listed.
4. Drag the object you want to add to the table from the Data tab, and drop the object where you want to add it:

<table>
<thead>
<tr>
<th>To add the object into a new...</th>
<th>drag the object onto...</th>
</tr>
</thead>
<tbody>
<tr>
<td>column to the left of an existing column,</td>
<td>the left edge of a column header.</td>
</tr>
<tr>
<td>column to the right of an existing column,</td>
<td>the right edge of a column header.</td>
</tr>
<tr>
<td>row before an existing row,</td>
<td>the top edge of a row header.</td>
</tr>
<tr>
<td>row after an existing row,</td>
<td>the bottom edge of a row header.</td>
</tr>
</tbody>
</table>
Adding or removing table rows or columns

To create a new column that displays values for Lines to the right of the State column, drag the **Lines** object to the right edge of the State column.

The name of the object appears in the new column or row header, and the values appear in the new body cells.

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>State</th>
<th>Lines</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2003</td>
<td>Q1</td>
<td>California</td>
<td>Accessories</td>
<td>623,659</td>
</tr>
<tr>
<td>2003</td>
<td>Q2</td>
<td>California</td>
<td>City Shirts</td>
<td>6,163</td>
</tr>
<tr>
<td>2003</td>
<td>Q3</td>
<td>California</td>
<td>City Trousers</td>
<td>5,269</td>
</tr>
<tr>
<td>2003</td>
<td>Q4</td>
<td>California</td>
<td>Dresses</td>
<td>61,564</td>
</tr>
<tr>
<td>2003</td>
<td>Q1</td>
<td>California</td>
<td>Jackets</td>
<td>33,581</td>
</tr>
<tr>
<td>2003</td>
<td>Q1</td>
<td>California</td>
<td>Leather</td>
<td>31,173</td>
</tr>
<tr>
<td>2003</td>
<td>Q1</td>
<td>California</td>
<td>Outerwear</td>
<td>952</td>
</tr>
</tbody>
</table>

The values for Lines display in a new column.

- **Adding table rows or columns using the Insert row or column toolbar menu**

To add a table row or column using the Insert row or column toolbar menu:

1. Make sure you are working in Report View. The **Edit Report** button is pressed in when you are in Report View.
2. Select the table you want to reformat.

A gray border appears around the table.

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>State</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2003</td>
<td>Q1</td>
<td>California</td>
<td>$75,745</td>
</tr>
<tr>
<td>2003</td>
<td>Q2</td>
<td>California</td>
<td>$783,560</td>
</tr>
<tr>
<td>2003</td>
<td>Q3</td>
<td>California</td>
<td>$775,766</td>
</tr>
<tr>
<td>2003</td>
<td>Q4</td>
<td>California</td>
<td>$697,770</td>
</tr>
</tbody>
</table>
3. Select the column or row next to which you want to insert the new column or row.

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>State</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2003</td>
<td>Q1</td>
<td>California</td>
<td>$720,745</td>
</tr>
<tr>
<td>2003</td>
<td>Q2</td>
<td>California</td>
<td>$795,356</td>
</tr>
<tr>
<td>2003</td>
<td>Q3</td>
<td>California</td>
<td>$775,756</td>
</tr>
<tr>
<td>2003</td>
<td>Q4</td>
<td>California</td>
<td>$697,770</td>
</tr>
</tbody>
</table>

Select the column displaying values for [State], to insert a column before or after it.

The Insert column or row button automatically displays one of the insert options.

1. Click the displayed option.
   For example, **Insert column before**.

   
   ![Insert Column Before]

   Or

   Click the arrow next to the **Insert**... button, and then select the appropriate option from the drop-down menu.

   ![Insert Column Options]

Web Intelligence adds a blank column or row to the table.
You can allocate an object or variable included in the document onto the new table column or row.
2. Drag an object from the Data tab, and drop the object onto the blank column or row.

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>State</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2003</td>
<td>Q1</td>
<td>California</td>
<td>$729,450</td>
</tr>
<tr>
<td>2003</td>
<td>Q2</td>
<td>California</td>
<td>$780,500</td>
</tr>
<tr>
<td>2003</td>
<td>Q3</td>
<td>California</td>
<td>$775,700</td>
</tr>
<tr>
<td>2003</td>
<td>Q4</td>
<td>California</td>
<td>$697,770</td>
</tr>
</tbody>
</table>

If the Data tab is hidden, click the Show/Hide Manager button on the Report toolbar.

Web Intelligence allocates the selected object to the new column or row. The name of the object displays in the column or row header, and the values for the object display on the body cells.

**Removing table rows or columns**

To remove a table row or column:

1. Make sure you are working in Report View. The Edit Report button is pressed in when you are in Report View and the report tabs of each report in the document are visible.

2. Right-click the table column or row you want to remove. The shortcut menu appears.

3. Select Remove Row, Remove Column, or Remove.

<table>
<thead>
<tr>
<th>If you want to remove...</th>
<th>then click...</th>
</tr>
</thead>
<tbody>
<tr>
<td>a row</td>
<td>Remove Row.</td>
</tr>
<tr>
<td>a column</td>
<td>Remove Column.</td>
</tr>
<tr>
<td>an object</td>
<td>Remove</td>
</tr>
</tbody>
</table>

When you remove an object, all the columns or rows that show values for the object are removed from the table.
Moving or swapping table rows or columns

You can re-order the information displayed on tables by:

- moving rows or columns
- swapping rows or columns

**Moving a row or column on a table**

To move a row or column on a table:

1. Make sure you are working in Report View. The **Edit Report** button is pressed in when you are in Report View and the report tabs of each report in the document are visible.
2. Select the table column or row that you want to move.
3. Drag the selected column or row and drop it before or after another column or row on the table.

When you drag a row or column, the column or row header displays next to your pointer.

### Table Example

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>State</th>
<th>Lines</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2002</td>
<td>Q1</td>
<td>California</td>
<td>Accessories</td>
<td>$63,919</td>
</tr>
<tr>
<td>2002</td>
<td>Q1</td>
<td>California</td>
<td>City Shirts</td>
<td>$6,183</td>
</tr>
<tr>
<td>2002</td>
<td>Q1</td>
<td>California</td>
<td>Trousers</td>
<td>$5,250</td>
</tr>
<tr>
<td>2002</td>
<td>Q1</td>
<td>California</td>
<td>Dresses</td>
<td>$51,854</td>
</tr>
<tr>
<td>2003</td>
<td>Q1</td>
<td>California</td>
<td>Jackets</td>
<td>$25,581</td>
</tr>
<tr>
<td>2003</td>
<td>Q1</td>
<td>California</td>
<td>Leather</td>
<td>$3,173</td>
</tr>
<tr>
<td>2003</td>
<td>Q1</td>
<td>California</td>
<td>Outerwear</td>
<td>$982</td>
</tr>
</tbody>
</table>

When you drag a row or column, the column or row header displays next to your pointer.

Web Intelligence inserts the row or column at the new position on the table.

### Table Example

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Lines</th>
<th>State</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2002</td>
<td>Q1</td>
<td>Accessories</td>
<td>California</td>
<td>$63,919</td>
</tr>
<tr>
<td>2002</td>
<td>Q1</td>
<td>City Shirts</td>
<td>California</td>
<td>$6,183</td>
</tr>
<tr>
<td>2002</td>
<td>Q1</td>
<td>Trousers</td>
<td>California</td>
<td>$5,250</td>
</tr>
<tr>
<td>2002</td>
<td>Q1</td>
<td>Dresses</td>
<td>California</td>
<td>$51,854</td>
</tr>
<tr>
<td>2003</td>
<td>Q1</td>
<td>Jackets</td>
<td>California</td>
<td>$25,581</td>
</tr>
<tr>
<td>2003</td>
<td>Q1</td>
<td>Leather</td>
<td>California</td>
<td>$3,173</td>
</tr>
<tr>
<td>2003</td>
<td>Q1</td>
<td>Outerwear</td>
<td>California</td>
<td>$982</td>
</tr>
</tbody>
</table>
Swapping table rows or columns

To swap table rows or columns:

1. Make sure you are working in Report View. The Edit Report button is pressed in when you are in Report View and the report tabs of each report in the document are visible.

2. Select one of the rows or columns you want to swap.

3. Drag the selected column or row onto the column or row with which you want to make the swap.

For example, to swap the Lines and State columns, drag the Lines column onto the State column.

Web Intelligence swaps the two columns or rows.
Replacing table columns and rows

You can replace table columns and rows with different data.

► Replacing a table column or row

To replace a table column or row:

1. Make sure you are working in Report View. The Edit Report button is pressed in when you are in Report View.
2. Select the report tab that contains the table you want to modify.
3. Click the Data tab.

If the Data tab is hidden, click the Show/Hide Manager button on the Report toolbar.

The objects and variables included in the document are listed on the Data tab.

4. Drag the object you want to add to the table from the Data tab, and then drop the object onto the row, column, or body you want to replace.

For example, to replace the values for quarter by values for state, drag and drop the [State] object onto the table column headed “Quarter.”
The values for the new object display on the table.

<table>
<thead>
<tr>
<th>Year</th>
<th>State</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>California</td>
<td>$1,704,211</td>
</tr>
<tr>
<td>2001</td>
<td>Colorado</td>
<td>$445,302</td>
</tr>
<tr>
<td>2001</td>
<td>DC</td>
<td>$693,211</td>
</tr>
<tr>
<td>2001</td>
<td>Florida</td>
<td>$405,985</td>
</tr>
<tr>
<td>2001</td>
<td>Hawaii</td>
<td>$789,234</td>
</tr>
<tr>
<td>2001</td>
<td>Massachusetts</td>
<td>$230,819</td>
</tr>
<tr>
<td>2001</td>
<td>New York</td>
<td>$1,667,896</td>
</tr>
<tr>
<td>2002</td>
<td>Texas</td>
<td>$2,189,677</td>
</tr>
<tr>
<td>2002</td>
<td>California</td>
<td>$2,792,690</td>
</tr>
<tr>
<td>2002</td>
<td>Colorado</td>
<td>$769,390</td>
</tr>
<tr>
<td>2002</td>
<td>DC</td>
<td>$2,315,138</td>
</tr>
<tr>
<td>2002</td>
<td>Florida</td>
<td>$661,258</td>
</tr>
<tr>
<td>2002</td>
<td>Hawaii</td>
<td>$1,190,859</td>
</tr>
<tr>
<td>2002</td>
<td>Massachusetts</td>
<td>$967,719</td>
</tr>
<tr>
<td>2002</td>
<td>New York</td>
<td>$2,785,561</td>
</tr>
<tr>
<td>2002</td>
<td>Texas</td>
<td>$3,732,689</td>
</tr>
<tr>
<td>2003</td>
<td>California</td>
<td>$2,992,879</td>
</tr>
<tr>
<td>2003</td>
<td>Colorado</td>
<td>$943,964</td>
</tr>
<tr>
<td>2003</td>
<td>DC</td>
<td>$1,263,961</td>
</tr>
<tr>
<td>2003</td>
<td>Florida</td>
<td>$511,924</td>
</tr>
<tr>
<td>2003</td>
<td>Hawaii</td>
<td>$1,134,985</td>
</tr>
<tr>
<td>2003</td>
<td>Massachusetts</td>
<td>$807,159</td>
</tr>
<tr>
<td>2003</td>
<td>New York</td>
<td>$3,151,022</td>
</tr>
<tr>
<td>2003</td>
<td>Texas</td>
<td>$4,185,048</td>
</tr>
</tbody>
</table>
Inserting and formatting tables

Modifying tables to create crosstabs

You can reformat vertical and horizontal tables as crosstabs by applying the crosstab template or using the Turn To dialog box as explained in “Applying a different template to existing tables” on page 178. You can also change tables to crosstabs using drag-and-drop to insert objects or variables onto a second table axis to form the crosstab. You can

- add an object onto a table
- move a table column or row

**Note:** If the document doesn’t include the data you want to add to the crosstab, you can edit the query. For more information, see “You can search for classes and objects in the tree by selecting an item in the tree, then typing a letter. You can refine the search by typing further letters. For example, if you type “y” then “e”, Web Intelligence first searches for objects beginning with “T, then “searches for objects beginning with “ye”,” on page 44.

**Creating a crosstab by adding an object to a vertical or horizontal table**

To create a crosstab by adding an object to a vertical or horizontal table:

1. Make sure you are working in Report View. The **Edit Report** button is pressed in when you are in Report View and the report tabs of each report in the document are visible.

2. Drag an object from the **Data** tab onto the top edge of the table or the left side of the table where you want to create the new axis and form the crosstab.

   ![Image of crosstab creation](image)

   If the Data tab is hidden, click the **Show/Hide Manager** button on the Report toolbar.
3. When the ToolTip “Drop here to create a crosstab” appears, drop the selected object onto the report.

Web Intelligence creates a second axis to form a crosstab and inserts the object on the new axis.

<table>
<thead>
<tr>
<th>Year</th>
<th>Q1</th>
<th>Q2</th>
<th>Q3</th>
<th>Q4</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>$2,880,969</td>
<td>$2,278,863</td>
<td>$1,367,841</td>
<td>$1,788,511</td>
</tr>
<tr>
<td>2002</td>
<td>$3,326,172</td>
<td>$2,840,561</td>
<td>$2,579,303</td>
<td>$4,105,216</td>
</tr>
<tr>
<td>2003</td>
<td>$3,742,989</td>
<td>$4,016,717</td>
<td>$3,953,305</td>
<td>$3,368,765</td>
</tr>
</tbody>
</table>
Creating a crosstab by moving a table column or row
To create a crosstab by moving a table column or row:
1. Make sure you are working in Report View. The **Edit Report** button is pressed in when you are in Report View and the report tabs of each report in the document are visible.
2. Select the table column or row you want to move to create the crosstab.
3. Drag the selected column or row onto the top edge of the table or the left side of the table where you want to create the new axis and form the crosstab.
4. Drop the column or row onto the header. Web Intelligence creates a second axis to form a crosstab, and displays the data of the column or row you moved on the new axis.

For example, you move the Quarter column above the Sales column to create a crosstab that displays Year values down the left axis, Quarter values across the top axis, and Sales revenue values in the body.
Clearing cells and removing tables

You can clear cell contents or remove rows and columns from tables. The following section tells you how to:

• clear cell contents from tables
• remove tables

For information on removing specific rows or columns from tables, see “Removing table rows or columns” on page 185.

Clearing cell contents from tables

You can clear cell contents and then use the empty cells to display images, hyperlinks, formulas, or text you type.

You can clear the following types of cell in a table:

• header cells – you can clear each header cell separately
• footer cells – you can clear each footer cell separately
• related body cells – when you clear one body cell, you automatically clear all of the body cells in the same column or row of the table

The following illustration shows the cells you can select.

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2002</td>
<td>Q1</td>
<td>$3,526,172</td>
</tr>
<tr>
<td>2002</td>
<td>Q2</td>
<td>$2,640,651</td>
</tr>
<tr>
<td>2002</td>
<td>Q3</td>
<td>$2,679,303</td>
</tr>
<tr>
<td>2002</td>
<td>Q4</td>
<td>$4,168,120</td>
</tr>
<tr>
<td>2003</td>
<td>Q1</td>
<td>$3,742,989</td>
</tr>
<tr>
<td>2003</td>
<td>Q2</td>
<td>$4,006,718</td>
</tr>
<tr>
<td>2003</td>
<td>Q3</td>
<td>$3,963,395</td>
</tr>
<tr>
<td>2003</td>
<td>Q4</td>
<td>$3,566,041</td>
</tr>
<tr>
<td></td>
<td><strong>Sum:</strong></td>
<td><strong>$28,291,389</strong></td>
</tr>
</tbody>
</table>
Clearing cell contents from a table

To clear cell contents from a table:

1. Make sure you are working in Report View.
   The Edit Report button is pressed in when you are in Report View and the report tabs of each report in the document are visible.

2. To select the cell you want to clear, click the cell.
   A the cell borders are highlighted.

3. Right-click the selected cell.
   The shortcut menu appears.

4. Click Clear Cell Contents.
   Or
   Click the Delete key.
   Web Intelligence clears the contents from the selected cell(s).
Removing tables from reports

You can remove tables from a report. You can remove a table:

• using the shortcut menu
• using drag-and-drop
• using the Delete key

Note: You cannot select and remove multiple tables at one time.

► Removing a table using the shortcut menu
To remove a table using the shortcut menu:

1. Make sure you are working in Report View. The Edit Report button is pressed in when you are in Report View and the report tabs of each report in the document are visible.

2. To select the table you want to remove, click the top edge of the table. A gray border appears around the table.

3. Right-click the selected table. The shortcut menu appears.

4. Click Remove.

► Removing a table using drag-and-drop
To remove a table using drag-and-drop:

1. Make sure you are working in Report View. The Edit Report button is pressed in when you are in Report View and the report tabs of each report in the document are visible.
2. Select the table you want to remove and drag it onto the Report Manager. If the Report manager is hidden, click the Show/Hide Manager button on the Report toolbar. Web Intelligence removes the table from the report.

▶ Removing a table using the Delete key
To remove a table using the Delete key:

1. Make sure you are working in Report View. The Edit Report button is pressed in when you are in Report View and the report tabs of each report in the document are visible.

2. Select the table you want to remove.
   A gray border appears around the table.

3. Press the Delete key.
   Web Intelligence removes the table from the report.
Formatting tables and table cells

You can format tables and cells on tables so that the look and feel of your documents reflects your corporate standard.

You can set the following formatting options:

- table or cell background – select colors, skins, and images
- table or cell borders – select line styles and colors
- cell text – define fonts, font sizes, and font styles
- cell size – specify the height and width of cells
- spacing within and between table cells – padding and spacing

**Note:** The colors available in Web Intelligence are the colors set up for your desktop.

Formatting table or cell backgrounds

By default, tables have the standard Web Intelligence format.

<table>
<thead>
<tr>
<th>Year</th>
<th>State</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2003</td>
<td>California</td>
<td>$2,992,670</td>
</tr>
<tr>
<td>2003</td>
<td>Colorado</td>
<td>$843,564</td>
</tr>
<tr>
<td>2003</td>
<td>DC</td>
<td>$1,053,561</td>
</tr>
<tr>
<td>2003</td>
<td>Florida</td>
<td>$811,924</td>
</tr>
<tr>
<td>2003</td>
<td>Illinois</td>
<td>$1,134,086</td>
</tr>
<tr>
<td>2003</td>
<td>Massachusetts</td>
<td>$887,169</td>
</tr>
<tr>
<td>2003</td>
<td>New York</td>
<td>$3,151,022</td>
</tr>
<tr>
<td>2003</td>
<td>Texas</td>
<td>$4,165,096</td>
</tr>
</tbody>
</table>

You can format table and cell backgrounds as follows:

- select a color – to highlight information or use corporate colors
- apply a color to alternate table rows – to make long tables easier to read
- select a skin – to add a texture or motif
- insert an image – to add icons, logos, or photos
Selecting a background color

To select a background color:

1. Make sure you are working in Report View. The Edit Report button is pressed in when you are in Report View and the report tabs of each report in the document are visible.

2. Select the table or table cell for which you want to format a background.

3. Right-click the table, then select Edit Format from the shortcut menu. The Properties tab displays the table or cell formatting options depending on which element you selected. (For more information on the Properties tab, see “Java Report Panel interface tour” on page 33.)

4. Select the drop-down arrow next to Appearance > Background color. A list of available colors appear.
5. Click the color you want to apply to the selected table or table cell.
   Or
   Click **Custom**, and then create a custom color, using the **Swatches**, **HSB** (Hue, Saturation, Brightness), or **RGB** (Red, Green, Blue) tab, and click **OK**.
   If you know the RGB hexadecimal color reference, you can type the reference into the combo boxes next to the + and - buttons on the **RGB** tab.
   Web Intelligence applies the background color to the selected table or cell.

   ▶ **Defining alternate row and column colors for a table**
   To define alternate row and column colors for a table:
   1. Make sure you are working in Report View.
      The **Edit Report** button is pressed in when you are in Report View and the report tabs of each report in the document are visible.
   2. Select the table for which you want to format alternate row colors.
      When the table is selected, a gray border appears around the table.
   3. Right-click the table, then select **Edit Format** from the shortcut menu.
      The **Properties** tab displays the table formatting options. (For more information on the Properties tab, see “Java Report Panel interface tour” on page 33.)
4. Open the **Appearance > Alternate color** property sub-group.

5. Set the frequency for the alternate row color in the combo box next to **Frequency** by clicking the + or - sign, or by entering a number.

6. Click the arrow next to **Color**.

7. Select a color from the list of colors.
   
   Or
   
   Click **Custom**, and then create a custom color, using the **Swatches**, **HSB** (Hue, Saturation, Brightness), or **RGB** (Red, Green, Blue) tab, and click **OK**.

   If you know the RGB hexadecimal color reference, you can type the reference into the combo boxes next to the + and - buttons on the **RGB** tab.
Inserting and formatting tables

Web Intelligence applies the alternate row color to the table.

<table>
<thead>
<tr>
<th>State</th>
<th>Lines</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>California</td>
<td>Accessories</td>
<td>$1,089,000</td>
</tr>
<tr>
<td>California</td>
<td>City Skirts</td>
<td>$74,534</td>
</tr>
<tr>
<td>California</td>
<td>City Trousers</td>
<td>$493,164</td>
</tr>
<tr>
<td>California</td>
<td>Dresses</td>
<td>$555,253</td>
</tr>
<tr>
<td>California</td>
<td>Jackets</td>
<td>$152,836</td>
</tr>
<tr>
<td>California</td>
<td>Leather</td>
<td>$73,108</td>
</tr>
<tr>
<td>California</td>
<td>Outerwear</td>
<td>$200,998</td>
</tr>
<tr>
<td>California</td>
<td>Overcoats</td>
<td>$341,304</td>
</tr>
<tr>
<td>California</td>
<td>Shirt Waist</td>
<td>$324,650</td>
</tr>
<tr>
<td>California</td>
<td>Sweaters</td>
<td>$502,868</td>
</tr>
<tr>
<td>California</td>
<td>Sweat-T-Shirts</td>
<td>$2,700,280</td>
</tr>
<tr>
<td>California</td>
<td>Trousers</td>
<td>$339,494</td>
</tr>
<tr>
<td>Colorado</td>
<td>Accessories</td>
<td>$895,624</td>
</tr>
<tr>
<td>Colorado</td>
<td>City Skirts</td>
<td>$19,557</td>
</tr>
<tr>
<td>Colorado</td>
<td>City Trousers</td>
<td>$12,977</td>
</tr>
<tr>
<td>Colorado</td>
<td>Dresses</td>
<td>$82,248</td>
</tr>
<tr>
<td>Colorado</td>
<td>Jackets</td>
<td>$37,377</td>
</tr>
<tr>
<td>Colorado</td>
<td>Leather</td>
<td>$14,576</td>
</tr>
<tr>
<td>Colorado</td>
<td>Outerwear</td>
<td>$52,644</td>
</tr>
</tbody>
</table>

In this example, the row color frequency is set to 2.

Selecting and removing skins

To select or remove a skin:

1. Make sure you are working in Report View. The Edit Report button is pressed in when you are in Report View and the report tabs of each report in the document are visible.
2. Select the table or table cell for which you want to format a background.
3. Right-click the table, then select Edit Format from the shortcut menu. The Properties tab displays the table or cell formatting options depending on which element you selected. (For more information on the Properties tab, see “Java Report Panel interface tour” on page 33.)
4. Click the ... button next to Background image in the Appearance property sub-group.
5. Select Skin in the Background Image dialog box.
6. Select the skin from the drop-down list.
7. Select None to remove the skin.
Inserting images
To insert an image:
1. Make sure you are working in Report View. The Edit Report button is pressed in when you are in Report View and the report tabs of each report in the document are visible.
2. Select the table or table cell where you want to insert an image. The Properties tab displays the table formatting options. (For more information on the Properties tab, see “Java Report Panel interface tour” on page 33.)
3. Click the ... button next to Background image in the Appearance property sub-group.
4. Click Custom in the Background Image dialog box.
5. Type the file name in the Image (URL) box.
   (Web Intelligence inserts the HTML tag boimg:/// before the file name and links to the image file on a corporate web server.)
   Or
   Type the web server URL followed by the file name of the image file. (The URL and file name must not include spaces.)
   For full information on specifying URLs and file paths see “How you display images in reports” on page 311.

Formatting borders
You can change border color and thickness one side at a time, or all sides at once.

Formatting borders
To format borders:
1. Make sure you are working in Report View. The Edit Report button is pressed in when you are in Report View and the report tabs of each report in the document are visible.
2. Select the table or table cell for which you want to format the borders.
3. Right-click the table, then select Edit Format from the shortcut menu. The Properties tab displays the table or cell formatting options depending on which element you selected. (For more information on the Properties tab, see “Java Report Panel interface tour” on page 33.)
4. Click the ... button next the the Borders property.
5. Use the buttons in the Border Editor dialog box to set the border style. 

**Note:** You can also set the borders of header cells, body cells and footer cells in the table properties. To do so, click the ... button next to the Borders property in the **Header cells**, **Body cells** and **Footer cells** property sub-groups.

### Formatting values on table cells

You can personalize how values display on tables by defining the formatting properties for the text:

- font style
- font size
- font color
- text alignment

#### Formatting text in table cells

To format text in table cells:

1. Make sure you are working in Report View. The **Edit Report** button is pressed in when you are in Report View and the report tabs of each report in the document are visible.

2. Select the table whose cells you want to format.

3. Right-click the table, then select **Edit Format** from the shortcut menu. The **Properties** tab displays the table formatting options. (For more information on the Properties tab, see “Java Report Panel interface tour” on page 33.)

4. Click the ... button next to the **Text format in** the **Appearance > Header cells/Body cells/Footer cells** property sub-group.

5. Format the text in the **Format Text** dialog box. 

**Note:** You can also format cell text by selecting the cell then setting the **Appearance > Text Format** property in the **Properties** tab.

You can define the format properties for numbers, date/time, currency and other data type by selecting from predefined formats or by creating your own custom formats. For full information, see “Formatting numbers and dates” on page 267.
Sizing cells

You can define the height and width of cells by:

• using drag and drop
• specifying the size of cells on the Properties tab

Note: If you want to hide cell contents on reports, you can set the cell width to 0.1 cm so that the cell width can be modified to display the cell contents later.

Note: When you upgrade documents created with an earlier version of the product, Web Intelligence does not display cells whose width was originally set to 0.0 cm. (The cell contents remain hidden and the cell width cannot be modified.)

► Defining the width and height of cells using drag and drop

To define the width and height of cells using drag and drop:

1. To change the cell height, select the bottom border of the cell you want to resize.
   Or
   To change the cell width, select the right border of the cell you want to resize.
   An arrow appears on the border.
2. To change the cell height, drag the border up or down.
   Or
   To change the cell width, drag the border to the left or right.

Web Intelligence modifies the size of all the cells on the same column or row as the selected cell.

If you want to hide cell contents on reports, you can set the cell width to 0.1 cm so that the cell width can be modified to display the cell contents later.
Setting AutoFit cell size by double-clicking the cell
To set AutoFit cell size by double-clicking the cell:
• To set AutoFit cell width, double-click the right border of the cell.
  Or
  To set AutoFit cell height, double-click the bottom border of the cell.
AutoFit retains the current cell size as the minimum size and enlarges the cell size, if the string or image that the cell contains is larger than the minimum size specified.

Setting cell height and cell width using the Properties tab
To set cell height and cell width using the Properties tab:
1. Make sure you are in Report View.
   The Edit Report button is pressed in when you are in Report View.
2. Select the table cell you want to format, right-click and select Edit Format from the menu.
   The Properties tab displays the cell formatting options. (For more information on the Properties tab, see “Java Report Panel interface tour” on page 33.)
3. Set the Width and Height properties in the Display properties sub-group.
4. If you want to set the cell to autofit, select Autofit Width and/or Autofit Height.
   Note: Some Web Intelligence functions are incompatible with AutoFit cells. If you place any of these functions in an AutoFit cell, Web Intelligence returns the #RECURSIVE error message as the function output. For more information, see “#RECURSIVE” on page 467.
   Tip: Documents that contain tables with the cell size set to AutoFit, take longer to display in the Java Report Panel or InfoView than documents where tables contain cells with a fixed cell width and cell height. We recommend that for large documents, you specify a fixed sized for cell width and cell height for tables.
Setting properties for table headers and footers

By default, Web Intelligence tables display:

- a header on each column or row
- no table footers

The header cells display the name of the objects included in the table. Web Intelligence automatically adds table footers, if you add a predefined calculation to a table to display the results of the calculation. You can also manually add table headers and footers.

You can set the following properties for table headers and footers:

- show or hide headers and footers
- repeat the headers or footers on every report page
- add headers to crosstabs to display the names of the objects for which the crosstab displays values
- add table headers or footers

**Showing or hiding table headers and footers**

To show or hide a table header or footer:

1. Make sure you are working in Report View.
   - The **Edit Report** button is pressed in when you are in Report View and the report tabs of each report in the document are visible.
2. Select the table, right-click and select **Edit Format** from the menu. The **Properties** tab displays the table formatting options. (For more information on the Properties tab, see “Java Report Panel interface tour” on page 33.)

3. Select **Show table headers** in the **Display** properties sub-group to display table headers.

4. Select **Show table footers** in the **Display** properties sub-group to display table footers.

Web Intelligence displays or hides the table headers or footers. You can set the page layout of reports so that the table headers and/or footers of tables are repeated on each report page. This is useful for long tables that span several pages. See “Repeating table headers or footers on report pages” on page 209.

► **Displaying object names in headers on crosstabs**

To display object names in headers on crosstabs:

1. Select the crosstab, right-click and select **Edit Format** on the menu. The **Properties** tab displays the crosstab formatting options. (For more information on the **Properties** tab, see “Java Report Panel interface tour” on page 33.)

2. Click **Display > Show object name** to display the object names in additional headers on the crosstab.
Setting page layout for tables

You can set the page layout for each page in a Web Intelligence report. You can do the following:

• start each table on a new report page
• avoid page breaks on a table
• repeat table headers or footers on report pages

Starting tables on a new report page
To start each table in your report on a new page:

1. Select the table, right-click and select Edit Format on the menu.
   The Properties tab displays the crosstab formatting options. (For more information on the Properties tab, see “Java Report Panel interface tour” on page 33.)


Avoiding page breaks in tables
To set Web Intelligence to avoid page breaks in tables:

1. Select the table, right-click and select Edit Format on the menu.
   The Properties tab displays the crosstab formatting options. (For more information on the Properties tab, see “Java Report Panel interface tour” on page 33.)

2. Select Position > Avoid page breaks in table.
   Tip: You can include multiple tables and charts on a single report, and then align them neatly on a report using the relative alignment feature. This ensures there is overlap between the different blocks of information on a report, if changes to report values increase the size of the tables or charts. See “Positioning charts in relation to other charts or tables” on page 240.
Inserting and formatting tables

Selecting display properties for empty table cells

Repeating table headers or footers on report pages

To repeat table headers or footers on report pages:
1. Select the table, right-click and select Edit Format on the menu.
   The Properties tab displays the crosstab formatting options. (For more information on the Properties tab, see "Java Report Panel interface tour" on page 33.)
2. Select Position > Repeat header on every page to repeat the header on every page.
3. Select Position > Report footer on every page to repeat the footer on every page.

Selecting display properties for empty table cells

Sometimes tables or specific rows and columns display no values. For example, if a sales of a specific product are discontinued, table rows or columns that normally show results for that product appear empty. By default, Web Intelligence displays such empty rows, columns, or tables. You can choose to display or hide empty tables, rows or columns.

Showing or hiding empty tables, rows, columns

To show or hide empty tables, rows, or columns:
1. Select the table, right-click and select Edit Format on the menu.
   The Properties tab displays the table formatting options. (For more information on the Properties tab, see "Java Report Panel interface tour" on page 33.)
2. Select the appropriate check box:

<table>
<thead>
<tr>
<th>If you want to show empty...</th>
<th>then select...</th>
</tr>
</thead>
<tbody>
<tr>
<td>tables,</td>
<td>Show table when empty</td>
</tr>
<tr>
<td>rows or columns in a vertical table,</td>
<td>Show empty rows</td>
</tr>
<tr>
<td>rows where some of the dimensions are empty</td>
<td>Show rows with empty dimension values</td>
</tr>
<tr>
<td>rows or columns in a horizontal table or crosstab,</td>
<td>Show empty columns</td>
</tr>
</tbody>
</table>

When you or other users view the report in Results View, the tables, columns, and rows appear or not as you specified.

Avoiding duplicate row aggregation

Web Intelligence automatically aggregates any rows that display the same set of dimensions.

If you select the **Avoid duplicate row aggregation** option, each duplicate value is displayed in a separate table column or row.

**Avoiding duplicate row aggregation**

To avoid duplicate row aggregation:

1. Select the table, right-click and select **Edit Format** from the menu.

   The Properties tab displays the table formatting options. (For more information on the Properties tab, see "Java Report Panel interface tour" on page 33.)

2. Select **Display > Avoid duplicate row aggregation**.

Copying tables

You can copy and paste tables within a report or into external applications such as Microsoft Word and Excel.

**Note:** You cannot copy tables from one instance of Web Intelligence to another.

**To copy a table**

1. Select the table, right-click and select **Copy** on the menu.

   Web Intelligence copies the table to the clipboard.
2. To paste the table to another part of the report, right-click where you want the table to appear and click **Paste** on the menu.

3. To paste the table into another application, paste the contents of the clipboard from within the other application.
   
The table appears as a picture in the open document if pasted to another application.
   
   **Note:** You can also copy a table into another application by dragging and dropping the table directly into the open document in the target application.

You can copy the data in a table as plain text into another application. For example, if you copy a table as text into Microsoft Excel, Web Intelligence copies the text in each table cell to a cell in the Excel worksheet.

**Note:** Web Intelligence copies the text to the clipboard as tab-separated text.

- **To copy and paste a table to another application as text**
  1. Select the table, right-click and select **Copy as text** on the menu.
  2. Paste the contents of the clipboard into the target application.

   **Note:** If you choose **Copy as text**, then paste the table into the current Web Intelligence report, the table appears as a normal Web Intelligence table.
Inserting and formatting tables

Copying tables
Displaying information in free-standing cells
Overview

This chapter explains how to insert and format free-standing cells in a Web Intelligence document using the Java Report Panel.

This chapter provides information on:
- what free-standing cells are
- inserting text, images, and formulas
- inserting information about report data
- inserting page number information
- formatting free-standing cells
- copying free-standing cells
**What are free-standing cells?**

Free-standing cells are single cells that stand alone in a report. You can use free-standing cells to display information that adds meaning to your report, such as:

- text comments — type messages or questions or to add titles
- images — display logos, icons, or photographs on reports
- formulas or calculations — add custom formulas or calculations
- the last refresh date — display the date when the document results were refreshed with the most recent data from the database
- the DrillFilter function — display the names of the objects by which the data on a drilled report is filtered
- page numbers — display the page number of each report page

**Example: Including additional information on a report using free-standing cells**

You are the line manager for the City clothing line at the eFashion company. City line margins are negative in several regions. You send a document to regional managers that includes sales results and margins for City lines, and ask managers to advise if the sales of City clothing lines should be discontinued.

You include free-standing cells that display the date the results were last refreshed with the data on the database and a comment from you asking the regional managers for their advice.
Inserting text, images, and formulas

You can insert blank cells on reports and then insert text, an image, a hyperlink, or a formula into the blank cell. You can position, size, and format each blank cell independently without affecting the other cells on the report.

Inserting a blank cell on a report

To insert a blank cell on a report:

1. Make sure you are in Report View.
   The Edit Report button is pressed in when you are in Report View.
2. Click the Templates tab.
   The Template categories appear.
3. Click the + sign next to Free-Standing Cells.
4. Select the Blank Cell template, and then drag the template onto an empty area of the report.
   The blank cell appears on the report.
5. Right-click the cell, then select Edit Format from the shortcut menu to display the Properties tab.
   The Properties tab lists the properties (arranged into groups) relevant to free-standing cells.
6. Do one of the following:

<table>
<thead>
<tr>
<th>If you want to display...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text – a title or comment,</td>
<td>* type the text into the <strong>General &gt; Text</strong> property.</td>
</tr>
</tbody>
</table>
| An image,                | * type the file name or the URL and file name into the **General > Text** property;  
(No**t**: you must not use spaces in the URL or file name)  
* select **Image (URL)** from the drop-down list next to the **Display > Read cell contents as** property.  
For full information on specifying URLs and file paths see “How you display images in reports” on page 311. |
| HTML code,               | * type the HTML string into the **General > Text** box;  
* select **HTML** from the drop-down list next to the **Display > Read cell contents as** property. |
| A hyperlink,             | * type the URL into the **General > Text** property;  
For full information on specifying URLs, see “Including hyperlinks in reports” on page 377. |
| A formula,               | * click the **Show/Hide Formula Toolbar** button on the Report View toolbar;  
* type the formula into the toolbar  
For full information on formula syntax and specifying the aggregation context for formulas, see “Defining the calculation context” on page 412 and “Specifying input and output contexts” on page 421. |

Web Intelligence displays the information you specified in the new cell.
Inserting information about the report data

You can insert special cells to show the following information about report data:

- **Last refresh date** – the date that the results displayed in the report were updated with the data on the database.
  
  For more information about setting refresh options, see page 31.

- **Drill filters** – the names of the objects that filter the results displayed on a drilled report.
  
  For more information about working with filters in drill mode, see page 507.

You can also add a blank cell next to the Last Refresh Date or Drill Filter cell to clearly indicate the type of information these cells display.

**Example:** What filters are filtering the results displayed in a drilled report?

In this example, you drill a report to analyze the reasons behind the results for line sales in Q1. To do this, you drill down on Q1 and then drill down again on Accessories to take a look at a breakdown of sales results for each accessories category. When you drill, the Drill toolbar displays filters for Accessories and Q1, to show how the results displayed in the drilled report are filtered.

You want to distribute a printout of the report at a meeting. However, the Drill toolbar will not be printed as part of the report and you would like readers of the printout to understand how the results are filtered.

To let your colleagues know what the values in the report are limited to results for Q1 and the Accessories line you include a free-standing cell with a predefined formula that displays the filters generated during drill.

When you generate the report to a PDF format file for printing, the drill filter information appears in the free-standing cell.

The following section tells you how to insert:

- the Last Refresh Date or Drill Filter free-standing cell
- text in front of the free-standing cell to label the cell contents

**Inserting the Last Refresh Date or Drill Filter cell**

To insert the refresh date of drill filter cell:

1. Make sure you are in Report View.

   The Edit Report button is pressed in when you are in Report View.
2. Click the **Templates** tab.
   The Template tab is brought to the foreground.

3. Click the + sign next to **Free-Standing Cells**.

4. Click the + sign next to **Formula and Text** cells.

5. Select the **Drill Filters** or the **Last Refresh Date** template, then drag the template onto a blank area of the report.
   The Drill Filter cell remains blank until you start Drill mode and perform a drill action on the drillable report. The Last Refresh Date cell displays the date the document was last refreshed immediately.

   ▶ **Adding a text label before a free-standing cell**
   To add a text label before a free-standing cell:

1. In Report View, click the **Templates** tab.
   The Template categories appear.

2. Click the + sign next to **Free-Standing Cells**.

3. Select the **Blank Cell** template, and then drag the template onto the report to the left of the Drill Filters cell or the Last Refresh Date cell.
   (For information on inserting Drill Filters or Last Refresh Date cells, see "Inserting the Last Refresh Date or Drill Filter cell" on page 218.)
   The blank cell appears on the report.

4. Right-click the cell, then select **Edit Format** from the shortcut menu to display the Properties tab.

5. Type the text label you want to appear in the **General > Text** property.
   For example, to label a Drill Filter cell, type: **Filters applied during drill:**
   or, to label a Last Refresh Date cell, type: **Report information last updated:**
   The text appears in the new cell. By default, the size of the characters and the cell size may not display the entire string.
   You can resize the cell.

6. Drag the right cell border to the right and/or drag the bottom cell border down.
   Or
   Modify the cell size using the + and - buttons next to the **Display > Width** and **Display > Height** properties on the Properties tab.
   You can modify the size and format of the text, and set the **Wrap text** option.
7. Click the ... button next to the **Text Format** property group to display the **Format Text** dialog box.

8. Set the text format and the **Wrap text** property in the **Format Text** dialog box.

   For more information about each option, see “Formatting tables and table cells” on page 197.

   You can position the cell so that the label is aligned with the Drill Filter or Last Refresh Date cell.

9. To modify the position of the cell on the report, type measurements into the **Position > Left edge** and **Position > Top edge** properties.

### Inserting page number information

You can insert the following special cells to display page information on a report:

- **Page Number**
- **Page Number/Total Pages**
- **Total Number of Pages**

**Page Number**

When you insert the Page Number cell, Web Intelligence displays the page number of the report page.

**Page Number/Total Pages**

The Page Number/Total Pages cell displays the page number of the report page followed by the total number of pages in the document.

**Total Number of Pages**

The Total Number of Pages cell displays the total number of pages in the document.

**Note:** The page information cells use the `Page()` and `NumberOfPages()` formulas, which are incompatible with Autofit cells. If the **Autofit Height** or **Autofit Width** properties of the free cell are set, the page number cell returns the `#RECURSIVE` error. For more information, see “#RECURSIVE” on page 467.

If you insert the Page Number/TotalNumberOfPages cell or the TotalNumberOfPages cell into a large report with many pages, Web Intelligence takes longer to return the data to the report.
You can insert a page number cell in any part of a Web Intelligence report. You can also type text into the special cell before or after the page number field to label the page number information.

The following section of this guide tells you how to insert:

- page number cells
- text before or after the special field in page number cells

**Inserting page number cells**

To insert a page number cell in your report:

1. Make sure you are in Report View.
2. Click the **Templates** tab.
   - Click the + sign next to **Free-Standing Cells**.
3. Click the + sign next to **Page Number** cells.
4. The next step depends on where you want to position the page numbers:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>position page numbers anywhere on the report except the page header or page footer,</td>
<td>drag the page number cell template of your choice, onto an empty area of the report.</td>
</tr>
</tbody>
</table>
| position the page numbers in the page header or footer, | • click the View Page Layout button  
• click the View Structure button  
• select the page header or page footer on the report  
• drag the page number cell template from the Template onto the header or footer cell |

See page 220 in this section for full information about each template.

If you are working in Results View, the page numbers appear in the cell. If you are working in Structure View, click the **View Results** button to display the page number information in the cell.
Displaying information in free-standing cells

Inserting page number information

Adding text to page number cells

You can edit the text surrounding the page numbers in each Page Number cell. For example, you can add text to the Page Number cell so that the page number includes the label “Page:”.

► Editing a Page Number cell

To edit a Page Number cell:

1. Make sure you are in Report View.

2. Right-click the cell and select Edit Format from the menu to display the Properties tab.

Web Intelligence builds special fields by using formula language functions in the General > Text property. For example, the Page Number field appears as =Page().

3. In the Text box, type the text you want to display before the Page() formula and join it to the Page() formula using the + operator. For example: ="Page number: " + Page().

Web Intelligence displays the page number cell with the text you typed.
Formatting free-standing cells

You can format any free-standing cells that appear in your report.

You can set the following properties:

- text format
- background
- borders
- page position

**Setting formatting options for free-standing cells**

To set the formatting options for free-standing cells:

1. Make sure you are in Report View.
2. Right-click the cell and select Edit Format to display the Properties tab.
3. Set the cell formatting properties in the Properties tab.

Web Intelligence applies the options to the selected cell. For more information about formatting cells, see “Formatting tables and table cells” on page 197.
Copy free-standing cells

You can copy and paste free-standing cells within a report or into external applications such as Microsoft Word and Excel.

**Note:** You cannot copy free-standing cells from one instance of Web Intelligence to another.

- **To copy a free-standing cell**
  1. Select the free-standing cell, right-click and select **Copy** on the menu.
    Web Intelligence copies the free-standing cell to the clipboard.
  2. To paste the free-standing cell to another part of the report, right-click where you want the free-standing cell to appear and click **Paste** on the menu.
  3. To paste the free-standing cell into another application, paste the contents of the clipboard from within the application.
    The free-standing cell appears as a picture in the open document if pasted to another application.
    **Note:** You can also copy a free-standing cell into another application by dragging and dropping the free-standing cell directly into the open document in the target application.

You can copy the data in a free-standing cell as plain text into another application. For example, if you copy a free-standing cell as text into Microsoft Excel, Web Intelligence copies the text in the free-standing cell to a cell in the Excel worksheet.

- **To copy and paste a free-standing cell to another application as text**
  1. Select the free-standing cell, right-click and select **Copy as text** on the menu.
  2. Paste the contents of the clipboard into the target application.

If you choose **Copy as text**, then paste the free-standing cell into the current Web Intelligence report, the free-standing cell appears as a normal Web Intelligence free-standing cell.
Inserting and formatting charts
Overview

This chapter explains how to create, edit, and format charts in Web Intelligence documents using the Java Report Panel. This chapter tells you:

• about charts and Web Intelligence chart templates
• how to create charts
• how to change tables and charts to different chart types
• removing charts
• setting page layout for charts
• formatting charts
• copying charts

Note: If you want to distribute a Web Intelligence document as a Microsoft Excel spreadsheet, you can create charts using Web Intelligence, save the document as an Excel spreadsheet, and then make your formatting changes in Excel. See “Saving Web Intelligence documents as Excel Spreadsheets” on page 528.
About charts and chart templates

Web Intelligence offers standard chart formats to graphically display your business information.

Choosing the appropriate chart template

You can select one of five basic chart types in Web Intelligence:

- bar charts
- line charts
- area charts
- pie charts
- radar, polar, and scatter charts

Bar charts

Bar charts display data in bar form, either vertically or horizontally. Bar charts are useful if you want to compare similar groups of data; for example one time period to another. There are five types of bar charts: grouped, bar and line, stacked, percent, and 3D.

Line charts

Line charts connect specific data values with lines, either horizontally or vertically. Line charts are useful if you want to show trends or changes in data over time. There are five types of line charts: mixed, stacked, percent, 3D, and 3D surface.

Area charts

Area charts are line charts in which the area between the lines and axis are filled in. Area charts are useful if you want to emphasize the size of the total data in a report, as opposed to the changes in the data. You may not want to use an area chart if you have a sharp contrast between specific data points. Use a line chart instead.

You can use more than one measure object on the Y-axis as long as the measures are of the same type and scale; for example, Number of Guests, and Future Guests. There are five types of area charts: absolute, stacked, percent, 3D area, and 3D surface.
Inserting and formatting charts

About charts and chart templates

Pie charts

Pie charts display data as segments of a whole. Pie charts are useful if you want to show how each part of your report data contributes to the total. You can only include one measure object in a pie chart. If you have several measures in your report, you should choose another chart type. There are four types of pie charts: pie, 3D pie, ring, 3D ring.

Radar, Polar, and scatter charts

In radar charts, the X- and Y-axis connect at the chart’s center. Radar charts are useful if you want to look at several different factors related to one item. For example, you could use a radar chart to display revenue data for different services within a hotel. On one axis, you could display revenue for the rooms. On another you could display revenue for the restaurant, and so on.

Scatter charts are similar to line graphs, except that the data points are plotted without a line connecting them. Scatter charts are useful if you want to make a comparison between specific data points.

There are four types of radar, polar, and scatter charts: radar line, stacked radar, polar, and scatter.
Creating charts

You can include one or multiple charts on the reports in a Web Intelligence document. You can create a chart when you build or new document or insert charts into an existing document.

If you are building a new document, you need to define the data definition of the document by building a query before you select a chart template. For full information on building data providers see “Building basic data providers” on page 39.

Once you have defined the query you go to Report View to define the chart(s) on report(s).

To create a chart, you follow three steps:
• select a chart template
• allocate dimensions and measures to the chart axes
• view the results displayed on the chart

Tip: If you want to create a chart that displays the same data as a table on a report, you can copy the table first and then turn the duplicate table into a chart using the Turn To dialog box. See “Duplicating a table” on page 176 and “Applying a different chart template to a table or chart using Turn To” on page 237.
Inserting and formatting charts

Creating charts

Selecting chart templates

- Inserting a chart template onto a report

To insert a chart template onto a report:

1. Make sure you are in Report View.
   The Edit Report button is pressed in when you are working in Report View.

2. Select the report where you want to insert the chart.
   If the report is not already selected, click the report tab of the report you want to select.
   It is recommended you work in Structure View when you insert a new chart. This is because Results View is designed to display the data contained in reports. Therefore, you can only view charts in Results View after you have allocated dimensions and measures to the empty chart template.

3. Click View Structure on the report panel toolbar.

4. Click the Templates tab.

5. Click the + sign next to Charts.

6. Select the chart template drag it onto an empty area of the report.
The empty template appears on the report.

7. Click the **Data** tab.

8. Drag a dimension or measure object onto the chart axis, where you want the results for that dimension or measure to appear on the chart.
   The template indicates whether you can drop dimension or measures on each axis.

9. Drop the dimension or measure onto the axis when the “Place dimension objects here” or the “Place measure objects here” ToolTip appears.

Here, the **[Year]** dimension is being dropped onto the x-axis of a 3D Bar chart.
10. To allocate more dimension and measure objects to each chart axis, repeat step 8.

You must allocate objects to the X-axis and Y-axis for charts to display correctly. Allocating objects to the Z-axis is optional.

11. To display the results in the chart, click the View Results button on the Report toolbar.

The chart displays the results corresponding to the objects you allocated to the chart axes.

The default size of the chart is minimal.
12. Resize the chart by selecting the chart and then dragging the borders outwards.

Drag the vertical borders to the right or the left to change the chart width.

Drag the horizontal borders up or down to change the chart height.
The finished chart appears.

For information on formatting charts and positioning charts on the report page, see “Formatting charts” on page 242 and “Positioning charts on the report page” on page 240.
Changing existing tables and charts to different chart types

You can change the way information is presented on reports by turning the tables and charts into different chart types. This enables you to apply different formats and decide which format communicates the information most clearly.

**Example:** How does revenue in California compare to revenue in other states?

You work in the California branch of a retail clothing chain, and have been sent a report showing revenue by quarter for the western region:

<table>
<thead>
<tr>
<th>Year</th>
<th>2001</th>
<th>2002</th>
<th>2003</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quarter</td>
<td>Sales revenue</td>
<td>Sales revenue</td>
<td>Sales revenue</td>
</tr>
<tr>
<td>Q1</td>
<td>$1,315,546</td>
<td>$1,038,264</td>
<td>$2,036,700</td>
</tr>
<tr>
<td>Q2</td>
<td>$1,277,741</td>
<td>$1,472,659</td>
<td>$2,439,086</td>
</tr>
<tr>
<td>Q3</td>
<td>$774,340</td>
<td>$1,066,318</td>
<td>$2,123,995</td>
</tr>
<tr>
<td>Q4</td>
<td>$942,230</td>
<td>$1,190,625</td>
<td>$1,630,540</td>
</tr>
</tbody>
</table>

The data is presented in crosstab form, which gives you a good method for analyzing exact revenues by state or quarter. But you want to quickly compare revenue in California to revenue in other states. You turn the crosstab into a 3D Bar chart to get a quick comparative overview of the data.
Applying different templates to charts

You can change the format of existing charts or turn tables into charts. Web Intelligence applies the new template to the chart values.

You can change the template by:
• dragging a different chart template onto a chart
• using the Turn To dialog box

Dragging a different chart template onto a table or chart

To drag a different chart template onto a table or chart:

1. Make sure you are in Report View.
   The Edit Report button is pressed in when you are working in Report View.
2. Click the Templates tab.
   If the Templates tab is not visible, click the Show/Hide Manager button on the Report toolbar to display the Templates tab.
3. Click the + sign next to Charts.
4. Click the + sign next to the template type you want to apply.
5. Drag a template onto the chart or table you want to modify.
   You must drop the template directly on the existing report block. If you drop the template outside the existing report block, you create a separate chart.
6. If necessary, resize the chart by selecting it and then dragging the horizontal and vertical borders.

7. If you want to move the dimensions or measures to different axes, click the View Structure button on the report panel toolbar, then drag the objects you want to move onto the Data tab, and then drag and drop the objects you want to display on the chart from the Data tab onto each chart axis.

▶ Applying a different chart template to a table or chart using Turn To

To apply a different chart template to a table or chart using Turn To:

1. Place your pointer on the border of the table or chart you want to modify. A gray border appears around the selected report block.

2. Right-click the selected table or chart. A shortcut menu appears.
3. Click **Turn To**.
   The Turn To dialog box appears.

4. Click the tab corresponding to the chart type you want, then click a format.

5. Click **OK**.
   Web Intelligence applies the selected template to the block and displays the data in the chart type you chose.

   **Note:** If the new chart type does not have data allocated to both the X-axis and the Y-axis, the chart will not appear when you view the report in Results View or in Drill mode. In this case, click the **View Structure** button on the report panel toolbar, and then click the **Data** tab and drag the appropriate dimensions or measures onto the axes on the new chart template. When you click **View Results**, the chart appears.

   **Note:** If the font for the text on the table was unicode, and if unicode is not defined as your default font for charts, the unicode font is not retained in the chart. You need to format the chart with the unicode font if available on your computer. If this is not the case, you need to contact your administrator to configure the Web Intelligence server and your computer appropriately.
Removing charts

You can remove a chart from a report at any time.

Note: If a report contains more than one chart or other report block, you must remove them individually.

- Removing charts

To remove a chart:

- Right-click the chart and click Remove.

Or

Verify that the Data tab is displayed, then drag the chart from the Document pane and drop it onto the Data tab.

The chart is removed from the report.

Working with charts

You work with charts by setting their properties on the Properties tab. The Properties tab displays the properties of the selected report element. When you select a chart, the Properties tab displays the properties that are relevant to charts.

For more information on the Properties tab, see “Java Report Panel interface tour” on page 33.
Setting page layout for charts

You can set the page layout for each page in a Web Intelligence report. You can do the following:
- position a chart on the report page
- position a chart relative to another chart or table to avoid overlap
- start a chart on a new report page

Positioning charts on the report page

You position charts on the report page by specifying a position for the chart in relation to the left edge and right edge of the report page.

1. Right-click the chart and click Edit Format.
   The chart properties appear in the Properties tab.
2. Open the Page layout > Position property group on the Properties tab.
3. Type the position from the report left edge in the Left edge box and the position from the report right edge in the Right edge box.

Positioning charts in relation to other charts or tables

If you have more than one block (table, chart, or form) in your report, you can use relative positioning. Relative positioning allows you to position a selected block (for example, a chart) in relation to other blocks in the report.

If new data on the database modifies the size of the tables or charts, relative positioning ensures that the different tables and charts display correctly without overlapping each other.

Note: If you position a chart in relation to another block (that is, a chart, table, or form), the position of the related block changes automatically, if you reposition the chart.

To position a chart in relation to another chart or table:
1. Right-click the chart and click Edit Format.
2. Open the Page layout > Position property group on the Properties tab.
3. Click ... next to the Position property to open the Relative Position dialog box.
Inserting and formatting charts

Working with charts

4. Select the distance of the upper left point of the chart in relation to another report element by entering
   • the number of pixels
   • the part of the other report element from which you want to measure the pixels (in the first drop-down list)
   • the report element from which you want to measure the pixels (in the second drop-down list)

5. Repeat this for the distance of the lower left point of the chart.

   Note: If the report does not contain multiple elements, the Relative Position dialog box is not available. You set the chart position using the method described in “Positioning charts on the report page” on page 240.

Setting page breaks for charts

When your report contains several pages, you can choose to avoid page breaks in charts. This enables you to keep charts in their entirety on the same page of a report.

▶ Avoiding page breaks in charts

To avoid page breaks in a chart:

1. Right-click the chart and click Edit Format.
2. Open the Page layout property group on the Properties tab.
3. Select Avoid page breaks in chart.
Formatting charts

This section explains the formatting options for charts. This section of this guide includes illustrations that will help you identify the different areas of charts you can format. Since not all chart types include all of the possible axes or legends, this section provides examples of several different chart templates.

About 2D charts

For example, 2D charts include an optional axis legend that lists the values displayed on the bars or lines.

In this example, a 2D bar chart includes the optional Z-axis. Including data on the Z-axis enables you to show an additional break down of the results displayed on the chart bars. The [Sales revenue] measure is on the Y-axis, the [Year] dimension is on the X-axis, and the [Quarter] dimension is on the Z-axis.
About 3D charts

3D bar charts do not include an axis legend. You can clearly see what information is displayed on the chart bars by looking at the axis labels.

The following example shows a 3D bar chart.

In this example, the chart bars display sales revenue per quarter, per year. The [Sales revenue] measure is on the Y-axis, the [Quarter] dimension is on the X-axis, and the [Year] dimension is on the Z-axis.
About pie charts

Pie charts have a single axis displayed on the body of the pie. This is the Y-Axis. Each segment of the pie chart displays a value for the measure on the Y-Axis. The pie chart legend indicates the dimension on the X-Axis.

![Pie chart example](image)

In this example, the 3D pie chart shows sales revenue per year. The measure on the Y-axis is [Sales revenue] and the dimension displayed on the X-Axis is [Year]. Like 2D pie charts, 3D pie charts display measures for a single dimension. The graphical design of 3D pie charts, however, gives a 3D appearance.

Chart formatting options

You can personalize the formatting properties of the following areas on a chart:

- **size** – the width and height of the chart
- **title** – insert, edit, and format a title for the chart
- **apply a 3D look to 2D charts**
- **apply a background color**
- **chart borders** – specify border style and color
- **walls and floors** – show/hide and specify formatting
- **axis legend** – show/hide and specify formatting
- **axis labels** – specify formatting (all charts), rename labels (all charts), show/hide the X-Axis label (Pie charts only)
- **axis values** – specify formatting and set the frequency
- **axis markers** – show/hide markers on one or more axes
Inserting and formatting charts

**Formatting charts**

- grid – show/hide and format a grid on one or more axes
- axis scale – choose either a linear or logarithmic scale for the Y-axis
- data series – show/hide values, choose a color for the primary data series, opt to show different markers per result (Line, Bar and Line, Scatter, and Polar charts)
- entire chart – opt to hide charts, for which there is no data
Setting the chart size

You can set the dimensions of the chart width and height in two ways:

• drag the chart borders using your pointer
• specify the chart width and height (in inches, centimeters, or pixels)

► Resizing a chart using your pointer
To resize a chart using your pointer:

1. Select the chart you want re-size.
   A border appears around the selected chart.

2. To modify the width of the chart, place your pointer on the right edge of
   the border.
   Your pointer becomes a double-arrow.

3. Press your pointer again, and then drag the border to resize the chart to
   the width you want.

4. To modify the height of the chart, place your pointer on the bottom border.

5. When your pointer turns to a double-arrow, press your pointer again and
   then drag the border to resize the chart to the height you want.

► Resizing a chart by specifying a measurement
To resize a chart by specifying a measurement:

1. Right-click the chart and click Edit Format.

2. Open the Display property group on the Properties tab.

3. Type the chart width in the Width property and the height in the Height
   property.
Inserting and formatting titles for charts

If wished, you can add a title to a chart. You can then format the text, background, and borders of the chart title.

► Inserting and formatting a chart title

To insert and format a chart title:

1. Right-click the chart and click Edit Format.
2. Open the Title > Text format property group on the Properties tab.
3. Click ... next to Text Format to open the Text Format dialog box.
4. Select the font in the Font list.
5. Select the font style in the Font style list.
6. Select the font size in the Size list.
7. Select the font color by clicking the Font color list and choosing a color from the palette, or clicking More Colors on the palette and creating a custom color using the Choose a Color dialog box. (For more information on creating custom colors, see “Creating custom colors for chart elements” on page 265.)
8. Select the horizontal and vertical alignment of the text by clicking the appropriate Horizontal and Vertical alignment buttons.
9. Select Underline to set the text style to underline.
10. Select Strikethrough to set the text style to strikethrough.
11. Select Wrap Text to wrap the text.

   Note: You can set many of the properties in the Text Format dialog box directly from the property list, where they appear beneath Text Format.

12. Select the background color by clicking the arrow next to the background color property and selecting the color from the palette or clicking More Colors on the palette and creating a custom color using the Choose a Color dialog box. (For more information on creating custom colors, see “Creating custom colors for chart elements” on page 265.)

13. Select the border style by clicking ... next to the Border style property and setting the border properties in the Define Border dialog box.
Inserting and formatting charts
Formatting charts

Displaying charts with a 2D or 3D look

You can format 2D charts with a 3D look. A 3D look shades the chart bars or pie segments, giving the 2D chart the appearance of being in relief.

A 2D bar chart without the 3D look

A 2D bar chart with the 3D look

- Displaying charts with a 3D look
To display a chart with a 3D look:
1. Right-click the chart and click Edit Format.
2. Open the Display property group on the Properties tab.
3. Select 3D look.

Web Intelligence displays the chart in the 3D look format.
Adding background colors

You can add a background color to charts in Web Intelligence reports. The background is applied to the entire block.

![Annual Sales Revenue chart](image)

The background color fills the block behind the chart and the legend

---

**Adding background colors**

To add a background color to a chart:

1. Right-click the chart and click **Edit Format**.
2. Open the **Appearance** property group on the **Properties** tab.
3. Click the arrow next to **Background color** to display the color palette.
4. Select a color from the color palette or click **More Colors** to display the **Choose Color** dialog box. (For more information on creating custom colors, see “Creating custom colors for chart elements” on page 265.)

---

**Formatting chart borders**

You can add a border around a chart, and then specify the border style and color. If a chart already has a border you can modify or remove the border.

---

**Modifying chart borders**

To modify a chart border:

1. Right-click the chart and click **Edit Format**.
2. Open the **Appearance** property group on the **Properties** tab by clicking + next to **Appearance**.
3. Click ... next to the **Borders** property to display the **Define Borders** dialog box.
4. Select the border style from the **Style** list and the color from the **Color** list.
Displaying chart floors and walls

Floors and walls give depth to charts and help to set off the data displayed on the chart bars or lines. 3D charts have a floor, a left wall, and a right wall. 2D charts just have a floor. You can specify a color for the floor and walls.

Selecting and formatting chart floors and walls

To select and format the chart floor and walls:

1. Right-click the chart and click **Edit Format**.
2. Open the **Display** property group on the **Properties** tab.
3. Select **Show floor** to display the chart floor, **Show left wall** to display the chart left wall and **Show right wall** to display the chart right wall.
   
   **Note:** The availability of these options depends on the type of chart.
4. Set the wall and floor color by clicking the **Wall and floor color** property in the **Appearance** property group and using the Color Palette or the **Choose Color** dialog box to set the color.
Inserting and formatting charts

Formatting axis legends

You can show an axis legend for the following chart types:

• 2D bar charts, 2D line charts, and 2D bar and line charts
• pie and doughnut charts
• radar, polar, and scatter charts

Note: Axis legends are not available for 3D Bar charts.

You can set Web Intelligence to display the axis legend to either the left, right, or bottom of the chart. You can also hide the axis legend.

Annual Sales

Sales revenue

You can format the text, background, and borders of the:

• axis legend title
• axis legend values

The following section explains how to show and format axis legends on charts.

Showing or hiding axis legends

To show or hide the axis legend:

1. Right-click the report and select Edit Format.
2. Open the Display property group in the Properties tab.
3. Select Show legend to show the legend.
4. To select the legend's position, open the Legend property group and select the position from the Position list.

Formatting axis legends

To format the axis legend:

1. Right-click the chart and click Edit Format.
2. Open the Legend property group in the Properties tab.
3. To format the legend title, open the Title property group.
4. Format the title text by clicking \( \ldots \) next to the **Text Format** property and using the **Format Text** dialog box to set the format.

5. Set the legend background color by clicking the arrow to the right of the **Background color** property and using the Color Palette or **Choose Color** dialog box to define the color.

6. Set the legend border style by clicking \( \ldots \) next to the **Borders** property and using the **Edit Borders** dialog box to define the border.

7. To format the legend values, open the **Legend > Values** property group.

8. Repeat steps 4 - 6 to format the legend values.
Formatting axis labels

You can personalize the formatting of axis labels text, borders, and background colors. By default, the axis labels display the object name(s) of the object(s) on each axis of all chart types except pie charts and polar charts.

For example, the object allocated to the X-axis on this 3D bar chart is [Year] so, by default, the axis label is Year. You can replace the name of the object by a label you type. When you do this, the label remains unchanged. Even if you allocate a different object to the axis later or drill on the chart to display values related to other objects, the labels display the same text you specified.

**Note:** For Pie charts Web Intelligence displays the X-axis labels on the axis legend. You can also display the labels on each segment of the chart, if you wish. For information on how to do this, see “Showing/hiding axis labels on pie charts” on page 253.

This section of this guide explains how to:

- format the text, borders, and background
- display fixed text
- display the object name for the dimension(s) or measure(s) on the axis
- show the X-axis label on pie charts

**Showing/hiding axis labels on pie charts**

1. Right-click the chart and select **Edit Format**.
2. Open the Legend > Data property group.
3. Select **Show segment labels**.
 Formatting the axis label text, borders, and background
To format the axis label text, borders, and background:
1.  Right-click the chart and click **Edit Format**.
2.  Open the **Appearance > X/Y/Z Axis > Label** property group.
3.  Select **Show object name** to show the object name on the label.
4.  Type the text into **Other label** if you want to assign custom text to the label in place of the object name.
5.  To format the text, Click ... next to **Text Format** to open the **Text Format** dialog box.
6.  Select the font in the **Font** list.
7.  Select the font style in the **Font style** list.
8.  Select the font size in the **Size** list.
9.  Select the font color by clicking the Font color list and choosing a color from the palette, or clicking **More Colors** on the palette and creating a custom color using the Choose a Color dialog box. (For more information on creating custom colors, see “Creating custom colors for chart elements” on page 265.)
10. Select the horizontal and vertical alignment of the text by clicking the appropriate **Horizontal** and **Vertical** alignment buttons.
11. Select **Underline** to set the text style to underline.
12. Select **Strikethrough** to set the text style to strikethrough.
13. Select **Wrap Text** to wrap the text.
14. You can set many of the properties in the Text Format dialog box directly from the property list, where they appear beneath **Text Format**.
Formatting axis values and axis markers

You can personalize how the axis values, scale, and markers display on charts as follows:

• axis value format – choose a specific number format for numbers, dates, currency, and so on, and choose the font size, orientation, and color for the text
• axis scale range – specify a min. or max. value on the axis
• axis value frequency – display axis values along an axis at an automatic frequency or at a frequency you specify
• axis markers – opt to show or hide axis markers
• grid – opt to show or hide a grid on an axis
Formatting axis value numbers and text
To format axis value numbers and text:
1. Select the chart and click Edit Format.
2. Open the Appearance > X/Y/Z Axis > Values property group in the Properties tab.
3. Click ... next to the Number format property to display the Number Format dialog box.
4. Use the Number Format dialog box to define the format.
   For a step-by-step information on how to select predefined number formats and how to create your own custom number formats, see “Applying predefined formats” on page 269or “Defining custom formats” on page 273.
5. Click ... next to the Text Format property to display the Text Format dialog box.
6. Select the font in the Font list.
7. Select the font style in the Font style list.
8. Select the font size in the Size list.
9. Select the font color by clicking the Font color list and choosing a color from the palette, or clicking More Colors on the palette and creating a custom color using the Choose a Color dialog box. (For more information on creating custom colors, see “Creating custom colors for chart elements” on page 265.)
10. Select the horizontal and vertical alignment of the text by clicking the appropriate Horizontal and Vertical alignment buttons.
11. Select Underline to set the text style to underline.
12. Select Strikethrough to set the text style to strikethrough.
13. Select Wrap Text to wrap the text.
14. You can set many of the properties in the Text Format dialog box directly from the property list, where they appear beneath Text Format.
Showing a specific range of axis values
To show a specific range of axis values:
1. Right-click the report and click Edit Format.
2. Open the Appearance > X/Y/Z Axis > Scale property group on the Properties tab.
3. Enter the minimum value in Min. value and the maximum value in Max. value.
Web Intelligence displays the minimum and/or maximum values you specified on the axis.

Defining the axis value frequency
To define the axis value frequency:
1. Right-click the chart and click Edit Format.
2. Open the Appearance > X/Y/Z Axis > Values property group in the Properties tab.
3. Select Automatic frequency to set the frequency to automatic.
4. Type the frequency in Frequency to set the frequency to a specific value.
5. When you set the frequency to $n$, Web Intelligence displays every $n$ values on the axis.
Note: Automatic frequency must be unselected before you can type a custom frequency.
Inserting and formatting charts

**Formatting charts**

- **Showing/hiding and formatting the grid for chart axes**
  To show/hide and format the grid for a chart axis:
  1. Right-click the chart and select **Edit Format**.
  2. Open the **Appearance > X/Y/Z Axis > Values** property group in the **Properties** tab.
  3. Select **Show grid** to show the grid.
  4. Select **Show markers** to show the grid markers.
  5. Click **Grid color** and select the grid color using the Color Palette or the **Choose Color** dialog box.
  The grid changes color accordingly.

Here, the chart has the grid shown on the X-axis and the Y-axis. The X-axis grid has a custom color applied. The Y-axis grid is the default color black.

Here, the chart has no grid shown.
Changing axis scales from linear to logarithmic

By default, Web Intelligence displays the Y-axis on charts as a linear scale. You can set the axis to a logarithmic scale. Logarithmic scales allow you to examine values that span many orders of magnitude without losing information on the smaller scales.

**Linear scales**
In a linear scale, the axis markers are evenly spaced. Linear scales are based on addition. Consider, for example, the linear sequence:

\[1, 3, 5, 7, 9\]

To get the next number in the sequence, you add 2 to the previous number.

**Logarithmic scales**
Logarithmic scales are based on multiplication rather than addition. In a logarithmic scale, the steps increase or decrease in size. Logarithmic scales are based on multiplication (or division). Consider, for example, the logarithmic sequence:

\[2, 4, 8, 16, 32\]

To get the next number in the sequence, you multiply the previous number by 2. We can say that this sequence represents "base 2."

Consider the following sequence:

\[1, 10, 100, 1000, 10000\]

This sequence represents "base 10," because you get the next term in the sequence by multiplying the previous term by 10.

**Displaying a logarithmic scale**
To display a logarithmic scale:

1. Right-click the chart and select **Edit Format**.
2. Open the **Appearance > Y Axis > Scale** property group in the Properties tab.
3. Select **Logarithmic**.
   The **Edit Report** button is pressed in when you are working in Report View.
4. Select the chart.
5. Click the **Properties** tab, and then click the **Chart Format** sub-tab.
   Or
   Right-click the chart, then select **Edit Format** from the shortcut menu.
Note: A logarithmic scale uniformly presents percent changes rather than point changes. In other words, the distance from 1 to 2 (100% increase) is the same as the distance from 2 to 4 (another 100% increase).

Choosing chart data display options

You can modify the chart display in order to:

• show/hide the values – for the data on each chart bar, line, or marker
• select a specific color – for the primary data series (that is, for the bars, lines, or markers that display the first measure on the chart body)
• show/hide data markers – on Line charts, Bar and Line charts, and Radar charts
• show/hide charts – when there is no data for the dimension(s) or measure(s) on the axes

Showing/hiding data values
To show/hide data values:

1. Right-click the chart and select Edit Format.
2. Open the Appearance > Data group in the Properties tab.
3. Select **Show data** to show the data.

The data values are shown or hidden on the chart, according to your selection.

- **Specifying a color palette for the chart data**
  
  To specify a color palette for the chart data:
  
  1. Right-click the report and select **Edit Format**.
  2. Open the **Appearance > Data** property group in the **Properties** tab.
  3. Click ... next to **Palette** to display the Choose Palette dialog box and select one of the predefined palettes in the **Predefined Palettes** list.
  4. To edit a palette, select the palette, then click **Edit Pallete**.
     
     The **Edit Palette** dialog box opens
  5. Select a color in the palette.
     
     The **Custom Color** dialog box opens
  6. Create a custom color using the Custom Color dialog box, then click OK.
     
     (For more information on creating custom colors, see “Creating custom colors for chart elements” on page 265.)
7. To set all the colors in the palette to the same color, click **Set All Colors**.

- **Varying the data markers for each result**
  
  To vary the data markers for each result:
  1. Right-click the chart and select **Edit Format**.
  2. Open the **Appearance > Data** property group in the **Properties** tab.
  3. Select **Vary data markers**.

  **Note:** You can only vary the data markers for each result on the following chart types: 2D Line charts, 2D Bar and Line charts, and Radar charts.
Showing or hiding charts with no data

Sometimes charts display no values. For example, if sales of a specific product are discontinued, a chart that normally displays results for that product will appear empty. By default, Web Intelligence displays such empty charts on reports. If wished, you set Web Intelligence to hide charts whenever they are empty.

Showing/hiding empty charts

1. Right-click the chart and click Edit Format
2. Open the Display property group in the Properties tab.
3. Select Show when empty.
The following sections describe how you change the display of charts by setting chart properties.

- **To access all chart properties**
  1. Select the chart.
  2. Select the property group that contains the property you want to set.
     You access the properties in a sub-group by clicking the + next to the group.
Creating custom colors for chart elements

- To create a custom color
  1. Select a base color in the Swatches tab.
  2. In the HSB (hue, saturation, brilliance) tab, set the hue by clicking H, then moving the vertical slider to the left of S or setting the value directly in the box to the right of H.
  3. Set the saturation by clicking S, then moving the vertical slider to the left of S or setting the value directly in the box to the right of S.
  4. Set the brilliance by clicking B, then moving the vertical slider to the left of B or setting the value directly in the box to the right of B.
  5. To hold one of hue, saturation or brilliance static while changing the values of the other two, click H, S or B, then change the other values by moving the white circle in the square spectrum to the left of the vertical slider.
  6. On the RBG (red, blue, green) tab, set the amount of red, blue and green in the color by moving the Red, Blue and Green sliders.
Copying charts

You can copy and paste charts within a report or into external applications such as Microsoft Word and Excel.

**Note:** You cannot copy charts from one instance of Web Intelligence to another.

▶ **To copy a chart**

1. Select the chart, right-click and select **Copy** on the menu.
   
   Web Intelligence copies the chart to the clipboard.

2. To paste the chart to another part of the report, right-click where you want the chart to appear then click **Paste** on the menu.

3. To paste the chart into another application, paste the contents of the clipboard from within the other application.

   The chart appears as a picture in the open document if pasted to another application.

   **Note:** You can also copy a chart into another application by dragging and dropping it directly into the open document in the target application.
Chapter 14

Formatting numbers and dates
Overview

This chapter describes the formats that you can apply to values displayed in cells and on chart axes. You can select from a range of predefined formats or create your own custom formats.

This chapter tells provides information on:

• default formats
• applying predefined formats
• defining custom formats
Default formats

You can change how values display in specific cells or on chart axes. You do this by applying predefined formats available in Web Intelligence or by creating your own custom formats. You can save your custom formats for reuse on multiple blocks and reports in the same document.

Applying predefined formats

The following predefined formats are available for cells:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>The format defined for the object on the universe.</td>
</tr>
<tr>
<td>Number</td>
<td>Formats for decimal or integer values.</td>
</tr>
<tr>
<td>Currency</td>
<td>Formats for currency values.</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Date and time formats.</td>
</tr>
<tr>
<td>Boolean</td>
<td>True, false.</td>
</tr>
</tbody>
</table>

In addition, you can create your own custom formats and re-use those custom formats throughout the reports in a document.

You can access the formatting options in one of two ways:
- using the shortcut menu
- using the Cell Properties tab

Applying a predefined format using the shortcut menu

To apply a predefined format using the shortcut menu:

1. Make sure you are in Report View.
   - The Edit Report button is pressed in when you are working in Report View.
2. Right-click a cell.
   - For example, right-click a cell in a section, table, or chart. If you select a cell in the body of a table, Web Intelligence automatically selects all the body cells that display values for the same object. If you want to modify the format of values on a chart access, you need to work in Structure View.
3. Click Format Number.
The Format Number dialog box appears.

4. Click a format in the Format Type list.
The available formats for the format type you selected appear in the Properties pane.
Samples of the format appear in the Positive, Negative, and Equal to Zero boxes or for Boolean formats only, samples appear in the True and False boxes.

5. Click OK.
Web Intelligence applies the new format to the cell.
Applying a predefined cell format using the Properties tab

To apply a predefined cell format using the Properties tab:

1. Make sure you are in Report View.
   
   The Edit Report button is pressed in when you are working in Report View.

2. Click a cell.
   
   For example, click a cell in a section, table, or chart. If you select a cell in the body of a table, Web Intelligence automatically selects all the body cells that display values for the same object. If you want to modify the format of values on a chart access, you need to work in Structure View.

   1. Click the Properties tab.
   
   2. Click the Cell Properties sub-tab.

   If the Properties tab is not visible, click the Show/Hide Manager button on the Report toolbar.
Formatting numbers and dates

Applying predefined formats

The Number Format section of the Cell Properties tab displays the type of format currently applied to the selected cell.

3. Click the Number Format button.

The Number Format dialog box appears.

4. Click a format in the Format Type list.

5. The available formats for the format type you selected appear in the Properties pane.

6. Select the specific format you want to apply to the contents of the selected cell(s).

7. Click OK.

Web Intelligence applies the new format to the cell(s).
Defining custom formats

You can use the **Custom** format type to define a customized number format for any cell. The example below shows how you can define a custom currency format for negative sales revenue and margin results.

**Example:** Defining a custom currency format to display negative results in red

You create a report which contains information on the sales revenue and margin for certain eFashion clothing lines. Some of the results are negative values.

The margin for City Trousers line is a negative result

<table>
<thead>
<tr>
<th>Quarter</th>
<th>Line</th>
<th>Sales revenue</th>
<th>Margin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q2</td>
<td>Accessories</td>
<td>86,012</td>
<td>40,104</td>
</tr>
<tr>
<td></td>
<td>City Skirts</td>
<td>8,995</td>
<td>3,839</td>
</tr>
<tr>
<td></td>
<td>City Trousers</td>
<td>277</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>Dresses</td>
<td>54,671</td>
<td>24,494</td>
</tr>
<tr>
<td></td>
<td>Jackets</td>
<td>8,995</td>
<td>4,029</td>
</tr>
<tr>
<td></td>
<td>Outerwear</td>
<td>563</td>
<td>37</td>
</tr>
<tr>
<td></td>
<td>Shirt Waist</td>
<td>77,531</td>
<td>24,756</td>
</tr>
<tr>
<td></td>
<td>Sweaters</td>
<td>76,010</td>
<td>31,428</td>
</tr>
<tr>
<td></td>
<td>Sweat-T-Shirts</td>
<td>451,758</td>
<td>184,781</td>
</tr>
<tr>
<td></td>
<td>Trousers</td>
<td>15,286</td>
<td>6,265</td>
</tr>
<tr>
<td><strong>Q2</strong></td>
<td><strong>Sum:</strong></td>
<td><strong>709,708</strong></td>
<td><strong>319,628</strong></td>
</tr>
</tbody>
</table>

The custom format displays negative values in red

You want to be able to spot any negative results quickly, so you create a custom number format that displays any negative values in red. You apply the custom format to the Sales Revenue column and Margin column of the table.

The negative values stand out clearly on the report in red.

<table>
<thead>
<tr>
<th>Quarter</th>
<th>Line</th>
<th>Sales revenue</th>
<th>Margin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q2</td>
<td>Accessories</td>
<td>86,012</td>
<td>40,104</td>
</tr>
<tr>
<td></td>
<td>City Skirts</td>
<td>8,995</td>
<td>3,839</td>
</tr>
<tr>
<td></td>
<td>City Trousers</td>
<td>277</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>Dresses</td>
<td>54,671</td>
<td>24,494</td>
</tr>
<tr>
<td></td>
<td>Jackets</td>
<td>8,995</td>
<td>4,029</td>
</tr>
<tr>
<td></td>
<td>Outerwear</td>
<td>563</td>
<td>37</td>
</tr>
<tr>
<td></td>
<td>Shirt Waist</td>
<td>77,531</td>
<td>24,756</td>
</tr>
<tr>
<td></td>
<td>Sweaters</td>
<td>76,010</td>
<td>31,428</td>
</tr>
<tr>
<td></td>
<td>Sweat-T-Shirts</td>
<td>451,758</td>
<td>184,781</td>
</tr>
<tr>
<td></td>
<td>Trousers</td>
<td>15,286</td>
<td>6,265</td>
</tr>
<tr>
<td><strong>Q2</strong></td>
<td><strong>Sum:</strong></td>
<td><strong>709,708</strong></td>
<td><strong>319,628</strong></td>
</tr>
</tbody>
</table>
Quick reference to characters for creating custom cell formats

The following table lists the strings you can use to create custom formats.

**Formatting cells displaying number and currency data**

<table>
<thead>
<tr>
<th>Character(s)</th>
<th>Display(s)</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>#</td>
<td>The corresponding digit. If the number has less digits than the number of # characters used to specify the format, no leading zeros are inserted.</td>
<td>‘12345’ with the format: #.##0 gives ‘12,345’ (if your locale defines the grouping separator as a comma) or ‘12 345’ (if your locale defines the grouping separator as a space)</td>
</tr>
<tr>
<td>0</td>
<td>The corresponding digit. If the number has less digits than the number of 0 characters used to specify the format, a leading zero(s) is inserted before the number.</td>
<td>‘123’ with the format #0,000 gives ‘0,123’</td>
</tr>
<tr>
<td>.</td>
<td>The grouping separator as defined by your locale.</td>
<td>‘1234567’ with the format: #.##0 gives ‘1,234,567’ (if you locale defines the grouping separator as a comma) or ‘1 234 567’ (if your locale defines the grouping separator as a non-breaking space)</td>
</tr>
<tr>
<td>.</td>
<td>The decimal separator as defined by your locale.</td>
<td>‘12.34’ with the format: #.0 gives ‘12.34’ (if your locale defines the decimal separator as a period) or ‘12,34’ (if your locale defines the decimal separator as a comma)</td>
</tr>
</tbody>
</table>
### Formatting numbers and dates

#### Defining custom formats

<table>
<thead>
<tr>
<th>Character(s)</th>
<th>Display(s)</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>[%]%</td>
<td>Displays a percentage sign (%) after the result and multiplies the result by 100.</td>
<td>‘0.5’ with the format: #.##0[%]% gives ‘50%’</td>
</tr>
<tr>
<td>%</td>
<td>The % sign after the result, but does not multiply the result by 100.</td>
<td>‘1’ with the format: #.##0% gives ‘1%’</td>
</tr>
<tr>
<td></td>
<td>A non-breaking space ()</td>
<td>‘1234567’ with the format: # ##0 gives ‘1234 567’</td>
</tr>
<tr>
<td>1, 2, 3, a, b, c, $, £, € (and so on)</td>
<td>The alphanumeric character.</td>
<td>‘705.15’ with the format: $#.##0 gives ‘$705.15’ or with the format: #.##0 € gives ‘705,15 €’</td>
</tr>
<tr>
<td>[Red], [Blue], [Green], [Yellow], [Gray], [White], [Dark Red], [Dark Blue], [Dark Green]</td>
<td>The value in the specified color.</td>
<td>‘150’ with the format: -.##0[Red] gives ‘150’ or -.##0[Blue] gives ‘-150’</td>
</tr>
</tbody>
</table>
### Characters for formatting cells displaying date and time data

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Character</th>
<th>Displays</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Day</strong></td>
<td>d</td>
<td>The number of the day in the month with no leading zeros. If the date for day is less than two characters, the date displays without a zero before it.</td>
<td>The first day of a month with the format: d gives ‘1’</td>
</tr>
<tr>
<td></td>
<td>dd</td>
<td>The number of the day with leading zeros. If the date for day is less than two characters, the date displays with a zero before it.</td>
<td>The first day of a month with the format: dd gives ‘01’</td>
</tr>
<tr>
<td></td>
<td>ddd</td>
<td>The name of the day abbreviated. The first letter is capitalized.</td>
<td>‘Monday’ with the format: ddd gives ‘Mon’</td>
</tr>
<tr>
<td></td>
<td>dddd</td>
<td>The name of the day in full. The first letter is capitalized.</td>
<td>‘Monday’ with the format: dddd gives ‘Monday’</td>
</tr>
<tr>
<td></td>
<td>dddd dd</td>
<td>The day of the week followed by a space and the number of the day.</td>
<td>‘Monday’ with the format: dddd dd gives ‘Monday 01’</td>
</tr>
<tr>
<td><strong>Month</strong></td>
<td>M</td>
<td>The number of the month with no leading zeros. If the number for month is less than two characters, the number displays without a zero before it.</td>
<td>‘January’ with the format: M gives ‘1’</td>
</tr>
<tr>
<td></td>
<td>MM</td>
<td>The number of the month with leading zeros. If the number for month is less than two characters, the number displays with a zero before it.</td>
<td>‘January’ with the format: MM gives ‘01’</td>
</tr>
<tr>
<td></td>
<td>mmm</td>
<td>The name of the month abbreviated. The first letter is capitalized.</td>
<td>‘January’ with the format: mmm gives Jan</td>
</tr>
<tr>
<td>Data Type</td>
<td>Character</td>
<td>Displays</td>
<td>Example</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------</td>
<td>----------</td>
<td>---------</td>
</tr>
<tr>
<td>mmmm</td>
<td>The name of the month in full. The first letter is capitalized.</td>
<td>'January' with the format: mmmm gives January</td>
<td></td>
</tr>
<tr>
<td>yy</td>
<td>The last two digits for year.</td>
<td>'2003' with the format: yy gives '03'</td>
<td></td>
</tr>
<tr>
<td>yyyy</td>
<td>All four digits for year.</td>
<td>'2003' with the format: yyyy gives '2003'</td>
<td></td>
</tr>
<tr>
<td>Time</td>
<td>h:mm:ss a</td>
<td>The hour with no leading zeros and the minutes and seconds with leading zeros. The &quot;a&quot; character displays AM or PM after the time.</td>
<td>'21:05:03' with the format: h:mm:ss a gives '9:05:03 PM'</td>
</tr>
<tr>
<td>HH</td>
<td>The hour according to the 24-hour clock.</td>
<td>'21:00' with the format: HH gives '21'</td>
<td></td>
</tr>
<tr>
<td>hh</td>
<td>The hour according to the 12-hour clock.</td>
<td>'21:00' with the format: hh gives '09'</td>
<td></td>
</tr>
<tr>
<td>HH:mm</td>
<td>The hour and minutes with leading zeros.</td>
<td>'7.15 am' with the format: HH:mm gives '07:15'</td>
<td></td>
</tr>
<tr>
<td>HH:mm:ss</td>
<td>The hour, minutes, and seconds with leading zeros.</td>
<td>'7.15 am' with the format: HH:mm:ss gives '07:15:00'</td>
<td></td>
</tr>
<tr>
<td>mm:ss</td>
<td>The minutes, and seconds with leading zeros.</td>
<td>'07:15:03' with the format: mm:ss gives '15:03'</td>
<td></td>
</tr>
</tbody>
</table>
Defining a new custom format

To define a new custom format:

1. Make sure you are in Report View.
   The Edit Report button is pressed in when you are working in Report View.
2. Right-click the cell(s) to which you want to apply a custom format.
3. Select Number Format.
   The Number Format dialog box appears.
4. In the Format Type list, select the format category that corresponds to the data type in the selected cell.
   For example, if the selected cell displays date and time information, select Number.
   The Custom check box appears.
5. Select the Custom check box.
   Text boxes appear for you to type your custom format(s).
6. Select a format listed in the Properties pane, and then edit the selected format by typing additional characters in one or more text boxes.

Or
Type a custom format in one or more text boxes.
For example, if you want to create a custom format for Number values, type the custom format you want in the Positive, Negative, and Equal to Zero boxes. If you want to create a custom format for Boolean values, type the custom format you want in the True and False boxes.

7. Click Add.
The custom format is added to the list of custom formats for the document.
Or
Click OK.
The custom format is added to the list of custom formats for the document and it is applied to the selected cell(s).

Note: You cannot delete or edit custom formats. To change a custom format, you need to create a new custom format and apply the new format to the selected cell(s). Any custom formats not applied to cells in a document are deleted automatically when you close the Web Intelligence Java Report Panel.
Applying a custom format already defined in a document

To apply a custom format already included in a document:

1. Make sure you are in Report View.
   
   The **Edit Report** button is pressed in when you are working in Report View.

2. Right-click the cell(s) to which you want to apply the custom format.

3. Select **Number Format**.
   
   The **Number Format** dialog box appears.

4. Select **Custom**.
   
   The list of custom formats already included in the document appears in the Properties pane.

5. Select the custom format you want.

6. Click **OK**.
   
   Web Intelligence applies the custom format to the selected cell(s).
Using sections, breaks, and sorts
Using sections, breaks, and sorts

Overview

This chapter describes how you can organize the information displayed in reports so that reports are easy to read and navigate.

It provides information on the following:

• using sections to group data on reports
• using breaks to group data in tables
• using sorts to organize sections and data on tables
Using sections to group data on reports

To make reports easy to navigate, you can divide the report into sections that group related data together. The tables and charts in a section only display the data relevant to the dimension on which the section is created. For example, if you create a section on the [Year] dimension, the tables and charts in the section for “2003” will only display data for the year 2003.

You can include sections in the report map. This enables you to quickly navigate long reports section-by-section or to go directly to the section that has the data you want to analyze.

The map displays a link to each section of the report.

The report is divided into sections by year. Each section displays values for a specific year.

You can include subsections below sections. For example, you can divide a report into sections by year and then add a subsection by state.
What makes up a section?

A section consists of a section cell and the section itself. The section cell is a free-standing cell that displays a value for a selected dimension (for example, state, customer, year, and so on).

For example, if a report has a section on the year dimension and the database has data for the years 2001-2003, then there will be one section for year 2001 data, a second section for year 2002 data, and a third section for year 2003 data.
A section can contain one or multiple tables, charts, or forms. The tables, charts, and forms on a section only contain data that corresponds to the value in the section cell. For example, a table in a section where the section cell displays 2003, only contains data for year 2003. You can view sections in Results View or Structure View. The following illustration shows a report with sections in Results View. The generic term block is used to refer to tables, charts, and forms.

The section cell displays the value for the section. In this example, the section shows information for Year 2003. This is indicated by the value 2003 which is displayed in the section cell.

The blocks in the section display information that corresponds to the value in the section cell. In this example, the pie chart and crosstab in this section show information for the year 2003.

The following illustration shows a report with sections in Structure View. When you view a report in Structure View, each section is clearly indicated by a section divider. It is easier to format sections when you work in Structure View.

The section divider is labelled, indicating which object is selected for the section. In this example the section is based on the [Year] dimension so, when the report is viewed in Results View, each section displays values for a specific year.
Creating sections

You create sections by selecting a dimension for the section cell. You can do this two ways:

• move a cell from a table to create a section cell
  or
• select a dimension object listed on the Data tab

**Note:** The objects available on the Data tab are the objects included in the query for the document. If your security profile enables you to modify the query, you can add other objects from the universe to the query definition and then run the query again.

**Creating a section by moving a cell from a table**

To create a section by moving a cell from a table:

1. Verify you are viewing the report in Report View.
   The Edit Report button is pressed in when you are working in Report View.
   You create a section on a dimension in the table.
2. Select the header cell on the table that displays the name of the dimension.
   Or
   Select a body cell on the table that displays a value for the dimension.
   For example, if you want a section for each state, either select the header cell labelled “State” or select one of the cells that displays the name of a state.
Using sections, breaks, and sorts

Using sections to group data on reports

3. Drag the selected cell above the table and drop it onto the report background.

A section is created for each value of the selected dimension.

Creating a section by adding a dimension from the Data tab

To create a section by adding a dimension from the Data tab:

1. Click the Data tab.
2. Select a dimension object and, then drag the dimension over to an empty area of the report.
3. Position and drop the dimension where you want the section cell to appear.

If the report includes tables or charts, then drop the section cell above the tables and charts that you want to be included in the section.
If you are in Results View, a cell containing one value for each unique value for the added object appears above the table or crosstab. The data in the table or crosstab is automatically sorted according to the cell value.

If you are in Structure View, a cell is added above the table or crosstab.

4. If you are in Structure View, click **View Results** to see the results.

Web Intelligence applies the section to the report and displays the results.

**Creating subsections**

You can create a report with multiple sections. You create multiple sections in the same way you create a section:

- by moving a cell from a table and dropping the cell below an existing section cell
  or
- by selecting a dimension object listed on the **Data** tab, and then dragging and dropping the dimension below an existing section cell.

For step-by-step instructions on creating subsections, follow the instructions in “Creating a section by moving a cell from a table” on page 286 or “Creating a section by adding a dimension from the Data tab” on page 287.
Setting section properties

You can set the following properties for a section:

- name the section
- specify your criteria for when you consider a section to be “empty”
  - For example, you may consider a section of no interest for your analysis whenever a specific table or chart within that section is empty. In this case you can choose to specify that the section is to be considered “empty.”

- hide or show sections that you consider empty
- include links to sections in the report map so you can jump from section-to-section when navigating the report

▶ Selecting the section display properties

To select the section display properties:

1. Make sure you are in Report View.
2. Click View Structure.
   
   In Structure View you can see the start and end divider of each section on the report.
   
   This makes it easy for you to select a specific section and then choose the properties you want to apply to the selected section.
3. Right-click the section divider.
   
   The Properties tab shows the properties relevant to sections.
4. Set the section properties.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of the section with a different name from the name of the dimension selected for the section,</td>
<td>type a name for the section in the General &gt; Name property.</td>
</tr>
<tr>
<td>Specify the component(s) of the section that will qualify the entire section as an “empty section,” if there is no data on the database for that component(s),</td>
<td>Check the components in the drop-down list next to the Display &gt; Hide section when empty property.</td>
</tr>
<tr>
<td>Show the section when there is no data on the database for this section,</td>
<td>check Show when empty. (To hide empty sections, uncheck this option.)</td>
</tr>
</tbody>
</table>
5. Click the **View Results** button to view the properties applied to the results on the report. Web Intelligence applies the properties to the section and displays the results on the report.

**Setting the page layout for sections**

You can set the following page layout options for a section:

- position the section cell on the report page
- position the section cell relative to a table or chart in the section
- control page breaks, by starting each section on a new page and avoiding breaks in sections
- repeat the section cell on each report page where the section appears

**Positioning the section cell on the report page**

To position the section cell on the report page:

1. Make sure you are in Report View. You can position section cells on the report page easily in either Results View or Structure View. To work in Results View, verify that the **View Results** button is pressed in. To work in Structure View, verify that the **View Structure** button is pressed in.

2. Select the section cell. The border of the selected section is highlighted.
3. Drag and drop the selected cell to where you want to position the cell. If you drop the cell outside the section dividers, a warning appears asking you to confirm that you want to place the cell outside the section. Or

Right-click the section cell and click Edit Format on the menu, then set the Position > Left edge and Position > Top edge properties on the Properties tab.

The section cell appears at the position you specified.

- **Controlling page breaks for sections**

To control page breaks for sections:

1. Make sure you are in Report View.
   
   The Edit Report button is pressed in when you are working in Report View.

2. Click View Structure.

   In Structure View you can see the start and end divider of each section on the report. This makes it easy for you to select a specific section and then choose the properties you want to apply to the selected section.

3. Select the section divider.

   The dividers for the selected section are highlighted.


<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then select...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start each section on a new page of the report.</td>
<td>Start section on a new page.</td>
</tr>
<tr>
<td>Keep the section cell and the tables and charts in the section on the same report page.</td>
<td>Avoid page break in section.</td>
</tr>
</tbody>
</table>

   **Note:** This option does nothing when a section is larger than one page.

5. Click the View Results button to view the properties applied to the results on the report.

Web Intelligence applies the properties to the section and displays the results on the report.

- **Repeat the section cell on each new page**

To repeat the section cell on each new page:
Using sections, breaks, and sorts

Using sections to group data on reports

1. Make sure you are in Report View.
   The Edit Report button is pressed in when you are working in Report View.
   You can position section cells on the report page easily in either Results View or Structure View.
   To work in Results View, verify that the View Results button is pressed in. To work in Structure View, verify that the View Structure button is pressed in.

2. Select the section cell.

3. Select the Page Layout > Repeat on every new page property in the Properties tab.

4. If you are working in Structure View, click the View Results button to view the option applied to the results on the report.
   The section cell appears on each report page where part of the section is displayed.
Removing sections

You can remove sections and subsections from a report. When you remove a section, the entire section including the tables and charts within the section are removed from the report.

You can also remove the section cell without removing the section. When you remove the section cell from a report, you do not remove the section. For example, if you remove the section cell for [State] from a report, the report remains divided in sections per state and the tables and charts still display results for each of the states. However, the name of each state no longer appears in a section cell at the top of each section.

**Removing a section**

To remove a section:

1. Make sure you in Structure View.
   - The **View Structure** button is pressed in when you are working in Structure View.
   - The report appears in Structure View. The section dividers appear.
2. Click the beginning or end divider of the section you want to remove.
   - The section divider becomes highlighted.
3. Click the **Delete** key.
   - The section is removed.
4. Click the **View Results** button.
   - Web Intelligence displays the report results without the section you deleted.

**Removing a section cell**

To remove a section cell:

1. Right click a section cell.
2. Select **Remove** from the shortcut menu.

Web Intelligence removes the section cell from the report. All the section cells in the same section are also removed from the report. For example, if you select the section cell labelled “California” which is part of the section for [State], then all of the section cells that display the names of the states will be removed from the report.

You can format the text, background, borders, and page layout position of section cells. For information on how to do this, see “Formatting free-standing cells” on page 223.
Using breaks to group data on tables

This section explains how to break up data in tables and crosstabs and describes the different options available to format and manage these breaks.

What is a break?

A break is a division in a result table in which data is grouped according to a selected value into self-contained parts. These parts are represented as smaller tables.

You use breaks to display all the data for each unique value of a dimension in separate tables.

Using breaks has two main advantages:

• you can more efficiently organize how your data is represented
• you can display subtotals

Example: How can I show revenue subtotals for each state in a table?

The table on the left displays the revenue per year per state with the total revenue displayed at the bottom of the table. The table on the right displays the same data but, by organizing the data by state, you can now show a subtotal for the revenue generated by each state for the years 2001-2003. A mini table is created for each of the three values of state. This separation, however, is only visual as the three mini tables still belong to a single table.
How is a break different from a section?

The example below shows sales revenue for each state sorted by year. The resulting data is presented differently as follows:

- When you create a break on Year, the data remains as one block. The year values are repeated for each corresponding value of State and Sales Revenue.
- When you create a section on Year, the data is no longer contained in one block, but divided into sections. One section for each value of Year. Each section is a separate block.

The difference between a break and a section is shown below:

<table>
<thead>
<tr>
<th>Year</th>
<th>State</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>California</td>
<td>$190021</td>
</tr>
<tr>
<td>2001</td>
<td>Colorado</td>
<td>$480000</td>
</tr>
<tr>
<td>2001</td>
<td>DC</td>
<td>$600021</td>
</tr>
<tr>
<td>2001</td>
<td>Florida</td>
<td>$430000</td>
</tr>
<tr>
<td>2001</td>
<td>Illinois</td>
<td>$780024</td>
</tr>
<tr>
<td>2001</td>
<td>Massachusetts</td>
<td>$280195</td>
</tr>
<tr>
<td>2001</td>
<td>New York</td>
<td>$1610986</td>
</tr>
<tr>
<td>2001</td>
<td>Texas</td>
<td>$198671</td>
</tr>
<tr>
<td>2002</td>
<td>California</td>
<td>$2970986</td>
</tr>
<tr>
<td>2002</td>
<td>Colorado</td>
<td>$780599</td>
</tr>
<tr>
<td>2002</td>
<td>DC</td>
<td>$215198</td>
</tr>
<tr>
<td>2002</td>
<td>Florida</td>
<td>$661290</td>
</tr>
<tr>
<td>2002</td>
<td>Illinois</td>
<td>$115935</td>
</tr>
<tr>
<td>2002</td>
<td>Massachusetts</td>
<td>$159791</td>
</tr>
<tr>
<td>2002</td>
<td>New York</td>
<td>$2970991</td>
</tr>
<tr>
<td>2002</td>
<td>Texas</td>
<td>$2732092</td>
</tr>
</tbody>
</table>

How is data sorted when you insert a break?

When you insert a break on a dimension, the values for the dimension are automatically sorted in ascending order. If the values are numeric, the lowest value appears in the first row of the table, the highest in the last row. If the values are alphabetical characters, then the values are sorted in alphabetical order from top to bottom. You can change this sort order at any time. For information on how to apply sorts, see “Using sorts to organize sections and data on tables” on page 303.
You can set multiple breaks and set a sort priority on each break, so that you control how the data is displayed when you insert multiple breaks across several dimensions. For more information on setting multiple breaks, see the section “Using multiple breaks” on page 298. Inserting and removing breaks in each view is described in the following sections.

## Inserting breaks

You can insert one or multiple breaks on a table or crosstab. You can insert breaks on any columns or rows that display values for dimensions or details.

**Note:** You cannot insert a break on columns or rows that display a measure.

For a complete description and examples of dimensions, details, and measures, see “What types of objects can you use in a query?” on page 43.

### Inserting a break

To insert a break:

1. Verify you are working in Report View.

   The *Edit Report* button is pressed in when you are working in Report View.

2. Click a cell in the column or row where you want to insert a break.

   The cell is highlighted.

3. Click the *Insert/Remove Break* button on the Reporting toolbar.

<table>
<thead>
<tr>
<th>Year</th>
<th>State</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>California</td>
<td>$1,704,421</td>
</tr>
<tr>
<td>2001</td>
<td>Colorado</td>
<td>$440,302</td>
</tr>
<tr>
<td>2001</td>
<td>DC</td>
<td>$683,241</td>
</tr>
<tr>
<td>2001</td>
<td>Florida</td>
<td>$465,865</td>
</tr>
<tr>
<td>2001</td>
<td>Illinois</td>
<td>$759,914</td>
</tr>
<tr>
<td>2001</td>
<td>Massachusetts</td>
<td>$288,819</td>
</tr>
<tr>
<td>2001</td>
<td>New York</td>
<td>$1,662,696</td>
</tr>
<tr>
<td>2001</td>
<td>Texas</td>
<td>$2,199,872</td>
</tr>
<tr>
<td>2002</td>
<td>California</td>
<td>$2,762,690</td>
</tr>
<tr>
<td>2002</td>
<td>Colorado</td>
<td>$765,690</td>
</tr>
<tr>
<td>2002</td>
<td>DC</td>
<td>$1,215,490</td>
</tr>
<tr>
<td>2002</td>
<td>Florida</td>
<td>$669,282</td>
</tr>
<tr>
<td>2002</td>
<td>Illinois</td>
<td>$1,150,059</td>
</tr>
<tr>
<td>2002</td>
<td>Massachusetts</td>
<td>$167,719</td>
</tr>
<tr>
<td>2002</td>
<td>New York</td>
<td>$2,765,603</td>
</tr>
<tr>
<td>2002</td>
<td>Texas</td>
<td>$3,752,855</td>
</tr>
</tbody>
</table>
Web Intelligence divides the table up into as many mini tables as there are unique values for the selected cell. Web Intelligence inserts a footer at the end of each break.

<table>
<thead>
<tr>
<th>Year</th>
<th>State</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>California</td>
<td>$170,4211</td>
</tr>
<tr>
<td>2001</td>
<td>Colorado</td>
<td>$469,3033</td>
</tr>
<tr>
<td>2001</td>
<td>DC</td>
<td>$699,3111</td>
</tr>
<tr>
<td>2001</td>
<td>Florida</td>
<td>$4059885</td>
</tr>
<tr>
<td>2001</td>
<td>Illinois</td>
<td>$739914</td>
</tr>
<tr>
<td>2001</td>
<td>Massachusetts</td>
<td>$299913</td>
</tr>
<tr>
<td>2001</td>
<td>New York</td>
<td>$166,9035</td>
</tr>
<tr>
<td>2001</td>
<td>Texas</td>
<td>$219,9627</td>
</tr>
</tbody>
</table>

In this report, the table splits into two mini tables – one mini table for each value for year.

The break footer displays the value at the end of each break in bold.

The **Insert/Remove Break** button is pressed in.
Using multiple breaks

You can insert multiple breaks on a table or crosstab. You can also set a priority on the order of the breaks. The following example shows two tables that show sales revenue results for Q3 and Q4 in year 2002 and 2003. Both tables have breaks on [Year] and [Quarter].

The table on the left has a break on [Year] first and then a second break on [Quarter]. The table is broken into two mini tables for year 2002 and year 2003. The results for Q3 and Q4 display for each year.

The table on the right has a break on [Quarter] first and then a second break on [Year]. The table is broken into two mini tables for Q3 and Q4. The results for year 2002 and year 2003 display for each quarter.

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2002</td>
<td>Q3</td>
<td>$2,097,932</td>
</tr>
<tr>
<td></td>
<td>Q3</td>
<td>$2,079,303</td>
</tr>
<tr>
<td></td>
<td>Sum</td>
<td>$4,177,235</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2003</td>
<td>Q3</td>
<td>$3,952,386</td>
</tr>
<tr>
<td></td>
<td>Q3</td>
<td>$3,952,386</td>
</tr>
<tr>
<td></td>
<td>Sum</td>
<td>$7,804,772</td>
</tr>
</tbody>
</table>

The break priority is: Year - Quarter

This section tells you how to:
• insert multiple breaks
• set the priority of multiple breaks

**Inserting multiple breaks**

To insert multiple breaks:

1. Verify you are working in Report View.

   The Edit Report button is pressed in when you are working in Report View.
2. Click a cell in the column or row where you want to insert a break. The cell is highlighted.

3. Click the Insert/Remove Break button on the Reporting toolbar.

4. Repeat steps 2. and 3. for each break that you want to insert.

**Prioritizing multiple breaks**

To set a priority on a break:

1. Verify you are working in Report View. The **Edit Report** button is pressed in when you are working in Report View.

2. Verify that the **View Structure** button is pressed in.

3. Right-click the table that contains multiple breaks and select **Edit Format** on the menu. The **Properties** tab shows the properties relevant to a table.

4. Click the ... button next to the Breaks > Break priority property to display the Breaks dialog box.

5. Click **Vertical breaks** or **Horizontal breaks** to display the type of break you want to prioritize.
   - If the selected table is a vertical table, then all the breaks are applied to columns. These are called Vertical breaks.
   - If the selected table is a horizontal table, then all the breaks are applied to rows. These are called Horizontal breaks.
   - If the selected table is a crosstab, then breaks can be applied to rows or to columns. You can choose the priority for the Horizontal breaks and for the Vertical breaks.

6. Select the break whose priority you want to change and click the Up/Down buttons to promote/demote the break in the list of breaks.
Removing breaks

You can remove breaks from tables and crosstabs.

► Removing a break
To remove a break:

1. Verify you are working in Report View.
   The Edit Report button is pressed in when you are working in Report View.

2. Click a cell in the column or row where you want to remove a break.
   The cell is highlighted.

3. Click the Insert/Remove Break button on the Reporting toolbar.
   Tip: If the Insert/Remove Break button is grayed out, this means that the selected break is dependant on another break above it. You need to remove the break above this selected break first. See “Prioritizing multiple breaks” on page 299 for information on viewing the break priority in a block.
Setting display properties and page layout for breaks

When you first insert a break on data, certain display options are applied by default. You can edit these settings and set options for the following:

- Display properties – how the results display on the break
- Page layout properties – how the breaks display on the report page

Break display properties

You can set the following display properties for a break:

<table>
<thead>
<tr>
<th>Format option</th>
<th>When selected...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show break header</strong></td>
<td>A header is displayed for each part of the table, crosstab, or form when you insert a break. For example:</td>
</tr>
<tr>
<td></td>
<td><img src="header.png" alt="header" /></td>
</tr>
<tr>
<td><strong>Show break footer</strong></td>
<td>A footer is added after the last row for a table or column for a crosstab when you insert a break. When you apply a calculation to the data, the result is shown in the footer. For example:</td>
</tr>
<tr>
<td></td>
<td><img src="footer.png" alt="footer" /></td>
</tr>
<tr>
<td><strong>Remove duplicates</strong></td>
<td>Removes all duplicate values from the data in a table or crosstab when you insert a break. Each value is only shown once.</td>
</tr>
<tr>
<td></td>
<td><img src="remove_duplicates.png" alt="remove duplicates" /></td>
</tr>
<tr>
<td><strong>Center value across break</strong></td>
<td>Active when Remove Duplicates is selected. It merges empty cells and centers the value name over the merged cells.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Year</th>
<th>State</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2002</td>
<td>California</td>
<td>$2,762,660</td>
</tr>
<tr>
<td></td>
<td>Colorado</td>
<td>$768,390</td>
</tr>
<tr>
<td></td>
<td>Florida</td>
<td>$861,250</td>
</tr>
<tr>
<td>2002</td>
<td></td>
<td>Sum: $4,712,319</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Year</th>
<th>State</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2002</td>
<td>California</td>
<td>$2,762,660</td>
</tr>
<tr>
<td></td>
<td>Colorado</td>
<td>$768,390</td>
</tr>
<tr>
<td></td>
<td>Florida</td>
<td>$861,250</td>
</tr>
<tr>
<td>2002</td>
<td></td>
<td>Sum: $4,212,319</td>
</tr>
</tbody>
</table>

The year value on the break is centered across the table rows.
Using sections, breaks, and sorts

Using breaks to group data on tables

Break page layout properties

You can set the following page layout properties for breaks:

<table>
<thead>
<tr>
<th>Page layout property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start on a new page</strong></td>
<td>Displays each part of the table crosstab, or form created by a break on a new page.</td>
</tr>
<tr>
<td><strong>Avoid page breaks in blocks</strong></td>
<td>Where possible, keeps each break section on the same page. This option is not taken into account when a block is larger than one page.</td>
</tr>
<tr>
<td><strong>Repeat header</strong></td>
<td>Repeats the header at the top of the table on every new page when a table goes over onto a new page.</td>
</tr>
<tr>
<td><strong>Repeat footer</strong></td>
<td>Repeats the footer at the bottom of the table on every new page when a table goes over onto a new page.</td>
</tr>
<tr>
<td><strong>Repeat break value on a new page</strong></td>
<td>Repeats the current value on each new page.</td>
</tr>
</tbody>
</table>

**Defining display properties for a break**

To define display properties for a break:

1. Verify you are working in Report View.
   
   The *Edit Report* button is pressed in when you are working in Report View.

2. Right-click a cell in the column/row on which you have defined a break and select *Edit Format* on the menu.

3. The *Properties* tab appears, displaying a property group called *Breaks* which contains the break properties.

4. Set the break properties in the *Breaks* property group.
Using sorts to organize sections and data on tables

You can apply sorts to the results displayed in:
- section cells – to organize the order in which sections are displayed on a report
- tables – to organize the order in which results are displayed in a column or row

You can apply sorts to sections and tables. Sorting sections enables you to organize the section headers logically in a report. For example, if you have created sections on a report for each year, you can apply a descending sort so that the sections are organized with the most recent year as the first section and the earliest year at the end of the report. You apply sorts to any dimensions, measures, or details displayed on a table. Sorting dimensions and details helps you organize results chronologically, while sorting measures helps you see highest or lowest results at a glance.

Available sort orders

The following sort orders are available:

<table>
<thead>
<tr>
<th>Sort order</th>
<th>Description</th>
</tr>
</thead>
</table>
| Default    | This is sometimes referred to as the “natural” order. Depending on the type of data in the column or row, the results are sorted as follows:  
• ascending numeric order for numeric data  
• ascending chronological order for date  
• alphabetical order for alphanumeric data |
| Ascending  | When selected, results are arranged in ascending order: The smallest value at the top of the column moving to the highest value at the bottom. For example: 100, 200, 300 or California, Colorado, Florida. |
Using sections, breaks, and sorts

Using sorts to organize sections and data on tables

Applying ascending or descending sorts

To apply an ascending or descending sort
1. Select the section cell or table cells you want to sort.
2. Click the down arrow next to the Apply/Remove Sort button on the Report toolbar and then, select Ascending or Descending from the drop-down list.

Or
Select the Ascending or Descending option directly by clicking the Apply/Remove Sort button.

If the icon displays A-Z, the sort is ascending
If the icon displays Z-A, the sort is descending

Or
Choose Ascending or Descending from the drop-down list next to the Sorts > Sort property in the Properties panel.

To apply multiple sorts to the same table, repeat step 1. to step 2. For information about prioritizing the order of multiple sorts, see “Prioritizing the order of multiple sorts on the same table” on page 305 below.

Applying custom sorts

To apply a custom sort
1. Select the section cell or table cells you want to sort.
2. Click the down arrow next to the Apply/Remove Sort button on the Report toolbar then select Custom... from the drop-down list.
3. Select a value in the list of sorted values and click the Up and Down buttons to promote/demote it in the sort order.

Tip: To sort months in chronological order, apply the Default sort order.

<table>
<thead>
<tr>
<th>Sort order</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Descending</td>
<td>When selected, results are arranged in descending order: The highest value at the top of the column moving to the smallest value at the bottom. For example: 300, 200, 100 or Florida, Colorado, California.</td>
</tr>
<tr>
<td>Custom</td>
<td>You define your own sort order.</td>
</tr>
</tbody>
</table>

Descending
When selected, results are arranged in descending order: The highest value at the top of the column moving to the smallest value at the bottom.

For example: 300, 200, 100 or Florida, Colorado, California.

Custom
You define your own sort order.

Sort order
Description

Descending
When selected, results are arranged in descending order: The highest value at the top of the column moving to the smallest value at the bottom. For example: 300, 200, 100 or Florida, Colorado, California.

Custom
You define your own sort order.
4. To add an additional temporary value to the list of sorted values, type the value in the **Temporary Values** box, then click >> to add it to the sort list.

**Prioritizing the order of multiple sorts on the same table**

To prioritize the order of multiple sorts on the same table:

1. Verify that you are in Report View. The **Edit Report** button is pressed in when you are working in Report View.
2. Right-click the table and select **Edit Format** to display the Properties tab.
3. Click the ... button next to the **Sorts > Sort priority** property to display the Sorts dialog box.
4. Click **Vertical sorts** to display the vertical sorts or **Horizontal sorts** to display the horizontal sorts.
   - If the selected table is a vertical table, then all the sorts are applied to columns. These are called Vertical sorts.
   - If the selected table is a horizontal table, then all the breaks are applied to rows. These are called Horizontal sorts.
   - If the selected table is a crosstab, then sorts can be applied to rows or to columns. You can choose the priority for the Horizontal sorts and for the Vertical sorts.
5. Select the sort whose priority you want to change and click the Up/Down buttons to promote/demote it in the list of sorts.
Using sections, breaks, and sorts
Using sorts to organize sections and data on tables
Ranking Data
Overview

This chapter describes ranking data in Web Intelligence. Ranking allows you to isolate the top and bottom records in a set based on a variety of criteria. For example, if you have a block showing countries and associated revenues, ranking allows you to rank the data in the block to show the top 3 countries only, based on the revenue they generate.

Ranking allows you to answer business questions such as:

- Which 3 regions generate the most revenue?
- Which are the bottom 10% of stores in terms of revenue generation?
- What is the group of the best-performing stores that generates a combined revenue of up to $10,000,000?
- What is the group of the worst-performing stores that generates a combined revenue of up to 30% of the total revenue?

Web Intelligence allows you to rank data in many ways to answer these kinds of business questions. You can:

- rank the top and/or bottom \( n \) records by dimension (for example Country) based on the sum of a related measure (for example Revenue)
- rank the top and/or bottom \( n\% \) of the total number of records by dimension based on the value of a related measure as a percentage of the total value of the measure
- rank the top and/or bottom \( n \) records by dimension based on the cumulative sum of a related measure
- rank the top and/or bottom \( n \) records by dimension based on the value of a related measure as a cumulative percentage of the total value of the measure

Ranking workflows

There are two ways of ranking data in Web Intelligence. You can:

- create a ranking by using the Web Intelligence interface
- use the \texttt{Rank()} function to return a ranking value

This chapter explains how to create a ranking using the Web Intelligence interface. For more information on the \texttt{Rank()} function, see Chapter 21: Web Intelligence functions on page 307 or the Web Intelligence online help.

Note: When you create a ranking using the interface, Web Intelligence uses the \texttt{Rank()} function behind the scenes to assign ranking values.
Creating a ranking using the Web Intelligence interface

When you rank the data in a block by using the Web Intelligence interface, you tell Web Intelligence to sort and filter the data in the block according to the rank. For example, if you rank the top 3 countries in a block by revenue, Web Intelligence sorts the countries in descending order by revenue, then filters the block to remove all countries other than the 3 with the highest revenue.

To create a rank using the Web Intelligence interface
1. Select the block that you want to rank.
2. Click Rank.
   The Create Rank dialog box appears.

3. Click Top and select the number of records if you want to rank the highest records in the block.
4. Click Bottom and select the number of records if you want to rank the lowest records in the block.
5. Select the measure on which the ranking is based in the Based on list.
6. Click For Each and select the dimension on which the ranking is based if you want to rank on a particular dimension rather than all dimensions in the block.
7. Select the rank calculation mode in the Calculation mode list.
8. Click OK.
## Ranking parameters

The following table describes the parameters that you set in a ranking and how they affect the rank:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top/bottom</td>
<td>When the calculation mode is <strong>Count</strong>, the ranking returns the top/bottom ( n ) records based on the measure specified in the <strong>Based on</strong> parameter. For example, the top 3 countries by revenue generated, the bottom 3 year/quarter combinations by revenue generated. When the calculation mode is <strong>Percentage</strong>, the ranking returns the top/bottom ( n% ) of the total number of records based on the measure specified in the <strong>Based on</strong> parameter. For example, if there are 100 records and you rank the top 10%, the ranking returns the top 10 records. When the calculation mode is <strong>Cumulative Sum</strong>, the ranking returns the top/bottom records for which the cumulative sum of the measure specified in <strong>Based on</strong> does not exceed ( n ). When the calculation mode is <strong>Cumulative Percentage</strong>, the ranking returns the top/bottom records for which the cumulative sum of the measure specified in <strong>Based on</strong> does not exceed ( n% ) of the total of the measure.</td>
</tr>
<tr>
<td>n/n%</td>
<td>When the calculation mode is <strong>Count</strong> - the number of records to retrieve based on the measure. When the calculation mode is <strong>Percentage</strong> - the percentage of records to retrieve based on the measure. When the calculation mode is <strong>Cumulative Sum</strong> - the cumulative sum that the measure must not pass. When the calculation mode is <strong>Cumulative Percentage</strong> - the cumulative sum of the measure, represented as a percentage of the total, that the measure must not pass.</td>
</tr>
<tr>
<td>Based on</td>
<td>The measure on which the ranking is based.</td>
</tr>
</tbody>
</table>
Ranking examples

In the following examples, you have a dimension, Region, and a measure, Revenue, which give the following values:

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
<th>% of Total Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>South East</td>
<td>1,000,000</td>
<td>7%</td>
</tr>
<tr>
<td>South West</td>
<td>2,000,000</td>
<td>13%</td>
</tr>
<tr>
<td>North East</td>
<td>3,000,000</td>
<td>20%</td>
</tr>
<tr>
<td>North West</td>
<td>4,000,000</td>
<td>24%</td>
</tr>
<tr>
<td>Central</td>
<td>5,000,000</td>
<td>33%</td>
</tr>
</tbody>
</table>

**Example: Rank the top 3 regions by revenue generated**

To perform this ranking you set the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top/Bottom</td>
<td>Top</td>
</tr>
<tr>
<td>n/n%</td>
<td>3</td>
</tr>
<tr>
<td>For Each</td>
<td>Region (or unspecified because region is the only dimension in the block and therefore the default ranking dimension)</td>
</tr>
<tr>
<td>Based on</td>
<td>Revenue</td>
</tr>
<tr>
<td>Calculation mode</td>
<td>Count</td>
</tr>
</tbody>
</table>
This ranking gives the following result:

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2005</td>
<td>5,000,000</td>
</tr>
<tr>
<td>2004</td>
<td>4,000,000</td>
</tr>
<tr>
<td>2003</td>
<td>3,000,000</td>
</tr>
</tbody>
</table>

To calculate this ranking, Web Intelligence:
• sorts the records in descending order
• displays the top 3 records

Example: Rank the bottom 40% of regions by revenue

To perform this ranking you set the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top/Bottom</td>
<td>Bottom</td>
</tr>
<tr>
<td>n/n%</td>
<td>40%</td>
</tr>
<tr>
<td>For Each</td>
<td>Region</td>
</tr>
<tr>
<td>Based on</td>
<td>Revenue</td>
</tr>
<tr>
<td>Calculation mode</td>
<td>Percentage</td>
</tr>
</tbody>
</table>

This ranking gives the following result:

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>South East</td>
<td>1,000,000</td>
</tr>
<tr>
<td>South West</td>
<td>2,000,000</td>
</tr>
</tbody>
</table>

To calculate this ranking, Web Intelligence:
• sorts the records in ascending order
• works through the records until 40% of the total number of records are displayed

Example: Rank the top regions whose cumulative revenue is less than or equal to 10,000,000
To perform this ranking you set the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top/Bottom</td>
<td>Top</td>
</tr>
<tr>
<td>n/n%</td>
<td>10,000,000</td>
</tr>
<tr>
<td>For Each</td>
<td>Region</td>
</tr>
<tr>
<td>Based on</td>
<td>Revenue</td>
</tr>
<tr>
<td>Calculation mode</td>
<td>Cumulative sum</td>
</tr>
</tbody>
</table>

This ranking gives the following result:

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>5,000,000</td>
</tr>
<tr>
<td>North West</td>
<td>4,000,000</td>
</tr>
</tbody>
</table>

To calculate this ranking, Web Intelligence:
- sorts the records in descending order
- works through the records until it reaches the record that causes the the cumulative total of the measure to pass 10,000,000
- includes those records that do not cause the cumulative total to pass 10,000,000

**Example:** Rank the bottom regions whose cumulative revenue is less than or equal to 30% of the total revenue

To perform this ranking you set the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top/Bottom</td>
<td>Bottom</td>
</tr>
<tr>
<td>n/n%</td>
<td>30%</td>
</tr>
<tr>
<td>For Each</td>
<td>Region</td>
</tr>
<tr>
<td>Based on</td>
<td>Revenue</td>
</tr>
<tr>
<td>Calculation mode</td>
<td>Cumulative percentage</td>
</tr>
</tbody>
</table>

This ranking gives the following result:

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>South East</td>
<td>1,000,000</td>
</tr>
<tr>
<td>South West</td>
<td>2,000,000</td>
</tr>
</tbody>
</table>
To calculate this ranking, Web Intelligence:
- sorts the records in ascending order
- works through the records until it reaches the record that causes the cumulative total of the measure, expressed as a percentage of the overall total of the measure, to exceed 30%
- displays those records that do not cause the cumulative percentage to pass 30%

---

**Ranking and sorts**

Web Intelligence sorts data as part of applying a ranking. For example, if you rank the top 3 stores by revenue, Web Intelligence sorts the stores in descending order by revenue generated.

The sorts that Web Intelligence applies in rankings take precedence over sorts that you have previously applied to your data. For example, if you have previously sorted the list of stores in alphabetical order, Web Intelligence overrides this sort when applying the ranking.

**Tied rankings**

Web Intelligence assigns equal ranking values to tied rankings and pushes back the ranking values of the rows after the tie. This means that a bottom $n$ ranking can return more than $n$ records.

**Example: Top and bottom tied rankings**

The following table shows a tied ranking. The Top 3 ranking column shows how Web Intelligence ranks these records in a top 3 ranking; the Bottom 3 Ranking column shows how Web Intelligence ranks these records in a bottom 3 ranking.

<table>
<thead>
<tr>
<th>Dimension</th>
<th>Measure</th>
<th>Top 3 Ranking</th>
<th>Bottom 3 Ranking</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>10</td>
<td>4</td>
<td>1</td>
</tr>
<tr>
<td>B</td>
<td>20</td>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>C</td>
<td>30</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td>D</td>
<td>30</td>
<td>1</td>
<td>3</td>
</tr>
</tbody>
</table>

In each case Web Intelligence includes records up to and including rank 3. This results in the following for a top 3 ranking:
It results in the following for a bottom 3 ranking:

<table>
<thead>
<tr>
<th>Dimension</th>
<th>Measure</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>10</td>
</tr>
<tr>
<td>B</td>
<td>20</td>
</tr>
<tr>
<td>C</td>
<td>30</td>
</tr>
<tr>
<td>D</td>
<td>30</td>
</tr>
</tbody>
</table>

**Ranking and data order**

You cannot rank on an object whose values depend on the data order. This is because the ranking changes the data order, which in turn changes the object data, which then requires Web Intelligence to recalculate the ranking. The result is a circular dependency between the ranking and the object that Web Intelligence cannot resolve.

If you create a rank on a measure whose values depend on the data order, for example a measure that uses the `Previous()` function or any of the running aggregate functions such as `RunningSum()`, Web Intelligence displays the #RANK error message in all cells in the block.
Ranking Data

Ranking workflows
Filtering the values displayed in reports
Overview

This chapter tells you how you can filter the data displayed in Web Intelligence reports to focus on the information that interests you for a specific business purpose. You do this by applying report filters.

This chapter explains how:

• report filters work
• you create report filters
• you combine multiple filters on a single report
• you view the filters applied to a report
• you edit and remove report filters
How report filters work

You can filter reports to limit the results that are displayed to specific information that interests you. For example, you can limit the displayed results to information for a specific customer or a sales period. The data you filter out remains within the Web Intelligence document; it is simply not displayed in the report tables or charts. This means you can change or remove report filters in order to view the hidden values, without modifying the query definition behind the document. You can apply different filters to different parts of a report. For example, you can limit the results in the entire report to a specific product line and then limit results in a table or chart further to focus on results for a specific region or customer profile.

**Example:** Using report filters to focus on different information on the tables and charts on a single report

You want to display results for all product lines in the state of **California**, where you have recently started doing business. You want to view results for the accessories product line in all states, to decide in which state you need to carry out a promotional campaign to increase sales. In the same report you filter the table for product line, so that only results for the **Accessories** product line are displayed, and you filter the chart for state, so that only results for California are displayed.
What makes up a report filter?

To create a report filter, you need to specify three elements:

- a filtered object
- an operator
- a value(s)

For example, to display data only for the year 2003, you define the following filter on the dimension [Year]:

- a filtered object: [Year]
- an operator: Equal to
- a value: 2003

When you refresh the data to apply the new filter to the report, Web Intelligence applies the operator to the filtered object and displays the results that correspond to the value(s) you specified.

You can filter multiple dimensions and measures in a report. For example, you can create another filter on the [Sales revenue] measure to focus the results displayed on the report to sales revenue totals that are higher than a specific company target:

- a filtered object: [Sales revenue]
- an operator: Greater than or equal to
- a value: 300000

When you refresh the data again, Web Intelligence displays the information that corresponds to the filter(s).
This report shows sales results greater than or equal to $300,000 during the year 2003.

The Report Filters pane is shown. The pane displays the filters applied to the report.

The filtered report.

What objects can I filter?

You can define filters on any of the dimension, measure, details, and variables listed on the Data tab of the document.
For example, you can filter the [Year] dimension to return values for a specific year, filter the [Revenue] measure to return values for a range of revenue figures, or filter the [Postal Code] detail to return values for a specific postal area. For an illustrated description and examples of dimensions and details, see "What types of objects can you use in a query?" on page 43.

### Which operator should I choose?

It is important to understand the effect of each operator available to you when you define a filter. The table below lists the operators available for report filters and provides an example of each operator in the context of a business question:

<table>
<thead>
<tr>
<th>To obtain data that...</th>
<th>for example to...</th>
<th>select this operator...</th>
<th>to create this filter...</th>
</tr>
</thead>
<tbody>
<tr>
<td>is equal to a value you specify,</td>
<td>retrieve data for the US only,</td>
<td>Equal to</td>
<td>[Country] Equal to US.</td>
</tr>
<tr>
<td>is different from a value you specify,</td>
<td>retrieve data for all quarters except Q4,</td>
<td>Different from</td>
<td>[Quarter] Different from Q4</td>
</tr>
<tr>
<td>is greater than a value you specify,</td>
<td>retrieve data for customers aged over 60,</td>
<td>Greater than</td>
<td>[Customer Age] Greater than 60</td>
</tr>
<tr>
<td>is greater than or equal to a value you specify,</td>
<td>retrieve data for stores where the sales floor size is 4,000 Sq. ft. or more,</td>
<td>Greater than or equal to</td>
<td>[Sales Floor Size Group] Greater than or equal to 4000</td>
</tr>
<tr>
<td>is lower than a value you specify,</td>
<td>retrieve data for exam grades below 40,</td>
<td>Less than</td>
<td>[Exam Grade] Less than 40</td>
</tr>
<tr>
<td>is lower than or equal to a value you specify,</td>
<td>customers whose age is 30 or less,</td>
<td>Less than or equal to</td>
<td>[Age] Less than or equal to 30</td>
</tr>
<tr>
<td>falls between two values you specify and includes those two values,</td>
<td>weeks starting at week 25 and finishing at 36 (includes week 25 and week 36),</td>
<td>Between</td>
<td>[Weeks] Between 25 and 36</td>
</tr>
</tbody>
</table>
Filtering the values displayed in reports

**How report filters work**

<table>
<thead>
<tr>
<th>To obtain data that...</th>
<th>for example to...</th>
<th>select this operator...</th>
<th>to create this filter...</th>
</tr>
</thead>
<tbody>
<tr>
<td>falls outside two given values you specify,</td>
<td>all the weeks of the year, except for weeks 25 through 36 (week 25 and week 36 are not included),</td>
<td><strong>Not between</strong></td>
<td>[Weeks] Not Between 25 and 36</td>
</tr>
<tr>
<td>is the same as several values you specify,</td>
<td>you only want to retrieve data for the following countries: the US, Japan, and the UK,</td>
<td><strong>In list</strong></td>
<td>[Country] In list ‘US, Japan, UK’</td>
</tr>
<tr>
<td>is different from the multiple values you specify,</td>
<td>you don’t want to retrieve data for the following countries: the US, Japan, and the UK,</td>
<td><strong>Not in list</strong></td>
<td>[Country] Not in list ‘US, Japan, UK’</td>
</tr>
<tr>
<td>for which there is no value entered on the database,</td>
<td>customers without children (the children column on the database has no data entry),</td>
<td><strong>Is null</strong></td>
<td>[Children] Is null</td>
</tr>
<tr>
<td>for which a value was entered on the database,</td>
<td>customers with children (the children column on the database has a data entry),</td>
<td><strong>Is not Null</strong></td>
<td>[Children] Is not Null</td>
</tr>
</tbody>
</table>

**Note:** If you are building filters on the query, more operators are available. See “Which operator should I choose?” on page 322.
**How do I specify the value(s)?**

When you define report filters, you need to specify the value(s) you want to display in the report. For example, if you want to limit the displayed data to data for one or more countries, the value(s) you define will be the names of specific countries, such as the US and Japan.

There are two ways you can define the values for a filter using the Java Report Panel:

- Type the value yourself – this is called a constant
- Ask Web Intelligence to prompt you with the list of values present on the database so that you can select the values you want to display

The following table gives examples of when it is more efficient to type a constant or select value(s) from list:

<table>
<thead>
<tr>
<th>If...</th>
<th>for example...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>the list of values on the dimension or detail you are filtering is long and you are sure of how to spell the value you want to filter;</td>
<td>names of months or numbers for specific years,</td>
<td>type a constant.</td>
</tr>
<tr>
<td>you are not sure how to spell the value(s) you want to filter;</td>
<td>customer names or product lines, which can change frequently and include unusual spellings,</td>
<td>select Value(s) from list.</td>
</tr>
</tbody>
</table>

**How many filters can I include in a report?**

You can include one or multiple filters in a single Web Intelligence report. Using the Java Report Panel, you can apply filters at three levels within a report:

- the entire report
- sections and subsections
- tables, charts, and forms
**Example:** Using filters to compare sales revenue for Colorado and average sales revenue across all US states

In this example, you are a sales manager for Colorado. You want to analyze year 2003 sales revenue results by product line for Colorado and compare those results with the average sales revenue for all US states. You only want to focus on product lines that generated more than $1M. To create a report that shows this information, you define filters on the following parts of a report:

- **Report:** you filter the [Year] dimension to retrieve values for 2003
- **A section for the [Product Line] dimension, which includes two tables:** you filter the section to retrieve product line data for lines where sales revenue was more that $1M
- **Table 1:** you filter the [State] dimension to retrieve values for Colorado
- **Table 2:** you don’t apply any filters, but you replace the Sales revenue measure with a formula that calculates the average revenue for all US states:

\[
=\text{Average}(\text{[Sales revenue]} \text{ In} \ (\text{[Lines]};\text{[Category]};\text{[Quarter]};\text{[State]})) \text{ ForAll([State])}
\]

This gives you the following report, which lets you compare how Colorado rates compared to the state average:

![Report Example](image)

The filters are listed in the Filters sub-tab on the Properties tab. To find out how to apply filters to each of the elements in a report, see "Creating custom report filters" on page 327.
The difference between query filters and report filters

Web Intelligence allows you to apply filters at two levels within a single document:

- the query definition – this is the data defined in Query View, retrieved from the data source, and returned to the Web Intelligence document
- the data displayed in the report – this is a subset of the data in the query definition that is displayed on a specific report within the document

Filters you apply to the query definition are called query filters. Query filters decrease the time it takes to run the reports in the document and limit the size of the document to the data relevant to the users who consult it.

Filters you apply to the data displayed in the report are called report filters. You use report filters to limit the values displayed in the reports within a document. You can filter each report to display a different subset of the same data.

The data hidden by the report filters is still saved with the Web Intelligence document. You can modify the report filters to display different data in the report or remove the report filters altogether without modifying the query.

Tip: Filtering the query minimizes the size of Web Intelligence documents, minimizes the time it takes to refresh report data, and ensures that the data the documents contain is relevant to users consulting the reports.

For more information about using query filters, see “How query filters work” on page 107.
Creating custom report filters

You define custom filters on reports, sections, or blocks to limit the displayed values to the values essential for a specific business focus. The filters only affect the values displayed in the specific report, section, or block.

The data hidden by the report filters is still saved with the Web Intelligence document. You can modify the report filters to display different data in the report or remove the report filters altogether to display all the data defined in the query.

You can define custom report filters two ways:

• Using the Quick Filter option – allows you to quickly select one or multiple values you want to display in a specific section or block on the report
• Using the Filter Editor – allows you to select from many operators and to apply filters to an entire report or to specific sections or blocks on the report

Creating a custom filter using the quick filter option

To create a custom filter using the quick filter option:

1. Make sure you are in Report View.
   The Edit Report button is pressed in when you are working in Report View.
2. Click the report tab of the report you want to filter.
3. If you want to filter a block (that is, a table, chart, or form), then click the top edge of the block to select it.
   Or
   If you want to filter a section, and not just the section cell, click View Structure and then select either the start section or end section divider.
Filtering the values displayed in reports

Creating custom report filters

4. Click the **Add Quick Filter** button on the Report toolbar.
   The List of Values dialog box appears. The values for the selected section or block are listed.

5. Select the value(s) you want to display in the section or block.
   For example, to filter the sections for values in Q3 and Q4, select the section header displaying the quarters, then select Q3 and Q4 from the list of values, by clicking Q3 and then clicking Q4.

6. Click **OK**.
   The selected section or block only displays values that correspond to the value you selected.
   You can apply multiple filters to the same report. See "**Applying multiple filters to a report**" on page 333. For information about editing and removing report filters, see "**Editing and removing report filters**" on page 336.
Creating a custom filter using the Filter Editor

To create a custom filter using the Filter Editor:

1. Make sure you are in Report View.
   The Edit Report button is pressed in when you are working in Report View.
2. Click the report tab of the report you want to filter.
   The report is displayed in the Document zone.
3. On the Report toolbar, click the Show/Hide Filter Pane button to display the Report Filters pane.
4. Select the part of the report you want to filter.
   For example, if you want to filter a table so that it only displays sales revenue figures over $1M, select the table block.

<table>
<thead>
<tr>
<th>Lines</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>$9,914,546</td>
</tr>
<tr>
<td>City Skirts</td>
<td>$3,477,775</td>
</tr>
<tr>
<td>City Trousers</td>
<td>$2,647,334</td>
</tr>
<tr>
<td>Dresses</td>
<td>$2,915,620</td>
</tr>
<tr>
<td>Jackets</td>
<td>$877,616</td>
</tr>
<tr>
<td>Leather</td>
<td>$167,413</td>
</tr>
<tr>
<td>Outerwear</td>
<td>$1,183,083</td>
</tr>
<tr>
<td>Overcoats</td>
<td>$426,268</td>
</tr>
<tr>
<td>Skirt Waist</td>
<td>$4,018,220</td>
</tr>
<tr>
<td>Sweaters</td>
<td>$2,839,035</td>
</tr>
<tr>
<td>Sweat-T-Shirts</td>
<td>$125,79,831</td>
</tr>
<tr>
<td>Trousers</td>
<td>$603,320</td>
</tr>
</tbody>
</table>

The following table will help you select the specific part of the report:

<table>
<thead>
<tr>
<th>For example, if...</th>
<th>select...</th>
</tr>
</thead>
<tbody>
<tr>
<td>the entire report is filtered for a single Country or Year and you want to edit these filters,</td>
<td>the report</td>
</tr>
<tr>
<td>a report section is filtered for Country or Product Line and you want to edit these filters,</td>
<td>the section</td>
</tr>
<tr>
<td>a table, chart, or form is displaying City or Customer names is filtered,</td>
<td>the table, chart, or form</td>
</tr>
</tbody>
</table>
The Report Filters pane displays the name of the selected part of the report. For example, if you select a table, the Report Filter pane displays the name of the selected table.

By default, Web Intelligence gives each block the following name: block followed by a number (for example, Block1, Block2, Block3, and so on). To make it easier to select blocks for positioning and formatting you can give blocks meaningful names (for example, Crosstab: Monthly Sales, Pie Chart: Annual Hires, and so on). For information on how to name blocks, see “Renaming report blocks” on page 360.

5. In the Data tab, select the object you want to filter.
   For example, if the section displays names of product lines and you want to display data for specific states in this section of the report, select the [Line] dimension.
6. Drag the selected object onto the Report Filters pane. The Filter Editor appears. The name of the object you selected is displayed below Filtered Object.

7. Select the operator.
Refer to "Which operator should I choose?" on page 322.

8. Select Constant or Value(s) from list.
The following table will help you decide which to choose:

<table>
<thead>
<tr>
<th>If...</th>
<th>for example...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>the values on the dimension, measure, or detail you are filtering do not change often and you are sure of how to spell the value you want to filter;</td>
<td>names of months or numbers for specific years,</td>
<td>type a constant.</td>
</tr>
<tr>
<td>the data on the dimension or detail you are filtering is updated frequently or you are not sure how to spell the value(s) you want to filter;</td>
<td>customer names or product lines, which can change frequently and include unusual spellings,</td>
<td>select Value(s) from list.</td>
</tr>
</tbody>
</table>

When you define filters on measures or variables, you cannot select value(s) from the list of values; you need to type a constant(s).
9. The next step depends on whether you selected **Constant** or **Value**:

<table>
<thead>
<tr>
<th>If you selected Constant...</th>
<th>If you selected Value...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the value(s), you want to retrieve, in the <strong>Constant</strong> box.</td>
<td>Select the value(s), you want to retrieve, from the displayed List of Values and add them to the <strong>Values Selected</strong> box, by clicking the &gt;&gt; button.</td>
</tr>
<tr>
<td>Depending on the operator you selected, type a single value:</td>
<td>Depending on the operator you selected, select one value:</td>
</tr>
</tbody>
</table>

...or type two values:

...or select multiple values:

To select values from a list quickly, you can double-click each value or select multiple values by holding the **Ctrl** key down while you select each value, and then click the >> arrow.

10. Click **OK** to confirm the filter definition.

The selected report, section, or table, chart, or form displays only the values you specified in the custom filter.

You can apply multiple filters to the same report. See “Applying multiple filters to a report” on page 333. See “Editing and removing report filters” on page 336.
Applying multiple filters to a report

You can apply multiple filters to a report, section, or block of data in a report.

1. **Combining multiple filters on a report**
   To combine filters on a report:
   
   1. Create each filter.

   See “Creating custom report filters” on page 327. By default Web Intelligence combines all the filters with the And operator.

<table>
<thead>
<tr>
<th>Report Filters Applied to Crosstab</th>
</tr>
</thead>
<tbody>
<tr>
<td>And</td>
</tr>
<tr>
<td>Year Equal to: 2003</td>
</tr>
<tr>
<td>Quarter Equal to: Q1</td>
</tr>
</tbody>
</table>

   2. You can leave the And operator or change the operator to Or.

   This table explains the difference between the And and the Or operators:

<table>
<thead>
<tr>
<th>You want to retrieve...</th>
<th>for example...</th>
<th>select...</th>
</tr>
</thead>
<tbody>
<tr>
<td>data true for both filters,</td>
<td>customers who ordered supplies in Q1 and who are based in the US (the data you retrieve will include: US customers who placed orders in Q1).</td>
<td>And</td>
</tr>
<tr>
<td>data true for any one of the filters,</td>
<td>customers who ordered supplies in: Q1 or who are based in the US (the data you retrieve will include: worldwide customers who placed orders in Q1and US customers who placed orders during any quarter).</td>
<td>Or</td>
</tr>
</tbody>
</table>

   If necessary, change the operator to Or, by double-clicking the And operator.

<table>
<thead>
<tr>
<th>Report Filters Applied to Crosstab</th>
</tr>
</thead>
<tbody>
<tr>
<td>Or</td>
</tr>
<tr>
<td>Year Equal to: 2003</td>
</tr>
<tr>
<td>Quarter Equal to: Q1</td>
</tr>
</tbody>
</table>

   Or now displays as the operator.
Viewing the filters applied to the report

You can view the filters applied a report to understand

► **Viewing the filters on the entire report**

To view all the filters on a report:

1. Make sure you are in Report View.
   
   The **Edit Report** button is pressed in when you are working in Report View.

2. Click on the area of the report for which you want to see filters.
   
   For example, if you want to see how the report is filtered, click an empty area of the report background. If you want to see how a section, table, or chart is filtered, click the section, table, or chart.

3. Click the **Properties** tab, then click the **Filters** sub-tab.
   
   The filters are listed here.

For information on how to edit or remove the filters on a report, see "Editing and removing report filters" on page 336.

► **Viewing the filters on a table, chart, or section**

To view the filters on a table, chart, or section:

1. Make sure you are in Report View.
   
   The **Edit Report** button is pressed in when you are working in Report View.

You can view filters in either Results View or Structure View. If you want to view filters on a section, however, we recommend you work in Structure View in order to view the section dividers or each section. This will make it easier for you to select a specific section of the report. To work in Structure View, click **View Structure**. To work in Results View, click **View Results**. For a full description of Results and Structure View, see “Working in Structure or Results View” on page 169.
2. Click the area of the report for which you want to view filters.
   To view the filters applied to a section, make sure you select the section divider not the section header.
   If any filters are applied to the select area the filters icon appears.

   ![Filter icon]

   In this example, the report is displayed in Structure View. A section is selected. The selected section divider is highlighted.

3. Place your pointer on the filter icon.
   The pointer becomes a hand.

   ![Filter icon]

4. Click the Filter icon.
   The Filter sub-tab appears in the left frame of the report panel. The filters are listed.
Editing and removing report filters

You can edit or remove any of the filters applied to the reports in a document.

**Editing report filters**

To edit a report filter:

1. Make sure you are working in Report View.
   
   The **Edit Report** button is pressed in when you are in Report View.

2. Make sure the Report Filters pane is visible.

   If the Report Filters pane is not displayed, click the **Show/Hide Filter Pane** button on the Report toolbar to display the Report Filters pane.

3. Click the area of the report for which you edit the filters.

   For example, a section, a table or chart, or the report background if you want to view filters applied to the report.

   The filters on the selected area display in the **Report Filters** pane.

4. Double-click the filter you want to edit.

   ![Filter Editor](image)

   The Filter Editor appears. The name of the filtered object is listed under Filtered Object.

   ![Editing Report Filters](image)

   You edit the operator and operand type here.

   For full information on how to define the filter properties see "Creating a custom filter using the Filter Editor" on page 329.
Removing report filters

To remove a report filter:

1. Make sure you are working in Report View.
   The Edit Report button is pressed in when you are in Report View.

2. Make sure the Report Filters pane is visible.
   If the Report Filters pane is not displayed, click the Show/Hide Filter Pane button on the Report toolbar to display the Report Filters pane.

3. Click the Data tab.
   If the Data tab is not displayed, click the Show/Hide Manager button on the Edit Report toolbar to show all the Report Manager tabs.

4. Click the area of the report from which you want to remove the filters.
   For example, a section, a table or chart, or the report background if you want to view filters applied to the report.
   The filters on the selected report, section, or block display in the Report Filters pane.

5. Select the filter you want to remove and drag it onto the Data tab.

6. If you are working in Structure View, click the View Results button.
   Web Intelligence removes the filter from the report and recalculates the results.
Filtering the values displayed in reports

Editing and removing report filters
Using standard calculations
Overview

This chapter describes how you can insert standard business calculations in a Web Intelligence report.

It covers the following areas:

• the standard calculations that are available in Web Intelligence
• how to insert a calculation into a table or crosstab
• how to insert multiple calculations
• how to remove calculations from a table or crosstab
Working with standard calculations

You can use standard calculation functions to make quick calculations on the data in Web Intelligence reports. These calculations are available from the Calculations list on the Report toolbar. You can customize functions and formulas to apply more advanced calculations on your data. For information on using custom calculations and formulas, see the chapter “Creating custom calculations” on page 401. This section describes how you can insert standard calculations on tables and crosstabs. It also describes how you can insert multiple calculations.

What standard calculations are available?

You can use the following standard calculations in Web Intelligence reports:

<table>
<thead>
<tr>
<th>Calculation type</th>
<th>Icon</th>
<th>Use to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sum</td>
<td>∑</td>
<td>Calculate the sum of the selected data.</td>
</tr>
<tr>
<td>Count</td>
<td>n</td>
<td>Count all rows for a measure object or count distinct rows for a dimension or detail object.</td>
</tr>
<tr>
<td>Average</td>
<td>✔</td>
<td>Calculate the average of the selected data.</td>
</tr>
<tr>
<td>Minimum</td>
<td>▼</td>
<td>Display the minimum value of the selected data.</td>
</tr>
<tr>
<td>Maximum</td>
<td>▼</td>
<td>Display the maximum value of the selected data.</td>
</tr>
<tr>
<td>Percentage</td>
<td>%</td>
<td>Display the selected data as a percentage of the total. The results of the percentage are displayed in an additional column or row of the table.</td>
</tr>
</tbody>
</table>

Note: Percentages are calculated for the selected measure compared to the total results for that measure on the table or break. To calculate the percentage of one measure compared to another measure, you need to build a custom calculation. See “Creating custom calculations” on page 401.
Inserting calculations in tables and crosstabs

You can insert a calculation in a table or crosstab. You use the same method to insert a calculation in both Results View and Structure View.

Inserting a calculation in a table or crosstab

To insert a calculation in a table or crosstab:

1. Verify that you are in Report View.
2. Click a cell that contains data in the table or cross tab. You want a calculation to apply to all the data in this column.
3. To insert a Sum, click Sum on the report panel toolbar.
   Or
   To insert other calculations, click the down arrow next to the Sum icon on the report panel toolbar.
   The calculation drop-down list appears.

   ![Drop-down list showing available calculations](image)

4. Select the calculation that you want to apply to the data in the column.
   If you insert the calculation into a vertical table, the calculation is applied to the column values.
A new row is added at the bottom of the table. This row is called a footer. The aggregated value appears in the new row cell.

<table>
<thead>
<tr>
<th>State</th>
<th>Year</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>California</td>
<td>2001</td>
<td>$170421</td>
</tr>
<tr>
<td>California</td>
<td>2002</td>
<td>$279228</td>
</tr>
<tr>
<td>California</td>
<td>2003</td>
<td>$3962879</td>
</tr>
<tr>
<td>Colorado</td>
<td>2001</td>
<td>$448300</td>
</tr>
<tr>
<td>Colorado</td>
<td>2002</td>
<td>$768906</td>
</tr>
<tr>
<td>Colorado</td>
<td>2003</td>
<td>$643504</td>
</tr>
<tr>
<td>DC</td>
<td>2001</td>
<td>$530271</td>
</tr>
<tr>
<td>DC</td>
<td>2002</td>
<td>$1545126</td>
</tr>
<tr>
<td>DC</td>
<td>2003</td>
<td>$1953581</td>
</tr>
<tr>
<td>Florida</td>
<td>2001</td>
<td>$405982</td>
</tr>
<tr>
<td>Florida</td>
<td>2002</td>
<td>$661256</td>
</tr>
<tr>
<td>Florida</td>
<td>2003</td>
<td>$6119554</td>
</tr>
<tr>
<td>Illinois</td>
<td>2001</td>
<td>$738224</td>
</tr>
<tr>
<td>Illinois</td>
<td>2002</td>
<td>$1155685</td>
</tr>
<tr>
<td>Illinois</td>
<td>2003</td>
<td>$1340825</td>
</tr>
<tr>
<td>Massachusetts</td>
<td>2001</td>
<td>$288815</td>
</tr>
<tr>
<td>Massachusetts</td>
<td>2002</td>
<td>$157719</td>
</tr>
<tr>
<td>Massachusetts</td>
<td>2003</td>
<td>$207189</td>
</tr>
<tr>
<td>New York</td>
<td>2001</td>
<td>$1657294</td>
</tr>
<tr>
<td>New York</td>
<td>2002</td>
<td>$769560</td>
</tr>
<tr>
<td>New York</td>
<td>2003</td>
<td>$191025</td>
</tr>
<tr>
<td>Texas</td>
<td>2001</td>
<td>$2198577</td>
</tr>
<tr>
<td>Texas</td>
<td>2002</td>
<td>$3732088</td>
</tr>
<tr>
<td>Texas</td>
<td>2003</td>
<td>$4198596</td>
</tr>
<tr>
<td><strong>Sum:</strong></td>
<td></td>
<td><strong>$3687312.4</strong></td>
</tr>
</tbody>
</table>

**Note:** If you insert a percentage calculation, the results of the percentage are displayed in an additional column or row of the table.

If you are Structure View, the calculation applies to the column definition. The definition for the calculation appears in the new cell.

<table>
<thead>
<tr>
<th>-NameOf(Year)</th>
<th>-NameOf(State)</th>
<th>-NameOf(Sales revenue)</th>
</tr>
</thead>
<tbody>
<tr>
<td>#Year</td>
<td>#State</td>
<td>#Sales revenue</td>
</tr>
<tr>
<td><strong>Sum:</strong></td>
<td></td>
<td><strong>Sum(Sales revenue)</strong></td>
</tr>
</tbody>
</table>

**Note:** You can create a break on a dimension to better organize the data. When you split up the table by separating out a dimension, for example Year, the data is reorganized based on the new grouping. The calculation is adjusted, and the total is re-calculated using the remaining dimensions within each new Year group. You now have a revenue total for each year group. See “Using sections, breaks, and sorts” on page 281.
Inserting multiple calculations

You can insert multiple calculations in a table or crosstab. When you apply two calculations to a table or crosstab, a footer is added for each calculation result. You insert multiple calculations in a table or crosstab in the same way that you insert one calculation, but you repeat the procedure for as many calculations as you want to insert.

► Inserting multiple calculations in a table or crosstab

To insert multiple calculations in a table or crosstab:

1. Verify that you are in Report View.
2. If you are in Results View, click a cell in the table or crosstab.
   Or
   If you are in Structure View, click an object in the table or crosstab.
3. Click the down arrow next to the Sum icon on the Report toolbar.
   The calculation drop-down list appears.
4. Select a calculation.
5. Repeat steps 2. to 4. for each calculation that you want to apply.

The table below shows both a sum and average on Sales revenue.

<table>
<thead>
<tr>
<th>Year</th>
<th>State</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2003</td>
<td>California</td>
<td>$290,287.91</td>
</tr>
<tr>
<td>2003</td>
<td>Colorado</td>
<td>$164,505.64</td>
</tr>
<tr>
<td>2003</td>
<td>DC</td>
<td>$1,025,238.1</td>
</tr>
<tr>
<td>2003</td>
<td>Florida</td>
<td>$311,924</td>
</tr>
<tr>
<td>2003</td>
<td>Illinois</td>
<td>$13,340,995</td>
</tr>
<tr>
<td>2003</td>
<td>Massachusetts</td>
<td>$327,165</td>
</tr>
<tr>
<td>2003</td>
<td>New York</td>
<td>$341,050,032</td>
</tr>
<tr>
<td>2003</td>
<td>Texas</td>
<td>$130,503,098</td>
</tr>
</tbody>
</table>

| Sum: 1,609,142.10 |
| Average: 1,182,392.10 |

Sum of Sales revenue values
Average of Sales revenue values
Removing calculations

You can remove a calculation from a table or cross tab at any time.

**Removing a calculation from a table or crosstab**

To remove a calculation from a table or crosstab:

1. Make sure you are in Report View.
   
   The **Edit Report** button is pressed in when you are working in Report View.

2. Right click the table or crosstab footer that contains the calculation.
   
   • If you are in Result View this is the calculated value
   
   • If you are Structure View, this is the cell that contains the aggregate formula.

3. Depending on the table type, select **Remove Row** or **Remove Column** from the shortcut menu.
Using standard calculations

Removing calculations
Using alerters to highlight key results
Overview

Alerters enable you to highlight specific ranges of results in a format that makes those results stand out on reports.

This chapter tells you about:

• how alerters work
• creating alerters
• personalizing the formatting you want alerters to apply
• adding multiple conditions
• adding sub-alerters to highlight different ranges of results
• switching alerters on and off
• prioritizing alerters
• editing, duplicating, and removing alerters
• using the formula language – to create advanced conditions and formatting
How alerters work

Alerter enables you to highlight results that meet or fail specific business targets. You can create a simple alerter to highlight particularly high or low results with a specific color or with a text comment, such as “High Performer.”

Alerter are dynamic. This means that when you refresh reports with the latest data on the database, the alerters highlight the new results accordingly.

**Example:** Highlight sales results that exceeded the quarterly target

For example, you can create an alerter to highlight any sales revenue results that exceeded your quarterly sales revenue target of $900K. Each time you refresh the report data, the sales revenue results equal to or greater than $900K will be highlighted in yellow.

<table>
<thead>
<tr>
<th></th>
<th>Q1</th>
<th>Q2</th>
<th>Q3</th>
<th>Q4</th>
</tr>
</thead>
<tbody>
<tr>
<td>California</td>
<td>$720,745</td>
<td>$769,398</td>
<td>$775,766</td>
<td>$897,770</td>
</tr>
<tr>
<td>Colorado</td>
<td>$204,704</td>
<td>$219,603</td>
<td>$222,609</td>
<td>$192,279</td>
</tr>
<tr>
<td>DC</td>
<td>$279,006</td>
<td>$363,098</td>
<td>$271,645</td>
<td>$259,831</td>
</tr>
<tr>
<td>Florida</td>
<td>$305,882</td>
<td>$211,469</td>
<td>$216,569</td>
<td>$171,033</td>
</tr>
<tr>
<td>Illinois</td>
<td>$255,650</td>
<td>$354,724</td>
<td>$273,165</td>
<td>$250,617</td>
</tr>
<tr>
<td>Massachusetts</td>
<td>$220,501</td>
<td>$220,528</td>
<td>$237,464</td>
<td>$206,877</td>
</tr>
<tr>
<td>New York</td>
<td>$747,161</td>
<td>$666,617</td>
<td>$814,247</td>
<td>$233,983</td>
</tr>
<tr>
<td>Texas</td>
<td>$1,102,481</td>
<td>$1,006,221</td>
<td>$1,322,629</td>
<td>$901,789</td>
</tr>
</tbody>
</table>
What makes up an alerter?

To create an alerter, you need to specify five elements:

- a name
- an object or cell contents
- an operator
- an operand (either a value(s) or another object)
- the conditional formatting

For example, this is an alerter designed to highlight sales revenue results equal to or greater than $900K:

The object (or cell contents), the operator, and the operand make up the condition that determines whether the formatting will be applied to the report cells. When you apply the alerter to a table column/row or cell, Web Intelligence compares the condition you defined to the results on the selected column/row or cell, and displays any results that meet that condition in the format you specified.
How many conditions can you include in an alerter?

An alerter can contain multiple conditions. This enables you to highlight information that meets multiple business criteria. For example, you can define an alerter that highlights high revenue for a specific business activity or customer sector.

The alerter illustrated here applies conditional formatting to cells displaying sales revenue greater or equal to $900K in Q3, in any state except Texas.

![Alerter Editor](image)

The conditions are listed here

**Note:** You can include a maximum of six conditions in a single sub-alerter.
What are sub-alerters?

An alerter can be made of multiple sub-alerters, each containing one or multiple conditions. Sub-alerters allow you to apply different conditions and different formatting to a single object.

For example, in a single alerter defined for [Sales revenue], one sub-alerter can highlight high results in green and a second sub-alerter can highlight low results in red. You can include a maximum of eight sub-alerters in an alerter.

Note: You can include a maximum of eight sub-alerters in an alerter. For full information, see “Adding sub-alerters” on page 374.
Where can you apply alerters?

You can apply alerters to table body cells (by column or row), to section cells, to header cells, and to free-standing cells. However, you cannot apply alerters to entire tables or forms, or to charts.

How many alerters can you include in a document?

Business Objects officially supports up to 30 alerters in a Web Intelligence document. You can apply those alerters to a maximum of 20 table columns or rows, free-standing cells, or section cells on the reports.

How many alerters can you apply to a single table column or row?

Business Objects officially supports up to 10 different alerters on a single table column or row, free-standing cell, or section cell.

What highlighting changes can alerters activate?

You can define alerters to activate the following formatting changes to the selected table columns/rows or cells:

• text color, size and style
• cell border colors and style
• cell background display – specific colors, images, or hyperlinks to web pages
Using alerters to highlight key results

How alerters work

You can also define alerters that display a text or formula, an image, or a hyperlink. In this case, the results that meet the condition defined in the alerter will be replaced by the formatting. If you want the results to be visible, you can apply the alerter to a blank table row or column next to the cells that display the corresponding values.

<table>
<thead>
<tr>
<th>Lines</th>
<th>Quarter</th>
<th>Sales revenue</th>
<th>Margin</th>
<th>% Margin of Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>City Skirts</td>
<td>Q1</td>
<td>$30,076</td>
<td>$12,533</td>
<td>42%</td>
</tr>
<tr>
<td></td>
<td>Q2</td>
<td>$28,258</td>
<td>$26,802</td>
<td>Over 40% of Sales</td>
</tr>
<tr>
<td></td>
<td>Q3</td>
<td>$117,680</td>
<td>$34,083</td>
<td>29%</td>
</tr>
<tr>
<td></td>
<td>Q4</td>
<td>$131,747</td>
<td>$69,096</td>
<td>Over 40% of Sales</td>
</tr>
<tr>
<td>City Skirts</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The alerter text replaces the cell values

The alerter text displays in a blank cell next to the cell values

For full information, see “Using the formula language to display a text or formula” on page 397.

How are alerters applied to tables with breaks?

If you apply an alerter to a table row or column with a break, the alerter is only activated when the value that meets the condition in the alerter appears on the first row of that break.

For example, an alerter that highlights sales revenue results over $1,000,000 in red is activated on the break cell for state, if the sales revenue values over $1,000,000 occur in the first row of the break:

<table>
<thead>
<tr>
<th>State</th>
<th>Lines</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>California</td>
<td>Sweat-T-Shirts</td>
<td>$1,555,555</td>
</tr>
<tr>
<td></td>
<td>Shirt Waist</td>
<td>$350,556</td>
</tr>
<tr>
<td></td>
<td>Jackets</td>
<td>$62,617</td>
</tr>
<tr>
<td>California</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

354   Building Reports Using the Web Intelligence Java Report Panel
However, if the sales revenue results over $1,000,000 appear on any other line within the break, the alerter is not applied to the break cell:

<table>
<thead>
<tr>
<th>State</th>
<th>Lines</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>California</td>
<td>Jackets</td>
<td>$62,517</td>
</tr>
<tr>
<td></td>
<td>Shirt Waist</td>
<td>$50,735</td>
</tr>
<tr>
<td></td>
<td>Sweet-T-Shirts</td>
<td>$1,595,535</td>
</tr>
<tr>
<td>California</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Creating alerters

You create alerters by defining the conditions and formatting you want to highlight report results that meet specific business criteria. For example, you can highlight results that fall below a business target of $10K in red.

Using alerters makes important results stand out on reports. You can also define alerters that will insert text comments or hyperlinks to related information into report cells automatically when results hit or miss your business targets.

For a complete overview of alerters, see “How alerters work” on page 349. The following section of this guide explains how to build a new alerter.

**Note:** You cannot apply alerters to entire tables or forms, or to charts.

In order to create an alerter you need to complete three to five steps:

- launch the Alerter Editor and name the new alerter
- define one or multiple conditions
- personalize the formatting that will be applied to cell values when the condition(s) defined for the alerter is true (optional)
- add sub-alerters (optional)
- save the alerter

**Step 1: launching the Alerter Editor and naming a new alerter**

To launch the Alerter Editor and name a new alerter:

1. With a document open in the Java Report Panel, verify that you are in Report View. The **Edit Report** button is pressed in when you are in Report View.

2. Click a table column, a table row, a section cell, or a free-standing cell. You can click the cell(s) where you want to apply the new alerter or click any cell now and then apply the alerter to a different cell later.

A blue border appears on the selected cell(s).

<table>
<thead>
<tr>
<th>State</th>
<th>California</th>
<th>Colorado</th>
<th>DC</th>
<th>Florida</th>
<th>Illinois</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q1</td>
<td>$759,765</td>
<td>$724,764</td>
<td>$799,609</td>
<td>$233,456</td>
<td>$215,609</td>
</tr>
<tr>
<td>Q2</td>
<td>$769,902</td>
<td>$724,863</td>
<td>$799,609</td>
<td>$234,456</td>
<td>$215,609</td>
</tr>
<tr>
<td>Q3</td>
<td>$779,100</td>
<td>$728,898</td>
<td>$814,648</td>
<td>$235,469</td>
<td>$215,798</td>
</tr>
<tr>
<td>Q4</td>
<td>$789,300</td>
<td>$728,279</td>
<td>$829,809</td>
<td>$236,740</td>
<td>$215,978</td>
</tr>
<tr>
<td>Semi</td>
<td>2,080,769</td>
<td>843,598.2</td>
<td>1,053,581.4</td>
<td>811,923.6</td>
<td>1,344,085.4</td>
</tr>
</tbody>
</table>

Sales revenue is selected

A blue border appears on the selected cell(s).
3. Click the **Alerter** button on the report panel toolbar.
   The Alerters dialog box appears.

4. Click **New**.
   The Alerter Editor appears.

5. In the **Alerter name** text box, type a meaningful name for the alerter.
   For example, if you are creating an alerter to highlight high revenue results for product lines, you could call the new alerter **High Earners**.

6. If wanted, you can type a description of the alerter into the **Description** text box.
   This will help other users who modify the document, understand what the alerter signifies.
   You are ready to specify the condition for the alerter.
Creating alerters

1. You can base the alerter on the contents of a cell(s) or on the values of a specific object:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Then, in the “Filtered object or cell” text box...</th>
</tr>
</thead>
<tbody>
<tr>
<td>define the alerter on</td>
<td>select <strong>Cell contents</strong>.</td>
</tr>
<tr>
<td>whichever cell contents</td>
<td>(If cell <strong>Contents</strong> is not displayed, click the...</td>
</tr>
<tr>
<td>are selected on the</td>
<td>button, and then select <strong>Cell contents</strong> from the</td>
</tr>
<tr>
<td>report, independent of</td>
<td>popup menu.)</td>
</tr>
<tr>
<td>any specific object or</td>
<td></td>
</tr>
<tr>
<td>variable,</td>
<td></td>
</tr>
<tr>
<td>* leave the current object name selected.</td>
<td></td>
</tr>
<tr>
<td>or</td>
<td></td>
</tr>
<tr>
<td>* to select a different object or variable, click the ... button, then select <strong>Objects and variables</strong> from the popup menu, then select an object or variable from the list and click <strong>OK</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

2. Click the arrow to the right of the **Operator** drop-down list box and select an operator from the list.
For example, if you want to highlight results equal to or greater than a specific figure, select the operator **Greater than or equal to**.

The same operators are available for alerters as for report filters. To see a full description and example of each operator, see “Which operator should I choose?” on page 322.

3. Specify the value or object appropriate for the operand.

(If the **Operand(s)** text box is grayed out and displays the name of an object, you need to remove this first by clicking the ... button to the right of the text box and selecting Empty.)

How you define the operand depends on whether you base the alert on cell contents or on a measure or dimension object:

<table>
<thead>
<tr>
<th>If the “Filtered object or cell” text box displays...</th>
<th>Then...</th>
</tr>
</thead>
</table>
| Cell contents,                                       | • Either type a value into the **Operand(s)** text box.  
  Or  
  Click the ... button to the right of the **Operand(s)** text box, then select an object or variable from the list and click **OK**. |
| a measure object,                                     | • Either type a value into the **Operand(s)** text box.  
  Or  
  Click the ... button to the right of the **Operand(s)** text box and select an object or variable from the list. |
Using alerters to highlight key results

Creating alerters

If the “Filtered object or cell” text box displays...

<table>
<thead>
<tr>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>a dimension object,</td>
</tr>
<tr>
<td>• Either type a value into the <strong>Operand(s)</strong> text box.</td>
</tr>
<tr>
<td>Or</td>
</tr>
<tr>
<td>Click the ... button to the right of the <strong>Operand(s)</strong> text box, and</td>
</tr>
<tr>
<td>then...</td>
</tr>
<tr>
<td>• To select a value on the same dimension, click <strong>Select Values</strong>,</td>
</tr>
<tr>
<td>then select the value(s) and click <strong>OK</strong>.</td>
</tr>
<tr>
<td>Or</td>
</tr>
<tr>
<td>To select a different object, <strong>Select an object or variable</strong>,</td>
</tr>
<tr>
<td>then select an object or variable from the list and click <strong>OK</strong>.</td>
</tr>
<tr>
<td>• Click <strong>OK</strong> again.</td>
</tr>
</tbody>
</table>

The formatting applied to the cells when the results meet the condition(s) defined for the alerter is the format displayed on the pane to the left of the **Format** button.

An example of the formatting defined for the alerter appears here.
You can leave the current format defined by Web Intelligence or define your own formatting for the text, borders, and background of the cells where the results meet the conditions defined by the alerter.

4. If you want to add another condition to the alerter, click the + button to the right of the Format button and specify the second condition in the new row that appears beneath the first condition.

(For full information, see “Applying multiple conditions” on page 370.)

▶ Step 3: Personalizing the formatting of cells with alerters

If you want to modify the formatting properties, click Format then follow the information in “Formatting alerters” on page 364.

You can build alerters that contain multiple sub-alerters, each with a different condition(s) and formatting. Using sub-alerters enables you to highlight different ranges of values on reports with different formatting.

If you want to add a sub-alerter, continue to “Step 4: adding sub-alerters (optional)” on page 362.

Or

If you want to save the alerter now, go directly to “Step 5: saving the alerter” on page 363.
Using alerters to highlight key results

Creating alerters

Step 4: adding sub-alerters (optional)

Sub-alerters enable you to apply different cell formatting to different ranges of results. You can include a maximum of eight sub-alerters per alerter. For full information about sub-alerters, see “Adding sub-alerters” on page 374.

1. To add a sub-alerter, click Add Sub-Alerter.

2. Define the condition(s) of the new sub-alerter in the same way as for the first sub-alerter.

   For full information, see “Step 2: defining conditions” on page 358, above.

   ![Add sub-alerter](image)

   You can leave the current format defined by Web Intelligence for the new sub-alerter or define your own formatting properties.

3. If you want to modify the formatting properties, click Format then follow the information in “Formatting alerters” on page 364.
Step 5: saving the alerter

You need to save the alerter before you can apply it to the different results in the reports.

1. To save the new alerter, click **OK**.
2. The new alerter is added to the list of alerters contained in the document.

3. To apply the alerter, verify that a table column, table row, free-standing cell, or section cell is selected on a report, and that the check box next to the alerter is checked.

4. To close the **Alerters** dialog box, click **OK**.

   The alerter is applied to the report results, when you view the report in Results View. If you are working in Structure View, click the **View Results** button on the report panel toolbar.

   For more information about activating and deactivating alerters, see “Switching alerters on or off” on page 379.
Formatting alerters

Alerters enable you to highlight low or high results, by specifying formatting that makes those results stand out on reports. When you create a new alerter, you either can use the default format properties defined by Web Intelligence or define your own formatting. If a document already contains alerters, you can edit the format of those alerters at any time.

This section of the guide tells you how to:

• select cell format properties – for the text, cell border, and cell background (including colors, images, and skins)
• specify a format for numbers – number, currency, date/time, and custom formats

Tip: You can also use the formula language to display a text, formula, or hyperlink. See “Using the formula language to display a text or formula” on page 397.

For information on creating a new alerter, see “Creating alerters” on page 356.

► Selecting cell format properties for an alerter

To select cell format properties for an alerter:

1. Verify that an alerter is selected and that the Alerter Editor is open.

If the Alerter Editor is not currently open, click the Alerter Editor button on the report panel toolbar, and then select the alerter you want to edit from the list of alerters.
2. Click **Format**.  

   The *Alerter Display* dialog box appears.

   ![Alerter Display Dialog Box]

3. Specify the formatting properties you want to apply to the text and the cell borders, by selecting the appropriate **Text** and **Border** options.  
   You can choose to include a color, an image, or a skin in the cell background.

4. To include a background color, click the arrow next to the color drop-down list box and then select a color, or click custom color and define your own customized color.
   
   Or
   
   To include an image, check **Image URL**, type the file name or URL for the image file in the **URL** text box, and then select the appropriate image display format and position options.

   (For full information about how to specify file names and URLs for images, see “How you display images in reports” on page 311).
Using alerters to highlight key results

Or

To include a skin, select **Skin** and then click the arrow next to the drop-down list box and select one of the listed skins.

5. To close the Alerter Display dialog box, click **OK**.
   The Alerter Editor appears.
6. To close the editor, click **OK**.
   The Alerters dialog box appears. The alerters are listed here.
7. To apply the alerter to the selected part of the report, verify that the check box next to the alerter is selected.
8. To close the Alerters dialog box, click **OK**.
   The modifications to the alerter are applied when you view the report in Results View. If you are working in Structure View, click the **View Results** button on the report panel toolbar.
   For more information about activating and deactivating alerters, see “Switching alerters on or off” on page 379.
Specifying the format for numbers

To specify the format for numbers:

1. Verify that an alerter is selected and that the Alerter Editor is open.

   ![Alerter Editor](image)

   1. Click **Format**.

      The **Alerter Display** dialog box appears.
Using alerters to highlight key results

Formatting alerters

2. Click the button to the right of Number format.

The Number Format dialog box appears.

3. Click the appropriate format type in the Format Type list.

(See “Applying predefined formats” on page 269 for information about each format.)

Or

Click Custom, and then define your own custom format.

For full information about custom formats, see the “Quick reference to characters for creating custom cell formats” on page 274.
4. Click **OK**.
   The Alerter Display dialog box reappears.

5. To save your modifications, click **OK**.
   The Alerter Editor appears.

6. To close the editor, click **OK**.
   The Alerter Editor appears. The alerters are listed here.

7. To apply the alerter to the selected part of the report, verify that the check box next to the alerter is selected.

8. To close the Alerters dialog box, click **OK**.
   The modifications to the alerter are applied when you view the report in Results View.
   If you are working in Structure View, click the **View Results** button on the report panel toolbar.
   For more information about activating and deactivating alerters, see “Switching alerters on or off” on page 379.
Applying multiple conditions

You can apply multiple conditions in a single alerter. For example, you can highlight sales revenue when results reach over $300K and when those results occur in stores in any US state except California. To do this, you create an alerter with the following two conditions:

\[
\begin{align*}
[Sales\ revenue] &= \text{Greater than } "$300,000" \\
\text{And} \\
[State] &= \text{Different from "California"}
\end{align*}
\]

Note that the formatting generated by the alerter is the same for each condition. To create different conditions that each implement different formatting, you need to define multiple sub-alerters in the alerter. For full information, see “Adding sub-alerters” on page 374.

The following section tells you how to:

- add a condition
- remove a condition

**Adding a condition to an alerter**

To add a condition to an alerter:

1. If you are building a new alerter, create the alerter in the usual way. See “Creating alerters” on page 356.

Or

2. If you want to add a condition to an existing alerter, click the **Alerter** button on the toolbar, then select the alerter you want to edit and click **Edit**.

3. In the **Alerter Editor**, click the + button to the right of the **Format** button.

   A new row appears below the first condition.
3. Define the additional condition by specifying the appropriate filtered object or cell, the operator, and the operand(s) as you did for the first condition.

For step-by-step instructions for building conditions, see “Step 2: defining conditions” on page 358.

4. If you want to add another condition, click the + button below the new condition you just added, and define the additional condition in the new row.

5. To save the alerter, click OK.
   The Alerters dialog box appears. The alerter is listed.

6. To apply the alerter, verify that the check box before the alerter is checked.
   The active alerter will only be applied to the parts of the report that are selected. You can also apply the alerter to other cells on the report or to other reports in the document. See “Switching alerters on or off” on page 379.
7. To close the Alerter dialog box, click OK. The alerter is applied when you view the report in Results View. If you are working in Structure View, click the View Results button on the report panel toolbar.

- **Removing a condition from an alerter**

To remove a condition from an alerter:

1. In Report View, click the Alerter button on the toolbar, then select the alerter you want to edit and click Edit.

   The Alerter Editor appears.

2. Click the - button on the right of the condition you want to remove.

   Web Intelligence removes the condition.

3. If necessary, change the name of the alerter in the Alerter name text box, to reflect your modification.
4. To save the alerter, click OK.
   The Alerters dialog box appears again. The alerter is listed.
5. To apply the modified alerter, verify that the check box before the alerter is checked.
   The active alerter will only be applied to the parts of the report that are selected. You can also apply the alerter to other cells on the report or to other reports in the document. See “Switching alerters on or off” on page 379.
6. To close the Alerters dialog box, click OK.
   The alerter is applied when you view the report in Results View. If you are working in Structure View, click the View Results button on the report panel toolbar.
Adding sub-alerters

You can create multiple sub-alerters. This is useful if you want to highlight different ranges of results on reports.

**Example:** Highlighting low, mid, and high sales revenue results by range

You want to see clearly which accessories have generated sales revenue that falls below, within, or above your financial target of between $1 - 5K. To do this you create an alerter on the [Sales revenue] object made up of three sub-alerters:

- **Sub-alerter 1**
  
  If [Sales revenue] is **Less than** $100,000
  
  highlight results in **Red**

- **Sub-alerter 2**
  
  If [Sales revenue] is **Less than** $500,000
  
  highlight results in **Green**

- **Sub-alerter 3**
  
  If [Sales revenue] is **Greater than** $500,000
  
  highlight results in **Blue**

When you apply the alerter to the report, the results are highlighted accordingly. Results in red are below your target, results in green meet your target, and results in blue exceed your target:

<table>
<thead>
<tr>
<th>Lines</th>
<th>Category</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>Bags, wallets</td>
<td>$759,361</td>
</tr>
<tr>
<td></td>
<td>Hair accessories</td>
<td>$147,963</td>
</tr>
<tr>
<td></td>
<td>Hats, gloves, scarves</td>
<td>$37,588</td>
</tr>
<tr>
<td></td>
<td>Jewelry</td>
<td>$20,066</td>
</tr>
<tr>
<td></td>
<td>Lounge wear</td>
<td>$257,052</td>
</tr>
<tr>
<td></td>
<td>Samples</td>
<td>$649,206</td>
</tr>
<tr>
<td><strong>Accessories</strong></td>
<td><strong>Sum:</strong></td>
<td><strong>$1,859,490</strong></td>
</tr>
</tbody>
</table>

**Note:** You can include a maximum of eight sub-alerters in an alerter.
Adding a sub-alerter

To add a sub-alerter:

1. Verify you have the Alerter Editor open.

   To access the Alerter Editor, click the Alerters button on the report panel toolbar, then on the Alerters dialog box, select the alerter you want to edit and click Edit.

   The Alerter Editor appears.

2. Click Add Sub-Alerter.

   A new sub-alerter section appears on the Alerter Editor.
3. Specify the condition and formatting for the sub-alerter in the usual way. For step-by-step instructions on specifying conditions and formatting for alerters, see “Step 2: defining conditions” on page 358 and “Formatting alerters” on page 364.

4. If you want to add another sub-alerter, click Add Sub-Alerter, and then repeat step 3 above.

5. To save the alerter, click OK. The Alerters dialog box appears again.

6. To apply the alerter, verify that the check box before the alerter is checked. The active alerter will only be applied to the parts of the report that are selected. You can also apply the alerter to other cells on the report or to other reports in the document. See “Switching alerters on or off” on page 379.

7. To close the Alerters dialog box, click OK. The alerter is applied when you view the report in Results View. If you are working in Structure View, click the View Results button on the report panel toolbar.

Note: You can include a maximum of eight sub-alerters in an alerter. For more information about activating and deactivating alerters, see “Switching alerters on or off” on page 379.
Removing a sub-alerter
To remove a sub-alerter:

1. Verify you have the Alerter Editor open.
   To access the Alerter Editor, click the Alerter button on the report panel toolbar, then on the Alerter dialog box, select the alerter you want to edit and click Edit.
   The Alerter Editor appears.

2. Click Remove Sub-Alerter.
   The sub-alerter pane is removed.

3. Click OK.
   The Alerters dialog box appears again.
4. To apply the alerter, verify that the check box before the alerter is checked.

![Apply alerter check box](image)

The active alerter will only be applied to the parts of the report that are selected. You can also apply the alerter to other cells on the report or to other reports in the document. See “Switching alerters on or off” on page 379.

5. To close the Alerters dialog box, click **OK**.

The alerter is applied when you view the report in Results View. If you are working in Structure View, click the **View Results** button on the report panel toolbar.
Switching alerters on or off

You can activate and deactivate the alerters in a document whenever you like. This allows you to activate highlighting for specific sets of results when appropriate and then return to the original formatting of your document.

► Activating an alerter

To activate an alerter:

1. With a document open in the Java Report Panel, verify that you are in Report View.

   The **Edit Report** button is pressed in when you are in Report View.

2. Click a table column, a table row, a section cell, or a free-standing cell to which you want to apply the alerter.

   A blue border appears on the selected cell(s).

3. Click the **Alerters** button on the report panel toolbar.

   The Alerters dialog box appears. The alerters are listed.

4. Check the check box next to the alerter you want to apply to the selected cell(s).
5. Click **OK**.

The alerter is applied to the selected cell(s), when you view the report in Results View.

If you are working in Structure View, click the **View Results** button on the report panel toolbar.

### Deactivating an alerter

To deactivate an alerter:

1. With a document open in the Java Report Panel, verify that you are in Report View.

   The **Edit Report** button is pressed in when you are in Report View.

2. Click a table column, a table row, a section cell, or a free-standing cell to which you want to apply the alerter.

   A blue border appears on the selected cell(s).

3. Click the **Alerters** button on the report panel toolbar.

   The Alerters dialog box appears. The alerters are listed.

4. Uncheck the check box next to the alerter you want to deactivate on the selected cell(s).
5. Click **OK**.

   The alerter is removed from the selected cell(s), when you view the report in Results View.

   If you are working in Structure View, click the **View Results** button on the report panel toolbar.
Using alerters to highlight key results

Prioritizing alerters

If a document already contains alerters, you can choose the order in which those alerters are applied.

This section of this guide explains how to change the priority of alerters for:

• a selected cell or a selected table row or column
• an entire document

If you want to add a new alerter to a document, see “Creating alerters” on page 356.

Changing the priority of alerters for a selected cell or a table column/row

To change the priority of alerters for a selected cell or a table column/row:

1. Verify that you are in Report View.
   The Edit Report button is pressed in when you are in Report View.
2. Click a table column, a table row, a section cell, or a free-standing cell.
   A blue border appears on the selected cell(s).

There are two ways to access the list of alerters and re-order them:

<table>
<thead>
<tr>
<th>Via the Alerters button</th>
<th>Via the Properties tab</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Click the Alerters button on the report panel toolbar.</td>
<td>• Click the Properties tab, then click the Alerters sub-tab.</td>
</tr>
<tr>
<td>The Alerters dialog box appears.</td>
<td>• Verify that one or more alerters are activated for the selected cell(s)</td>
</tr>
<tr>
<td>• Verify that one or more alerters are activated for the selected cell(s)</td>
<td>The alerter check box(es) is checked when an alerter is activated.</td>
</tr>
<tr>
<td>The alerter check box(es) is checked when an alerter is activated.</td>
<td>• Select the activated alerter you want to move.</td>
</tr>
<tr>
<td>• Select the activated alerter you want to move.</td>
<td>• Click the Up arrow.</td>
</tr>
<tr>
<td>• Click the Up arrow.</td>
<td>Or</td>
</tr>
<tr>
<td>Or</td>
<td>Click the Down arrow.</td>
</tr>
<tr>
<td>Click the Down arrow.</td>
<td>Web Intelligence re-orders the alerters as you specified.</td>
</tr>
<tr>
<td>• To close the Alerters dialog box, click OK.</td>
<td></td>
</tr>
</tbody>
</table>

Web Intelligence re-orders the alerters as you specified.
Web Intelligence applies the new order for the alerters to the selected cell(s), when you view the report in Results View.

If you are working in Structure View, click the View Results button on the report panel toolbar.

**Changing the priority of alerters for an entire document**

To change the priority of alerters for an entire document:

1. Verify that you are in Report View.
   The Edit Report button is pressed in when you are in Report View.

2. Click a blank area of the report page.

3. Click the Alerters button on the report panel toolbar.
   The Alerters dialog box appears. Notice that no check boxes appear next to the alerters, when a blank area of a report page is selected.

4. Select the alerter you want to move.

5. Click the Up arrow to move the alerter before the preceding alerter.
   Or
   Click the Down arrow to move the alerter after the following alerter.

6. To close the Alerters dialog box, click OK.

Web Intelligence applies the new order for the alerters to the selected cell(s), when you view the report in Results View.

If you are working in Structure View, click the View Results button on the report panel toolbar.

For information about activating and deactivating alerters on selected report cells, see “Switching alerters on or off” on page 379.
Editing, duplicating, and removing alerters

You can edit, duplicate, or remove alerters at any time. Duplicating alerters enables to modify the definition of an existing alerter in order to create a new alerter, instead of starting from scratch.

► Editing an alerter
To edit an alerter:

1. Verify that you are in Report View. The Edit Report button is pressed in when you are in Report View.
2. Click the Alerters button on the report panel toolbar. The Alerters dialog box appears. The alerters are listed. If any alerter(s) are applied to the selected report cell(s) then those alerters are checked.
3. Select the alerter you want to edit, and then click Edit.
Using alerters to highlight key results

Editing, duplicating, and removing alerters

The Alerter Editor appears.

![Alerter Editor](image)

You can edit the condition and formatting properties of the alerter here.

For full information about defining the condition(s) and formatting for alerters, see “Step 2: defining conditions” on page 358 and “Selecting cell format properties for an alerter” on page 364.

**Duplicating an alerter**

To duplicate an alerter:

1. Verify that you are in Report View.
   
   The Edit Report button is pressed in when you are in Report View.

2. Click the Alerter button on the report panel toolbar.
   
   The Alerter dialog box appears. The alerters are listed.

3. Select the alerter you want to duplicate, and then click Duplicate.
The duplicate alerter appears in the list of alerters. By default, the duplicate alerter has the name of the original alerter followed by a number (n).

To rename the alerter and modify its condition(s) and formatting, you need to use the Alerter Editor.

4. Click **Edit**.

   The Alerter Editor appears.

5. In the **Alerter name** text box, type a meaningful name for the alerter. You can edit the condition and formatting properties of the alerter now. To see how to do this, see “Step 2: defining conditions” on page 358 or “Formatting alerters” on page 364.
Removing an alerter

To remove an alerter:

1. Verify that you are in Report View.
   The Edit Report button is pressed in when you are in Report View.

2. Click the Alerter button on the report panel toolbar.
   The Alerter dialog box appears. The alerters are listed.

3. Select the alerter you want to remove, and then click Remove.
   Web Intelligence removes the alerter from the list.

4. To close the Alerter dialog box, click OK.
   The alerter is removed from the document.
Using formulas to create advanced alerters

You can build advanced alerters using the Web Intelligence formula language. This is useful if you want to include formulas within the definition of the alerter.

**Example:** Highlighting three ranges of quarterly sales revenue results calculated as percentages of the average sales revenue

In this example, you build three alerters to color-code sales revenues, depending on their relationship to the average sales revenue. The table includes results for three years, and this is the average to which you want to compare each sales revenue result calculated per quarter per product line.

Using the Formula option in the Alerter Editor, you build the following alerter, which contains three sub-alerters.

Each sub-alerter has a single condition. Web Intelligence combines the sub-alerters with the Or operator, as follows:

\[
\text{[Sales revenue]} < ((\text{Average([Sales revenue]) In Block}) \times 0.8)
\]

\[
= \text{[Sales revenue]} < ((\text{Average([Sales revenue]) In Block}) \times 1.2)
\]

\[
= \text{[Sales revenue]} > ((\text{Average([Sales revenue]) In Block}) \times 1.2)
\]

The formula you specify for each sub-alerter is calculated as follows:

- The first sub-alerter will be activated on sales revenue results that are < 0.8 (this means, less than 80%) of the average.
- The second sub-alerter will be activated on sales revenue results that are < 1.2 (this means, less than 120%) of the average.
- The third sub-alerter will be activated on sales revenue results that are > 1.2 (this means, greater than 120%) of the average.

Notice that the context “In Block” is specified in the formula. This means that the average is calculated for all of the dimensions included in the table (the generic term used to refer to a table, chart, or form is block). (For detailed information on how to specify the calculation context for formulas, see “Defining the calculation context” on page 412.)

You then use the formula pane in the Alerter Display dialog box, to specify the conditional formatting you want displayed on the report cells. Here, you specify an appropriate text string and format you want displayed, when the results in a table cell meet the condition for one of the sub-alerters.

You specify the following:
• Report cells containing sales revenue results that are less than 80% of the average revenue, display the character string in red.

• Report cells containing sales revenue results that are less than 20% above the average revenue, display in blue.

Note that this alerter covers values also covered by the first alerter. For example, if the average is 100, then 79 is both > 80% below the average and < 20% above the average. In this case, the first alerter takes precedence.

• Report cells containing sales revenue results that are greater than 20% above the average revenue, display in green.
The average sales revenue result for the three-year period included in the table is $263,678. When the alerter is applied to the quarterly sales revenue results per product line, Web Intelligence applies each sub-alerter in the order they appear on the Alerter Editor. The report looks like this:

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Lines</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>Q1</td>
<td>Accessories</td>
<td>1,136,127</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>City Skirts</td>
<td>9,950</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>City Trousers</td>
<td>18,364</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>Dresses</td>
<td>136,431</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>Jackets</td>
<td>54,005</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>Leather</td>
<td>14,836</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>Outerwear</td>
<td>40,905</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>Overcoats</td>
<td>19,592</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>Shirt Vest</td>
<td>240,476</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>Sweaters</td>
<td>204,775</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>SWEAT-T-SHIT</td>
<td>751,036</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>Trousers</td>
<td>30,692</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>Accessories</td>
<td>1,096,975</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>City Skirts</td>
<td>1,984</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>City Trousers</td>
<td>2,138</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>Dresses</td>
<td>47,633</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>Jackets</td>
<td>36,700</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>Outerwear</td>
<td>160,967</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>Overcoats</td>
<td>148</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>Shirt Vest</td>
<td>162,007</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>Sweaters</td>
<td>95,645</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>SWEAT-T-SHIT</td>
<td>697,470</td>
</tr>
</tbody>
</table>

This enables you to see at a glance which product lines are generating above or below the total average sales revenue.

This section of this guide tells you how to use the formula language to:

- build a formula that specifies the condition(s) on which the alerter is based
- display a text, formula, or hyperlink on report cells when the condition(s) of the alerter are met
Building the condition for the alerter using the formula language

To build the formula for an alerter, you need to include the following elements:

```
[<object_name>]<operator>"<value>"
```

Notice that the object name separators before and after the object name are [ ] and that there are quote marks before and after the value.

For example, to specify a condition that will activate the alerter, if sales revenue results are lower than $50K, type the following formula:

```
[Sales revenue]<"50000"
```

You can include multiple conditions. For example, an alerter with two conditions is structured like this:

```
([<object_name>]<operator>"<value>") And
([<object_name>]<operator>"<value>")
```

Creating alerters that display strings in cells where values meet the alerter condition(s)

If you want the alerter to display a character string or date string in cells that meet the condition of the alerter, do not try to use the IF function for this purpose. If you want to an alerter to display a specific string on report cells, where the results meet the condition in the alerter, you need to use the formula pane on the Alerter Display dialog box. (See “Using the formula language to display a text or formula” on page 397.)

If you use the IF function to create a boolean condition, the alerter is only applied correctly, when you use numerical values in the condition. For example, the following condition includes the numerical values “1” and “0”:

```
If [Sales revenue] > 300000;1;0
```

This will apply the alerter to all sales revenue results greater than $300K.

However, if you use a character or date string in the condition, the alerter is not applied. This is because, according to boolean logic, 1 or numbers greater than 1 are true, but numbers less than 1 (or character or date strings, such as “True” or 15 May 2004), are false. For example, the following condition includes the strings “High” and “Low”:

```
If [Sales revenue] > 300000;"High";"Low"
```

This will not apply the alerter to any results on the report.
The following example shows how to use the formula pane in the Alerter Display dialog box, to display a string in the report cells where results meet the condition(s) in an alerter.

**Example:** Flag high-selling product lines with a “high performer” tag

In this example, you want to flag products that have generated sales revenue of over 20% of the annual sales revenue average, in just one quarter. First, using the **Formula** option in the Alerter Editor, you build the following alerter:

Then, using the formula pane in the **Alerter Display** dialog box you specify the character string “High performer” for the cell format:
This is the format that Web Intelligence will apply to the report cells where results meet the condition defined in the alerter.

Lastly, you create an empty column next to the column for **Lines** and type the text "Rating" into the new column header. You apply the new alerter to that column. (For full information on how to add columns to tables, see "Adding or removing table rows or columns" on page 182.) The average sales revenue per product over the year in all states is $93,002. When the alerter is applied to the quarterly sales revenue results per line, the report looks like this:

Using the formula language, you can create alerters that display a text string, objects or variables, formulas, or URLs that include the OpenDocument function to link to other documents on the repository. For step-by-step instructions on how to do this, see "Using the formula language to display a text or formula" on page 397.

► **Building a condition for an alerter using the formula language**

To build a condition for an alerter using the formula language:
Using alerters to highlight key results

Using formulas to create advanced alerters

1. Verify you have the Alerter Editor open.

   To access the Alerter Editor, click the Alerter button on the report panel toolbar, then on the Alerter dialog box, then either click New or select the alerter you want to edit and click Edit.

   The Alerter Editor appears.

2. In the Alerter name text box, type a meaningful name for the alerter.

   For example, if you are creating an alerter to highlight high revenue results for product lines, you could call the new alerter High Earners.

3. If wanted, you can type a description of the alerter into the Description text box.

   This will help other users understand what the alerter signifies. You are ready to specify the condition for the alerter using the formula language.

4. Check the Formula check box.

   The Formula Pane appears.

   ![Formula Pane]
The next step depends on whether you want to type the formula yourself or use the Formula Editor to select the appropriate operators and objects.

5. If you want to use the Formula Editor, click the Formula button.
   Or
   If you want to use the Formula Pane go directly to step 6.

6. Specify the condition(s) for the alerter. (How you do this depends on whether you are using the Formula Editor or the Formula Pane:

<table>
<thead>
<tr>
<th>If you are using...</th>
<th>then...</th>
</tr>
</thead>
</table>
| the Formula Editor, | • Drag-and-drop or double-click the object(s) and operator(s) you want in the condition, from the Available Objects and Available Operators lists.  
• Type the value(s) you want in the condition.  
Ensure you insert a double quote before the value and another double quote after the value.  
(For an example of how to structure a formula for an alerter, see “Building the condition for the alerter using the formula language” on page 391.)  
• To check if the formula is correct, click the green check button next to the Formula Pane.  
Web Intelligence parses the formula and notifies you, if the formula contains any syntax errors.  
• When the syntax is correct, click OK. |
| the Formula Pane,   | • Type the Equals operator (=) into the Formula Pane.  
(For an example of how to structure a formula for an alerter, see “Building the condition for the alerter using the formula language” on page 391.)  
• Type the formula into the Formula Pane. |

You can apply multiple conditions in a single alerter. For example, you can highlight sales revenue when results reach over $300K when those results occur later than January 1, 2004. (For full information about multiple conditions in alerters, see “How many conditions can you include in an alerter?” on page 351.)
7. If you want to add a second condition, click the + button to the right of the Format button and then type the condition into the new row that appears. If you want to create multiple boolean conditions on an object that each generate different formatting, you can include multiple sub-alerters within the same alerter. For full information about sub-alerters, see “What are sub-alerters?” on page 352.

8. If you want to add a sub-alerter, click Add Sub-Alerter to display a new sub-alerter section, then specify the formula for the new sub-alerter as you did in step 6.

You can include a maximum of eight sub-alerters in an alerter.

9. If you want to modify the formatting properties already selected for the alerter, click Format, then follow the information in “Formatting alerters” on page 364.

10. Click OK.

The Alerter Editor closes and the Alerters dialog box reappears.

11. Click OK.

12. To close the Alerters dialog box, click OK.

Web Intelligence applies the new order for the alerters to the selected cell(s), when you view the report in Results View. If you are working in Structure View, click the View Results button on the report panel toolbar.

Including a text, formula, or hyperlink for the alerter formatting

You can create alerters that display text, formulas, or hyperlinks in the report cells, where results meet the condition(s) defined in the alerter.

This enables you to display messages in cells, such as “UNPAID,” or to display formulas that change the results (for example, to display a text you specify and the result of the object in the same cell), or to include links to other web pages that can be consulted easily whenever results meet the business condition(s) set in the alerter.
Using the formula language to display a text or formula

To use the formula language to display a text or formula:

1. Verify you have the Alerter Editor open.

To access the Alerter Editor, click the Alerter button on the report panel toolbar, then on the Alerter dialog box, then either click New or select the alerter you want to edit and click Edit.

The Alerter Editor appears.

2. Click Format.

The Alerter Display dialog box appears.
3. The next step depends on what you want Web Intelligence to display on the report cells where the results meet the condition(s) in the alerter:

<table>
<thead>
<tr>
<th>If you want to display...</th>
<th>then...</th>
</tr>
</thead>
</table>
| text,                     | • Type the text into the Formula Pane, and then click the Validate button.  
                             |   **Note:** Do not include quote marks before or after the text. For example, if you want the alerter to display OVERDUE, then type: OVERDUE  
                             |   Web Intelligence inserts the “=” sign followed by quote marks before the text string and inserts quote marks after the string.  
                             |   **Note:** (If you type the Equals sign (=) into the Formula Pane, then you need to type quote marks followed by the text, and then type quote marks again after the text. For example, if you want the alerter to display OVERDUE, then type: ="OVERDUE") |
| a formula,                | • If you want to use the Formula Editor, click the Formula button,  
                             |   then build the formula by selecting objects, operators, and functions, and click OK.  
                             |   Or  
                             |   If you want to use the Formula Pane, type the Equals sign (=) into the Formula Pane, then type the formula.  
                             |   For full information about creating formulas see "Creating formulas" on page 403 |
Using alerters to highlight key results

Using formulas to create advanced alerters

If you want to display... then...

a hyperlink,

• In the Formula Pane, type the URL of the web page you want to appear as a hyperlink on the report cells.
  
  You must not use spaces in the URL or file path. For information on the URL types supported by Web Intelligence, see page 378.

  Note: You can specify hyperlinks that link to other documents by using the OpenDocument syntax.

  • Check the Read contents as check box, and then select Hyperlink from the drop-down list to the right of the check box.

4. To close the Alerter Display dialog box, click OK.

The Alerter Editor reappears.

This formula displays the text message “Below $100K” in the report cells that meet the condition specified in the alerter

5. Click OK.

The Alerters dialog box reappears.
Using alerters to highlight key results

Using formulas to create advanced alerters

6. To close the Alerters dialog box, click OK. The modifications to the alerter are applied when you view the report in Results View. If you are working in Structure View, click the View Results button on the report panel toolbar.
Creating custom calculations
Overview

Custom calculations allow you to add additional calculations to your report beyond its base objects and the standard calculations provided by Web Intelligence.

You add a custom calculation by writing a formula that Web Intelligence evaluates when you run the report. A formula can consist of base report variables, functions, operators and calculation contexts.

This chapter describes:
- creating formulas
- functions
- operators
- defining calculation contexts in formulas
- examples of useful formulas

Example: Showing average revenue per sale

If you have a report with Sales Revenue and Number Sold objects and you want to add revenue per sale to the report. The calculation

\[ \frac{\text{Sales Revenue}}{\text{Number Sold}} \]

gives this value by dividing the revenue by the number of items sold in order to give the revenue per item.

A custom calculation is a formula that can consist of report objects, functions and operators. Formulas have a calculation context that you can specify explicitly if you choose.

For information on formulas, see "Creating formulas" on page 403. For information on operators, see "Examples of useful formulas" on page 435. For information on calculation contexts, see "Defining the calculation context" on page 412.
Creating formulas

This section describes the ways in which you can create formulas in your reports. You can add formulas in Structure View in two ways:

- by typing or dragging and dropping the formula components into the Formula toolbar
- by using the Formula Editor to build the formula

The first way is more suitable for experienced users. If you are not familiar with formulas, you should use the Formula Editor to build them. The Formula Editor is an interface that allows you to select the different components of your formula (that is, operators, objects, and functions) and add them to it.

Using the Formula toolbar

You display the Formula toolbar by clicking the Show/Hide Formula Toolbar button. Now, when you select a cell, its formula appears in the Formula toolbar.

The Formula toolbar has the following buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Formula Editor</td>
<td>Opens the Formula Editor which allows you to build a formula using a graphical interface</td>
</tr>
<tr>
<td>Create variable</td>
<td>Allows you to save a formula as a variable</td>
</tr>
<tr>
<td>Clear changes</td>
<td>Clears all changes made to the formula since the last save or validation</td>
</tr>
<tr>
<td>Validate formula</td>
<td>Verifies the formula syntax and replaces the current formula</td>
</tr>
</tbody>
</table>
Creating formulas

To enter a formula in the Formula toolbar you can:

• type the formula directly
• drag report objects to the Formula toolbar

**Example: Calculating the average number of items sold**

You have a report showing Year, Quarter, Sales Revenue and Quantity Sold and you want to add an additional column that shows the average revenue generated per item sold. The formula that gives this is:

\[
\frac{\text{Sales Revenue}}{\text{Quantity Sold}}
\]

**Entering a formula by typing**

To enter a formula by typing:

1. Add an additional column to the right of the Quantity Sold column by selecting this column on the table, and then clicking **Insert Column After** on the toolbar.

2. Click **Show/Hide Formula Toolbar** to display the Formula toolbar. To enter a formula by typing you type the formula directly into the Formula toolbar.

3. In the Formula toolbar, type the formula.

   For example, to calculate the average revenue generated per item sold, type:

   \[
   \frac{\text{Sales Revenue}}{\text{Quantity Sold}}
   \]

   Web Intelligence gives you suggestions for completing the component of the formula you are typing.
4. To select a Web Intelligence suggestion, press the down arrow button to highlight it, then press **Return**.
   Or
   Select the suggestion with your cursor.
   Web Intelligence then adds the component you selected to the formula.

5. If you are in Structure View, click **View Results** to see the results of the formula.
   The formula is added to the report.
   **Note:** Formulas always begin with ‘=’ and report objects always appear inside square brackets in Web Intelligence formulas.

   ▶ **Entering the formula using drag and drop**
   To enter a formula using drag and drop:
   • Drag report objects onto the Formula toolbar.

   ![Formula toolbar with Drag and Drop](image)

   When you release an object, it appears in the Formula toolbar as if you had typed it directly.
   **Note:** When you drag a formula component to the Formula toolbar, it appears at the current cursor position.
Using the Formula Editor

You can use the Formula Editor to enter formulas in the Formula toolbar. The Formula Editor is a graphical interface that you use to build formulas. It contains all report objects, functions and operators that you can use in a formula.

Displaying the Formula Editor
To display the Formula Editor:

- Click the Formula Editor button on the Formula toolbar.

The Formula Editor appears below the Formula toolbar:

![Formula Editor screenshot]

The Formula Editor shows the report objects, functions and operators that you can use to build a formula.

Note: To make your formula easier to read, you can use the Ctrl+Enter or Alt+Enter keys to insert line breaks.

Building a formula using the Formula Editor
To build a formula, using the Formula Editor:
Creating custom calculations

Creating formulas

1. Select the cell on the report where you want to include the formula. You can select a table cell or a free-standing cell.
2. Display the Formula toolbar and the Formula Editor. See “Displaying the Formula Editor” on page 406, above.
3. On the **Data**, **Functions** and **Operators** tabs, double-click the report objects, functions and operators you want to include in the formula, or type the formula directly.

   For example, to create the formula \( \text{Average}([\text{Revenue}]) \), double-click the Average() function, then double-click the Revenue object.

   **Note:** When you double-click a function to include it in a formula, Web Intelligence places the cursor between the function parentheses.
Including text in cells

The text in report cells always begins with ‘=’ . Literal text appears in quotation marks, while formulas appear without quotation marks. For example, the formula Average([Revenue]) appears in a cell as:

```
=Average([Revenue])
```

The text “Average Revenue” appears as:

```
="Average Revenue"
```

You can use text alone in a cell, or mix formulas and text by using the ‘+’ operator. If you want a cell to display the average revenue preceded by the text “Average Revenue”, the cell text is as follows:

```
="Average Revenue: " + Average([Revenue])
```

Note the space at the end of the text string so that the text and the value are not placed directly side-by-side in the cell.

Saving formulas as variables

You can save a formula as a variable in order to re-use it throughout a report. For information on how to do this, see “Saving formulas as variables” on page 449.
About functions

A custom calculation might consist of report objects only, for example
\[ \frac{\text{Sales Revenue}}{\text{Number of Sales}} \]

However, calculations often include functions as well. A function is an operation that receives zero or more values as input and returns output based on those values. For example, the Sum function totals all the values in a measure and outputs the result. The formula \( \text{Sum}(\text{Sales Revenue}) \) outputs a total of sales revenues. In this case, the function input is the Sales Revenue measure and the output is the total of all Sales Measures.

To find out more about Web Intelligence functions, see “What is a function?” on page 440.
About operators

Operators link the various components in a formula. Formulas can contain five kinds of operators:

- Mathematical
- Conditional
- Logical
- Context
- Function-specific

You can see all the operators supported by Web Intelligence by clicking on the Operators tab in the Formula Editor. The following sections describe each type of operator.

Mathematical operators

Mathematical operators are familiar from everyday arithmetic. There are addition (+), subtraction (-), multiplication (*), division (/) operators that allow you to perform mathematical operations in a formula. The formula:

\[ \text{[Sales Revenue]} - \text{[Cost of Sales]} \]

**Note:** contains a mathematical operator, in this case subtraction.

When used with character strings, the ‘+’ operator becomes a string concatenation operator. That is, it joins character strings. For example, the formula “John” + “ Smith” returns ‘John Smith’.

Conditional operators

Conditional operators determine the type of comparison to be made between values. The following table describes them:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>Equal to</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than</td>
</tr>
<tr>
<td>&lt;</td>
<td>Less than</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater than or equal to</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less than or equal to</td>
</tr>
<tr>
<td>!=</td>
<td>Not equal to</td>
</tr>
</tbody>
</table>
Creating custom calculations

Creating custom calculations

You use conditional operators in conjunction with If, as in:

If ([Revenue] >= 10000; 'High'; 'Low')

which returns “High” for all rows where the revenue is greater than or equal to 10000 and “Low” for all other rows.

Logical operators

Logical operators are used in expressions that return True or False. You use such expressions in the If function. The Web Intelligence logical operators are AND, OR, NOT, Between and InList. For example, the expression:

If ([Resort] = 'Bahamas Beach' OR [Resort] = 'Hawaiian Club'; 'US'; 'France')

returns “US” if the resort is “Bahamas Beach” or “Hawaiian Club”, “France” otherwise.

The expression:

[Resort] = ‘Bahamas Beach’ OR [Resort] = ‘Hawaiian Club’

returns True or False, True if the Resort variable is equal to ‘Bahamas Beach’ or ‘Hawaiian Club’, False otherwise.

Context operators

Context operators form part of extended calculation syntax. Extended syntax allows you to define which dimensions a measure or formula takes into account in a calculation. It is described in detail in the section “Defining the calculation context” on page 412.

Function-specific operators

Some Web Intelligence functions can take specific operators as arguments. For example, the Previous() function can take the SELF operator. See the functions on-line help and “Web Intelligence functions” on page 439 for more information.
Defining the calculation context

Before you can define a specific calculation context, you need to understand how calculation contexts work.

What are calculation contexts?

Calculation contexts give you more control over how a formula or measure is evaluated. To understand them, you need to be familiar with basic report concepts. A report contains two kinds of objects: dimensions, which are types of data about your business that can have measures associated with them (for example: products, years, states) and the measures that you can calculate in relation to dimensions (for example: sales revenue, number of sales). For example, a report could show sales revenue (measure) by year (dimension).

The important thing to remember about measures is that they are semantically dynamic. This means that the figures returned by a measure depend on the dimensions with which it is associated; in other words, on the context in which it is placed. Web Intelligence places measures in default contexts depending on where they appear in a report. However, you can change these default contexts. This is what is meant by defining the calculation context.

You can see default contexts by creating a block containing Year and Sales Revenue objects. In this case the Sales Revenue object returns the revenue by year, because revenue is evaluated in the context of the Year dimension. If you then add the Quarter dimension to the block, the figures in the Sales Revenue column change because the default context is now year and quarter.

<table>
<thead>
<tr>
<th>Year</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>$8,598,124</td>
</tr>
<tr>
<td>2002</td>
<td>$13,232,245</td>
</tr>
<tr>
<td>2003</td>
<td>$15,858,413</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>Q1</td>
<td>$2,900,700</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>$2,279,003</td>
</tr>
<tr>
<td>2001</td>
<td>Q3</td>
<td>$1,957,841</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>$1,789,586</td>
</tr>
<tr>
<td>2002</td>
<td>Q1</td>
<td>$3,743,172</td>
</tr>
<tr>
<td>2002</td>
<td>Q2</td>
<td>$2,840,651</td>
</tr>
<tr>
<td>2002</td>
<td>Q3</td>
<td>$2,929,903</td>
</tr>
<tr>
<td>2002</td>
<td>Q4</td>
<td>$4,156,120</td>
</tr>
<tr>
<td>2003</td>
<td>Q1</td>
<td>$3,742,869</td>
</tr>
<tr>
<td>2003</td>
<td>Q2</td>
<td>$4,006,710</td>
</tr>
<tr>
<td>2003</td>
<td>Q3</td>
<td>$3,953,396</td>
</tr>
<tr>
<td>2003</td>
<td>Q4</td>
<td>$3,958,041</td>
</tr>
</tbody>
</table>
From this you can see that when you place a measure or formula in a block, the default calculation context that Web Intelligence applies includes all the dimensions in the block.

Default calculation contexts

Depending on where you place a measure or formula, Web Intelligence selects a default context. All the following examples use the `Sum()` function to illustrate default contexts.

**Note:** For more information on the terms input context and output context used in this section, see “Modifying the default calculation context using extended syntax” on page 418

**Default contexts in a vertical table**

A vertical table is a standard report table with headers at the top, data going from top to bottom and footers at the bottom. The default contexts in a down table are:

<table>
<thead>
<tr>
<th>When the calculation is in the...</th>
<th>The input context is</th>
<th>The output context is</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td>The dimensions and measures used to generate the body of the block</td>
<td>All the data is aggregated then the calculation function returns a single value</td>
</tr>
<tr>
<td>Body of the block</td>
<td>The dimensions and measures used to generate the current row</td>
<td>The same as the input context</td>
</tr>
<tr>
<td>Footer</td>
<td>The dimensions and measures used to generate the body of the block</td>
<td>All the data is aggregated then the calculation function returns a single value</td>
</tr>
</tbody>
</table>
Creating custom calculations

**Defining the calculation context**

**Example: Default contexts in a vertical table**

The following table shows the default contexts in a vertical table:

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
<th>Input context</th>
<th>Output context</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>Q1</td>
<td>$2585730.00</td>
<td>(Year, Quarter)</td>
<td>Values aggregated to single output</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>$2076893.40</td>
<td>(Year, Quarter)</td>
<td>Values aggregated to single output</td>
</tr>
<tr>
<td>2001</td>
<td>Q3</td>
<td>$1207401.11</td>
<td>(Year, Quarter)</td>
<td>Values aggregated to single output</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>$1780580.10</td>
<td>(Year, Quarter)</td>
<td>Values aggregated to single output</td>
</tr>
<tr>
<td>2002</td>
<td>Q1</td>
<td>$3352682.34</td>
<td>(Year, Quarter)</td>
<td>Values aggregated to single output</td>
</tr>
<tr>
<td>2002</td>
<td>Q2</td>
<td>$3564650.38</td>
<td>(Year, Quarter)</td>
<td>Values aggregated to single output</td>
</tr>
<tr>
<td>2002</td>
<td>Q3</td>
<td>$2679301.30</td>
<td>(Year, Quarter)</td>
<td>Values aggregated to single output</td>
</tr>
<tr>
<td>2002</td>
<td>Q4</td>
<td>$4619321.20</td>
<td>(Year, Quarter)</td>
<td>Values aggregated to single output</td>
</tr>
<tr>
<td>2003</td>
<td>Q1</td>
<td>$3742988.00</td>
<td>(Year, Quarter)</td>
<td>Values aggregated to single output</td>
</tr>
<tr>
<td>2003</td>
<td>Q2</td>
<td>$4006719.10</td>
<td>(Year, Quarter)</td>
<td>Values aggregated to single output</td>
</tr>
<tr>
<td>2003</td>
<td>Q3</td>
<td>$3653995.10</td>
<td>(Year, Quarter)</td>
<td>Values aggregated to single output</td>
</tr>
<tr>
<td>2003</td>
<td>Q4</td>
<td>$5586041.90</td>
<td>(Year, Quarter)</td>
<td>Values aggregated to single output</td>
</tr>
<tr>
<td><strong>Sum</strong></td>
<td></td>
<td><strong>$3630720.60</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Default context in a horizontal table**

A horizontal table is like a vertical table turned on its side. Headers appear at the left, data goes left to right and footers appear at the right. The default contexts for a horizontal table are the same as those for a vertical table.

**Default contexts in a crosstab**

A crosstab displays data in a matrix with measures appearing at the intersections of dimensions. The default contexts in a crosstab are:

<table>
<thead>
<tr>
<th>The calculation is in the...</th>
<th>The input context is...</th>
<th>The output context is...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td>The dimensions and measures used to generate the body of the block.</td>
<td>All the data is aggregated, then the calculation function returns a single value.</td>
</tr>
<tr>
<td>Body of the block</td>
<td>The dimensions and measures used to generate the body of the block.</td>
<td>The same as the input context.</td>
</tr>
<tr>
<td>Footer</td>
<td>The dimensions and measures used to generate the body of the block.</td>
<td>All the data is aggregated, then the calculation function returns a single value.</td>
</tr>
</tbody>
</table>
### Creating custom calculations

#### Defining the calculation context

<table>
<thead>
<tr>
<th>The calculation is in the...</th>
<th>The input context is...</th>
<th>The output context is...</th>
</tr>
</thead>
<tbody>
<tr>
<td>VBody footer</td>
<td>The dimensions and measures used to generate the current column.</td>
<td>All the data is aggregated, then the calculation function returns a single value.</td>
</tr>
<tr>
<td>HBody Footer</td>
<td>The dimensions and measures used to generate the current row.</td>
<td>All the data is aggregated, then the calculation function returns a single value.</td>
</tr>
<tr>
<td>VFooter</td>
<td>Same as footer.</td>
<td>All the data is aggregated, then the calculation function returns a single value.</td>
</tr>
<tr>
<td>HFooter</td>
<td>Same as footer.</td>
<td>All the data is aggregated, then the calculation function returns a single value.</td>
</tr>
</tbody>
</table>

**Example:** Default contexts in a crosstab

The report below shows the default contexts in a crosstab:

<table>
<thead>
<tr>
<th></th>
<th>FY2008 Q1</th>
<th>FY2008 Q2</th>
<th>FY2008 Q3</th>
<th>FY2008 Q4</th>
<th>FY2009 Q1</th>
<th>FY2009 Q2</th>
<th>FY2009 Q3</th>
<th>FY2009 Q4</th>
<th>FY2009 Q1 Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>France</td>
<td>259,178</td>
<td>261,066</td>
<td>70,080</td>
<td>100,640</td>
<td>259,178</td>
<td>261,066</td>
<td>70,080</td>
<td>100,640</td>
<td>1,115,738</td>
</tr>
<tr>
<td>HS</td>
<td>866,561</td>
<td>196,031</td>
<td>189,896</td>
<td>234,574</td>
<td>256,293</td>
<td>856,561</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sum</td>
<td>1,115,738</td>
<td>258,726</td>
<td>266,441</td>
<td>384,654</td>
<td>210,960</td>
<td>1,115,738</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

Building Reports Using the Web Intelligence Java Report Panel  415
Default contexts in a section

A section consists of a header, body and footer. The default contexts in a section are:

<table>
<thead>
<tr>
<th>The calculation is in the...</th>
<th>The input context is...</th>
<th>The output context is...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Body</td>
<td>The dimensions and measures in the report, filtered to restrict the data to the section data.</td>
<td>All the data is aggregated, then the calculation function returns a single value.</td>
</tr>
</tbody>
</table>

Example: Default contexts in a section

<table>
<thead>
<tr>
<th>Year</th>
<th>Sales revenue</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Q1</td>
<td>$2,862,703</td>
<td>6,036,123.6</td>
</tr>
<tr>
<td>Q2</td>
<td>$2,270,033</td>
<td>6,036,123.6</td>
</tr>
<tr>
<td>Q3</td>
<td>$1,367,841</td>
<td>6,036,123.6</td>
</tr>
<tr>
<td>Q4</td>
<td>$1,789,600</td>
<td>6,036,123.6</td>
</tr>
<tr>
<td>Sum</td>
<td>8,096,123.6</td>
<td></td>
</tr>
</tbody>
</table>

Input context (Year, Quarter); data aggregated

<table>
<thead>
<tr>
<th>Year</th>
<th>Sales revenue</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>2002</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Q1</td>
<td>$5,326,172</td>
<td>13,232,246</td>
</tr>
<tr>
<td>Q2</td>
<td>$2,840,651</td>
<td>13,232,246</td>
</tr>
<tr>
<td>Q3</td>
<td>$2,979,803</td>
<td>13,232,246</td>
</tr>
<tr>
<td>Q4</td>
<td>$4,186,130</td>
<td>13,232,246</td>
</tr>
<tr>
<td>Sum</td>
<td>13,232,246</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Year</th>
<th>Sales revenue</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>2003</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Q1</td>
<td>$3,742,909</td>
<td>16,059,142.8</td>
</tr>
<tr>
<td>Q2</td>
<td>$4,036,716</td>
<td>16,059,142.8</td>
</tr>
<tr>
<td>Q3</td>
<td>$3,952,805</td>
<td>16,059,142.8</td>
</tr>
<tr>
<td>Q4</td>
<td>$3,952,805</td>
<td>16,059,142.8</td>
</tr>
<tr>
<td>Sum</td>
<td>15,059,142.8</td>
<td></td>
</tr>
</tbody>
</table>
Default contexts in a break

A break consists of a header, body and footer. The default contexts in a break are:

<table>
<thead>
<tr>
<th>The calculation is in the...</th>
<th>The input context is...</th>
<th>The output context is...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td>Current instance of the break.</td>
<td>All the data is aggregated, then the calculation function returns a single value.</td>
</tr>
<tr>
<td>Footer</td>
<td>Current instance of the break.</td>
<td>All the data is aggregated, then the calculation function returns a single value.</td>
</tr>
</tbody>
</table>

**Example**: Default contexts in a break

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>$IRR</th>
<th>3423</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>Q1</td>
<td>$1,060,743</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Q2</td>
<td>$2,070,031</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Q3</td>
<td>$3,089,241</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Q4</td>
<td>$4,019,481</td>
<td></td>
</tr>
<tr>
<td>Sum:</td>
<td></td>
<td>$8,069,434</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>$IRR</th>
<th>3423</th>
</tr>
</thead>
<tbody>
<tr>
<td>2002</td>
<td>Q1</td>
<td>$5,089,172</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Q2</td>
<td>$6,099,301</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Q3</td>
<td>$7,109,435</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Q4</td>
<td>$8,119,581</td>
<td></td>
</tr>
<tr>
<td>Sum:</td>
<td></td>
<td>$27,332,245</td>
<td></td>
</tr>
</tbody>
</table>
Modifying the default calculation context using extended syntax

What if the default context of a formula or measure is not the context that you need? In this case, you can use extended syntax to tailor the context to the context you are looking for.

What is extended syntax?

Extended syntax uses context operators that you add to a formula or measure to specify its context. A measure or formula’s context consists of its input context and output context.

What is an input context?

A formula’s input context consists of the dimensions that feed into the formula.

Specifying dimensions in input and output contexts

Input and output contexts consist of lists of dimensions. These lists must always be enclosed in parentheses, even if the list contains only one dimension. For example, a context must be specified as ([Year]; [Quarter]) or ([Year]).

Example: Specifying an input context

In the examples given in “What are calculation contexts?” on page 412, the input contexts consist of (Year) and (Year, Quarter) respectively. That is, in the first example, Web Intelligence calculates revenue by year. In the second example it calculates revenue by year by quarter. When specified explicitly in a formula, the input context looks like this:

\[
\text{Sum (}[\text{Sales revenue}] \text{ In} ([\text{Year}];[\text{Quarter}]))
\]

That is, the dimensions in the input context appear inside the parentheses of the function (in this case, Sum) whose input context you are specifying.

For an explanation of the In operator that appears in this formula, see “The In context operator” on page 424
What is an output context?

A formula’s output context causes the formula to output a value is if it were placed in the footer of a block containing a break. Think of an output context as a “break” in a formula.

**Example: Specifying an output context**

Look at the following report, which shows revenue by year and quarter, with a break on year, and the minimum revenue calculated by year.

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Q1</td>
<td>$2,898,696.90</td>
</tr>
<tr>
<td></td>
<td>Q2</td>
<td>$2,279,003.03</td>
</tr>
<tr>
<td></td>
<td>Q3</td>
<td>$1,367,840.70</td>
</tr>
<tr>
<td></td>
<td>Q4</td>
<td>$1,768,602.40</td>
</tr>
<tr>
<td>2001</td>
<td>Min:</td>
<td>$1,367,840.70</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Q1</td>
<td>$3,251,722.20</td>
</tr>
<tr>
<td></td>
<td>Q2</td>
<td>$2,840,609.50</td>
</tr>
<tr>
<td></td>
<td>Q3</td>
<td>$2,979,326.00</td>
</tr>
<tr>
<td></td>
<td>Q4</td>
<td>$4,186,120.00</td>
</tr>
<tr>
<td>2002</td>
<td>Min:</td>
<td>$2,149,650.00</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Q1</td>
<td>$3,745,906.90</td>
</tr>
<tr>
<td></td>
<td>Q2</td>
<td>$4,035,717.60</td>
</tr>
<tr>
<td></td>
<td>Q3</td>
<td>$3,553,855.30</td>
</tr>
<tr>
<td></td>
<td>Q4</td>
<td>$3,356,041.10</td>
</tr>
<tr>
<td>2003</td>
<td>Min:</td>
<td>$3,356,041.10</td>
</tr>
</tbody>
</table>

What if you want to show the minimum revenue by year in a block with no break? You can do this by specifying the output context in a formula. In this case, the formula looks like this:

```
Min ([Revenue]) In ([Year])
```

That is, the output context appears after the parentheses of the function whose output context you are specifying. In this case, the output context tells Web Intelligence to calculate minimum revenue by year.
If you add an additional column containing this formula to the block, the result is as follows:

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
<th>Min by Year</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>Q1</td>
<td>$1,889,829.94</td>
<td>$1,889,829.94</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>$2,279,403.00</td>
<td>$2,279,403.00</td>
</tr>
<tr>
<td>2001</td>
<td>Q3</td>
<td>$1,367,940.79</td>
<td>$1,367,940.79</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>$1,760,530.40</td>
<td>$1,760,530.40</td>
</tr>
<tr>
<td>2002</td>
<td>Q1</td>
<td>$3,301,772.32</td>
<td>$3,040,360.85</td>
</tr>
<tr>
<td>2002</td>
<td>Q2</td>
<td>$3,040,360.85</td>
<td>$3,040,360.85</td>
</tr>
<tr>
<td>2002</td>
<td>Q3</td>
<td>$2,750,363.00</td>
<td>$2,750,363.00</td>
</tr>
<tr>
<td>2002</td>
<td>Q4</td>
<td>$1,861,202.00</td>
<td>$1,861,202.00</td>
</tr>
<tr>
<td>2003</td>
<td>Q1</td>
<td>$2,742,306.90</td>
<td>$2,742,306.90</td>
</tr>
<tr>
<td>2003</td>
<td>Q2</td>
<td>$3,076,717.50</td>
<td>$3,076,717.50</td>
</tr>
<tr>
<td>2003</td>
<td>Q3</td>
<td>$3,953,095.30</td>
<td>$3,953,095.30</td>
</tr>
<tr>
<td>2003</td>
<td>Q4</td>
<td>$2,958,041.10</td>
<td>$2,958,041.10</td>
</tr>
</tbody>
</table>

You can see that the Min By Year column contains the minimum revenues that appear in the break footers in the previous report.

Notice that in this example, the input context is not specified because it is the default context (Year, Quarter) for the block. In other words, the output context tells Web Intelligence which revenue by year and quarter to output. In full, with both input and output formulas explicitly specified, the formula looks like this:

\[
\text{Min} \left( \left[ \text{Sales Revenue} \right] \text{In} (\left[ \text{Year} \right], \left[ \text{Quarter} \right]) \right) \text{In} (\left[ \text{Year} \right])
\]

Explained in words, this formula tells Web Intelligence to “calculate revenues by year by quarter, then output the smallest of these revenues that occurs in each year”.

What would happen if you did not specify the output context in the Min by Year column? In this case, these figures would be identical to the figures in the Sales Revenue column. Why? Remember that the default context in a block includes the dimensions in that block. The minimum revenue by year by quarter is the same as the revenue by year by quarter simply, because there is only one revenue for each year/quarter combination.
Specifying input and output contexts

You can specify both input and output contexts in the same formula.

**Example:** Specifying input and output contexts in the same formula

Look at the following table:

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Month</th>
<th>Sales revenue</th>
<th>Min by Year</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>Q1</td>
<td>1</td>
<td>$1,000,000.00</td>
<td>$1,000,000.00</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>2</td>
<td>$3,000,000.00</td>
<td>$1,000,000.00</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>3</td>
<td>$1,020,000.00</td>
<td>$1,000,000.00</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>4</td>
<td>$8,000,000.00</td>
<td>$1,000,000.00</td>
</tr>
<tr>
<td>2001</td>
<td>Q3</td>
<td>5</td>
<td>$5,000,000.00</td>
<td>$1,000,000.00</td>
</tr>
<tr>
<td>2001</td>
<td>Q3</td>
<td>6</td>
<td>$2,500,000.00</td>
<td>$1,000,000.00</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>7</td>
<td>$1,750,000.00</td>
<td>$1,000,000.00</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>8</td>
<td>$1,750,000.00</td>
<td>$1,000,000.00</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>9</td>
<td>$5,000,000.00</td>
<td>$1,000,000.00</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>10</td>
<td>$5,000,000.00</td>
<td>$1,000,000.00</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>11</td>
<td>$4,000,000.00</td>
<td>$1,000,000.00</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>12</td>
<td>$4,000,000.00</td>
<td>$1,000,000.00</td>
</tr>
</tbody>
</table>

Notice that the figures in the **Min by Year** column are the same as those in the block footers in the example “Specifying an output context” on page 419, even though this block contains an additional dimension, **Month**. This is because the formula for **Min by Year** explicitly excludes **Month** from the input context. The formula looks like this:

\[
\text{Min ([Sales Revenue] In ([Year];[Quarter])) In ([Year])}
\]
This formula tells Web Intelligence to ignore month and calculate revenues by year and quarter (the input context), then output the smallest of these revenues for each year (the output context). If you had not explicitly specified the input context, the table would look like this:

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Month</th>
<th>Sales revenue</th>
<th>Min By Year</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>Q1</td>
<td>1</td>
<td>$100,564.30</td>
<td>$173,756.40</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>2</td>
<td>$63,007.25</td>
<td>$173,756.40</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>3</td>
<td>$100,768.10</td>
<td>$173,756.40</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>4</td>
<td>$95,265.90</td>
<td>$173,756.40</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>5</td>
<td>$85,675.10</td>
<td>$173,756.40</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>6</td>
<td>$178,109.50</td>
<td>$173,756.40</td>
</tr>
<tr>
<td>2001</td>
<td>Q3</td>
<td>7</td>
<td>$52,903.60</td>
<td>$173,756.40</td>
</tr>
<tr>
<td>2001</td>
<td>Q3</td>
<td>8</td>
<td>$173,756.40</td>
<td>$173,756.40</td>
</tr>
<tr>
<td>2001</td>
<td>Q3</td>
<td>9</td>
<td>$96,819.20</td>
<td>$173,756.40</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>10</td>
<td>$95,528.40</td>
<td>$173,756.40</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>11</td>
<td>$46,402.40</td>
<td>$173,756.40</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>12</td>
<td>$54,834.80</td>
<td>$173,756.40</td>
</tr>
<tr>
<td>2002</td>
<td>Q1</td>
<td>1</td>
<td>$135,549.50</td>
<td>$601,093.90</td>
</tr>
<tr>
<td>2002</td>
<td>Q1</td>
<td>2</td>
<td>$80,912.90</td>
<td>$601,093.90</td>
</tr>
<tr>
<td>2002</td>
<td>Q1</td>
<td>3</td>
<td>$136,179.50</td>
<td>$601,093.90</td>
</tr>
<tr>
<td>2002</td>
<td>Q2</td>
<td>4</td>
<td>$104,032.80</td>
<td>$601,093.90</td>
</tr>
<tr>
<td>2002</td>
<td>Q2</td>
<td>5</td>
<td>$104,189.50</td>
<td>$601,093.90</td>
</tr>
<tr>
<td>2002</td>
<td>Q2</td>
<td>6</td>
<td>$59,457.10</td>
<td>$601,093.90</td>
</tr>
<tr>
<td>2002</td>
<td>Q3</td>
<td>7</td>
<td>$101,954.70</td>
<td>$601,093.90</td>
</tr>
<tr>
<td>2002</td>
<td>Q3</td>
<td>8</td>
<td>$56,103.60</td>
<td>$601,093.90</td>
</tr>
<tr>
<td>2002</td>
<td>Q4</td>
<td>9</td>
<td>$145,625.40</td>
<td>$601,093.90</td>
</tr>
<tr>
<td>2002</td>
<td>Q4</td>
<td>10</td>
<td>$145,607.00</td>
<td>$601,093.90</td>
</tr>
<tr>
<td>2002</td>
<td>Q4</td>
<td>11</td>
<td>$138,191.50</td>
<td>$601,093.90</td>
</tr>
<tr>
<td>2002</td>
<td>Q4</td>
<td>12</td>
<td>$155,832.50</td>
<td>$601,093.90</td>
</tr>
</tbody>
</table>

In this case, the input context is now (Year, Quarter, Month), so Web Intelligence calculates revenues by year, quarter and month before outputting the smallest revenue that occurs in the Sales Revenue column for each year. For example, 173,756.40 is the smallest value that appears in the Sales Revenue column in 2001, so this value appears in the Min by Year column in all rows where the year is 2001.
What would happen if you changed output context of the formula to (Year, Quarter)? The formula now calculates revenues by year, quarter and month (the input context), but the formula’s “break” occurs at each year/quarter change, rather than each year change. As a result, the block is as follows:

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Month</th>
<th>Sales revenue</th>
<th>Min By Year, Quarter</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>Q1</td>
<td>1</td>
<td>$1003471.20</td>
<td>$650073.20</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>2</td>
<td>$132073.20</td>
<td>$650073.20</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>3</td>
<td>$1027885.10</td>
<td>$650073.20</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>4</td>
<td>$195250.80</td>
<td>$517618.50</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>5</td>
<td>$195215.10</td>
<td>$517618.50</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>6</td>
<td>$517618.50</td>
<td>$517618.50</td>
</tr>
<tr>
<td>2001</td>
<td>Q3</td>
<td>7</td>
<td>$525903.40</td>
<td>$173896.40</td>
</tr>
<tr>
<td>2001</td>
<td>Q3</td>
<td>8</td>
<td>$173896.40</td>
<td>$173896.40</td>
</tr>
<tr>
<td>2001</td>
<td>Q3</td>
<td>9</td>
<td>$699180.80</td>
<td>$173896.40</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>10</td>
<td>$655206.40</td>
<td>$484024.20</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>11</td>
<td>$484024.20</td>
<td>$484024.20</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>12</td>
<td>$484024.20</td>
<td>$484024.20</td>
</tr>
<tr>
<td>2002</td>
<td>Q1</td>
<td>1</td>
<td>$1356401.90</td>
<td>$626012.80</td>
</tr>
<tr>
<td>2002</td>
<td>Q1</td>
<td>2</td>
<td>$686128.60</td>
<td>$626012.80</td>
</tr>
<tr>
<td>2002</td>
<td>Q1</td>
<td>3</td>
<td>$1851757.90</td>
<td>$680497.10</td>
</tr>
<tr>
<td>2002</td>
<td>Q2</td>
<td>4</td>
<td>$1098318.00</td>
<td>$650497.10</td>
</tr>
<tr>
<td>2002</td>
<td>Q2</td>
<td>5</td>
<td>$1098318.00</td>
<td>$650497.10</td>
</tr>
<tr>
<td>2002</td>
<td>Q2</td>
<td>6</td>
<td>$680497.10</td>
<td>$680497.10</td>
</tr>
<tr>
<td>2002</td>
<td>Q3</td>
<td>7</td>
<td>$313156.80</td>
<td>$351993.50</td>
</tr>
<tr>
<td>2002</td>
<td>Q3</td>
<td>8</td>
<td>$313156.80</td>
<td>$351993.50</td>
</tr>
<tr>
<td>2002</td>
<td>Q3</td>
<td>9</td>
<td>$1462654.80</td>
<td>$621993.50</td>
</tr>
<tr>
<td>2002</td>
<td>Q4</td>
<td>10</td>
<td>$1545871.90</td>
<td>$1061915.30</td>
</tr>
<tr>
<td>2002</td>
<td>Q4</td>
<td>11</td>
<td>$1061915.30</td>
<td>$1061915.30</td>
</tr>
<tr>
<td>2002</td>
<td>Q4</td>
<td>12</td>
<td>$1959352.90</td>
<td>$1061915.30</td>
</tr>
</tbody>
</table>

In words, this formula tells Web Intelligence to calculate revenues by year, quarter and month, then output the smallest of these revenues that occurs in each year/quarter combination.

**Extended syntax context operators**

In the examples so far, you specified input and output contexts by using the word *In*, then listing the dimensions to be included in the context. *In* is known as a context operator. The other context operators are *ForEach* and *ForAll*. The following table describes the context operators:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>In</em></td>
<td>Used to specify dimensions explicitly. Also used with extended syntax keywords (see “Extended syntax keywords” on page 427)</td>
</tr>
<tr>
<td><em>ForEach</em></td>
<td>Adds dimensions to the context</td>
</tr>
<tr>
<td><em>ForAll</em></td>
<td>Removes dimensions from the context</td>
</tr>
</tbody>
</table>
Modifying the default calculation context using extended syntax

The In context operator

The In context operator specified dimensions explicitly in a context.

Example: Using In to specify the dimensions in a context

In this example you have a report showing Year and Sales Revenue. Your data provider also contains the Quarter object but you do not include this dimension in the block. Instead, you want to include an additional column to show the maximum revenue by quarter in each year. Your report looks like this:

<table>
<thead>
<tr>
<th>Year</th>
<th>Sales revenue</th>
<th>Max Quarterly Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>$10,000,000</td>
<td>$2,000,000</td>
</tr>
<tr>
<td>2002</td>
<td>$12,000,000</td>
<td>$4,000,000</td>
</tr>
<tr>
<td>2003</td>
<td>$15,000,000</td>
<td>$4,000,000</td>
</tr>
</tbody>
</table>

You can see where the values in the Max Quarterly Revenue column come from by examining this block alongside a block that includes the Quarter dimension:

- The Max Quarterly Revenue column shows the highest quarterly revenue in each year. For example, Q4 has the highest revenue in 2002, so the Max Quarterly Revenue shows Q4 revenue on the row showing 2002.
Using the In operator, the formula for Max Quarterly Revenue is:
Max ([Sales Revenue] In ([Year]; [Quarter])) In ([Year]).

This formula tells Web Intelligence to calculate the maximum sales revenue for each (Year, Quarter) combination, then output this figure by year.

Note: Because the default output context of the block is Year, you do not need to specify the output context explicitly in this formula.

The ForEach context operator
The ForEach operator adds dimensions to a context.

Example: Using ForEach to add dimensions to a context
In the example “Using In to specify the dimensions in a context” on page 424 you used the formula:
Max ([Sales Revenue] In ([Year]; [Quarter])) In ([Year])
to calculate the maximum revenue by year and quarter in the table, below, which does not show the Quarter dimension:

<table>
<thead>
<tr>
<th>Year</th>
<th>Sales revenue</th>
<th>Max Quarterly Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>$18591234.56</td>
<td>$345678.90</td>
</tr>
<tr>
<td>2002</td>
<td>$12323245.67</td>
<td>$456789.01</td>
</tr>
<tr>
<td>2003</td>
<td>$15659142.89</td>
<td>$678901.23</td>
</tr>
</tbody>
</table>

Using the ForEach context operator, you can achieve the same result with the formula:
Max ([Sales Revenue] ForEach ([Quarter])) In ([Year])

Why? Because the Year dimension is the default input context in the block (see “Default calculation contexts” on page 413 for more information on default contexts). By using the ForEach operator, you add the Quarter dimension to the context, giving an input context of ([Year]; [Quarter]).
The ForAll context operator

The ForAll context operator removes dimensions from a context.

**Example:** Using ForAll to remove dimensions from a context

You have a report showing Year, Quarter and Sales Revenue and you want to add a column that shows the total revenue in each year, as shown in the following block:

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales Revenue</th>
<th>Yearly Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>Q1</td>
<td>$256,070.00</td>
<td>$659,612.40</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>$227,300.00</td>
<td>$639,612.40</td>
</tr>
<tr>
<td>2001</td>
<td>Q3</td>
<td>$367,541.00</td>
<td>$809,612.40</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>$179,980.00</td>
<td>$509,612.40</td>
</tr>
<tr>
<td>2002</td>
<td>Q1</td>
<td>$332,517.20</td>
<td>$1,232,224.60</td>
</tr>
<tr>
<td>2002</td>
<td>Q2</td>
<td>$234,085.10</td>
<td>$1,232,224.60</td>
</tr>
<tr>
<td>2002</td>
<td>Q3</td>
<td>$259,393.03</td>
<td>$1,232,224.60</td>
</tr>
<tr>
<td>2002</td>
<td>Q4</td>
<td>$139,120.10</td>
<td>$1,232,224.60</td>
</tr>
<tr>
<td>2003</td>
<td>Q1</td>
<td>$374,294.09</td>
<td>$1,605,914.30</td>
</tr>
<tr>
<td>2003</td>
<td>Q2</td>
<td>$400,671.80</td>
<td>$1,605,914.30</td>
</tr>
<tr>
<td>2003</td>
<td>Q3</td>
<td>$395,325.05</td>
<td>$1,605,914.30</td>
</tr>
<tr>
<td>2003</td>
<td>Q4</td>
<td>$335,604.11</td>
<td>$1,605,914.30</td>
</tr>
</tbody>
</table>

To total revenues by year the input context needs to be (Year); by default it is (Year; Quarter). Therefore, you can remove Quarter from the input context by specifying ForAll ([Quarter]) in the formula, which looks like this:

```
Sum([Sales Revenue] ForAll ([Quarter]))
```

Note that you can use the In operator to achieve the same thing; in this case the formula is:

```
Sum([Sales Revenue] In ([Year]))
```

This version of the formula explicitly specifies Year as the context, rather than removing Quarter to leave Year.

The ForAll and ForEach operators are useful when you have a default context with many dimensions. It is often easier to "add" or "subtract" from the context using ForAll and ForEach than it is to specify the list explicitly using In.
Extended syntax keywords

Extended syntax keywords are a form of “shorthand” that allows you to refer to dimensions in extended syntax without specifying those dimensions explicitly. This helps future-proof reports; if formulas do not contain hard-coded references to dimensions, they will continue to work even if dimensions are added to or removed from a report.

There are five extended syntax keywords: **Report**, **Section**, **Break**, **Block** and **Body**.

The following sections describe each keyword, with an example to illustrate each. The section “Using keywords to make reports generic” on page 432 illustrates the way in which the use of keywords makes reports generic.

The Report keyword

The following table describes the data referenced by the **Report** keyword depending on where it is placed in a report:

<table>
<thead>
<tr>
<th>When placed in...</th>
<th>References this data...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A block</td>
<td>All data in the report</td>
</tr>
<tr>
<td>A block break (header or footer)</td>
<td>All data in the report</td>
</tr>
<tr>
<td>A section (header, footer, or outside a block)</td>
<td>All data in the report</td>
</tr>
<tr>
<td>Outside any blocks or sections in the report</td>
<td>All data in the report</td>
</tr>
</tbody>
</table>

**Example:** The Report keyword

You have a report showing **Year**, **Quarter** and **Sales revenue**. The report has a column, **Report Total**, that shows the total of all revenue in the report.

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
<th>Report Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>Q1</td>
<td>$2,692,700</td>
<td>36,397,512.4</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>$2,279,013</td>
<td>36,397,512.4</td>
</tr>
<tr>
<td>2001</td>
<td>Q3</td>
<td>$1,367,241</td>
<td>36,397,512.4</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>$1,738,652</td>
<td>36,397,512.4</td>
</tr>
<tr>
<td>2002</td>
<td>Q1</td>
<td>$3,326,172</td>
<td>36,397,512.4</td>
</tr>
<tr>
<td>2002</td>
<td>Q2</td>
<td>$2,840,651</td>
<td>36,397,512.4</td>
</tr>
<tr>
<td>2002</td>
<td>Q3</td>
<td>$2,879,303</td>
<td>36,397,512.4</td>
</tr>
<tr>
<td>2002</td>
<td>Q4</td>
<td>$4,106,120</td>
<td>36,397,512.4</td>
</tr>
<tr>
<td>2003</td>
<td>Q1</td>
<td>$3,742,989</td>
<td>36,397,512.4</td>
</tr>
<tr>
<td>2003</td>
<td>Q2</td>
<td>$4,096,710</td>
<td>36,397,512.4</td>
</tr>
<tr>
<td>2003</td>
<td>Q3</td>
<td>$3,953,395</td>
<td>36,397,512.4</td>
</tr>
<tr>
<td>2003</td>
<td>Q4</td>
<td>$3,596,941</td>
<td>36,397,512.4</td>
</tr>
</tbody>
</table>
The formula for the Report Total column is \( \text{Sum}([\text{Sales revenue}]) \) In Report. Without the Report keyword, this column would duplicate the figures in the Sales Revenue column because it would use the default output context ([Year];[Quarter]). For more information on default contexts, see “Default calculation contexts” on page 413.

The Section keyword

The following table describes the data referenced by the Section keyword depending on where it is placed in a report:

<table>
<thead>
<tr>
<th>When placed in...</th>
<th>References this data...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A block</td>
<td>All data in the section</td>
</tr>
<tr>
<td>A block break (header or footer)</td>
<td>All data in the section</td>
</tr>
<tr>
<td>A section</td>
<td>All data in the section</td>
</tr>
<tr>
<td>Outside any blocks or sections</td>
<td>Not applicable</td>
</tr>
</tbody>
</table>

Example: The Section keyword

You have a report showing Year, Quarter, and Sales revenue. The report has a section based on Year. The Section Total column has the formula:

\[ \text{Sum} ([\text{Sales Revenue}]) \text{ In Section} \]

<table>
<thead>
<tr>
<th>Year</th>
<th>Sales revenue</th>
<th>Section Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>$2,203,700</td>
<td>$2,203,700</td>
</tr>
<tr>
<td>2002</td>
<td>$2,975,000</td>
<td>$2,975,000</td>
</tr>
<tr>
<td>2003</td>
<td>$1,078,000</td>
<td>$1,078,000</td>
</tr>
<tr>
<td>2004</td>
<td>$1,799,000</td>
<td>$1,799,000</td>
</tr>
</tbody>
</table>

The figure in the Section Total column is the total revenue for 2001, because the section break occurs on the Year object. Without the Section keyword this column would duplicate the figures in the Sales revenue column, because it would use the default output context ([Year];[Quarter]). For more information on default contexts, see “Default calculation contexts” on page 413.
The Break keyword

The following table describes the dimensions referenced by the Break keyword depending on where it is placed in a report:

<table>
<thead>
<tr>
<th>When placed in...</th>
<th>References this data...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A block</td>
<td>Data in the part of a block delimited by a break.</td>
</tr>
<tr>
<td>A block break (header or footer)</td>
<td>Data in the part of a block delimited by a break.</td>
</tr>
<tr>
<td>A section (header, footer, or outside a block)</td>
<td>Not applicable.</td>
</tr>
<tr>
<td>Outside any blocks or sections in the report</td>
<td>Not applicable.</td>
</tr>
</tbody>
</table>

**Example: The Break keyword**

You have a report showing **Year**, **Quarter** and **Sales revenue**. The report has break on Year. The **Break Total** column has the formula:

\[
\text{Sum ([Sales Revenue]) In Break}
\]

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
<th>Break Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>Q1</td>
<td>$2,580,700</td>
<td>8,096,123.8</td>
</tr>
<tr>
<td></td>
<td>Q2</td>
<td>$2,279,003</td>
<td>8,096,123.8</td>
</tr>
<tr>
<td></td>
<td>Q3</td>
<td>$1,367,841</td>
<td>8,096,123.5</td>
</tr>
<tr>
<td></td>
<td>Q4</td>
<td>$1,796,566</td>
<td>8,096,123.5</td>
</tr>
</tbody>
</table>

Without the Break keyword this column would duplicate the figures in the Sales revenue column, because it would use the default output context ([Year],[Quarter]).

For more information on default contexts, see "Default calculation contexts" on page 413.
Creating custom calculations

Modifying the default calculation context using extended syntax

The Block keyword

The following table describes the dimensions referenced by the Block keyword depending on where it is placed in a report: The Block keyword often encompasses the same data as the Section keyword. One difference is that Block accounts for filters on a block whereas Section ignores them.

<table>
<thead>
<tr>
<th>When placed in...</th>
<th>References this data...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A block</td>
<td>Data in the whole block, ignoring breaks, respecting filters</td>
</tr>
<tr>
<td>A block break (header or footer)</td>
<td>Data in the whole block, ignoring breaks, respecting filters</td>
</tr>
<tr>
<td>A section (header, footer, or outside a block)</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Outside any blocks or sections</td>
<td>Not applicable</td>
</tr>
</tbody>
</table>

Example: The Block keyword

You have a report showing Year, Quarter and Sales revenue. The report has a section based on Year. The block is filtered to exclude the third and fourth quarters. The Yearly Average column has the formula:

\[
\text{Average}([\text{Sales revenue}] \text{ In Section})
\]

and the First Half Average column has the formula \(\text{Average} ([\text{Sales revenue}] \text{ In Block})\). You can see how the Block keyword takes account of the filter on the block.

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
<th>First Half Average</th>
<th>Yearly Average</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>01</td>
<td>$3,550,780</td>
<td>$2,559,061.75</td>
<td>$4,308,512.50</td>
</tr>
<tr>
<td></td>
<td>02</td>
<td>$2,279,002</td>
<td>$2,468,511.25</td>
<td>$3,606,725.50</td>
</tr>
<tr>
<td></td>
<td>Sum</td>
<td>4,839,782.5</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>2002</th>
<th>Quarter</th>
<th>Sales revenue</th>
<th>First Half Average</th>
<th>Yearly Average</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>01</td>
<td>$3,926,772</td>
<td>$3,085,411.50</td>
<td>$13,232,246.00</td>
</tr>
<tr>
<td></td>
<td>02</td>
<td>$2,940,051</td>
<td>$3,085,411.50</td>
<td>$13,232,246.00</td>
</tr>
<tr>
<td></td>
<td>Sum</td>
<td>6,866,823</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>2003</th>
<th>Quarter</th>
<th>Sales revenue</th>
<th>First Half Average</th>
<th>Yearly Average</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>01</td>
<td>$3,742,908</td>
<td>$3,974,983.20</td>
<td>$15,065,142.80</td>
</tr>
<tr>
<td></td>
<td>02</td>
<td>$4,506,718</td>
<td>$3,974,983.20</td>
<td>$15,065,142.80</td>
</tr>
<tr>
<td></td>
<td>Sum</td>
<td>7,749,706.4</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The **Body** keyword

The following table describes the dimensions referenced by the **Body** keyword depending on where it is placed in a report:

<table>
<thead>
<tr>
<th>When placed in...</th>
<th>References this data...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A block</td>
<td>Data in the block</td>
</tr>
<tr>
<td>A block break (header or footer)</td>
<td>Data in the block</td>
</tr>
<tr>
<td>A section (header, footer, or outside a block)</td>
<td>Data in the section</td>
</tr>
<tr>
<td>Outside any blocks or sections</td>
<td>Data in the report</td>
</tr>
</tbody>
</table>

**Example:** The **Body** keyword

You have a report showing **Year**, **Quarter** and **Sales revenue**, with a break on **Year**. The report has a section based on **Year** and a break on **Quarter**. The **Body** column has the formula `SUM([Sales Revenue])` in Body.

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
<th>Body</th>
</tr>
</thead>
<tbody>
<tr>
<td>2021</td>
<td>Q1</td>
<td>2,340,700</td>
<td>2,340,700</td>
</tr>
<tr>
<td></td>
<td>Q2</td>
<td>2,279,800</td>
<td>2,279,800</td>
</tr>
<tr>
<td></td>
<td>Q3</td>
<td>1,347,541</td>
<td>1,347,541</td>
</tr>
<tr>
<td></td>
<td>Q4</td>
<td>1,798,580</td>
<td>1,798,580</td>
</tr>
<tr>
<td>2001</td>
<td></td>
<td>8,096,123.6</td>
<td></td>
</tr>
</tbody>
</table>

The totals in the **Body** column are the same as those in the **Sales revenue** column because the **Body** keyword refers to the data in the block. If you were to remove the **Month** object, the figures in the **Block** column would change to correspond with the changed figures in the **Sales revenue** column. If you were to place the formula in the report footer it would return the total revenue for the block.
Using keywords to make reports generic

Extended keywords future-proof your report against changes. If you refer to data explicitly (by specifying dimensions using In, ForEach or ForAll) your reports might return unexpected data if dimensions are added or removed. The following example illustrates this.

**Example: Using the Report keyword to display percentages**

In this example you have a block that contains Year, Quarter and Sales revenue objects. You want to display revenues by year and quarter, and the percentage of the total revenue in the report that each individual revenue represents, as shown:

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
<th>Percentage of Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>Q1</td>
<td>$2600000.00</td>
<td>7.31</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>$2275000.00</td>
<td>6.26</td>
</tr>
<tr>
<td>2001</td>
<td>Q3</td>
<td>$1350000.00</td>
<td>3.76</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>$1780000.00</td>
<td>4.92</td>
</tr>
<tr>
<td>2002</td>
<td>Q1</td>
<td>$3526172.00</td>
<td>9.14</td>
</tr>
<tr>
<td>2002</td>
<td>Q2</td>
<td>$2840661.00</td>
<td>7.81</td>
</tr>
<tr>
<td>2002</td>
<td>Q3</td>
<td>$2079000.00</td>
<td>5.79</td>
</tr>
<tr>
<td>2002</td>
<td>Q4</td>
<td>$4196128.00</td>
<td>11.51</td>
</tr>
<tr>
<td>2003</td>
<td>Q1</td>
<td>$3740604.00</td>
<td>10.29</td>
</tr>
<tr>
<td>2003</td>
<td>Q2</td>
<td>$4006718.00</td>
<td>11.01</td>
</tr>
<tr>
<td>2003</td>
<td>Q3</td>
<td>$3956586.00</td>
<td>10.98</td>
</tr>
<tr>
<td>2003</td>
<td>Q4</td>
<td>$3396041.00</td>
<td>9.22</td>
</tr>
</tbody>
</table>

The formula for the Percentage of Total column is:

\[
\frac{[\text{Sales revenue}]}{\text{Sum}([\text{Sales revenue}]) \text{ In Report}} \times 100
\]

Remember that, in a block, the Report includes all data in a report, so this formula could be written:

\[
\frac{[\text{Sales revenue}]}{\text{Sum}([\text{Sales revenue}] \text{ ForAll} ([\text{Year}];[\text{Quarter}]))} \times 100
\]

Sum([Sales revenue]) ForAll ([Year],[Quarter])

tells Web Intelligence to remove Year and Quarter from the output context; in other words, to calculate a grand total, because there are no other dimensions in the report. (See “The ForAll context operator” on page 426 for an explanation of ForAll.) The formula then divides each revenue by the grand total to give its percentage of the total.
Although you can use `ForAll` in this situation, it is much better to use the `Report` keyword. Why? What if the `Month` dimension were subsequently added to the report? The version of the formula that uses the `Report` keyword still calculates each percentage correctly, but the version that explicitly specifies the `Year` and `Quarter` dimensions is now wrong:

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Month</th>
<th>Sales revenue</th>
<th>Percentage of Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>Q1</td>
<td>1</td>
<td>$100,844.20</td>
<td>36.13</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>2</td>
<td>$120,007.20</td>
<td>39.37</td>
</tr>
<tr>
<td>2001</td>
<td>Q1</td>
<td>3</td>
<td>$102,735.10</td>
<td>39.12</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>4</td>
<td>$89,258.98</td>
<td>30.11</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>5</td>
<td>$99,626.78</td>
<td>35.3</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>6</td>
<td>$51,789.66</td>
<td>17.77</td>
</tr>
<tr>
<td>2001</td>
<td>Q3</td>
<td>7</td>
<td>$52,655.65</td>
<td>30.13</td>
</tr>
<tr>
<td>2001</td>
<td>Q3</td>
<td>8</td>
<td>$173,995.42</td>
<td>11.11</td>
</tr>
<tr>
<td>2001</td>
<td>Q3</td>
<td>9</td>
<td>$689,190.88</td>
<td>16.45</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>10</td>
<td>$555,266.40</td>
<td>18.58</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>11</td>
<td>$481,924.20</td>
<td>18.95</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>12</td>
<td>$8,656.89</td>
<td>0.11</td>
</tr>
<tr>
<td>2002</td>
<td>Q1</td>
<td>1</td>
<td>$133,501.36</td>
<td>34.77</td>
</tr>
<tr>
<td>2002</td>
<td>Q1</td>
<td>2</td>
<td>$69,012.86</td>
<td>19.97</td>
</tr>
<tr>
<td>2002</td>
<td>Q1</td>
<td>3</td>
<td>$91,767.60</td>
<td>26.49</td>
</tr>
<tr>
<td>2002</td>
<td>Q2</td>
<td>4</td>
<td>$103,682.94</td>
<td>33.23</td>
</tr>
<tr>
<td>2002</td>
<td>Q2</td>
<td>5</td>
<td>$108,188.48</td>
<td>30.38</td>
</tr>
<tr>
<td>2002</td>
<td>Q2</td>
<td>6</td>
<td>$69,896.71</td>
<td>19.03</td>
</tr>
<tr>
<td>2002</td>
<td>Q3</td>
<td>7</td>
<td>$89,195.74</td>
<td>31.14</td>
</tr>
<tr>
<td>2002</td>
<td>Q3</td>
<td>8</td>
<td>$58,103.65</td>
<td>17.15</td>
</tr>
<tr>
<td>2002</td>
<td>Q3</td>
<td>9</td>
<td>$149,954.68</td>
<td>35.84</td>
</tr>
<tr>
<td>2002</td>
<td>Q4</td>
<td>10</td>
<td>$154,589.78</td>
<td>42.97</td>
</tr>
<tr>
<td>2002</td>
<td>Q4</td>
<td>11</td>
<td>$108,191.66</td>
<td>41.47</td>
</tr>
<tr>
<td>2002</td>
<td>Q4</td>
<td>12</td>
<td>$55,562.79</td>
<td>20.43</td>
</tr>
<tr>
<td>2003</td>
<td>Q1</td>
<td>1</td>
<td>$55,186.67</td>
<td>39.03</td>
</tr>
<tr>
<td>2003</td>
<td>Q1</td>
<td>2</td>
<td>$86,956.59</td>
<td>41.07</td>
</tr>
<tr>
<td>2003</td>
<td>Q1</td>
<td>3</td>
<td>$78,938.96</td>
<td>36.08</td>
</tr>
<tr>
<td>2003</td>
<td>Q2</td>
<td>4</td>
<td>$122,225.46</td>
<td>38.37</td>
</tr>
<tr>
<td>2003</td>
<td>Q2</td>
<td>5</td>
<td>$151,474.35</td>
<td>45.33</td>
</tr>
<tr>
<td>2003</td>
<td>Q2</td>
<td>6</td>
<td>$171,042.45</td>
<td>43.2</td>
</tr>
<tr>
<td>2003</td>
<td>Q3</td>
<td>7</td>
<td>$124,743.56</td>
<td>38.44</td>
</tr>
<tr>
<td>2003</td>
<td>Q3</td>
<td>8</td>
<td>$89,966.40</td>
<td>31.74</td>
</tr>
<tr>
<td>2003</td>
<td>Q3</td>
<td>9</td>
<td>$89,603.46</td>
<td>40.7</td>
</tr>
<tr>
<td>2003</td>
<td>Q4</td>
<td>10</td>
<td>$143,004.10</td>
<td>39.39</td>
</tr>
<tr>
<td>2003</td>
<td>Q4</td>
<td>11</td>
<td>$104,369.66</td>
<td>39.95</td>
</tr>
<tr>
<td>2003</td>
<td>Q4</td>
<td>12</td>
<td>$88,234.20</td>
<td>29.56</td>
</tr>
</tbody>
</table>

Why is this? The problem lies in:

```
Sum ([Sales Revenue] ForAll ([Year],[Quarter]))
```

When `Year` and `Quarter` were the only dimensions in the report, this was equivalent to “a grand total of all revenues”. Once you add the `Month` dimension, this expression removes `Year` and `Quarter` from the default output context, but leaves `Month`. 

Building Reports Using the Web Intelligence Java Report Panel | 433
The formula now has a “break” on month. In other words, on every row where
Month is 1, this expression now means “the total revenue of all month 1s”. In
every row where Month is 2, it means “the total revenue of all month 2s”. As a
result, the percentages are not the percentages you expect.
Examples of useful formulas

Example: Calculating a percentage using the Percentage function

Web Intelligence has the **Percentage** function for calculating percentages. This function calculates the percentage of a number in relation to its surrounding context. For example, the following table shows revenues by year and quarter. The percentage column contains the formula:

\[
\text{Percentage ([Sales Revenue])}
\]

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>Q1</td>
<td>$360700</td>
<td>0.07</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>$227500</td>
<td>0.06</td>
</tr>
<tr>
<td>2001</td>
<td>Q3</td>
<td>$1367841</td>
<td>0.04</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>$1788589</td>
<td>0.05</td>
</tr>
<tr>
<td>2002</td>
<td>Q1</td>
<td>$3326172</td>
<td>0.09</td>
</tr>
<tr>
<td>2002</td>
<td>Q2</td>
<td>$2540661</td>
<td>0.08</td>
</tr>
<tr>
<td>2002</td>
<td>Q3</td>
<td>$2579083</td>
<td>0.08</td>
</tr>
<tr>
<td>2002</td>
<td>Q4</td>
<td>$4196130</td>
<td>0.12</td>
</tr>
<tr>
<td>2003</td>
<td>Q1</td>
<td>$3742569</td>
<td>0.11</td>
</tr>
<tr>
<td>2003</td>
<td>Q2</td>
<td>$4002716</td>
<td>0.11</td>
</tr>
<tr>
<td>2003</td>
<td>Q3</td>
<td>$3459508</td>
<td>0.11</td>
</tr>
<tr>
<td>2003</td>
<td>Q4</td>
<td>$3356661</td>
<td>0.09</td>
</tr>
<tr>
<td>Sum:</td>
<td></td>
<td></td>
<td>1.00</td>
</tr>
</tbody>
</table>

In this case the function calculates each revenue as a percentage of the total revenue. The surrounding context is the total revenue; this is the only revenue figure that is relevant outside the breakdown by year and quarter in the table.

If the report is split into sections by year, the surrounding context outside the table becomes the total revenue in the section.

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>Q1</td>
<td>$360700</td>
<td>0.33</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>$227500</td>
<td>0.29</td>
</tr>
<tr>
<td>2001</td>
<td>Q3</td>
<td>$1367841</td>
<td>0.17</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>$1788589</td>
<td>0.22</td>
</tr>
<tr>
<td>Sum:</td>
<td></td>
<td></td>
<td>1.00</td>
</tr>
</tbody>
</table>
If the **Percentage** cell is placed outside the table but still inside the section, the surrounding context becomes the total revenue. In this case the **Percentage** function calculates the total revenue for the section as a percentage of the total overall revenue.

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>Q1</td>
<td>$2000700</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>$2279003</td>
</tr>
<tr>
<td>2001</td>
<td>Q3</td>
<td>$1367641</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>$1766880</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2002</td>
<td>Q1</td>
<td>$3260172</td>
</tr>
<tr>
<td>2002</td>
<td>Q2</td>
<td>$354055</td>
</tr>
<tr>
<td>2002</td>
<td>Q3</td>
<td>$2679303</td>
</tr>
<tr>
<td>2002</td>
<td>Q4</td>
<td>$4188120</td>
</tr>
</tbody>
</table>
Creating custom calculations
Examples of useful formulas

Example: Calculating a percentage using the Sum function

You can gain more control over the context in which a percentage is calculated by using the Sum function. If you divide one figure in a set of figures by the total of those figures, you get its percentage of the total; for example, the formula \( \frac{\text{Sales Revenue}}{\text{Sum(\text{Sales Revenue})}} \) gives the sales revenue as a percentage of the total revenue.

In the following table the Percentage of Total column has the formula: \( \frac{\text{Sales revenue}}{\text{Sum(\text{Sales revenue} In Report})} \) and the Percentage of Year column has the formula: \( \frac{\text{Sales revenue}}{\text{Sum(\text{Sales revenue} In Section})} \).

These formulas take advantage of the extended syntax keywords Report and Section to instruct the Sum function to calculate the overall total revenue and yearly revenue respectively.

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
<th>Percentage of Total</th>
<th>Percentage of Year</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>Q1</td>
<td>$2660012</td>
<td>0.07</td>
<td>0.33</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>$2279903</td>
<td>0.06</td>
<td>0.28</td>
</tr>
<tr>
<td>2001</td>
<td>Q3</td>
<td>$1,367844</td>
<td>0.04</td>
<td>0.17</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>$1765902</td>
<td>0.05</td>
<td>0.23</td>
</tr>
</tbody>
</table>

For more details on the extended syntax that you can use with functions, including the Report and Section keywords, see “Defining the calculation context” on page 412.
Example: Showing prompt input with UserResponse()

You have a report showing Year, Quarter and Sales revenue. The State object also appears in the report data, although it is not displayed. When the user runs the report they are presented with a prompt and they must choose a state. You want to show the state that they have chosen in the report title. If your data provider is called “eFashion” and the text in the prompt is “Choose a State”, the formula for the title is:

"Quarterly Revenues for " + UserResponse("eFashion";"Choose a State")

The report is as follows:

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>Q1</td>
<td>$356,454</td>
</tr>
<tr>
<td></td>
<td>Q2</td>
<td>$241,450</td>
</tr>
<tr>
<td></td>
<td>Q3</td>
<td>$107,006</td>
</tr>
<tr>
<td></td>
<td>Q4</td>
<td>$133,306</td>
</tr>
<tr>
<td>2001</td>
<td>Total</td>
<td>$730,223.80</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2002</td>
<td>Q1</td>
<td>$334,297</td>
</tr>
<tr>
<td></td>
<td>Q2</td>
<td>$354,722</td>
</tr>
<tr>
<td></td>
<td>Q3</td>
<td>$220,573</td>
</tr>
<tr>
<td></td>
<td>Q4</td>
<td>$331,087</td>
</tr>
<tr>
<td>2002</td>
<td>Total</td>
<td>$1,150,688.80</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2003</td>
<td>Q1</td>
<td>$265,868</td>
</tr>
<tr>
<td></td>
<td>Q2</td>
<td>$354,724</td>
</tr>
<tr>
<td></td>
<td>Q3</td>
<td>$375,195</td>
</tr>
<tr>
<td></td>
<td>Q4</td>
<td>$256,917</td>
</tr>
<tr>
<td>2003</td>
<td>Total</td>
<td>$1,134,085.40</td>
</tr>
</tbody>
</table>
Web Intelligence functions
Overview

This chapter looks at the functions available in Web Intelligence. You often use functions when creating Web Intelligence custom calculations. For more information on custom calculations, see “Creating custom calculations” on page 401.

This chapter covers the following topics:

• what is a function?
• using functions
• function examples and descriptions

What is a function?

In mathematics, a function is a rule relating different values or sets of values. Functions describe the relationships between variables and allow you to determine the value of one variable given the value of another variable or variables. A function prototype (see below) is a description of the relationship between input value(s) and output values and allows you to derive a value (the output value) given zero or more existing values (the input value or values). You input values to a function through its parameters and the function returns a value related to the values of the parameters.

For example, the *Left()* function describes the relationship between two input values (a character string and an integer) and a character string output value. It outputs the first [integer] characters of this character string as another character string. If the input string is ‘Hello’ and the input integer is 2, the output string is therefore ‘He’.

Note: Not all functions require input parameters.

Function prototypes

To use a function you need to know its name, how many input values it requires and the data types of these input values. You also need to know the type of data that the function outputs.

For example, the *Sum* function takes a numerical object as input (for example a measure showing sales revenue) and outputs numeric data (the sum of all the values of the measure object).
This description of a function’s inputs and outputs is known as its prototype. You see a brief description of a function prototype when you select the function in the Formula Editor. For example, if you select the `Abs` function, you see the following display:

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>number Abs (number input_number)</td>
</tr>
<tr>
<td>Returns the absolute value of a number.</td>
</tr>
</tbody>
</table>

You can get a much more detailed description of the function, including its prototype and examples of its use, by clicking the **More on this function** after you have selected the function in the Variable Editor. When you do this, the online help opens to the page that describes the function you have selected.

**Using functions**

Often you need to build additional calculations or objects into a report beyond the report’s base objects or calculations. In some cases existing report objects are sufficient to create these additional objects or calculations. For example, if you have Revenue and Number of Sales objects, you can create the formula `[Revenue]/[Number of Sales]` to show the revenue per sale.
More often you need to use functions to provide the additional calculations and objects you need. Web Intelligence has seven categories of functions:

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>All the functions for all the categories listed below in this table.</td>
</tr>
<tr>
<td>Aggregate</td>
<td>Aggregates data (for example by summing or averaging a set of values)</td>
</tr>
<tr>
<td>Character</td>
<td>Manipulates character strings</td>
</tr>
<tr>
<td>Date and Time</td>
<td>Returns date or time data</td>
</tr>
<tr>
<td>Document</td>
<td>Returns data about a document</td>
</tr>
<tr>
<td>Data Provider</td>
<td>Returns data about a document's data provider</td>
</tr>
<tr>
<td>Logical</td>
<td>Returns TRUE or FALSE.</td>
</tr>
<tr>
<td>Numeric</td>
<td>Returns numeric data</td>
</tr>
<tr>
<td>Misc</td>
<td>Functions that do not fit into the above categories</td>
</tr>
</tbody>
</table>

For more information on using functions as part of custom calculations, see “Creating custom calculations” on page 401.

You can see a full list of the functions available in Web Intelligence in the Formula Editor, or by referring to the Index of Web Intelligence Functions in the online help. For more detail on the Variable Editor, see “Creating, editing, and deleting variables” on page 450.

**Function examples and descriptions**

This section shows how to use some of the functions available with Web Intelligence to answer typical business questions. For full information on all the functions available in Web Intelligence, see the online help.

**Example: Calculating a percentage using the Percentage function**

Web Intelligence has the Percentage function for calculating percentages. This function calculates the percentage of a number in relation to its surrounding context. For example, the following table shows revenues by year and quarter. The **Percentage** column contains the formula:
Percentage ([Sales Revenue])

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>Q1</td>
<td>$23660700</td>
<td>0.07</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>$22790000</td>
<td>0.06</td>
</tr>
<tr>
<td>2001</td>
<td>Q3</td>
<td>$1367848</td>
<td>0.04</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>$17898800</td>
<td>0.06</td>
</tr>
<tr>
<td>2002</td>
<td>Q1</td>
<td>$23261723</td>
<td>0.06</td>
</tr>
<tr>
<td>2002</td>
<td>Q2</td>
<td>$3494651</td>
<td>0.02</td>
</tr>
<tr>
<td>2002</td>
<td>Q3</td>
<td>$3275901</td>
<td>0.06</td>
</tr>
<tr>
<td>2002</td>
<td>Q4</td>
<td>$41861833</td>
<td>0.12</td>
</tr>
<tr>
<td>2003</td>
<td>Q1</td>
<td>$37429995</td>
<td>0.11</td>
</tr>
<tr>
<td>2003</td>
<td>Q2</td>
<td>$40067158</td>
<td>0.11</td>
</tr>
<tr>
<td>2003</td>
<td>Q3</td>
<td>$31953955</td>
<td>0.11</td>
</tr>
<tr>
<td>2003</td>
<td>Q4</td>
<td>$35880011</td>
<td>0.09</td>
</tr>
<tr>
<td>Sum</td>
<td></td>
<td>$154864212</td>
<td>1</td>
</tr>
</tbody>
</table>

In this case the function calculates each revenue as a percentage of the total revenue. The surrounding context is in this case the total revenue; this is the only revenue figure that is relevant outside the breakdown by year and quarter in the table.

If the report is split into sections by year, the surrounding context outside the table becomes the total revenue in the section.
If the **Percentage** cell is placed outside the table but still inside the section, the surrounding context becomes the total revenue. In this case the **Percentage** function calculates the total revenue for the section as a percentage of the total overall revenue.

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>Q1</td>
<td>$2660700</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>$2279001</td>
</tr>
<tr>
<td>2001</td>
<td>Q3</td>
<td>$1369641</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>$1780500</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2002</td>
<td>Q1</td>
<td>$1356172</td>
</tr>
<tr>
<td>2002</td>
<td>Q2</td>
<td>$2840656</td>
</tr>
<tr>
<td>2002</td>
<td>Q3</td>
<td>$2898508</td>
</tr>
<tr>
<td>2002</td>
<td>Q4</td>
<td>$4198129</td>
</tr>
</tbody>
</table>
**Example:** Calculating a percentage using the Sum function

You can gain more control over the context in which a percentage is calculated by using the **Sum** function. If you divide one figure in a set of figures by the total of those figures, you get its percentage of the total; for example, the formula \([\text{Sales Revenue}] / \text{Sum(} [\text{Sales Revenue}] \text{)}\) gives the sales revenue as a percentage of the total revenue.

In the following table the **Percentage of Total** column has the formula \(\text{[Sales revenue]} / \text{Sum([Sales revenue] In Report)}\) and the **Percentage of Year** column has the formula \(\text{[Sales revenue]} / \text{Sum([Sales revenue] In Section)}\).

These formulas take advantage of the extended syntax keywords **Report** and **Section** to instruct the **Sum** function to calculate the overall total revenue and yearly revenue respectively.

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
<th>Percentage of Total</th>
<th>Percentage of Year</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>Q1</td>
<td>$650700</td>
<td>0.07</td>
<td>0.33</td>
</tr>
<tr>
<td>2001</td>
<td>Q2</td>
<td>$277903</td>
<td>0.03</td>
<td>0.20</td>
</tr>
<tr>
<td>2001</td>
<td>Q3</td>
<td>$1567641</td>
<td>0.54</td>
<td>0.37</td>
</tr>
<tr>
<td>2001</td>
<td>Q4</td>
<td>$1788683</td>
<td>0.08</td>
<td>0.25</td>
</tr>
</tbody>
</table>

For more details on the extended syntax that you can use with functions, including the **Report** and **Section** keywords, see “Defining the calculation context” on page 412.
Example: Highlighting values using the If function

The If function receives three inputs: a condition that returns true or false, a value to output if the condition is true and a value to output if the condition is false. For example the formula

\[ \text{If}([\text{Sales Revenue}] > 2000000; "High Revenue"; "Low Revenue") \]

returns “High Revenue” if the value of [Sales Revenue] is greater than 2000000. “Low Revenue” otherwise. The condition [Sales Revenue]>2000000 is true in the first case, false in the second.

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
<th>Revenue description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>Q1</td>
<td>$3,003,700</td>
<td>High Revenue</td>
</tr>
<tr>
<td></td>
<td>Q2</td>
<td>$2,279,000</td>
<td>High Revenue</td>
</tr>
<tr>
<td></td>
<td>Q3</td>
<td>$1,307,841</td>
<td>Low Revenue</td>
</tr>
<tr>
<td></td>
<td>Q4</td>
<td>$1,789,580</td>
<td>Low Revenue</td>
</tr>
</tbody>
</table>

What if you want to output three descriptions, “High revenue” (for revenues over 2000000), “Medium revenue” (for revenues between 1500000 and 2000000) and “Low revenue” (for revenues below 1500000)? In this case you nest If functions. Nesting means placing one If function inside another. The formula is as follows:

\[ \text{If} ([\text{Sales revenue}] > 2000000; "High Revenue"; \text{If} ([\text{Sales revenue}] \geq 1500000; "Medium Revenue"; "Low Revenue")) \]

The outer If function outputs “High Revenue” if the revenue is greater than 2000000. If it is not, the inner If function then determines whether the revenue is greater than or equal to 1500000 (in which case it outputs “Medium Revenue”) or less than 1500000 (in which case it outputs “Low Revenue”). The result is as follows:

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales revenue</th>
<th>Revenue description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>Q1</td>
<td>$3,003,700</td>
<td>High Revenue</td>
</tr>
<tr>
<td></td>
<td>Q2</td>
<td>$2,279,000</td>
<td>High Revenue</td>
</tr>
<tr>
<td></td>
<td>Q3</td>
<td>$1,307,841</td>
<td>Low Revenue</td>
</tr>
<tr>
<td></td>
<td>Q4</td>
<td>$1,789,580</td>
<td>Medium Revenue</td>
</tr>
</tbody>
</table>
Function reference

For a list of all the functions, operators and keywords available in Web Intelligence, together with examples of their use, see the Creating and Editing > Adding Calculations, Alerters and Formulas > Functions section in the Web Intelligence online help.
Saving formulas as variables
Overview

“Creating custom calculations” on page 401 describes Web Intelligence custom calculations and using formulas as part of calculations. You can create formulas directly in a report cell, but it is often better to save a formula as a variable. By saving a formula as a variable you can reuse it throughout the reports in a document without the need to continually retype it.

This chapter shows you how to save formulas as variables and use them in reports. It contains the following sections:

• Creating, editing, and deleting variables
• Using variables to simplify formulas

Creating, editing, and deleting variables

“Creating custom calculations” on page 401 describes how you can create custom calculations beyond the simple calculations provided by Web Intelligence. Calculations are formulas that can include base report objects and functions. Web Intelligence allows you to save a formula as a variable; a variable is simply a named formula. Saving formulas as variables has the advantages of:

• allowing you to re-use a formula in a report without the need to re-create it each time
• simplifying complex formulas by breaking them down into variables

Example: Showing the amount of revenue generated per guest

You have a report that contains [Revenue] and [Number of Guests] objects. The formula:

\[ \frac{\text{[Revenue]}}{\text{[Number of Guests]}} \]

gives the average revenue per guest. If you save this formula as a variable called Average Revenue, you can re-use it throughout a report.

Creating formulas

Variables and formulas are closely linked because variables are named formulas. To find out how to create a formula, see “Creating formulas” on page 403.
Saving formulas as variables

There are two ways of saving a formula as a variable:

• using the Create Variable dialog box – you save an existing formula as a variable
• using the Variable Editor – you create the formula and save it as a variable at the same time

Note: You can use the Create Variable dialog box to change an existing report formula to a variable.

Creating a variable using the Create Variable dialog box

To create a variable using the Create Variable dialog box:

1. Create your formula in the Formula toolbar (see “Creating formulas” on page 403) or select an existing formula in the report.

2. Click Create Variable.

The Create Variable dialog box appears.

3. Type the variable name in the Name box.

4. Select the variable type by selecting Dimension, Measure or Detail.

For a full description of the difference between each object type, see “What types of objects can you use in a query?” on page 43.
5. If you select Detail, an **Associated Dimension** box appears. Click ... next to the box to open the Objects and Variables dialog box and select the dimension you want to associate with the detail. (For more information on associating details with dimensions, see “Associating details with dimensions” on page 454.)

6. Click **OK**.

   The variable appears in the list of report variables.

   ![Variable Editor](image)

   You can now drag the variable into your report just as you do with objects.

   ▶ **Saving variables using the Variable Editor**

   To save a formula as a variable using the Variable Editor:
1. Click **Show/Hide Variable Editor** on the report panel toolbar. The **Variable Editor** appears.

![Variable Editor](image)

2. Type your formula in the **Formula** pane or use the functions and operators on the **Functions** and **Operators** tab to build the formula. (For more information, see “Using the Formula Editor” on page 406.)

3. Type the variable name in the **Name** box.

4. Select the variable type by selecting **Dimension**, **Measure** or **Detail**. For a full description of the difference between each object type, see “What types of objects can you use in a query?” on page 43.

5. If you select Detail, an **Associated Dimension** box appears. Click ... next to the box to open the Objects and Variables dialog box and select the dimension you want to associate with the detail. (For more information on associating details with dimensions, see “Associating details with dimensions” on page 454.)

6. Click **OK**.

The variable appears inside the Variables folder on the **Data** tab.
Associating details with dimensions

A detail object is an object that provides additional information about a dimension. For example, if you have a Customer and Customer Name objects, you can associate Customer Name as a detail of Customer. Web Intelligence requires a one-to-one relationship between a dimension and its associated detail(s). If a detail contains more than one value for one value of the dimension, it returns the #MULTIVALE error when placed in the same block as the dimension.

The behavior of detail objects Web Intelligence
Editing and deleting variables

After you have created a variable you can edit it or delete it.

▶ Editing a variable
To edit a variable:
1. Select the variable in the list of report variables.
2. Click the right mouse button and click Edit Variable on the shortcut menu.
   The Variable Editor appears.
3. Edit the variable.
4. Click OK to save the new variable definition.
   The variable is saved in the document. You can include the variable in any of the reports within the same document.

▶ Deleting a variable
To delete a variable:
1. Select the variable in the list of report variables.
2. Click the right mouse button and click Delete Variable on the shortcut menu.

Using variables to simplify formulas

If a formula is complex you can use variables to simplify it. By using variables you break a complex formula down into manageable parts and make it much easier to read, as well as making building formulas much less error-prone.

You can use previously-created variables in a formula in exactly the same way as you use other report objects. Variables appear in the formula editor under the “Variables” folder.

You can type this variable name into a formula or drag the variable to the Formula toolbar as you would for any report object.

Example: Create a formula to return a statistical variance

Variance is a statistical term. The variance of a set of values measures the spread of those values around their average. Web Intelligence has the function \texttt{Var()} that calculates the variance in one step, but manual calculation of variance provides a good example of how to simplify a complex formula using variables. To calculate the variance manually you need to:
• calculate the average number of items sold
• calculate the difference between each number of items sold and the average, then square this value
• add up all these squared differences
• divide this total by the number of values - 1

You have a report showing numbers of items sold by quarter and you want to include the variance. Without the use of variables to simplify it, this formula is as follows:

\[
\text{Sum}\left(\left(\text{Quantity sold} - \text{Average(Quantity sold ForEach [Quarter] In Report)}\right)^2\right) / \text{Count(Quantity sold ForEach [Quarter]) - 1}
\]

This formula is clearly unwieldy. By using variables you can simplify it to:

\[
\text{Sum \{Difference Squared\}} / \text{Number of Observations - 1}
\]

which is much easier to understand. This simplified version of the formula gives you a high-level view of what the formula is doing, rather than plunging you into the confusing details. You can then examine the formulas of the variables referenced in the high-level formula to understand its component parts.

For example, the formula references the variable Difference Squared, which itself references the variable Average Sold. By examining the formulas of Difference Squared and Average sold, you can drill down into the formula to understand the details of what it is doing.

---

**Simplifying a variance formula with variables**

As the example above shows, there are several steps involved in creating a variance formula. You encapsulate each of these steps in a variable. The variables you create are:

• average number of items sold
• number of observations (that is, the number of separate values of the number of items sold)
• difference between an observation and the average, squared
• sum of these differences divided by the number of observations - 1
In this example, your initial report looks like this:

<table>
<thead>
<tr>
<th>Quarter</th>
<th>Quantity sold</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q1</td>
<td>61,806</td>
</tr>
<tr>
<td>Q2</td>
<td>54,406</td>
</tr>
<tr>
<td>Q3</td>
<td>66,890</td>
</tr>
<tr>
<td>Q4</td>
<td>51,325</td>
</tr>
</tbody>
</table>

**Creating an Average Sold variable**

To create an Average Sold variable:

1. Click **Show/Hide Variable Editor**.
   The Variable Editor appears.

2. In the **Formula** pane, type the formula:
   - Average([Quantity Sold] In ([Quarter])) In Report
   Or
   - Double-click items on the **Data, Functions, and Operators** tabs to the **Formula** pane to build the formula.

3. Set the formula qualification to **Measure**.

4. In the **Name** text box, type:
   - Average Sold

5. Click **OK**.
Creating a Number of Observations variable
To create a Number of Observations variable:
1. Click Show/Hide Variable Editor.
   The Variable Editor appears.
2. In the Formula pane, type the formula:
   \( \text{Count([Quantity Sold] in ([Quarter]) in Report} \)
   or double-click items on the Data, Functions, and Operators tabs to the
   Formula pane to build the formula.
3. Set the formula qualification to Measure.
4. In the Name text box, type:
   Number of Observations
5. Click OK.

Creating a Difference Squared variable
To create a Difference Squared variable:
1. Click Show/Hide Variable Editor.
   The Variable Editor appears.
2. In the Formula pane, type the formula:
   \( \text{Power(([Quantity sold] - [Average Sold]);2)} \)
   or double-click items on the Data, Functions, and Operators tabs to the
   Formula pane to build the formula.
3. Set the formula qualification to Measure.
4. In the Name text box, type:
   Difference Squared
5. Click OK.
Creating the Variance variable
To create a Variance variable:

1. Click **Show/Hide Variable Editor**.
   - The Variable Editor appears.
2. In the **Formula** pane, type the formula:
   - \( \text{Sum}([\text{Difference Squared}] \text{ In } ([\text{Quarter}]))/(\text{[Number of Observations]} - 1) \)
   - or double-click items on the **Data**, **Functions**, and **Operators** tabs to the **Formula** pane to build the formula.
3. Set the formula qualification to **Measure**.
4. In the **Name** text box, type:
   - Variance
5. Click **OK**.

Adding the variance to the report
To add the variance to the report:

- Select the **Variance** variable on the **Data** tab, and then drop the variable onto the report.
Saving formulas as variables

*Using variables to simplify formulas*
Troubleshooting formulas
Overview

This chapter describes the errors that Web Intelligence generates when you create a formula that contains an error. All formula error messages begin with ‘#’ and appear in the cell in which the formula is placed.

The errors are:

• #DIV/0
• #MULTIVALUE
• #OVERFLOW
• #SYNTAX
• #INCOMPATIBLE
• #RANK
• #DATASYNC
• #CONTEXT
• #SECURITY
• #RECURSIVE
• #ERROR
#DIV/0

#DIV/0 occurs when a formula tries to divide a number by zero, which is mathematically impossible. Zero can never appear as a divisor.

**Example:** Determining revenue per item

You have a report showing sales revenues, numbers of items sold and the revenue per item (which is calculated by dividing the sales revenue by the number of items sold).

You had a very bad quarter in which you didn’t create any revenue; the Revenue per Item column returns #DIV/0 for this quarter, because the formula is attempting to divide by zero; that is, divide the revenue by zero number of items sold.
#MULTIVALUE

#MULTIVALUE occurs when you place a formula that returns more than one value in a cell that outputs one value only.

**Example: Multivalue in a cell**

You have a report showing **Country**, **Resort** and **Revenue** and you add a cell to the report containing the formula `[Revenue] ForEach ([Country])`. This cell returns #MULTIVALUE because **Country** has two values in the report: ‘US’ and ‘France’.

One cell cannot display the revenues for both the **US** and **France**. Placed outside the table, a cell containing revenue can only aggregate the revenues in the table in some way (for example by summing or averaging them).

**Note:** If the report is broken into sections on **Country**, the formula is correct when placed in a section because there is only one value of **Country** per section. Outside a section, however, the formula still returns #MULTIVALUE.

---

#OVERFLOW

#OVERFLOW occurs when a calculation returns a value that is too large for Web Intelligence to handle. This value, in exponential form, is 1.7E308 (1.7 followed by 307 zeros).

---

#SYNTAX

#SYNTAX error when a formula references an object that no longer exists in the report.

**Example: Referencing a non-existent object**

You have a report that originally showed **Year**, **Quarter** and **Sales revenue**, with an additional column showing difference between the revenue and the average yearly revenue. This figure is given by the variable **Difference from Yearly Average**.

If the **Difference from Yearly Average** variable is deleted from the report, the column containing it returns #SYNTAX.
Troubleshooting formulas

#INCOMPATIBLE

#INCOMPATIBLE occurs when a block contains incompatible objects. For an explanation of incompatible objects, see “About Incompatible objects in data providers” on page 66.

**Example:** Incompatible objects in a query
If a block based on the Island Resorts Marketing universe contains the Year and Reservation Year dimensions, the columns containing these dimensions show #INCOMPATIBLE because these objects are incompatible.

#RANK

#RANK occurs when you try to rank data based on an object that depends on the order of values. (Objects that use the Previous() function or any running aggregate function depend on the order of values.) Ranking causes these objects to recalculate their values, which then changes the ranking, resulting in a circular dependency. Such a dependency can occur either when you use the Rank dialog box to create a ranking, or when you use the Rank() function.

**Example:** Ranking on running average or previous values
If you attempt to rank a block on a column that contains the Previous() function or any running aggregate function, the entire block returns #RANK.

#DATASYNC

#DATASYNC occurs when you place a dimension from a different data provider in a block containing dimensions from another data provider, and the two data providers are not synchronized through a merged dimension. #DATASYNC appears in all dimensions in the block and #CONTEXT in the measures.

For more information on merged dimensions, see Chapter 7: Merging dimensions from multiple data providers on page 461.
Example: Dimensions from different data providers in a block
If a report based on the Island Resorts Marketing universe contains data providers with the objects (Year, Revenue) and (Quarter), a block containing Year, Quarter and Revenue displays #DATASYNC in the Year and Quarter columns because the two data providers are not synchronized through a merged dimension.

#CONTEXT

#CONTEXT is related to the #INCOMPATIBLE and #DATASYNC error messages, both of which occur when a block contains a non-existent aggregation context. In the case of #INCOMPATIBLE the aggregation context is non-existent because the dimensions are incompatible; in the case of #DATASYNC the aggregation context is non-existent because the dimensions are from multiple unsynchronized data providers.

Example: Non-existent aggregation context in a query
If a block based on the Island Resorts Marketing universe contains the Reservation Year and Revenue objects, the #CONTEXT error message appears because it is not possible to aggregate revenue by reservation year.

#SECURITY

#SECURITY occurs when you attempt to use a function for which you do not have security rights.

Example: Using the DataProviderSQL() function
If a user who does not have the right to view data provider SQL places the DataProviderSQL() function in a cell, the #SECURITY message appears in the cell.
#RECURSIVE

#RECURSIVE occurs when Web Intelligence cannot make a calculation due to a circular dependency.

**Example:** Using the `NumberOfPages()` function

If you place the `NumberOfPages()` function in a cell whose Autofit Height or Autofit Width properties are set, Web Intelligence returns `#RECURSIVE` because the placing of this formula in an autofit cell creates a circular dependency. Web Intelligence must know the exact size of the report before it can return a value from the function, but the size of the cell (which affects the size of the report) is determined by the cell content.

#ERROR

#ERROR is the default error message that covers all errors not covered by the messages described previously in this chapter.
Troubleshooting formulas

#ERROR
part

Working with Documents
Setting up documents for drill analysis
Overview

This chapter explains how you can make reports in Web Intelligence documents drillable, so that you and other users can analyze the detailed data that makes up the results displayed on tables and charts.

This chapter provides information on:

• what drill analysis is
• how to set your drill options
• making documents drillable
• beginning your drill session
• drilling on dimensions in tables and sections
• drilling on measures in tables and sections
• synchronizing drill across multiple tables and charts
• drilling on charts
• using filters when you drill
• ending your drill session
What is drill?

You use drill to analyze the results displayed in reports. Drilling on reports lets you look deeper into your data to discover the details behind a good or bad summary result displayed in tables, charts, or sections.

**Example:** Why did sales of accessories, outwear, and overcoats rise in Q3?

You work for a US national fashion retail chain, and are in charge of sales of accessories, outerwear and overcoat clothing lines in western states. You see that revenue is much higher for Q3 than the other quarters.

To understand why, you drill down to look at the factors behind the result.

You see that jewelry sales escalated in July (month #7).
Setting your drill options

Before you begin a drill session, you specify how reports will change each time you drill by setting your drill options in InfoView. This section tells you:

• about the drill options available to you
• how to select the drill options appropriate for your analysis

Available drill options

Start drill on the existing report or on a duplicate report

When you drill on a report, you can either:

• **Start drill on the existing report** – the current report becomes drillable and when you end drill mode, the report displays the drilled values.

• **Start drill on a duplicate report** – InfoView creates a duplicate of the current report and you drill on the duplicate. When you end drill mode, both the original report and the drilled report remain in the document.

Being prompted if a drill action requires additional data

When you drill the results displayed on a Web Intelligence report, you may want to drill to higher- or lower-level information that isn’t included in the scope of analysis for the document. When this is the case, Web Intelligence needs to run a new query to retrieve the additional data from the data source.

Since data providers on large selections of data can take a significant time to be completed, you can choose to be prompted with a message every time a new query is necessary. The prompt message asks you to decide whether you want to run the additional query or not. In addition, the prompt allows you to apply filters to the extra dimensions you include in the new query. This means you can restrict the size of the query to just the data necessary for your analysis.

**Note:** You need permission from your administrator to drill out of the scope of analysis during a drill session.

For more information about extending the scope of analysis in a document, see “Retrieving more levels of data to the report” on page 494.
Synchronizing or not synchronizing drill on all blocks in the report

Each table, chart, or free-standing cell in a report represents a specific block of data. There are two ways to drill on a report with multiple report blocks:

- synchronize drill on report blocks
- drill on only the selected block

The following example shows how each option affects a report as you drill down on Q4 results in a table to analyze detailed results per month in Q4.

In this example, Synchronize drill on report blocks is selected in your view options, so both the table and the chart display the drilled values:

<table>
<thead>
<tr>
<th>Year</th>
<th>Month</th>
<th>Sales revenue 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>1</td>
<td>$8,454,920</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>$3,865,261</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>$6,542,031</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>$7,845,325</td>
</tr>
<tr>
<td>AVG</td>
<td></td>
<td>$7,103,123</td>
</tr>
</tbody>
</table>

In this example, Synchronize drill on report blocks is not selected in your view options so only the table displays the drilled values:

<table>
<thead>
<tr>
<th>Year</th>
<th>Month</th>
<th>Sales revenue 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>1</td>
<td>$2,438,660</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>$9,231,848</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>$890,962</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>$7,114,569</td>
</tr>
<tr>
<td>AVG</td>
<td></td>
<td>$11,019,741</td>
</tr>
</tbody>
</table>

For more information on how drilling affects each report block, see “Synchronizing drill across multiple tables and charts” on page 499.
Setting up documents for drill analysis

Setting your drill options

 Showing or hiding the Drill toolbar

When you start drill mode, the Drill toolbar automatically appears at the top of the drilled report. The toolbar displays the value(s) on which you drilled. These values filter the results displayed on the drilled report.

For example, if you drill on the 2003 date for year, the values for Q1, Q2, Q3, and Q4 are the quarters for year 2003. This means that the quarterly values you drilled to are filtered by 2003.

The Drill toolbar allows you to select other values in order to filter the results differently. For example, if you use the Drill toolbar to select 2002, the Q1, Q2, Q3, and Q4 results displayed on the drilled block would be quarters for year 2002.

**Note:** If you are drilling in query drill mode, the drill toolbar shows only the drilled value in the list of values of the drilled dimension. For example, if you drill on 2002, you see 2002 only in the list of Year values. For more information on query drill, see “Query drill” on page 477.

If the drilled report includes dimensions from multiple data providers, a ToolTip appears when you rest your cursor on the value displayed on the filter. The ToolTip displays the name of the query and the dimension for the value.

You can opt to hide the Drill toolbar when you start drill mode. This is useful if you do not want to select filters during your drill session. You can also manually display or hide the Drill toolbar once you have started Drill mode. For more information, see “Using the Drill toolbar” on page 508.
Query drill

Query drill is a special drill mode that you can activate for each document. Normally, when you drill on a report, Web Intelligence adds drill filters to isolate the data into which you are drilling. (For more information on drill filters, see “Using filters when you drill” on page 507.) When you drill in Query Drill mode, Web Intelligence modifies the underlying query.

For more information, see “Using query drill” on page 515.
Setting your drill options

You set your drill options in InfoView. When you modify your drill options, the modifications are implemented the next time you start Drill mode.

Setting your drill options

To set your drill options:

1. On the InfoView toolbar, click **Preferences**.
2. Click the **Web Intelligence Document Preferences** tab.
   
The **Web Intelligence Document Preferences** page appears.
3. In the **Select a view format** section, select the view format that corresponds to the tasks you want to perform on reports:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then select...</th>
</tr>
</thead>
<tbody>
<tr>
<td>perform drill analysis only,</td>
<td><strong>HTML</strong></td>
</tr>
<tr>
<td>perform drill analysis and interactive reporting, (Interactive reporting possibilities include sorting and filtering, adding predefined and custom calculations, modifying the selection of data displayed in tables and charts, and modifying formatting).</td>
<td>Interactive</td>
</tr>
</tbody>
</table>

   For full information about interactive reporting, see the **Performing On-Report Analysis with Web Intelligence** guide.

4. In the **For each new drill session** section, select the drill option that corresponds to whether you want to keep a record of the report results or not before you modify those results using drill:

<table>
<thead>
<tr>
<th>If you want Web Intelligence to...</th>
<th>then select...</th>
</tr>
</thead>
<tbody>
<tr>
<td>retain a copy of the original report, so that you can compare the drilled results to the results on the original report,</td>
<td><strong>Start drill on a duplicate report</strong></td>
</tr>
<tr>
<td>drill on the existing report, so that the original report becomes modified by your drill actions,</td>
<td><strong>Start drill on the existing report</strong></td>
</tr>
</tbody>
</table>
5. In the **General drill options** section, select the options that you would like to apply during your drill sessions:

<table>
<thead>
<tr>
<th>If you want Web Intelligence to...</th>
<th>then select...</th>
</tr>
</thead>
</table>
| prompt you whenever a drill action requires a new query, so that Web Intelligence can extend the scope of analysis and add more data to reports, | Prompt if drill requires additional data  
For more information, see “Being prompted if a drill action requires additional data” on page 474.  
**Note:** Web Intelligence ignores the setting for this option if you are working in query drill mode because extension of the scope of analysis is implicit in query drill.  
For more information on query drill, see “Using query drill” on page 515.  |
| synchronize drilling on all report blocks, | Synchronize drill on report blocks  
For more information, see “Synchronizing or not synchronizing drill on all blocks in the report” on page 475.  |
| hide the **Drill toolbar** when you switch to drill mode, | Hide drill toolbar  
For more information see “Showing or hiding the Drill toolbar” on page 476.  |

1. To apply the new drill settings, click **OK**.  
The modifications are implemented the next time you open a Web Intelligence document and start Drill mode.
Making documents drillable

To make a document drillable you need to:

• specify the scope of analysis included behind the displayed results
• understand the drill hierarchies on the universe upon which the document is based

Specifying the scope of analysis for a document

The scope of analysis is the ability to include additional data in a document, which is not displayed in the reports. When you start Drill mode, you can drill on any of the displayed results down to the detailed data included in the scope of analysis. You specify the scope of analysis when you define the query for the document. The larger the scope of analysis, the more data is included in the document and the larger the document size.

You can select a predefined level for the scope of analysis or define your own custom level.

• Predefined – the scope of analysis is the same for each dimension in the report.
  For example, if you set the scope of analysis at two levels, each dimension in the report will contain additional data two levels down.

• Customized – you specify the dimensions in each class to which you want to be able to drill.
  Setting a custom scope of analysis reduces the length of time it takes Web Intelligence to run the query or refresh the reports. For example, a document might contain up to a thousand rows of data. If you know that you or other users will need to analyze only certain dimensions in the reports (for example, [Customer] or [Geography]), you can specify those dimensions in a custom scope of analysis.

For step-by-step instructions on how to define the scope of analysis for a Web Intelligence document, see “Setting the scope of analysis” on page 50.

If your security profile allows, you can drill beyond the data included in the scope of analysis to retrieve more detailed information from the data source on which the document is based. See “Retrieving more levels of data to the report” on page 494.
About drill paths and hierarchies

When you analyze data in drill mode, you move along a drill path. These paths are based on the dimension hierarchies set by the designer of the universe. Universe designers organize objects in classes in a hierarchy with the most summary objects at the top and the most detailed at the bottom. So if you want to make a high-level report, you know that your query should include objects at the top of the list. If you want to see more detailed information, you can then switch to Drill mode and drill down on each dimension value displayed in the reports.

For example, if the data from [Quarter] did not sufficiently explain a result, you could drill down to [Month] or [Week], depending on how the universe designer set up the hierarchy. When you drill to a different level, measures, such as a [Revenue] or [Margin], are recalculated accordingly.

Drill paths usually follow the same hierarchy order as the classes on a universe. For example, a class called Time typically includes the [Year] dimension at the top of the class, followed by the [Quarter], [Month], and [Week] dimensions. The hierarchies for drill within the Time hierarchy typically follow the same order, because users want to drill annual results to analyze details for quarter, month, and so on. However, the universe designer can also define custom hierarchies.

For information on designing universes, see the Designer’s Guide.
Setting up documents for drill analysis
Making documents drillable

- Viewing drill hierarchies on the universe on which a document is created

To view the drill hierarchies on the universe on which a document is created:

1. Open a document in Edit mode using the Java Report Panel.
2. Verify you are in Query View.
   The Edit Query button is pressed in when you are working in Query View.
3. Click the Data tab.
   If the Data tab is not visible, click the Show/Hide Manager button.
4. Click the Hierarchies radio button.
   The hierarchies appear.
5. To view the dimensions on each hierarchy, click the + sign next to each hierarchy.
   The hierarchies organize the dimensions with the most summary data at the top and the most detailed data at the bottom.

Note: A dimension can belong to several hierarchies. When you drill a result on a dimension that belongs to more than one hierarchy, Web Intelligence prompts you to select the drill path. See “Choosing a drill path when more than one is possible” on page 493.
Beginning your drill session

This section describes how to start a drill session, so you can analyze the data behind the results displayed on the tables and charts in reports.

*Note:* This chapter assumes that your security profile includes the necessary access rights to perform drill.

Starting drill mode

Drill mode lets you look deeper into your data to discover the details behind a good or bad summary result. To start drilling on a report you either:

- switch the report to Drill mode
- or
- if the report is saved in drill mode, drill directly

*Note:* Before you begin a drill session in Web Intelligence, you need to set your drill options in InfoView. For full information about each option and to find out how to select the appropriate options for your analysis, see “Beginning your drill session” on page 483, above.

▶ Switching to drill mode
To switch to drill mode:

1. With a document open in the Web Intelligence Java Report Panel, verify you are in Report View.
   The *Edit Report* button is pressed in when you are working in Report View.
2. Select the report you want to drill.
   The Drill button appears in the Web Intelligence toolbar.
3. Click the Drill button.
   By default, a drill icon appears on the tab of the drillable report. Depending on the drill options you selected on the *Web Intelligence Document Preferences* page in InfoView, Web Intelligence either makes the selected report drillable or creates a duplicate of the selected report, in drill mode. For information on how to set this option, see “Beginning your drill session” on page 483 above.
Opening a report saved in Drill mode

To open a report saved in Drill mode:

1. With a document open in the Web Intelligence Java Report Panel, verify you are in Report View.
   The Edit Report button is pressed in when you are working in Report View.
2. Select the report you want to drill.
   - If you have permission to drill, the report displays in drill mode.
   - If you do not have permission to drill, the report displays in Results View.
Drilling on dimensions in tables and sections

Dimensions typically represent character-type data, such as customer or business names, and dates. Web Intelligence makes calculations based on the dimensions in a report. For example, if you create a report that calculates a region’s total sales revenue for a given year, Web Intelligence calculates the [Sales revenue] measure based on the two dimensions: [State] and [Year].

When you drill on a dimension to see the more data behind the displayed result, the sales revenue is calculated according to the values to which you drill.

<table>
<thead>
<tr>
<th>State</th>
<th>Year</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>California</td>
<td>2001</td>
<td>$1,914,491</td>
</tr>
<tr>
<td></td>
<td>2002</td>
<td>$7,825,580</td>
</tr>
<tr>
<td></td>
<td>2003</td>
<td>$2,995,579</td>
</tr>
<tr>
<td>California</td>
<td>Sum:</td>
<td>$7,815,650</td>
</tr>
<tr>
<td></td>
<td>Average:</td>
<td>$2,605,150</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>State</th>
<th>Year</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colorado</td>
<td>2001</td>
<td>$445,102</td>
</tr>
<tr>
<td></td>
<td>2002</td>
<td>$160,390</td>
</tr>
<tr>
<td></td>
<td>2003</td>
<td>$643,561</td>
</tr>
<tr>
<td>Colorado</td>
<td>Sum:</td>
<td>$2,880,753</td>
</tr>
<tr>
<td></td>
<td>Average:</td>
<td>$960,251</td>
</tr>
</tbody>
</table>

When you drill down on year 2003 to view the detailed data for each quarter in year 2003, the sales revenue, sum, and average measures are calculated for each quarter.

<table>
<thead>
<tr>
<th>State</th>
<th>Quarter</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>California</td>
<td>Q1</td>
<td>$729,745</td>
</tr>
<tr>
<td></td>
<td>Q2</td>
<td>$719,936</td>
</tr>
<tr>
<td></td>
<td>Q3</td>
<td>$775,741</td>
</tr>
<tr>
<td></td>
<td>Q4</td>
<td>$697,770</td>
</tr>
<tr>
<td>California</td>
<td>Sum:</td>
<td>$2,996,079</td>
</tr>
<tr>
<td></td>
<td>Average:</td>
<td>$749,017</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>State</th>
<th>Quarter</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colorado</td>
<td>Q1</td>
<td>$204,754</td>
</tr>
<tr>
<td></td>
<td>Q2</td>
<td>$276,995</td>
</tr>
<tr>
<td></td>
<td>Q3</td>
<td>$232,899</td>
</tr>
<tr>
<td></td>
<td>Q4</td>
<td>$182,370</td>
</tr>
<tr>
<td>Colorado</td>
<td>Sum:</td>
<td>$843,504</td>
</tr>
<tr>
<td></td>
<td>Average:</td>
<td>$210,876</td>
</tr>
</tbody>
</table>

Note: You cannot drill on detail objects. For a full description and examples of detail objects, see “What types of objects can you use in a query?” on page 43.
You can drill on dimension values in tables, section cells, and charts on a report.

**Drilling on a table**

<table>
<thead>
<tr>
<th>Year</th>
<th>California Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>$1,124,711</td>
</tr>
<tr>
<td>2002</td>
<td>$1,235,886</td>
</tr>
<tr>
<td>2003</td>
<td>$2,092,678</td>
</tr>
</tbody>
</table>

**Drilling on a section cell**

This section of this guide explains how to:

- drill down to detailed information
- drill up to summary information
- drill by different dimensions to view a specific slice of data
- choose a drill path when more than one path is available
- drill to dimensions already displayed on a report block
- retrieve more data to the document to continue drilling
Drilling down

You drill down to see the lower-level data that makes up the summary results displayed on reports. This helps explain why high or low results occurred.

**Example: Using drill analysis to find out why sales decreased dramatically in 2003**

In this example, you receive a report that shows sales revenue results for the accessories line at the eFashion retail store. The following crosstab shows that the *Accessories* line decreased in 2003.

<table>
<thead>
<tr>
<th>2001</th>
<th>2002</th>
<th>2003</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Accessories</strong></td>
<td>$2,545,222</td>
<td>$5,468,019</td>
</tr>
</tbody>
</table>

To analyze more precisely when the decrease occurred, you drill down on the cell value **2003**, to view the detailed data for each quarter.

When you drill down on the cell value **2003**, a filter appears in the **Drill toolbar** to show that the quarterly values you have drilled to are filtered for the year 2003. The drilled chart clearly shows that the problem arose in **Q4** of 2003.

The Drill toolbar displays the filter on Year, to show that the quarterly values displayed on the drilled chart are for the year 2003.

To find out which of the categories within the *Accessories* line was responsible for the drop in revenue, you drill down again on the cell value *Accessories*. 
The drilled crosstab shows which categories were responsible for low revenue in Q4.

<table>
<thead>
<tr>
<th></th>
<th>Q1</th>
<th>Q2</th>
<th>Q3</th>
<th>Q4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Women's bags, wallets</td>
<td>$195,102</td>
<td>$235,782</td>
<td>$126,272</td>
<td>$229,219</td>
</tr>
<tr>
<td>Hair accessories</td>
<td>$801,574</td>
<td>$1,133</td>
<td>$48,047</td>
<td>$15,490</td>
</tr>
<tr>
<td>Hats, gloves, scarves</td>
<td>$14,664</td>
<td>$1,263</td>
<td>$12,771</td>
<td>$9,510</td>
</tr>
<tr>
<td>Jewelry</td>
<td>$17,118</td>
<td>$10,691</td>
<td>$26,496</td>
<td>$7,406</td>
</tr>
<tr>
<td>Lounge wear</td>
<td>$16,460</td>
<td>$26,342</td>
<td>$46,401</td>
<td>$22,305</td>
</tr>
<tr>
<td>Samples</td>
<td>$36,021</td>
<td>$218,041</td>
<td>$301,838</td>
<td>$89,518</td>
</tr>
</tbody>
</table>

**Note:** If you try to drill to a dimension that is already displayed in another column or row of the same table, Web Intelligence automatically displays the next available dimension in the drill path.

**Drilling down on a dimension value in a table or section cell**

To drill down on a dimension value in a table or section cell:

1. Verify you are in Drill mode.
   - The Drill button is pressed in when you are working in Drill mode and the drillable values display on the report as hyperlinks.

2. On a table or section cell, place your pointer over the dimension value on which you want to drill.
   - A ToolTip appears, showing the next dimension in the drill path.

3. Click the value.
   - The drilled table or section displays data one dimension level down.

   The Drill toolbar, at the top of the report, displays the values from which you drilled. These values filter the values displayed on the drilled table.

**Note:** If the drilled report includes dimensions from multiple data providers, the ToolTip displays the name of the query and the dimension for the value. (For more information about how drilled reports are filtered see, “Using filters when you drill” on page 507.)
Drilling up

You drill up on a dimension value to see how the more detailed data aggregates to a higher-level result. For example, you may have drilled down on Year to examine data for each quarter. If you want to see how this data aggregates to yearly results, you can drill up.

When you drill up on a dimension value, you move along the drill path from lower- to higher-level data. For example, you may have drilled down on [Year] to [Quarter]. If you drill up on [Quarter], you return to [Year].

You can only drill up on a dimension value if:

- you have previously drilled down to that dimension
- or
- you have defined the appropriate drill path in the scope of analysis.

For more information on setting the scope of analysis, see “Setting levels of analysis” on page 51.

Drilling up on a dimension value

To drill up on a dimension value:

1. Verify you are in Drill mode.
   
   The Drill button is pressed in when you are working in Drill mode and the drillable values display on the report as hyperlinks.

2. On a table or section cell, right-click the dimension value on which you want to drill up, then on the shortcut menu click Drill up.
   
   Or
   
   Click the Drill Up icon next to the dimension value you want to drill up.

   ![The Drill Up icon appears next to the name of each dimension from which you can drill up.](image)

   Note: If the table is a crosstab without headers that display the names of the dimensions on the table, then the Drill Up icon appears next to each value from which you can drill up.

   The report now displays data one dimension level up. The filters that filtered the value you drilled up from, are removed from the Drill toolbar.
Drilling by

When you drill down or up, you move through a hierarchy one dimension at a time. However, you can get another view of the data by slicing it in a different way, and then look at the data in other hierarchies. To do this, you drill by the other dimensions that interest you.

**Example:** Drilling by the Products hierarchy to slice sales revenue results by product

You work as regional manager for California in a retail clothing store, and have been sent the following report that shows quarterly sales revenue by state:

<table>
<thead>
<tr>
<th>Quarter</th>
<th>State</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q1</td>
<td>California</td>
<td>$619,250</td>
</tr>
<tr>
<td></td>
<td>Colorado</td>
<td>$131,757</td>
</tr>
<tr>
<td></td>
<td>DC</td>
<td>$18,024</td>
</tr>
<tr>
<td></td>
<td>Florida</td>
<td>$130,200</td>
</tr>
<tr>
<td></td>
<td>Hawaii</td>
<td>$276,454</td>
</tr>
<tr>
<td></td>
<td>Massachusetts</td>
<td>$37,595</td>
</tr>
<tr>
<td></td>
<td>New York</td>
<td>$655,503</td>
</tr>
<tr>
<td></td>
<td>Texas</td>
<td>$167,796</td>
</tr>
<tr>
<td>Q1</td>
<td>Sum:</td>
<td>$2,608,409</td>
</tr>
<tr>
<td></td>
<td>Average:</td>
<td>$372,587</td>
</tr>
</tbody>
</table>

You are only interested in analyzing the results in the state of California. In addition, you want to analyze the sales revenue broken down by each product line you sell. To drill on California data, you place your pointer on the table cell that says California.

If you drilled down now, however, you would drill to results for each city within California, because [City] is the dimension below [State]. Instead, you select Drill by from the drill menu and then you navigate through the dimensions on the Products hierarchy by selecting the sub-menus until you reach the [Lines] dimension.
The drilled report displays the detailed sales revenue results for each product line sold in California.

<table>
<thead>
<tr>
<th>Quarter</th>
<th>2 Lines</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q1</td>
<td>Accessories</td>
<td>$219,696</td>
</tr>
<tr>
<td></td>
<td>City Skirts</td>
<td>$25,294</td>
</tr>
<tr>
<td></td>
<td>City Trouser</td>
<td>$2,003</td>
</tr>
<tr>
<td></td>
<td>Dresses</td>
<td>$22,382</td>
</tr>
<tr>
<td></td>
<td>Jackets</td>
<td>$11,389</td>
</tr>
<tr>
<td></td>
<td>Leather</td>
<td>$5,000</td>
</tr>
<tr>
<td></td>
<td>Outerwear</td>
<td>$6,812</td>
</tr>
<tr>
<td></td>
<td>Overcoat</td>
<td>$3,360</td>
</tr>
<tr>
<td></td>
<td>Shirt Waist</td>
<td>$6,524</td>
</tr>
<tr>
<td></td>
<td>Skirt</td>
<td>$22,480</td>
</tr>
<tr>
<td></td>
<td>Short-Sleeved Shirt</td>
<td>$156,722</td>
</tr>
<tr>
<td></td>
<td>Trousers</td>
<td>$8,209</td>
</tr>
</tbody>
</table>

Q1  | Sum: | $515,220 |
    | Average: | $41,288 |

Drilling by a dimension value

To drill by a dimension value:

1. Verify you are in Drill mode.

   The Drill button is pressed in when you are working in Drill mode and the drillable values display on the report as hyperlinks.

2. On a table or section cell, right-click the dimension value you want to drill by.

A shortcut menu appears, displaying the available drill paths.
3. Place your pointer on **Drill by**, then on the class to which you want to drill.
4. Click the dimension to which you want to drill.

The report now displays data for the dimension to which you drilled.

The *Drill toolbar* displays the values that filter the results displayed on the drilled table. This drilled table displays results for 2001 Q1.

**Note:** You can only Drill by to a dimension that is included in the scope of analysis of the document. For more information, see “Setting levels of analysis” on page 51.
Choosing a drill path when more than one is possible

A dimension can belong to several classes. When you drill down on such a dimension value, Web Intelligence does not know which drill path to follow. You must define the drill path.

► Choosing a drill path when more than one is available
To choose a drill path when more than one is available:

1. Verify you are in Drill mode.
   The Drill button is pressed in when you are working in Drill mode and the drillable values display on the report as hyperlinks.

2. Drill on a dimension value in a table or section cell.
   The Select Drill Path dialog box appears.

3. Select the path you want to drill.
4. Click OK.

Note: If the dimension value you choose to drill on is the result of a previous drill, the drill path is already known. Therefore you do not need to select a drill path.
Retrieving more levels of data to the report

When you are drilling a Web Intelligence report, you may want to drill up or down to a dimension that lies outside the scope of analysis defined for the document. To return the additional data, Web Intelligence must run a new query that includes the additional dimension(s) you specify. This is called extending the scope of analysis.

When you extend the scope of analysis, you can select filters to limit the data Web Intelligence retrieves when running the new query. This saves time, if you are working with a large document. If you have several reports in one document, and you select filters when you extend the scope of analysis, those filters affect all the reports in the document.

Note: You will not be given the option to select filters, if your Drill options are set not to display the Extend the Scope of Analysis prompt message during drill. In this case, Web Intelligence automatically returns data for all the values on the dimensions you are drilling. To find out how to modify your drill options see, “Being prompted if a drill action requires additional data” on page 474.

Drilling out of the scope of analysis
To drill out of the scope of analysis:

1. Verify you are in Drill mode.
   The Drill button is pressed in when you are working in Drill mode and the drillable values display on the report as hyperlinks.

2. Drill on a dimension value.
   A ToolTip informs you that a new query is necessary to return the additional data to the document.
If your Drill options are set for Web Intelligence to prompt you when a drill action requires a new query, the **Extend the Scope of Analysis** dialog box appears.

The dialog box lists the dimensions in the hierarchy above and below the drilled value. The dimensions already included in the document are checked.

The dialog box also displays the filters that you can select to filter the new query. For example, in the illustration above Web Intelligence suggests that you filter the query by limiting the additional data for **Lines** to data for the **Accessories** line. If you don’t select the filter, Web Intelligence will return data for all product lines to the document.

3. Select the check box(es) next to the dimension(s) to which you want to drill.

4. Select the check box(es) next to the filters you want to use to filter the query.

5. Click **OK**.

Web Intelligence runs a new query and returns the additional data to the document.

The results for the dimension you drilled to appear on the table.

**Note:** You need permission from your administrator to drill out of the scope of analysis during a drill session.
Drilling on measures in tables and sections

When you drill on a measure value, Web Intelligence performs the drill action one level down for each related dimension in the block and displays the new measure calculation for the displayed dimensions.

**Example:** Drill on annual sales revenue results to see the breakdown by city and quarter

For example, you drill down on the year 2003 sales revenue value for California, which is displayed on a crosstab that shows sales revenue by year in by state.

<table>
<thead>
<tr>
<th>State</th>
<th>2001</th>
<th>2002</th>
<th>2003</th>
</tr>
</thead>
<tbody>
<tr>
<td>California</td>
<td>$1,746,211</td>
<td>$2,790,600</td>
<td>$3,592,670</td>
</tr>
<tr>
<td>Colorado</td>
<td>$456,302</td>
<td>$769,395</td>
<td>$1,269,620</td>
</tr>
<tr>
<td>BC</td>
<td>$199,211</td>
<td>$251,158</td>
<td>$328,328</td>
</tr>
<tr>
<td>Florida</td>
<td>$406,385</td>
<td>$801,250</td>
<td>$111,524</td>
</tr>
<tr>
<td>Illinois</td>
<td>$732,514</td>
<td>$1,103,050</td>
<td>$1,392,000</td>
</tr>
<tr>
<td>Massachusetts</td>
<td>$2,289,819</td>
<td>$1,975,719</td>
<td>$822,168</td>
</tr>
<tr>
<td>New York</td>
<td>$1,667,050</td>
<td>$2,763,500</td>
<td>$3,151,022</td>
</tr>
<tr>
<td>Texas</td>
<td>$2,195,072</td>
<td>$3,732,505</td>
<td>$4,165,000</td>
</tr>
</tbody>
</table>

The drilled report displays sales revenue by quarter by city for California – the state on which you drilled.

The Drill ToolTip shows you which dimension levels you will drill to.

The following section of this guide tells you how to do the following drill analysis on measures displayed on tables and sections:

- drill up
- drill down

For information about drilling on measure values displayed on charts, see “Drilling on measures in charts” on page 503.
Drilling down on a measure value

To drill down on a measure value:

1. Verify you are in Drill mode.
   
The Drill button is pressed in when you are working in Drill mode and the drillable values display on the report as hyperlinks.

2. Place your pointer over the measure value on which you want to drill. Only values with hyperlinks are drillable.
   
   A ToolTip appears, displaying the next dimension(s) in each related drill path.

3. Click the measure value.
   
   Your report now displays data one dimension level down.

   The table headers display the names of the dimensions you drilled to and the drill up arrow, which indicates you can drill back up to the summary results if wished. The Drill toolbar displays the values that filter the results displayed on the drilled table or section.

   **Tip:** If the table you are drilling is a crosstab, and the dimension names are not displayed in the headers, you can display the dimension names by following the steps in “Displaying object names in headers on crosstabs” on page 207.
Drilling up on a measure value in a table or section cell

To drill up on a measure value in a table or section cell:

1. Verify you are in Drill mode.
   
   The Drill button is pressed in when you are working in Drill mode and the drillable values display on the report as hyperlinks.

2. Right-click the measure value on which you want to drill up, then click the Drill up option on the shortcut menu.

   Or

   Click the Drill Up icon next to the measure value you want to analyze.

The drilled table now displays data one dimension level up.
Synchronizing drill across multiple tables and charts

A Web Intelligence report can contain several tables or charts. The generic term used to refer to tables and charts in this guide is a block. There are two ways to drill on a report with multiple blocks:

- drill simultaneously on each block in the report the contains the drilled dimension
- drill on only the current block of data

**Note:** You set how Web Intelligence performs drill on reports with multiple blocks in the Drill options section on the Web Intelligence Document Preferences page in InfoView. For more information on setting your drill options, see “Beginning your drill session” on page 483.

Synchronizing the drill on all blocks in a report

If you set Web Intelligence to synchronize drilling across a report, you drill on each block in the report containing that drilled dimension. The next dimension in the drill path replaces the previous dimension in all blocks of the report.

For example, if you drill on the Year 2003 in the crosstab below to view results for each quarter in year 2003, both the crosstab and the chart show the drilled results for quarter. When you activate Drill mode, the report looks like this:

<table>
<thead>
<tr>
<th>State</th>
<th>Year 2001</th>
<th>Year 2002</th>
<th>Year 2003</th>
<th>Average</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Sales revenue</td>
<td>Sales revenue</td>
<td>Sales revenue</td>
<td></td>
</tr>
<tr>
<td>California</td>
<td>$7,394,251</td>
<td>$7,791,880</td>
<td>$7,992,919</td>
<td>$7,992,919</td>
</tr>
<tr>
<td>New York</td>
<td>$548,327</td>
<td>$579,980</td>
<td>$663,013</td>
<td>$688,798</td>
</tr>
<tr>
<td>Florida</td>
<td>$513,752</td>
<td>$579,980</td>
<td>$714,913</td>
<td>$699,597</td>
</tr>
<tr>
<td>Texas</td>
<td>$478,695</td>
<td>$611,420</td>
<td>$611,420</td>
<td>$611,420</td>
</tr>
<tr>
<td>Arizona</td>
<td>$321,925</td>
<td>$378,927</td>
<td>$378,927</td>
<td>$378,927</td>
</tr>
<tr>
<td>New York</td>
<td>$317,230</td>
<td>$371,038</td>
<td>$311,342</td>
<td>$317,947</td>
</tr>
<tr>
<td>Texas</td>
<td>$235,592</td>
<td>$274,592</td>
<td>$165,109</td>
<td>$274,592</td>
</tr>
<tr>
<td>Average</td>
<td>$313,917</td>
<td>$345,831</td>
<td>$312,383</td>
<td>$313,917</td>
</tr>
</tbody>
</table>

![Sales revenue chart](chart.png)
After drill, when drill is synchronized across report blocks, the report looks like this:

<table>
<thead>
<tr>
<th>City</th>
<th>Year 2001</th>
<th>Year 2002</th>
<th>Year 2003</th>
<th>Average</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales Revenue</td>
<td>$4,000,000</td>
<td>$4,500,000</td>
<td>$5,000,000</td>
<td>$4,750,000</td>
</tr>
<tr>
<td>California</td>
<td>$1,000,000</td>
<td>$1,100,000</td>
<td>$1,200,000</td>
<td>$1,100,000</td>
</tr>
<tr>
<td>Canada</td>
<td>$1,000,000</td>
<td>$1,100,000</td>
<td>$1,200,000</td>
<td>$1,100,000</td>
</tr>
<tr>
<td>Europe</td>
<td>$1,000,000</td>
<td>$1,100,000</td>
<td>$1,200,000</td>
<td>$1,100,000</td>
</tr>
<tr>
<td>Japan</td>
<td>$1,000,000</td>
<td>$1,100,000</td>
<td>$1,200,000</td>
<td>$1,100,000</td>
</tr>
<tr>
<td>Mexico</td>
<td>$1,000,000</td>
<td>$1,100,000</td>
<td>$1,200,000</td>
<td>$1,100,000</td>
</tr>
<tr>
<td>Europe Total</td>
<td>$5,000,000</td>
<td>$5,500,000</td>
<td>$6,000,000</td>
<td>$5,750,000</td>
</tr>
</tbody>
</table>

Drilling on only the selected block in a report

If you set Web Intelligence not to synchronize drilling on all blocks in a report, the next dimension in the drill path replaces the previous dimension only in the current block of the report. For example, if you drill on the Year 2003 in the crosstab, below, to view results for each quarter in year 2003, only the crosstab displays the drilled results for each quarter:

<table>
<thead>
<tr>
<th>City</th>
<th>Year 2003</th>
<th>Average</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales Revenue</td>
<td>$3,000,000</td>
<td>$3,250,000</td>
</tr>
<tr>
<td>California</td>
<td>$1,000,000</td>
<td>$1,000,000</td>
</tr>
<tr>
<td>Canada</td>
<td>$1,000,000</td>
<td>$1,000,000</td>
</tr>
<tr>
<td>Europe</td>
<td>$1,000,000</td>
<td>$1,000,000</td>
</tr>
<tr>
<td>Japan</td>
<td>$1,000,000</td>
<td>$1,000,000</td>
</tr>
<tr>
<td>Mexico</td>
<td>$1,000,000</td>
<td>$1,000,000</td>
</tr>
<tr>
<td>Europe Total</td>
<td>$3,000,000</td>
<td>$3,250,000</td>
</tr>
</tbody>
</table>

The entire report, however, is filtered for 2003, which means that only results for year 2003 are displayed in blocks that include the [Year] dimension.

Note:
Drilling on charts

Drilling down, up, or by on a chart, provides you with a graphical explanation for why summary results are particularly high or low.

The following section of this guide tells you how to drill on:

- dimensions – by drilling on chart axes
- measures – by drilling on the data bars or markers in the body of the chart
- dimensions – by drilling on the chart legend

**Note:** You cannot **Drill by** dimensions on chart axes. However, you can **Drill by** dimensions on chart legends (see “Drilling on axis legends” on page 506).

For information on creating and formatting charts in Web Intelligence reports, see “Template book” on page Chapter.

**Drilling on dimensions via chart axes**

On 2D charts, you can drill on dimensions via the X-Axis. On 3D charts, you can drill on dimensions via the X-Axis and the Z-Axis. Charts can contain one or multiple dimensions on a single axis. When an axis contains multiple dimensions, each possible combination of the dimension values appear on the axis (this is sometimes referred to as a cartesian product).

In the 2D bar chart illustrated below, the X-axis includes the [Year] and [Quarter] dimensions. Each bar on the chart shows the values for one combination of year and quarter; for example, 2001/Q1, 2001/Q2, and so on.

![Image of a bar chart with X-axis values and drill down functionality](image)

When you drill on an axis value with multiple dimensions, the drilled results are filtered by both dimensions. For example, in the chart illustrated above, if you drill down on **2001/Q1** to the next level of data for [Month], the results displayed on the drilled chart are those for the months in Q1 of 2001.
### Drilling on a chart axis with a single dimension

To drill on a chart axis with a single dimension:

1. Verify you are in Drill mode.
   
   The **Drill** button is pressed in when you are working in Drill mode.

2. Place your pointer over the dimension value on which you want to drill.

3. The next step depends on whether you want to drill down, drill up, or drill by on the dimension value:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>drill down on the dimension</td>
<td>click the value.</td>
</tr>
<tr>
<td>value,</td>
<td></td>
</tr>
<tr>
<td>drill up on the dimension</td>
<td>right-click the value, then click <strong>Drill</strong></td>
</tr>
<tr>
<td>value,</td>
<td><strong>up</strong>.</td>
</tr>
<tr>
<td>drill by on the dimension</td>
<td>right-click the value, then click <strong>Drill</strong></td>
</tr>
<tr>
<td>value,</td>
<td><strong>by</strong>.</td>
</tr>
</tbody>
</table>

The chart displays the value(s) for the dimension to which you drilled.

### Drilling on a chart axis with multiple dimensions

To drill on a chart axis with multiple dimensions:

1. Verify you are in Drill mode.

   The **Drill** button is pressed in when you are working in Drill mode.

2. Place your pointer over the values on which you want to drill.

3. The next step depends on whether you want to drill down or drill up on the dimension value:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>drill down on the dimension</td>
<td>click the values.</td>
</tr>
<tr>
<td>values,</td>
<td></td>
</tr>
<tr>
<td>drill up on the dimension</td>
<td>right-click the values, then click <strong>Drill</strong></td>
</tr>
<tr>
<td>values,</td>
<td><strong>up</strong>.</td>
</tr>
</tbody>
</table>

**Note:** You cannot **Drill by** on a chart axis with multiple dimensions.

The chart displays the value(s) for the dimension to which you drilled.
Drilling on measures in charts

You can drill on the measures displayed on the following types of chart:

- bar charts – by drilling on the bars
- line and radar line charts – by drilling on the data markers
- pie chart – by drilling on the segments

When you drill on measures, Web Intelligence performs the drill action on each dimension displayed on the chart axes. The new measure calculations displayed on the bars or data markers on the drilled chart, correspond to the lower- or higher-level dimensions to which you drilled. The chart axis labels display the names of the drilled dimensions.

**Example:** Analyze detailed information for the sales revenue measure on a chart

For example, this 3D bar chart displays values for the [State] dimension on the X-Axis and displays values for the [Lines] dimension on the Z-Axis. This means that the chart bars display values for **sales revenue per state per line**.

As the example below shows, when you drill down on the bar for “City Trousers” in “California” you also drill down from [State] to [City] on the X-Axis and from [Lines] to [Category] on the Y-Axis.
The drilled chart displays sales revenue per city per category for the “City Trousers” clothing line.

The Drill toolbar displays the values that filter the dimensions displayed on the chart. By looking at the filters in this example, you can quickly see that the chart only displays sales revenue information for City Trousers sold in California during Q1 in 2001.

Drilling on a measure in a chart
To drill on a measure in a chart:
1. Verify you are in Drill mode.
   The Drill button is pressed in when you are working in Drill mode.
2. Place your pointer on the measure value on which you want to drill.
   On charts, each measure is represented by a bar (on bar charts) or by a data marker (on a line charts and radar line charts).
3. The next step depends on whether you want to drill down or drill up on the measure value:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>drill down on the measure value</td>
<td>click the bar or data marker.</td>
</tr>
<tr>
<td>drill up on the measure value</td>
<td>right-click the bar or data marker, and then click Drill up.</td>
</tr>
</tbody>
</table>

The chart displays the value(s) for the dimension to which you drilled.
Limitations when drilling on measures on certain chart types

When you drill on charts that are not bar charts, Web Intelligence may perform the drill action only on certain dimensions instead of performing the drill action on all of the dimensions on the chart axes. When you drill on measures in the following chart types, Web Intelligence only performs the drill action on the values in the axis legend:

- area charts – 2D, 3D, and stacked
- radar and scatter charts – all types

For more information, see “Drilling on axis legends” on page 506.

Note: You cannot drill on measures in 3D surface charts.
Drilling on axis legends

You can drill on charts via the chart legend whenever the legend lists the dimensions displayed on the chart. When the chart legend lists the measures displayed on the chart, drilling on the legend is not possible. The example, below, shows drilling on California, which is one of the values on the [State] dimension listed in the legend.

Drilling on a legend is useful, if you are working with a pie chart, because the axis labels, which display the names of the dimensions represented by each pie segment, are not often displayed. (To find out how to display the axis labels on pie charts, see “Showing/hiding axis labels on pie charts” on page 253). Also, when a result is low, the segment of the pie can be too small to drill.

**Note:** You can only Drill by on a chart legend, if there is a single dimension on the axis.

> **Drilling on an axis legend**

To drill on an axis legend:

1. Verify you are in Drill mode.
   
   The Drill button is pressed in when you are working in Drill mode.
2. Place your pointer over the value on which you want to drill.
3. The next step depends on the direction in which you want to drill:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>drill down the dimension value,</td>
<td>• click the color associated with the value.</td>
</tr>
<tr>
<td>drill up the dimension value,</td>
<td>• right-click the color associated with the value, then click Drill up. or • click the Drill Up icon.</td>
</tr>
<tr>
<td>drill by the dimension value,</td>
<td>• right-click the color associated with the value, then click Drill by.</td>
</tr>
</tbody>
</table>

The chart displays the value(s) for the dimension to which you drilled.
Using filters when you drill

When you drill on a dimension or measure value in a table or chart, Web Intelligence filters the drilled results by the dimension or measure you drilled on. The filter is applied to all of the results displayed on the drilled report.

**Example: Filtering drilled reports by different US states**

For example, if you drill down on a table cell displaying “California,” to view results for cities in California, Web Intelligence filters the values in the entire report for California and only displays results for California in the report.

By changing the value of each filter, you can then see data for other values on the drilled dimension.

For example, you can select Colorado in the filter on State.

Now the drilled report displays values for Colorado instead of California.

**Note:** If the drilled report includes dimensions from multiple data providers, a ToolTip appears when you rest your cursor on the value displayed on the filter. The ToolTip displays the name of the query and the dimension for the value.
Using the Drill toolbar

You can choose to show or hide the **Drill toolbar**.

**Showing or hiding the Drill toolbar**

To show or hide the **Drill toolbar**:

1. Verify you are in Drill mode.
   
   The **Drill** button is pressed in when you are working in Drill mode.
   
   The **Show/Hide Drill Toolbar** button is activated on the report panel toolbar.

2. The next step depends whether the **Drill toolbar** is displayed or not at the top of the report:

<table>
<thead>
<tr>
<th>If...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>the <strong>Show/Hide Drill Toolbar</strong> button is pressed in,</td>
<td>click the button to hide the <strong>Drill toolbar</strong>.</td>
</tr>
<tr>
<td>the <strong>Show/Hide Drill Toolbar</strong> button is not pressed in,</td>
<td>click the button to show the <strong>Drill toolbar</strong>.</td>
</tr>
</tbody>
</table>

**Tip:** You can set your drill options in InfoView, so that when you open a document to start Drill mode, the **Drill toolbar** is always hidden by default. For more information, see “Showing or hiding the Drill toolbar” on page 476.
Changing filter values during drill analysis

Filters appear as list boxes in the Drill toolbar. Each list box contains the values associated with that filter. You select the data displayed in a table or chart by choosing the appropriate values from the list boxes. For example, if you drill on results for Q3 to see more detailed data for month, the monthly results are filtered for Q3. To see monthly results for another quarter, you simply change the filter value in the list box by selecting the quarter you want.

► Changing a filter value on the Drill toolbar

To change a filter value on the Drill toolbar:

1. Verify you are in Drill mode.
   
   The Drill button is pressed in when you are working in Drill mode. The filters display as list boxes on the Drill toolbar.

2. In the Drill toolbar, click the drop-down arrow in the appropriate list box.
   
   Each dimension value associated with that filter appears.

3. Click the value you want.
   
   The report displays data based on the new dimension value.
Adding and removing filters

You can add and remove filters to the Drill toolbar. This enables you to quickly filter the values displayed on the drilled table or chart. For example, you can filter the displayed values by a specific geographical area or time period.

- **Adding a filter to a drilled report**
  
  To add a filter to a drilled report:
  
  1. Verify you are in Drill mode.
     
     The Drill button is pressed in when you are working in Drill mode.
  2. From the Data tab, drag the dimension containing the values around which you want to filter your report and drop it onto the Drill toolbar.

A list box for the new filter appears on the Drill toolbar.

You can select a value from the list of values to filter the results displayed on the drilled table, chart, or report.
Removing a filter from a drilled report

To remove a filter from a drilled report:

1. Verify you are in Drill mode.

   The Drill button is pressed in when you are working in Drill mode.

2. Verify that the Data tab is visible in the frame to the left of the report.

   If the Data tab is not visible, click the Show/Hide Manager button on the Report toolbar.

3. Place your pointer over the dimension icon on the left of the list box of the filter you want to remove.

   Your pointer changes to a crossbar.

4. Press your pointer, and then, with the pointer still pressed in, drag the list box onto the Data tab to the left of the report.

Web Intelligence removes the filter and the report values change accordingly.
Inserting the DrillFilters cell into your report

Inserting the DrillFilters cell into a report is useful when you want to distribute a drilled report results to users who do not have the security profile to drill. The DrillFilters cell displays the dimensions you drilled during your drill analysis.

The filters remain displayed in the DrillFilters cell when you end drill mode. Other users who read the drilled report can then easily see how the report information is filtered.

The DrillFilters cell is also useful if you want to print a copy of a drilled report and want to show readers of the report how the information is filtered.

To find out how to insert the DrillFilters function as a predefined cell into a report, see “Inserting the Last Refresh Date or Drill Filter cell” on page 218.
Saving reports with filters

When you save a document with reports in drill mode, Web Intelligence maintains any filters that have been generated during drill. When you open a document saved in drill mode, Web Intelligence displays the **Drill toolbar** on the drilled reports showing the filters generated during the last drill session.

For more information, see “Saving your drilled results” on page 519.

**Note:** Documents saved in drill mode take longer to open than documents saved in results mode. To find out how to return to results mode, see “Ending drill mode” on page 519.
Refreshing data in a report with prompts

Some Web Intelligence reports contain prompts. When you refresh the document, the prompt(s) require(s) you to specify the value(s) you want to retrieve from the database and return to the report(s) in the document. For example, a prompt can require you to specify a year, for which you want to retrieve data. This drilled report shows values for Year 2003 – the year selected for the prompt.

The Drill toolbar shows that the [Year] dimension is filtered for 2003.

If the drilled report is filtered for Year 2003, and you then refresh the document and select year 2002 to answer the prompt, Web Intelligence retrieves results for 2002 instead of 2003.

The drilled report then displays values for 2002.
Using query drill

You can set Web Intelligence to drill in *query drill* mode, which behaves differently from the standard drill mode described so far in this chapter. When you activate query drill, Web Intelligence drills by modifying the underlying query (adding and removing dimensions and query filters) in addition to applying drill filters.

**Example:** Drilling down from Month to Week

In this example, Month is the lowest dimension currently available in the query from a time hierarchy, and Week is the dimension immediately below it in the hierarchy.

If you drill down on Month = January, three things happen:
- Web Intelligence adds Week to the query scope of analysis.
- Web Intelligence adds a query filter to restrict Month to January.
- Web Intelligence adds a drill filter to restrict Month to January.

If you drill up from Week to Month, the process is reversed:
- Web Intelligence removes Week from the query scope of analysis.
- Web Intelligence removes the query filter.
- Web Intelligence removes the drill filter.

**Note:** Drill filters are not strictly necessary in query drill mode. Web Intelligence applies them for consistency with standard drill mode. For example, the `DrillFilters()` function returns the correct value in query drill mode because Web Intelligence applies drill filters to match the query filters.

For information on how to activate query drill, see “Activating query drill” on page 517.

When do you use query drill?

You use query drill when your report contains aggregate measures calculated at the database level. It is designed in particular to provide a drill mode adapted to databases such as Oracle 9i OLAP, which contain aggregate functions that Web Intelligence either does not support, or cannot calculate accurately at the report level during a drill session.
The kinds of aggregate functions that are candidates for drilling in query drill mode are: percentages, distinct counts, ranks, standard deviations and variances, running aggregates, lead and lag functions. Because query drill modifies the query at each drill operation, it ensures that these aggregates are recalculated by the server each time you drill.

Query drill is also useful for reducing the amount of data that Web Intelligence must store locally during a drill session. Because query drill reduces the scope of analysis when you drill up, Web Intelligence is able to purge unnecessary data.

**Drilling with query drill**

**Drilling down**

When you drill down, query drill behaves similarly to standard drill at the point where the data moves outside the scope of analysis.

When Web Intelligence filters a drilled dimension in query drill mode it does so by adding a query filter in addition to a drill filter. For example, if you drill on Year=2001, Web Intelligence adds a filter at the query level to restrict the Year dimension to 2001. For this reason, the only value that appears in the drill toolbar for the drilled dimension is the value on which you drilled (in this case 2001). This is different from standard drill mode, in which all values of the dimension are visible in the toolbar. As a result, you cannot change filter values in query drill mode (for example, drill on Year=2001 then switch to Year=2003) as you can in standard drill mode. (For more information on changing filter values during drill analysis, see “Changing filter values during drill analysis” on page 509.)

Because query drill automatically extends the scope of analysis, you can use it only if your BusinessObjects XI administrator has granted you the right to drill outside the scope. See your administrator for more details.

**Drilling up**

When you drill up, query drill removes dimensions from the query. For example, if you drill up from Month to Quarter, Web Intelligence removes Month from the query. This has two consequences:

- Query drill is incompatible with drill snapshots. For more information, see “Query drill and drill snapshots” on page 517.
- Web Intelligence does not allow you to drill up beyond any dimension that appears as one of the report objects. For example, if your report displays Year, Quarter and Revenue, you cannot drill up from Quarter to Year because this would remove quarter from the list of report objects.
Query drill and the scope of analysis

Query drill adds and removes dimensions from the scope of analysis in response to drill actions. For this reason, you cannot set the scope of analysis manually when using query drill. In addition, you cannot activate query drill if your document already has a scope of analysis defined. In this case you receive a message telling you to clear the scope of analysis before activating query drill.

You can see how Web Intelligence has modified the scope of analysis and query filters to match the drill by viewing the Query Panel during a query drill session.

Note: The scope of analysis is read-only during a query drill session.

Query drill and other reports based on the same data provider

If your document contains other reports that contain dimensions on which you drill in query drill mode, these reports are affected because the query drill modifies the dimensions they contain.

Example: Drilling on a dimension that appears in another report

If you have two reports based on a query that contains Year, Quarter and Sales Revenue, and you use query drill to drill down to Year = 2001 on the first report, Web Intelligence also filters the data for Year in the second report to include 2001 only.

You can avoid this (at the cost of retrieving duplicate data into Web Intelligence) by creating a new data provider and rebuilding the other report against it. Now when you drill in query drill mode, the other report remains unaffected.

Query drill and drill snapshots

Do not use drill snapshots when working in query drill mode, because query drill means that snapshots cannot be guaranteed to stay the same. (For more information on snapshots, see “Saving your drilled results” on page 519.)

In query drill mode, snapshots change when you drill up beyond a dimension that you included in a snapshot. Because the drill up removes the dimension from the underlying query, it also removes the dimension from the snapshot.

Activating query drill

You activate query drill at the document level.
Setting up documents for drill analysis

Using query drill

To activate query drill

1. Right-click on the document anywhere outside a table or chart and click Document Properties to display the Document Properties pane.
2. Open the Document Options group within the tab.
3. Check Use query drill.

Note: If your report already has a scope of analysis defined, you see a message telling you to clear the scope of analysis before activating query drill.
Ending Drill Mode

When you end drill mode in Web Intelligence, you return to View mode. Any filters generated in drill mode become simple report filters.

Ending your drill session

You can end your drill session only from the Report View.

Ending drill mode

To end your drill session in Web Intelligence:

• Click the Drill button in the toolbar.

The Drill toolbar is removed, and the report appears in Results mode.

Saving your drilled results

You can save your drilled results by:

• taking a snapshot of the drilled report – Web Intelligence inserts a duplicate of the drilled report in the document in Results View as a reference. You can continue drilling in the current report.

• saving the report while you are still in Drill mode – when you or another user opens the document, the drilled report is in Drill mode.

Taking a snapshot of a drilled report

To take a snapshot of a drilled report:

1. Make sure you are in Drill mode.
   The Drill button is pressed in when you are working in Drill mode.
2. In the toolbar, click the Snapshot button.
   A new report appears after your last report in the document.
Setting up documents for drill analysis

**Ending Drill Mode**

- **Saving a report in Drill mode**
  
  To save a report in Drill mode:

  1. Click the **Save** button to save a document you have saved previously. 
     Or 
     
     Click the arrow next to the **Save** button, and then save the document as either a Corporate Document or as a Personal Document. 

  For full information on saving Web Intelligence documents using the Java Report Panel, see “Saving and deleting Web Intelligence documents” on page 523.
Printing your report in drill mode

You print your report in drill mode like other Web Intelligence reports.

For more information, see “Printing Web Intelligence documents” on page 545.

Tip: Filters in the Drill toolbar do not appear when you print a Web Intelligence report. You can insert a special field to display the active filters the Drill toolbar. For full information on the DrillFilter function, see “Inserting the DrillFilters cell into your report” on page 512.
Setting up documents for drill analysis

Ending Drill Mode
Saving and deleting Web Intelligence documents
Overview

You can save Web Intelligence documents exclusively for your personal reference or share your documents with other users. You save Web Intelligence documents to InfoView, the corporate business intelligence portal.

You can also save Web Intelligence documents as Microsoft Excel spreadsheets and Adobe Acrobat PDF files. The layout and formatting in the original Web Intelligence document is closely retained in the new file format.

This chapter tells you how to:
• save Web Intelligence documents to InfoView
• delete Web Intelligence documents from InfoView
• save Web Intelligence documents as Excel or PDF files

This chapter tells you how to save documents using the Java Report Panel. For information on how to save documents when viewing them in InfoView, see “Saving and deleting Web Intelligence documents” on page 523.
Saving Web Intelligence documents to InfoView

You save documents to InfoView. Depending on whether you want exclusive access to documents or whether you want to share documents with other users, you can save documents to personal or public folders. Two options are available when you save a Web Intelligence document to InfoView:

- **Save** – to save a new document or replace a document with a newer version
- **Save as** – to save a newer version of a document with a different name

**Note:** Before you can save a document, you need to run the query at least once. To do this, click Run Query or Refresh. The results are displayed on the report(s).

**Saving a new document or replacing a document with a newer version**

To save a new document or to replace a document with a newer version:

1. Using the Java Report Panel, make your changes to the document.
2. Click the **Save** button on the Web Intelligence toolbar.
   
   The InfoView **Save** page opens.
3. In the **Title** box, type the title of the document.
4. In the **Description** box, type a meaningful description of the document (optional).
5. In the **Keywords** box, type keywords that you or other users can use to search for the document in the future.
   
   By default, the document is saved to the current location displayed in the **Location** box.
6. Select the folder where you want to save the document in the **Location** box.
7. Select the categories that you want to associate with the document in the **Categories** box.
8. Click **OK**.
The document is saved in InfoView.
Deleting Web Intelligence documents

You can delete the Web Intelligence documents you save to InfoView.

**Note:** You can only delete documents from InfoView, if you have the appropriate security profile.

▶ **Deleting your Web Intelligence documents from InfoView**

To delete your Web Intelligence documents from InfoView:

1. From the InfoView home page, navigate to the folder that contains the document you want to delete.
   
The documents are listed.

   ![Folder with documents]

2. Click the check box next to the name of the document you want to delete.

3. Click Delete.
   
   A message prompts you to confirm if you want to delete the selected document.

4. Click OK.
   
   The document is deleted from InfoView.
Saving documents as Excel or PDF files

You can save Web Intelligence documents as two different file formats:

- Microsoft Excel spreadsheets
- Adobe Acrobat PDF files

Saving Web Intelligence documents as Excel Spreadsheets

Creating a copy of your documents as a Microsoft Excel file is especially useful if you want to combine the information in your Web Intelligence document with other data in an Excel spreadsheet.

Unlike Web Intelligence documents, the Excel files are not connected to the database. This means you cannot refresh the data in the Excel file. To display up-to-date data in Excel format, refresh the Web Intelligence document and then save it as a new Excel file.

Tip: When you name reports in a document that you want to save as an Excel spreadsheet, the names of reports must not include more than 31 characters or include spaces or the following special characters: * : / [ ]

Note: Dates prior to 1900 do not display correctly in Excel.

Saving a Web Intelligence document as an Excel spreadsheet

To save a Web Intelligence document as an Excel spreadsheet:

1. Click the arrow next to the Save button on the Web Intelligence toolbar.
2. From the Save menu, select Save to my computer as...
   The Excel and PDF format options appear.
3. Select As Excel.
   Web Intelligence generates a copy of your document in Microsoft Excel Format. Each report within the Web Intelligence document converts to a separate Excel worksheet within the Excel file.
   You can save the document using the Excel Save menu. The file has the standard Microsoft Excel file extension: .xls.
Note: Some Web Intelligence chart formats do not exist in Excel format. These charts are automatically converted to the closest corresponding chart format available in Excel.

To share Excel files with other users, you can save them to InfoView. For more information, see the BusinessObjects Enterprise InfoView User’s Guide.

Generating Web Intelligence documents to PDF

Creating a copy of your documents as a PDF file is especially useful if you want to provide other users with the document information in a printable format. The page layout and formatting of the Web Intelligence document is retained in the PDF file.

► Saving a Web Intelligence document as a PDF
To save a Web Intelligence document as a PDF file:

1. Click the arrow next to the Save button on the Web Intelligence toolbar.
2. From the Save menu, select Save to computer as...
The Excel and PDF format options appear.
3. Select As PDF.
Web Intelligence generates a copy of your document in Adobe Acrobat PDF Format.

You can save the document using the Acrobat Save menu. The file has the standard Microsoft Excel file extension: pdf.

To share PDF files with other users, you can save them to InfoView. For more information, see the BusinessObjects Enterprise InfoView User’s Guide.
Saving and deleting Web Intelligence documents

Saving documents as Excel or PDF files
Chapter 27

Linking documents with OpenDocument
Overview

OpenDocument is a function that enables you to open another document from within a Web Intelligence document using a URL. You can use OpenDocument to create a hyperlink in one document that opens another document containing related information. Both documents must be stored in the corporate repository and accessible through InfoView.

How OpenDocument works

You place the OpenDocument function in a report cell in the form:

`=OpenDocument function`

For example:


Example: Link a report, showing sales revenue results for US states to a document showing store information for the state you choose

In this example a Web Intelligence report displays sales revenue per US state for each quarter. A particularly high result interests you. You would like to find out more information about the retail outlets in a specific state, to understand more about their operating conditions, and find out the name of the store managers you could contact across that state.

You click on the hyperlink on the cell that displays “New York.” A document opens that contains detailed information about the stores in New York.

Using prompts to filter results in the opened document

You can define the hyperlink to pass parameters that enter one or more values as the response to prompts on the target document. This enables you to dynamically filter the document you open by the specific values you want to analyze.

In the example given above, the target document has a prompt on the [State] object and the OpenDocument hyperlink in the parent document requests Web Intelligence to use the value that is clicked as the value for the prompt. So, when you click the hyperlink on “New York”, you see only those values for New York in the target document that opens.
You can specify a value in the hyperlink that is different from the value displayed in the hyperlink. For example, you can create the hyperlink in the cell that displays the sales revenue values and specify that the target report is filtered by whichever state is displayed on the same table row as the clicked hyperlink.

You can filter the target document by as many prompts as you like. For example, the same hyperlink can also filter the target document by whichever state, product line, and quarter is displayed on the same table row.

You can also filter the target document by multiple values, even though the document contains only a single prompt. For example, a target document with a single prompt on a dimension that represents data for [Flight Number] can be filtered by values for other objects in the query definition that are logically related, such as [Arrival Time] and [Departure Time]. Information on the syntax for single-value and multi-value prompts is provided on "Using prompts to filter results in the opened document" on page 532.

Supported document types

You can use OpenDocument to create cross-system links to and from the following document types:

- .wid: Web Intelligence version 6.x documents
- .rpt: Crystal reports
- .car: OLAP Intelligence reports

OpenDocument syntax

The general syntax of OpenDocument is
http://<webserver>/businessobjects/enterprise115/<platformSpecific>?<parameter_list>

There are two implementations of OpenDocument. The form of the <platformSpecific> portion depends on your implementation:

- For Java implementations, use desktoplaunch/opendoc/openDocument.jsp in place of <platformSpecific>, for example:
  http://<webserver>/businessobjects/enterprise115/desktoplaunch/opendoc/openDocument.jsp?sType=wid
For .NET implementations, use `InfoView/scripts/opendocument.aspx` in place of `<platformSpecific>`, for example:

http://<webserver>/businessobjects/enterprise115/
InfoView/scripts/opendocument.aspx?sType=wid

### OpenDocument parameters

OpenDocument parameters can appear in any order and must be separated by an ampersand (&). For example, `sType=wid&sDocName=Sales2003`. Do not place spaces around the ampersand.

The parameters are listed in the following tables.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Mandatory?</th>
<th>Values accepted</th>
</tr>
</thead>
<tbody>
<tr>
<td>sPath</td>
<td>The name of the Crystal folder and subfolder containing the target document.</td>
<td>Yes if <code>sDocName</code> is specified and is not unique.</td>
<td>Crystal folder and/or subfolder: [folder], [subfolder]</td>
</tr>
</tbody>
</table>

#### Example: Example of sPath

http://<webserver>/businessobjects/enterprise115/<platformSpecific>?sPath=Sales+Reports,Sub+Folder.

**Note:** To ensure correct URL encoding, the spaces in this parameter and several following parameters are replaced with +. You can ensure correct URL encoding of parameter values with the WebIntelligence `URLEncode()` function. For more information on URL encoding parameter values, see “URL encoding” on page 542.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Mandatory?</th>
<th>Values accepted</th>
</tr>
</thead>
<tbody>
<tr>
<td>sType</td>
<td>The type of target document or report.</td>
<td>Yes.</td>
<td>.wid .rpt .car</td>
</tr>
</tbody>
</table>
Example: Example of sType
http://<webserver>/businessobjects/enterprise115/<platformSpecific>?sType=wid

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Mandatory?</th>
<th>Values accepted</th>
</tr>
</thead>
<tbody>
<tr>
<td>sDocName</td>
<td>The document name</td>
<td>One of sDocName or iDocID is mandatory.</td>
<td>The document name.</td>
</tr>
</tbody>
</table>

Example: Example of sDocName
http://<webserver>/businessobjects/enterprise115/<platformSpecific>?sPath=Sales+Reports&sDocName=Sales+in+2005

Note: Do not specify both the sDocID and sDocName parameters in the same parameter list. Specify one or the other.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Mandatory?</th>
<th>Values accepted</th>
</tr>
</thead>
<tbody>
<tr>
<td>iDocID</td>
<td>The document identifier.</td>
<td>One of sDocName or iDocID is mandatory.</td>
<td>The document identifier.</td>
</tr>
</tbody>
</table>

Example: Example of sDocID
http://<webserver>/businessobjects/enterprise115/<platformSpecific>?sType=wid&iDocID=2010

Tip: To obtain the document ID, navigate to the document in InfoView, hover your mouse over the document name hyperlink, and look for the ID number in the browser’s status bar. You can also obtain the document ID from the Central Management Console.
**Note:** Do not specify both the `sDocID` and `sDocName` parameters in the same parameter list. Specify one or the other.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Mandatory?</th>
<th>Values accepted</th>
</tr>
</thead>
</table>
| `sIDType` | The Crystal object type.             | Yes if the target is a Crystal report or OLAP Intelligence report (`sType=rpt or car`), otherwise, use `sPath` and `sDocName`. | • CUID  
  • GUID  
  • RUID  
  • ParentID  
  • InfoObjectID (default) |
Example: Example of sIDType
http://<webserver>/businessobjects/enterprise115/<platformSpecific>?iDocID=AWimiw9StnhGm993evk.Amc&sIDType=CUID

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Mandatory?</th>
<th>Values accepted</th>
</tr>
</thead>
<tbody>
<tr>
<td>sReportName</td>
<td>The report to open if the target document is multi-report.</td>
<td>No. (First report is the default value.)</td>
<td>Report name for Web Intelligence documents, sub-report for Crystal Reports, pages for OLAP Intelligence reports.</td>
</tr>
</tbody>
</table>

Example: Example of sReportName
http://<webserver>/businessobjects/enterprise115/<platformSpecific>?sType=wid&sDocName=Sales+in+2003&sReportName=First+Report+Tab

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Mandatory?</th>
<th>Values accepted</th>
</tr>
</thead>
</table>
| sOutputFormat   | Format in which the target document is opened.                              | No. (Default is HTML.) | • H (HTML)  
• P (PDF)  
• E (Excel)  
• W (Word)  
**Note:** W is supported by Crystal Reports only. |

Example: Example of sOutputFormat
http://<webserver>/businessobjects/enterprise115/<platformSpecific>?sPath=Sales+Reports&sDocName=Sales+in+2003&sOutputFormat=E

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Mandatory?</th>
<th>Values accepted</th>
</tr>
</thead>
<tbody>
<tr>
<td>sReportPart</td>
<td>The part of the report to open.</td>
<td>No.</td>
<td>The name of the report part.</td>
</tr>
</tbody>
</table>
### Example: Example of `sReportPart`

```
http://<webserver>/businessobjects/enterprise115/
<platformSpecific>?sPath=Sales+Reports&sDocName=Sales+in
+2003&sReportPart=Part1
```

### Parameter Description Mandatory? Values accepted
---
`sPartContext` The data context of the report part (Crystal Reports only). Yes if a value is specified for `sReportPart`. The data context of the report part.

### Example: Example of `sPartContext`

```
http://<webserver>/businessobjects/enterprise115/
<platformSpecific>?sPath=Sales+Reports&sDocName=Sales+in
+2005&sReportPart=Part1&sPartContext=0-4-0
```

### Parameter Description Mandatory? Values accepted
---
`sInstance` The instance of the target report to open. No. User (Link to latest instance owned by current user)
- Last (Link to latest instance for report)
- Param (Link to latest instance of report with matching parameter values)

### Example: Example of `sInstance`

```
http://<webserver>/businessobjects/enterprise115/
<platformSpecific>?sPath=Sales+Reports&sDocName=Sales+in
+2003&sReportPart=Part1&sInstance=User
```

### Parameter Description Mandatory? Values accepted
---
`sReportMode` For Crystal targets only, indicates whether the link should open the full target report or just the report part specified in `sReportPart`. No. (Default is Full.) Full, Part
Example: Example of sReportMode

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Mandatory?</th>
<th>Values accepted</th>
</tr>
</thead>
<tbody>
<tr>
<td>sRefresh</td>
<td>Indicates whether a refresh should be forced when the target document or report is opened.</td>
<td>No.</td>
<td>• Y (forces the document refresh) • N (note that the refresh on open feature overrides this value)</td>
</tr>
</tbody>
</table>

Example: Example of sRefresh
http://<webserver>/businessobjects/enterprise115/ <platformSpecific>?sType=wid&sDocName=SalesReport&iDocID =2010&sRefresh=Y

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Mandatory?</th>
<th>Values accepted</th>
</tr>
</thead>
<tbody>
<tr>
<td>sWindow</td>
<td>Indicates whether the target report will open in the current browser window or a new window.</td>
<td>No</td>
<td>• Same (current window) • New (new window)</td>
</tr>
</tbody>
</table>

Example: Example of sWindow
http://<webserver>/businessobjects/enterprise115/ <platformSpecific>?sType=wid&sDocName=SalesReport&iDocID =2010&sWindow=New

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Mandatory?</th>
<th>Values accepted</th>
</tr>
</thead>
<tbody>
<tr>
<td>IsS[NAME]</td>
<td>Specifies a single value for a prompt. [NAME] is the prompt text.</td>
<td>No.</td>
<td>A single prompt value.</td>
</tr>
</tbody>
</table>
### Linking documents with OpenDocument

**OpenDocument syntax**

**Example:** Example of lsS[NAME]

http://<webserver>/businessobjects/enterprise115/<platformSpecific>?sType=wid&sDocName=SalesReport&iDocID=2010&lsSSelect+a+City=Paris

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Mandatory?</th>
<th>Values accepted</th>
</tr>
</thead>
<tbody>
<tr>
<td>lsS[NAME]</td>
<td>Specifies multiple values for a prompt. [NAME] is the prompt text.</td>
<td>No.</td>
<td>Multiple prompt values, separated by a comma. If the target is a Crystal report, each value must be enclosed in square brackets. If the target is an OLAP Intelligence report, use the MDX WITH clause.</td>
</tr>
</tbody>
</table>

**Example:** Example of lsM[NAME]

http://<webserver>/businessobjects/enterprise115/<platformSpecific>?sType=rpt&sDocName=SalesReport&lsMSel ect+Cities=[Paris],[London]

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Mandatory?</th>
<th>Values accepted</th>
</tr>
</thead>
<tbody>
<tr>
<td>lsM[NAME]</td>
<td>Specifies a range of values for a prompt. [NAME] is the prompt text.</td>
<td>No.</td>
<td>A range of values separated by a double period (..). If the target is a Crystal report, the range must be enclosed in square brackets and/or parentheses (use a square bracket next to a value to include it in the range, and parentheses to exclude it). If the target is an OLAP Intelligence report, use the MDX WITH clause.</td>
</tr>
</tbody>
</table>

**Note:** Not supported by OLAP Intelligence.
Example:  Example of lsR[NAME]

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Mandatory?</th>
<th>Values accepted</th>
</tr>
</thead>
<tbody>
<tr>
<td>lsU</td>
<td>URL to which the user is redirected.</td>
<td>No.</td>
<td>A URL.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Not supported by OLAP Intelligence.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Example:  Example of lsU

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Mandatory?</th>
<th>Values accepted</th>
</tr>
</thead>
<tbody>
<tr>
<td>lsC</td>
<td>Specifies a universe context (BusinessObjects and Web Intelligence documents only).</td>
<td>No.</td>
<td>Universe context.</td>
</tr>
</tbody>
</table>

Example:  Example of lsC
http://<webserver>/businessobjects/enterprise115/<platformSpecific>?sType=wid&sDocName=SalesReport&iDocID=2010&lsC=Sales
Linking documents with OpenDocument

OpenDocument syntax

Example:  Example of NAII
http://<webserver>/businessobjects/enterprise115/<platformSpecific>?sType=wid&sDocName=SalesReport&iDocID=2010&NAII=Y

Further information on syntax and parameters

URL encoding

Parameters cannot contain spaces or other special characters that require URL encoding. Use the WebIntelligence URLEncode() function to ensure correct URL encoding.

Example:  Encoding the sDocName parameter
To pass the string “World Sales Report” in the sDocName parameter, use sDocName=URLEncode(“World Sales Report”). This ensures that the string is passed URL-encoded as “World+Sales+Report”

The examples given earlier in this section do not specify the URLEncode() function explicitly. They give URL parameter values in URL-encoded form.

Trailing spaces

Trim trailing spaces at the end of parameter values and prompt names. Do not replace them with a plus sign (+). The viewer may not know whether to interpret the plus sign (+) as part of the prompt name or as a space. For example, if the prompt name displays:

Select a City:_
(where _ represents a space), enter the following text in the link:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Mandatory?</th>
<th>Values accepted</th>
</tr>
</thead>
</table>
| NAII      | Forces the display of the prompt selection page. **Note:** Not supported by OLAP Intelligence. | No. | • Y (all prompts whose values are passed with lsS, lsM or lsR are pre-selected).  
• N (displays only the prompts whose values passed with lsS, lsM or lsR) |
lsSSelect+a+City:=Paris

where the spaces within the prompt name are replaced with the plus sign,
and the trailing space is trimmed off.

Note: You can use the Web Intelligence RightTrim() function to trim trailing spaces.

Case sensitivity

All the OpenDocument parameters are case sensitive.

Length limit

The encoded URL cannot exceed 2083 total characters.

Prompts for OLAP Intelligence report targets

If the target document is an OLAP Intelligence report (.car) you can use the lsS and lsM parameters to specify prompts.

Using the lsS parameter with OLAP Intelligence

The parameters are passed in as a URL-encoded string using the unique name of the parameter set up in the OLAP Intelligence report.

Example: Opening a report to a specific page

If the URL-encoded unique name for the page parameter in the OLAP Intelligence report is 23CAA3C1-8DBB-4CF3-BA%2CB8%2CD7%2CF0%2C68%2CEF%2C9C%2C6F, you use the following URL to open the OLAP Intelligence report to page 2:

http://<webserver>/businessobjects/enterprise115/<platformSpecific>?sType=car&sIDType=InfoObject&iDocID=440&lsS23CAA3C1-8DBB-4CF3-BA%2CB8%2CD7%2CF0%2C68%2CEF%2C9C%2C6F=2

Example: Opening a cube parameter

If the URL-encoded unique name for the cube parameter opening the warehouse cube in the catalogue FoodMart 2000 on MSAS is 8401682C-9B1D-4850-8B%2C5E%2CD9%2C1F%2C20%2CF8%2C1%2C62, you would use the following URL to open this cube parameter:

http://<webserver>/businessobjects/enterprise115/<platformSpecific>?sType=car&sIDType=InfoObject&lsS8401682C-9B1D-4850-8B%2C5E%2CD9%2C1F%2C20%2CF8%2C1%2C62=CATALOG%3DFoodMart%2020
Using the lsM parameter with OLAP Intelligence

lsM parameters are also passed in as a URL-encoded string using the unique name of the parameter set up in the OLAP Intelligence report.

The following is an example of using lsM:

http://<webserver>/businessobjects/enterprise115/
<platformSpecific>?sType=car&sIDType=InfoObject&lsMADC216EA-09A5-4285-6E%2C21%2C84%2CA9%2CF9%2C6E%2C31%2C7=[%5BCustomers%5D.%5BCountry%5D.%26%5BMexico%5D],[%5BCustomers%5D.%5BCountry%5D.%26%5BCanada%5D]&iDocID=544

This is a memberset parameter opening up a report with Customers > Country > Mexico and Customers > Country > Canada in the view.

Sub-reports

You cannot pass parameter values to a sub-report of a target Crystal report.
Printing Web Intelligence documents
Overview

You print Web Intelligence documents report-by-report. You can print one or multiple reports from a single document. Web Intelligence generates a temporary PDF file from the selected report before printing.

This chapter tells you how to:

• print reports in Web Intelligence documents using the Java Report Panel

**Note:** To print Web Intelligence reports, you need Adobe Acrobat Reader installed on your local computer. If you don’t have Acrobat Reader installed, you can download Acrobat Reader free at: [http://www.adobe.com/products/acrobat/readstep2.htm](http://www.adobe.com/products/acrobat/readstep2.htm)

**Note:** If you don’t have Internet access to download Acrobat Reader, you can print reports using the Print menu of your web browser. However, when you use your browser to print, the page layout and formatting is determined by the browser.
Printing the reports in documents

You print Web Intelligence documents report-by-report. This section of the guide tells you how:

• Web Intelligence inserts page breaks for printing
• to print reports in Web Intelligence documents

How Web Intelligence organizes page breaks

Web Intelligence prints reports from left to right, and then top to bottom. If a report is wider than the width of the paper size defined in the Report Page Layout, Web Intelligence inserts page breaks for the printout, as illustrated below:

If the report page is wider than the paper size defined in the Report Page Layout properties...

...the page breaks go from left to right.
The paper size and page orientation for printing can be different from the paper size and page orientation set for the reports when you view them in the Java Report Panel. This enables users using different printers to specify the appropriate layout when they print. You define the paper size and page orientation of printed reports when you define the print setup, see “Printing a report” on page 548.

Printing reports in Web Intelligence documents

You print Web Intelligence documents report-by-report. You can print one or multiple reports from a single document. This section tells you how to print Web Intelligence reports when you are working in the Java Report Panel. For information on printing reports when you are viewing a document in InfoView, see the Performing On-Report Analysis with Web Intelligence guide.

Printing a report

To print a report:

1. Make sure you are in Edit Report View.
   The Edit Report button on the Web Intelligence toolbar is pressed in when you are in Edit Report View.
2. Make sure you are in Results View.
   Results View displays the data in the report tables and charts.
3. Click the report tab of the report you want to print.
4. Click the Export to PDF for Printing button on the Report toolbar.
   The Make Printable Version dialog box appears.
5. Under the Print Range option, you specify whether you want to print the entire selected report or just some of the report pages:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>print the entire report</td>
<td>select <strong>Current report</strong></td>
</tr>
<tr>
<td>print the page currently displayed</td>
<td>select <strong>Current page</strong></td>
</tr>
<tr>
<td>print a range of pages you specify</td>
<td>in the <strong>Pages</strong> box: type specific page numbers separated by commas (for example: 1,4,5) or indicate a page range (for example, 2-4)</td>
</tr>
</tbody>
</table>

You can specify the paper size of the report or page(s) for the printout. The paper size you set for printing overrides the paper size defined for the report in the Report Properties Page Layout tab.

6. To change the paper size, click the arrow next to the list box below **Paper Size**, and then select a different paper size from the list.
7. Under the Orientation options, select the page orientation that suits the report page layout:

<table>
<thead>
<tr>
<th>For this page orientation...</th>
<th>select...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portrait</td>
<td></td>
</tr>
<tr>
<td>Landscape</td>
<td></td>
</tr>
</tbody>
</table>

8. Click OK.
   Web Intelligence generates a copy or the report to a PDF file.

9. If you receive a prompt offering you the choice to open or save the file to your computer, select Open.
   The report opens in Adobe Acrobat.

10. You can print the report using the Print button or menu on the Acrobat toolbar.

11. If you want to print other reports in the same document, repeat steps 3. to 10.
Business Objects
Information Resources
Documentation and information services

Business Objects offers a full documentation set covering its products and their deployment. Additional support and services are also available to help maximize the return on your business intelligence investment. The following sections detail where to get Business Objects documentation and how to use the resources at Business Objects to meet your needs for technical support, education, and consulting.

Documentation

You can find answers to your questions on how to install, configure, deploy, and use Business Objects products from the documentation.

What’s in the documentation set?

View or download the Business Objects Documentation Roadmap, available with the product documentation at http://www.businessobjects.com/support/. The Documentation Roadmap references all Business Objects guides and lets you see at a glance what information is available, from where, and in what format.

Where is the documentation?

You can access electronic documentation at any time from the product interface, the web, or from your product CD.

Documentation from the products

Online help and guides in Adobe PDF format are available from the product Help menus. Where only online help is provided, the online help file contains the entire contents of the PDF version of the guide.

Documentation on the web

The full electronic documentation set is available to customers with a valid maintenance agreement on the Online Customer Support (OCS) on the web from support web site at: http://www.businessobjects.com/support/.
Documentation on the product CD

Look in the docs directory of your product CD for versions of guides in Adobe PDF format.

Buy the documentation CD

You can order the CD containing the full electronic documentation set on the Business Objects website. www.businessobjects.com/services/documentation.htm

This CD brings together the full set of documentation in searchable, printable Adobe PDF format, plus tips and tricks, and demo materials.

Tips & Tricks

Open to everyone, this is a regularly updated source of creative solutions to any number of business questions. You can even contribute by sending us your own tips.

www.businessobjects.com/forms/tipsandtricks_login.asp

Developer Suite Online

Developer Suite Online provides documentation, samples, and tips to those customers with a valid maintenance agreement and a Developer Suite license via the Online Customer Support (OCS) website.


Knowledge Exchange and Knowledge Base

Our Knowledge Exchange is an open, online forum for Business Objects users to share business intelligence strategies, experiences, ideas, and opinions. It's a great way to find technical answers to your problems, rate the information you see, share thoughts with others, and receive specialized technical information.

The Knowledge Base, accessible if you have a valid maintenance contract, is a regularly updated, searchable database containing technical articles and resolutions to customer cases.

http://www.techsupport.businessobjects.com/
Send us your feedback

Do you have a suggestion on how we can improve our documentation? Is there something you particularly like or have found useful? Drop us a line, and we will do our best to ensure that your suggestion is included in the next release of our documentation: documentation@businessobjects.com.

Note: If your issue concerns a Business Objects product and not the documentation, please contact our Customer Support experts. For information about Customer Support visit: http://www.businessobjects.com/support/.

Customer support, consulting and training

A global network of Business Objects technology experts provides customer support, education, and consulting to ensure maximum business intelligence benefit to your business.

How can we support you?

Business Objects offers customer support plans to best suit the size and requirements of your deployment. We operate customer support centers in the following countries:

• USA
• Australia
• Canada
• United Kingdom
• Japan

Online Customer Support

The Business Objects Customer Support web site contains information about Customer Support programs and services. It also has links to a wide range of technical information including knowledgebase articles, downloads, and support forums.

http://www.businessobjects.com/support/
Looking for the best deployment solution for your company?

Business Objects consultants can accompany you from the initial analysis stage to the delivery of your deployment project. Expertise is available in relational and multidimensional databases, in connectivities, database design tools, customized embedding technology, and more.

For more information, contact your local sales office, or contact us at:
http://www.businessobjects.com/services/consulting/

Looking for training options?

From traditional classroom learning to targeted e-learning seminars, we can offer a training package to suit your learning needs and preferred learning style. Find more information on the Business Objects Education web site:
http://www.businessobjects.com/services/training
Useful addresses at a glance

<table>
<thead>
<tr>
<th>Address</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Business Objects product information</strong></td>
<td>Information about the full range of Business Objects products.</td>
</tr>
<tr>
<td><a href="http://www.businessobjects.com">http://www.businessobjects.com</a></td>
<td></td>
</tr>
<tr>
<td><strong>Business Objects Documentation Roadmap</strong></td>
<td>Overview of Business Objects documentation.</td>
</tr>
<tr>
<td><a href="http://www.businessobjects.com/support">www.businessobjects.com/support</a></td>
<td></td>
</tr>
<tr>
<td><strong>Product documentation</strong></td>
<td>Business Objects product documentation, including the Business Objects Documentation Roadmap.</td>
</tr>
<tr>
<td><a href="http://www.businessobjects.com/support">http://www.businessobjects.com/support</a></td>
<td></td>
</tr>
<tr>
<td><strong>Business Objects Documentation mailbox</strong></td>
<td>Send us feedback or questions about documentation.</td>
</tr>
<tr>
<td><a href="mailto:documentation@businessobjects.com">documentation@businessobjects.com</a></td>
<td></td>
</tr>
<tr>
<td><strong>Tips &amp; Tricks</strong></td>
<td>Business-focused examples.</td>
</tr>
<tr>
<td><a href="http://www.businessobjects.com/forms/tipsandtricks_login.asp">www.businessobjects.com/forms/tipsandtricks_login.asp</a></td>
<td></td>
</tr>
<tr>
<td><strong>Developer Suite Online</strong></td>
<td>Requires a valid maintenance agreement and a Developer Suite License.</td>
</tr>
<tr>
<td><a href="http://www.techsupport.businessobjects.com">www.techsupport.businessobjects.com</a></td>
<td></td>
</tr>
<tr>
<td><strong>Knowledge Base (KB) and Knowledge Exchange</strong></td>
<td>Technical articles, documents, case resolutions, plus an online forum.</td>
</tr>
<tr>
<td><a href="http://www.techsupport.businessobjects.com">www.techsupport.businessobjects.com</a></td>
<td></td>
</tr>
<tr>
<td><strong>Online Customer Support</strong></td>
<td>Information on Customer Support programs, as well as links to technical articles, downloads, and online forums.</td>
</tr>
<tr>
<td><a href="http://www.businessobjects.com/support/">http://www.businessobjects.com/support/</a></td>
<td></td>
</tr>
<tr>
<td><strong>Business Objects Consulting Services</strong></td>
<td>Information on how Business Objects can help maximize your business intelligence investment.</td>
</tr>
<tr>
<td><a href="http://www.businessobjects.com/services/consulting/">http://www.businessobjects.com/services/consulting/</a></td>
<td></td>
</tr>
<tr>
<td><strong>Business Objects Education Services</strong></td>
<td>Information on Business Objects training options and modules.</td>
</tr>
<tr>
<td><a href="http://www.businessobjects.com/services/training">http://www.businessobjects.com/services/training</a></td>
<td></td>
</tr>
</tbody>
</table>
Index

#DATASYNC error 465
#DIV/0 error 463
#ERROR error 467
#INCOMPATIBLE error 465
#MULTIVALUE error 464
#OVERFLOW error 464
#RANK error 315, 465
#SYNTAX error 464

Symbols
3D look
   charts 248
508-compliancy 19

A
accessibility 19
adding
   breaks 301
   sub-alerters 362
   table rows, columns 182
Adobe
   installing Reader 545
aggregation
   show/hide duplicate rows 210
alerters
   adding conditions 370
   adding sub-alerters 375
   creating 356
   defining conditions 358
   defining formatting with formulas 392, 397
   describing 348
   describing sub-alerters 374
   display a skin 366
   display an image 365
   duplicating 385
   editing 384
   prioritizing for a cell 382
   prioritizing in a document 383
   removing 387
   removing conditions 372
   removing sub-alerters 377
   saving 363
   sub-alerters 362
   using formulas in 388, 393
   using on tables with breaks 354
ambiguous query
   describing 61
And operator
   describing 124
   example 125
   with Or for query filters 126
area charts
   describing 227
ASP mode 25
AutoFit
   table cell size 205
Average
   example on filtered report 325
   inserting 341
axis legends
   formatting charts 251
   inserting on charts 251
axis values
   formatting charts 256
   setting range on charts 257

B
background colors
   for charts 249
   for tables 198
Bar charts
   describing 227
blank cells
   inserting 216
boolean formats 269
boolean logic 391
Index

borders
   for charts 249
   for tables 202

breaks
   adding 301
   applying alerters 354
   applying conditional formatting 354
   describing 294, 294
   editing 301
   inserting 296, 296
   removing 301
   sorting data within 295
   using multiple 298

building
   a query 46
   multiple queries 81
   query overview 46

Business Objects
   consulting services 555, 556
   support services 554
   training services 555, 556, 556

calculation context
   default 413
   defined 412
   describing 412
   modifying 418

calculations
   inserting standard 344
   removing 345
   using in reports 341

cells
   AutoFit size 205
   backgrounds 223
   borders 223
   clearing 193
   defining height, width 204
   format values 269
   formatting free-standing cells 223
   formatting how values display 269
   free-standing 215
   hidden in migrated reports 204
   hiding 204
   inserting free-standing 216

charts
   3D look format 248
   adding titles 247
   area formats 227
   axis legends 251, 251
   axis value range 257
   background colors 249
   bar formats 227
   changing the template 236, 236
   creating 230
   deleting see charts - removing
   drill axis legends 506
   drilling on 503, 504
   filtering 324, 329
   format background 249
   formatting axis values 256
   formatting borders 249
   formatting data series 260
   legends 251
   line formats 227
   pie formats 228
   polar formats 228
   positioning on reports 240
   radar formats 228
   removing 239
   resizing 233, 246
   scatter formats 228
   setting page breaks 241
   show floors and walls 250
   show/hide data markers 262
   show/hide empty charts 263
   showing grids 258
   templates 227

class
   describing 43, 44
   opening folder 47

clearing
   table cells 193

closing
   class folder 47

colors
   alternate table rows 199
   table backgrounds 198

columns
adding to tables 182
deleting from tables see removing
removing from tables 185
replacing on tables 188
show/hide empty 209
swapping on tables 187
comments
in free-standing cells 217
conditions
adding to alerters 370
defining for alerters 358
removing from alerters 372
consultants, Business Objects 555
context
clearing list (Java) 57
describing 61, 61
list (Java) 57
selecting 63
selecting properties 63
use in query 62
copying
tables 176
Count
inserting 341
creating
alerters 356
charts 230
documents 25
formulas 403
query 44
sections 286
tables on reports 170
variables 450
crosstabs
creating from tables 190
displaying object names 207
template for 166
with dimensions in body 167
cube
description 45
stored data 45
currency formats 269
custom
formats for cell values 273, 274, 278, 280
report filters 329
customer support 554
D
data
returned to cube 45
data markers
show/hide on charts 262
data providers
multiple
merging dimensions from 94
database ranking
creating 142
defined 141
how it works 141
parameters 142
uses of 141
date formats 269
dates
creating prompts on 152
custom formats 273, 276
defining
multiple queries 83
query properties 56
deleting
charts see removing - charts
documents 527
table rows, columns see removing
variables 450
detail
describing 43
Developer Suite 553, 556
dimension
describing 43
dimensions
drilling on 485
in crosstab body cells 167
merging 94
displaying
prompts 152, 154
documentation
feedback on 554
on product CD 553
on the web 552
roadmap 552
documents 545
## Index

- **deleting** 527
- **linking** 393
- **saving** 525

**download**
- **report panel** 29

**drill analysis**
- **drill by** 491
- **drill by example** 490
- **drill down** 485, 488
- **drill paths** 481, 493
- **drill up** 489
- **drilling measures** 496, 503
- **drilling multiple blocks** 499
- **ending drill** 519
- **example** 473
- **filters** 509
- **hierarchies** 481, 482
- **on axis legends** 506
- **on charts** 501, 504
- **on duplicate report** 474
- **saving documents** 484
- **setting your options** 474
- **starting drill** 483

**DrillFilter**
- in printed reports 521

**DrillFilter function**
- including in reports 218

**drilling**
- **multiple query documents** 476, 507

**duplicating**
- **alerters** 385
- **queries** 87
- **reports for drill analysis** 474

**tables** 176

**E**

- **editing**
  - **alerters** 384
  - **breaks** 301
  - **formulas** 406
  - **variables** 450

- **education** see training

- **emptiness**
  - **hiding empty charts** 263

**Excel**

- **saving documents as spreadsheets** 528
- **extended syntax**
  - **modifying calculation context** 418

**F**

- **feedback, on documentation** 554
- **Filter Editor**
  - using for reports 329

**filtering**
- **linked documents** 532
- **objects** 109
- **queries** 108

**filters**
- **combining on queries** 113, 122, 123
- **combining on reports** 333
- **creating on queries** 117, 120
- **custom report filters** 329
- **during drill** 509
- **multi-value for document linking** 533
- **operators (queries)** 110
- **predefined on queries** 114, 115
- **query versus report** 108
- **quick filters** 117
- **quick for reports** 327
- **removing from reports** 336
- **report versus query** 326
- **single value for document linking** 533
- **types of for queries** 114
- **viewing on reports** 334, 334

**footers**
- **on tables** 206

**formats**
- **creating custom cell formats** 278
- **for cell values** 269
- **for negative values** 273

**formatting**
- **cell values** 269
- **conditional formatting (alerters)** 392
- **fonts and text in cells** 203
- **free-standing cells** 223
- **table borders** 202
- **tables** 197

**forms**
- **filtering** 324, 329
- **templates** 168
Index

Formula Editor
   using 406
formula errors
   #DATASYNC 465
   #DIV/0 463
   #ERROR 467
   #INCOMPATIBLE 465
   #MULTIVALUE 464
   #OVERFLOW 464
   #RANK 465
   #SYNTAX 464
Formula toolbar
   using 403
formulas
   creating 403
   defining alerter conditions with 388, 393
   defining alerter formatting with 392, 397
   editing 406
   insert in cells 217
   saving as variables 408, 451
   use variables to simplify 455
free-standing cells
   describing 215
   displaying page numbers 220
   formatting 223
   including DrillFilter 218
   including formulas 217
   including HTML code 217
   including hyperlinks 217
   including images 217
   including LastRefreshDate 218
   including text 217
   inserting 216
   labelling other cells 219
functions
   business examples 442, 445, 446
   describing 409, 440
   prototypes 440
   using 441

G
   grid
      report panel display 32
   grids
      showing on charts 258
   grouping
      data in breaks 294
H
   headers
      on crosstabs 207
      on tables 206
   height
      setting for cells 204
      setting for charts 246
   hierarchies
      and drill 481
      viewing 482
   HTML
      code in cells 217
   HTML Report Panel
      description 19
   hyperlinks
      including in cells 217
      report linking 532
      URL types in reports 399
I
   If function
      business example 446
   images
      define in alerters 365
      including in free-standing cells 217
      including in reports 216
   incompatible objects
      describing 66
      errors 66
   information resources 551, 552
InfoView
   logging in 23
   logging out 24
   URL 23
inserting
   Average 341
   breaks 295, 296, 296
   Count 341
   Max 341
   Min 341
   Percentage 341
Index

standard calculations 344
Sum 341
table rows, columns 184
interactive reporting
view format 478
interrupting queries 64

J
Java Report Panel
description 17
selecting 25

K
Knowledge Base 556, 556

L
labels
for free-standing cells 219
LastRefreshDate function
displaying in a cell 218
legends
inserting on charts 251
limits
max retrieval time 56
max rows retrieved 56
line charts
describing 227
linking documents 532
List of Values
for merged prompts on multiple queries 154
selecting query filters 118
selecting report filters 328
logging in 23
logging out 24

M
managing 301
breaks 301
markers (chart data)
show/hide 262
Max
inserting 341
max retrieval time
setting limits 56
max rows retrieved
setting limits 56
measure
describing 43
measures
drilling 496, 503
merged dimensions
adding to reports 98
and block filters 104
and report filters 103
and section filters 103
creating 95
deleting 98
drilling on 104
editing 97
extending returned values 100
filtering 102
using in reports 97
Min calculation
inserting 341
modifying
calculation context 418
moving
queries in a document 89
table rows, columns 186
multiple breaks
using 298
multiple queries 81
drilling 476, 507

N
negative formats 273
number
custom formats 273
numbers
displaying page numbers 220, 222

O
objects
describing 43
filtering 109
filtering on reports 321
for drill 481
Index

building 46
combining filters 122
defining multiple queries 83
drilling multiple queries 476, 507
duplicating 87
filtering 108, 109, 117
interrupting 64
moving in a document 89
naming 56
object types 43
prompts on multiple queries 153
purging 90
renaming 88
running 59
using contexts 62
query
defining properties 56
Query – HTML
description 17
query context
describing 61
query filters
combining 122
creating 120
describing 109
queries
ambiguous 61
quick filters
for reports 327
using on queries 117

R
radar charts
describing 228
range
for chart axes 257
ranking
and data order 315
and sorts 314
creating with Web Intelligence interface 309
demonstrations 311
parameters 310
tied rankings 314
workflows 308
refreshing report values
displaying last refresh date 218
removing
alerters 387
breaks 301
calculations 345
charts 239
objects from query 49
report filters 336
Table rows, columns 185
renaming
queries 88
report 333
report panel 28
reports
filtering 324, 327, 329, 333, 334, 336
printing 548
using quick filters 327
viewing filters 334, 334
resizing
charts 233, 237
resources 551, 552
Results View
describing 169
retrieve duplicate rows
setting (Java) 56
reusing custom formats 280
rows
adding to tables 182
deleting from tables see rows - removing
removing from tables 185
replacing on tables 188
show/hide empty 209
swapping on tables 187
running
query 44, 59

S
saving
alerters 363
documents as Excel spreadsheets 528
documents as PDF files
Acrobat 529
documents in drill mode 513, 520
formulas as variables 408, 451
saving documents 525
saving documents as PDF 529
scatter charts
describing 228
scope of analysis
describing 50
setting 50
types of 480
sections
creating 286
defining properties 289
filtering 324, 329
using to organize data 283
security
setting for query (Java) 57
security profile
download report panel 29
selecting
contexts 63
Java Report Panel 25
setting
create document options 25
levels of analysis 51
scope of analysis 50
skins
define in alerters 366
for table backgrounds 201
snapshots
of drilled reports 519
sorting
data within breaks 295
sorts
prioritizing multiple sorts 305, 305
SQL
viewing the query definition 53, 54
Structure View
describing 169
sub-alerters
adding 362, 375
describing 374
removing 377
subclass
describing 44
subquery
building 137
defined 136
description of 136
parameters 139
Sum
inserting 341
Sum function
business example 445
support
customer 554
locations 554
technical 554
web site 554
swapping
table columns, rows 187
T
tables
adding columns, rows to 182
adding rows, columns 183
alternate row colors 199
AutoFit cell size 205
background colors 198
cell size 204
clearing cells 193
creating 170
crosstab template 166
deleting rows, columns see removing
duplicate row aggregation 210
duplicating on reports 176
filtering 324, 329
format fonts and text 203
formatting 197
formatting borders 202
hidden cells in migrated reports 204
hiding cells 204
horizontal template 166
making into crosstabs 190
moving rows, columns 186
page breaks 208
page layout for 208
removing rows, columns 185
repeat headers, footers 209
replacing columns, rows 188
selecting templates 172
Index

show/hide headers and footers 206
show/hide when empty 209
swapping rows, columns 187
templates 165
turning to charts 178
using skins 201
vertical template 165
technical support 554
templates
changing charts with 236
changing tables with 179
charts 227, 236
crosstabs 166
forms 168
free-standing cells 216
horizontal tables 166
inserting for charts 230
selecting tables 172
tables 165
vertical tables 165
text
formatting in cells 223
inserting in cells 217
time
custom formats 273, 276
time formats 269
Tips & Tricks 553
titles
for charts 247
training, on Business Objects products 555
Turn To
tables to charts 178, 235, 237

U
universe
describing 42
URL
InfoView 23
syntax for hyperlinks 399
using
functions 441

V
values
for filters 112, 324
variables
creating 450
deleting 450
editing 450
formulas saved as 451
saving formulas as 408
use to simplify formulas 455
variance formula
simplify with variable 456
viewing
report filters 334, 334
SQL 53, 54

W
web
customer support 554
getting documentation via 552
useful addresses 556
web sites
support 554
training 555
width
setting for cells 204
setting for charts 246

566 Building Reports Using the Web Intelligence Java Report Panel